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About  this  document  

This document provides information about how to set up, install, configure, and 

work with the IBM®® System Storage® DS4000 Storage Manager Version 10.10 in 

the following host environments: 

v   AIX® 

v   HP-UX 

v   Solaris 

v   SUSE Linux® Enterprise Server 9 (SLES 9) on POWER™ 

v   SUSE Linux Enterprise Server 10 (SLES 10) on POWER 

v   Red Hat Enterprise Linux 4 (RHEL 4) on POWER. 

v   Red Hat Enterprise Linux 5 (RHEL 5) on POWER—SMclient only

Use this document to: 

v   Determine the hardware and software that is required to install the DS4000 

Storage Manager software into your subsystem network 

v   Install the DS4000 Storage Manager software 

v   Upgrade the controller’s nonvolatile storage random access memory (NVSRAM) 

and firmware 

v   Configure the host subsystem 

v   Identify management features that are unique to your specific installation

For information about installing Storage Manager on other host operating systems, 

see the IBM System Storage DS4000 Storage Manager Version 10 Installation and 

Host Support Guide for Windows 2000/Server 2003, NetWare, VMWare ESX 

Server, and Linux. 

This document does not cover hardware installation or integration. For information 

about these topics, see the DS4000 Installation and Host Guide that is appropriate 

for your storage subsystem. See Appendix H, “Accessibility,” on page 251 for a list 

of these documents. 

Who should read this document 

This document is intended for system administrators and storage administrators 

who are responsible for installing storage management software. 

Readers should have knowledge of the following concepts: 

v   Redundant array of independent disks (RAID) 

v   Small computer system interface (SCSI) 

v   Fibre channel and serial ATA (SATA) technology

Readers should also have working knowledge of the applicable host operating 

systems that are used with DS4000 Storage Manager. 

DS4000 Storage Subsystem installation tasks - General overview 

Table 1 on page xiv provides a sequential list of many installation and configuration 

tasks that are common to most DS4000™ configurations. When you install and 

configure your DS4000 storage subsystem, refer to this table to find the 

documentation that explains how to complete each task. 
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Table 1. Where to find DS4000 installation and configuration procedures 

Installation task Where to find information or procedures 

1 Plan the installation v   DS4000 Storage Manager Concepts Guide 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris, and Linux on POWER  

v   DS4000 Storage Manager Installation and Host Support 

Guide for Windows® 2000/Server 2003/2008, NetWare, 

VMWare ESX Server, and Linux 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage™ Subsystem Installation, User’s, 

and Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User's, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User's, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage™ Quick Start Guide, Quick reference for 

the DS4800 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

2 Mount the DS4000 

storage subsystem in 

the rack 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4400 and DS4500 Rack Mounting Instructions 

v   DS4300 Rack Mounting Instructions 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4100 Storage Subsystem Installation, User’s and 

Maintenance Guide 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

3 Mount the DS4000 

EXP storage 

expansion unit in the 

rack 

v   DS4000 EXP100 Storage Expansion Unit Installation, User’s 

and Maintenance Guide 

v   DS4000 EXP420 Storage Expansion Enclosures Installation, 

User’s, and Maintenance Guide 

v   DS4000 EXP700 and EXP710 Storage Expansion Enclosures 

Installation, User’s, and Maintenance Guide 

v   DS4000 EXP810 Storage Expansion Enclosures Installation, 

User’s, and Maintenance Guide 

v   FAStT EXP500 Installation and User’s Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

4 Route the storage 

expansion unit fibre 

channel cables 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Cabling Instructions 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

5 Route the host 

server fibre channel 

cables 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Cabling Instructions 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

6 Power up the 

subsystem 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

7 Configure DS4000 

network settings 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

8 Zone the fabric 

switch 

(SAN-attached only) 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris, and Linux on POWER  

v   DS4000 Storage Manager Installation and Host Guide for 

Windows 2000/Server 2003/2008, NetWare, VMWare ESX 

Server, and Linux 

v   DS4000 Storage Manager Copy Services Guide (describes 

switch zoning for the Remote Mirror Option) 

v   See also the documentation provided by the switch 

manufacturer. 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

9 Install DS4000 

Storage Manager 

software on the 

management station 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris, and Linux on POWER  

v   DS4000 Storage Manager Installation and Host Support 

Guide for Windows 2000/Server 2003/2008, NetWare, 

VMWare ESX Server, and Linux 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

v   DS4000 Storage Manager online help (for post-installation 

tasks) 

10 Install host software 

(failover drivers) on 

host server 

11 Start DS4000 

Storage Manager 

12 Set the DS4000 

Storage Manager 

clock 

13 Set the DS4000 

Storage Manager 

host default type 

14 Verify DS4000 

subsystem health 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

15 Enable DS4000 

Storage Manager 

premium feature 

keys 

Copy Services premium features 

DS4000 Storage Manager Copy Services Guide 

FC/SATA Intermix premium feature 

DS4000 Fibre Channel and Serial ATA Intermix 

Premium Feature Installation Overview 

Storage Partitioning (and general premium features 

information) 

v   DS4000 Storage Manager Concepts Guide 

v   DS4000 Storage Manager Installation and Host 

Support Guide for AIX, HP-UX, Solaris, and Linux on 

POWER  

v   DS4000 Storage Manager Installation and Host 

Support Guide for Windows 2000/Server 2003/2008, 

NetWare, VMWare ESX Server, and Linux
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

16 Configure arrays and 

logical drives 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris, and Linux on POWER  

v   DS4000 Storage Manager Installation and Host Support 

Guide for Windows 2000/Server 2003/2008, NetWare, 

VMWare ESX Server, and Linux 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

v   DS4000 Storage Manager online help 

17 Configure host 

partitions 

18 Verify host access to 

DS4000 storage

  

How this document is organized 

Chapter 1, “Overview and introduction,” on page 1 provides a summary of the 

DS4000 Storage Manager product, including information about product resources 

additional to this document. 

Chapter 2, “Installing and configuring storage management software on AIX host 

systems,” on page 27 provides information about how to install and configure 

DS4000 Storage Manager with an AIX host operating system and contains 

information about high-availability clustering system options. 

Chapter 3, “Installing and configuring storage management software on HP-UX host 

systems,” on page 83 provides information about how to install and configure 

DS4000 Storage Manager with an HP-UX host operating system. 

Chapter 4, “Installing and configuring storage management software on Solaris host 

systems,” on page 107 provides information about how to install and configure 

DS4000 Storage Manager with a Solaris host operating system. 

Chapter 5, “Installing and configuring storage management software on 

POWER-based Linux host systems,” on page 151 provides information about how 

to configure a DS4000 Storage Manager subsystem with SUSE Linux Enterprise 

Server and Red Hat Enterprise Linux operating systems on a POWER or Series 

p-based host. 

Chapter 6, “Completing the software configuration,” on page 197 provides 

information about how to install and configure DS4000 Storage Manager with a 

Solaris host operating system. 

Chapter 7, “Using DS4000 Storage Manager with high-availability cluster services,” 

on page 209 provides step-by-step instructions for post-installation tasks, such as 

how to create storage arrays, logical drives, and storage partitions. 

Appendix A, “MC/Service Guard configuration details,” on page 221 discusses the 

configuration distribution process for an HP-UX host operating system. 

Appendix B, “JNI and QLogic host bus adapter settings,” on page 223 provides 

detailed settings for the various host bus adapter (HBA) cards for Sun Solaris. 
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Appendix C, “Downloading ESM firmware and drive firmware,” on page 229 

describes how to download current ESM firmware to a DS4000 EXP storage 

expansion enclosure and current drive firmware to a DS4000 storage subsystem 

and provides the procedures for verifying and downloading Environmental Service 

Module (ESM) firmware. 

Appendix D, “Using the IBM System Storage DS4000 Controller Firmware Upgrade 

Tool,” on page 235 explains how to use this tool to upgrade Storage Manager 

firmware versions 05.xx. and 06.xx to the current 07.10.xx.xx and provides the 

steps to a successful migration. 

Appendix E, “Limitations,” on page 241 provides the procedure for how to correct 

the primary and alternate paths of the imported volume groups that are changed 

after using vgimport -m -s with LVM commands. 

Appendix F, “Connecting HBAs in a FC switch environment,” on page 245 provides 

an example of a fibre channel fabric switch configuration, and a Web site that 

contains links to switch documentation. 

Appendix G, “DS4000 Diagnostic Data Capture (DDC),” on page 247 provides 

information about saving event data for a critical internal controller error. 

Appendix H, “Accessibility,” on page 251 offers alternatives to navigating in the 

DS4000 Storage Manager software for those of restricted mobility. 

Appendix I, “Additional DS4000 documentation,” on page 253 provides a 

comprehensive listing of all DS4000-related documentation. 

Notices used in this document 

This document contains the following notices that are designed to highlight key 

information: 

Note: These notices provide tips, guidance, or advice. 

Important: These notices provide information or advice that might help you 

avoid inconvenient or problem situations. 

Attention: These notices indicate possible damage to programs, devices or 

data. An attention notice is placed just before the instruction or 

situation in which damage could occur.

Getting information, help, and service 

If you need help, service, or technical assistance or just want more information 

about IBM products, you will find a wide variety of sources available from IBM to 

assist you. This section contains information about where to go for additional 

information about IBM and IBM products, what to do if you experience a problem 

with your system, and whom to call for service, if it is necessary. 

Before you call 

Before you call, take these steps to try to solve the problem yourself: 

v   Check all cables to make sure that they are connected. 

v   Check the power switches to make sure that the system is turned on. 

v   Use the troubleshooting information in your system documentation, and use the 

diagnostic tools that come with your system. 
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v   Check for technical information, hints, tips, and new device drivers at the IBM 

support Web site pages that are listed in this section. 

v   Use an IBM discussion forum on the IBM Web site to ask questions.

You can solve many problems without outside assistance by following the 

troubleshooting procedures that IBM provides in the DS4000 Storage Manager 

online help or in the documents that are provided with your system and software. 

The information that comes with your system also describes the diagnostic tests 

that you can perform. Most subsystems, operating systems, and programs come 

with information that contains troubleshooting procedures and explanations of error 

messages and error codes. If you suspect a software problem, see the information 

for the operating system or program. 

Using the documentation 

Information about your IBM system and preinstalled software, if any, is available in 

the documents that come with your system. This includes printed books, online 

documents, readme files, and help files. See the troubleshooting information in your 

system documentation for instructions for using the diagnostic programs. The 

troubleshooting information or the diagnostic programs might tell you that you need 

additional or updated device drivers or other software. 

Finding DS4000 readme files 

1.   Go to the following Web site: 

www.ibm.com/systems/support/storage/disk 

2.   Click the link for your Storage Subsystem (for example, DS4800). 

3.   When the subsystem support page opens, click the Download tab. 

4.   Under the Download tab, click Storage Manager, firmware, HBA, tools, 

support & pubs (including readmes). 

5.   Now, click the appropriate tab for the type of readme file that you are looking 

for: 

v   Firmware 

v   Storage Mgr 

v   HBA 

v   Tools

A table displays as you click each tab. 

6.   In the table, click on the appropriate link in the Current® version and readmes 

column. 

7.   Click the link for the readme file.

Web  sites 

The most up-to-date information about DS4000 storage subsystems and DS4000 

Storage Manager, including documentation and the most recent software, firmware, 

and NVSRAM downloads, can be found at the following Web sites. 

DS4000 Midrange Disk Systems 

Find the latest information about IBM System Storage disk storage systems, 

including all of the DS4000 storage subsystems: 

 www.ibm.com/servers/storage/disk/ds4000 

IBM System Storage products 

Find information about all IBM System Storage products: 
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www.storage.ibm.com 

Support for IBM System Storage disk storage systems 

Find links to support pages for all IBM System Storage disk storage 

systems, including DS4000 storage subsystems and expansion units: 

 www.ibm.com/systems/support/storage/disk 

System Storage DS4000 interoperability matrix 

Find the latest information about operating system and HBA support, 

clustering support, storage area network (SAN) fabric support, and DS4000 

Storage Manager feature support: 

 www.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Storage Area Network (SAN) support 

Find information about using SAN switches, including links to user guides 

and other documents: 

 www.ibm.com/systems/support/storage/san 

DS4000 technical support 

 Find downloads, hints and tips, documentation, parts information, HBA and 

fibre channel support: 

http://www.ibm.com/systems/support/storage/disk 

Select your Storage Subsystem (for example, DS4800). 

Premium feature activation 

Activate a DS4000 premium feature by using the online tool: 

 www-912.ibm.com/PremiumFeatures/jsp/keyInput.jsp 

IBM publications center 

Find IBM publications: 

 www.ibm.com/shop/publications/order/ 

Support for System p™ servers 

Find the latest information supporting System p AIX and Linux servers: 

 www.ibm.com/systems/support/supportsite.wss/
brandmain?brandind=5000025 

Support for System x™ servers 

Find the latest information supporting System x Intel®- and AMD-based 

servers: 

 www.ibm.com/systems/support/supportsite.wss/
brandmain?brandind=5000008 

Fix delivery center for AIX and Linux on POWER 

Find the latest AIX and Linux on POWER information and downloads: 

 www-912.ibm.com/eserver/support/fixes/fcgui.jsp 

In the Product family drop down menu, select UNIX® servers. Then select 

your product and fix type from the subsequent drop down menus. 

Eserver System p and AIX information center 

Find everything you need to know about using AIX with System p and 

POWER servers: 

 publib.boulder.ibm.com/infocenter/pseries/index.jsp?
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Software service and support 

Through IBM Support Line, for a fee you can get telephone assistance with usage, 

configuration, and software problems. For information about which products are 

supported by Support Line in your country or region, go to the following Web site: 

www.ibm.com/services/sl/products 

For more information about the IBM Support Line and other IBM services, go to the 

following Web sites: 

v   www.ibm.com/services 

v   www.ibm.com/planetwide

Hardware service and support 

You can receive hardware service through IBM Integrated Technology Services or 

through your IBM reseller, if your reseller is authorized by IBM to provide warranty 

service. Go to the following Web site for support telephone numbers: 

www.ibm.com/planetwide 

In the U.S. and Canada, hardware service and support is available 24 hours a day, 

7 days a week. In the U.K., these services are available Monday through Friday, 

from 9 a.m. to 6 p.m. 

Fire suppression systems 

A fire suppression system is the responsibility of the customer. The customer’s own 

insurance underwriter, local fire marshal, or a local building inspector, or both, 

should be consulted in selecting a fire suppression system that provides the correct 

level of coverage and protection. IBM designs and manufactures equipment to 

internal and external standards that require certain environments for reliable 

operation. Because IBM does not test any equipment for compatibility with fire 

suppression systems, IBM does not make compatibility claims of any kind nor does 

IBM provide recommendations on fire suppression systems. 

How to send your comments 

Your feedback is important to help us provide the highest quality information. If you 

have any comments about this document, you can submit them in one of the 

following ways: 

E-mail 

 Submit your comments by e-mail to: 

starpubs@us.ibm.com 

Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, 

such as a page number or table number. 

Mail 

 Fill out the Readers’ Comments form (RCF) at the back of this document 

and return it by mail or give it to an IBM representative. 

If the RCF has been removed, send your comments to:

International Business Machines Corporation 

Information Development 

Department GZW
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9000 South Rita Road 

Tucson, Arizona 

USA 

85744-0001

 Be sure to include the name and order number of the document and, if 
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Chapter  1.  Overview  and  introduction  

Overview 

The DS4000 Storage Manager 

The DS4000 Storage Manager software is used to configure, manage and 

troubleshoot the IBM System Storage DS4000 Storage Server. 

It is used primarily to configure RAID arrays and logical drives, assign logical drives 

to hosts, replace and rebuild failed disk drives, expand the size of the arrays and 

logical drives, and convert from one RAID level to another. It allows troubleshooting 

and management tasks, like checking the status of the Storage Server components, 

updating the firmware of the RAID controllers, and managing the Storage Server. 

Finally, it offers advanced functions such as FlashCopy®, Volume Copy, and 

Enhanced Remote Mirroring. 

This chapter includes discussions of the following topics: 

v   “Readme files and concepts” 

v   “Supported controller firmware versions” on page 2 

v   “Product updates and support notifications” on page 3 

v   “DS4000 Storage Manager client software packages” on page 4 

v   “Storage subsystem management methods” on page 8 

v   “Setting up IP addresses for DS4000 storage controllers” on page 13 

v   “DS4000 Storage Manager performance planning” on page 14 

v   “DS4000 limitations” on page 8 

v   “DS4000 Storage Manager premium features” on page 16 

v   “DS4000 hardware and firmware requirements for AIX, HP-UX, Solaris, and Linux 

on POWER” on page 20

Readme files and concepts 

Before you install DS4000 Storage Manager software, consult the following 

documentation: 

Storage Manager readme files 

Read these first.

Important:  Updated readme files contain the latest device driver versions, 

firmware levels and other information that supersede this 

document. 

To access the most recent DS4000 Storage Manager readme files, 

complete the following steps: 

1.   Go to the following Web site:www-1.ibm.com/servers/storage/support/
disk/ 

2.   Click the link for your storage subsystem (for example, DS4800). 

3.   When the subsystem support page opens, click the Install and Use tab, 

then click the DS4000 Storage Manager Pubs and Code link. The 

Downloads page for the subsystem opens. 

4.   When the download page opens, ensure that the Storage Mgr tab is 

selected. A table displays. 
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5.   In the table, find the entry that lists the Storage Manager package for 

your operating system, then click on the corresponding v10.10 link in 

the Current version and readmes column. The Storage Manager page 

for your operating system opens. 

6.   Click the link for the readme file.

IBM DS4000 Storage Manager Concepts Guide 

Use this reference document to become familiar with the terminology and 

the features of the DS4000 Storage Manager software. This document is 

available on the DS4000 Storage Manager installation CD and at the Web 

site listed above.

Supported controller firmware versions 

IBM DS4000 Storage Manager version 10.10 host software supports the new 

features that are incorporated into all releases of controller firmware version 

07.10.xx.xx, and manages DS4000 storage subsystems with all generally-released 

controller firmware versions (05.30.xx.xx to 07.10.xx.xx). 

All of the controller firmware versions that are listed in Table 2 are available 

free-of-charge. 

Each DS4000 storage subsystem supports only one particular controller firmware 

code thread. Please see the Current firmware version column in Table 2 to find 

the latest controller firmware code for a particular DS4000 storage subsystem 

model. 

See “New features and enhancements” on page 7 for new features that are 

associated with the 07.10.xx.xx controller firmware. 

Note:  Check the DS4000 Storage Manager readme file for your host operating 

system for information on latest supported controller firmware code levels 

available for all DS4000 storage subsystem models. See “Readme files and 

concepts” on page 1.

 Table 2. Latest firmware versions by storage subsystem model 

Storage subsystem model Machine type and 

model 

Current firmware 

version 

IBM System Storage DS4800 Storage 

Subsystem 

1815 - 80A/H, 82A/H, 

84A/H, and 88 A/H 

07.10.xx.xx (see note 1, 

below) 

IBM System Storage DS4700 Storage 

Subsystem 

1814 - 70A/H, 72A/H 07.10.xx.xx 

IBM TotalStorage® DS4500 Storage 

Subsystem (see note 5) 

1742 - 90X/U 06.60.xx.xx 

IBM TotalStorage DS4400 Storage 

Subsystem 

1742 - 1RU/RX 06.12.xx.xx 

IBM TotalStorage DS4300 Base and 

Turbo Storage Subsystem (see note 

5) 

1722 - 60U/X 06.60.xx.xx 

IBM TotalStorage DS4300 - Storage 

Subsystem single controller unit 

(SCU) (see note 5) 

1722 - 6LU/LX 05.34.xx.xx 

IBM TotalStorage DS4200 Express 7VA and 7VH 07.10.xx.xx 

IBM TotalStorage DS4100 Storage 

Subsystem 

1724 - 100 06.12.xx.xx 
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Table 2. Latest firmware versions by storage subsystem model (continued) 

Storage subsystem model Machine type and 

model 

Current firmware 

version 

IBM TotalStorage DS4100 Storage 

Subsystem - single controller unit 

(SCU) 

1SC, 1S_x 06.12.xx.xx 

IBM FAStT200 Storage Subsystem 

(see note 4) 

3542 - 1RU/RX 05.3x.xx.xx 

IBM FAStT200 High Availability 

Storage Subsystem (see note 4) 

3542 - 2RU/RX 05.3x.xx.xx 

Netfinity® FAStT500 RAID Controller 

Enclosure Unit (see note 3) 

3552 - 1RU/RX 05.3x.xx.xx

  

Notes:  

1.   The DS4800 Model 80A/H does not support controller firmware versions 

06.14.xx.xx or 06.15.xx.xx; however, firmware versions 06.23.xx.xx through 

07.10.xx.xx are fully supported. 

2.   With controller firmware 06.12.xx.xx and higher, Storage Manager 10.10 

supports DS4100 standard (base) and single-controller (SCU) SATA storage 

subsystems, and EXP100 SATA storage expansion enclosures. 

3.   FAStT200 and FAStT500 storage subsystems are no longer available; therefore, 

the Storage Manager features that are specific to version 06.1x.xx.xx firmware 

and above, and corresponding NVSRAM are unavailable for those FAStT 

subsystems. IBM recommends that you use Storage Manager 10.10 software to 

manage these FAStT subsystems, using controller firmware versions 5.3x.xx.xx.

Product updates and support notifications 

Be sure to download the latest versions of the DS4000 Storage Manager host 

software, DS4000 storage subsystem controller firmware, DS4000 drive expansion 

enclosure ESM firmware, and drive firmware at the time of the initial installation and 

when product updates become available. 

 

 

Important 

Keep your system up to date with the latest firmware and other product 

updates by subscribing to receive support notifications.

 For more information about support notifications or the My Support feature, 

including instructions on how to register, see the following IBM Support Web page: 

www.ibm.com/systems/support/storage/subscribe/moreinfo.html 

You can also check the Stay Informed section of the IBM Disk Support Web site: 

www.ibm.com/servers/storage/support/disk/index.html 

Introduction 

The DS4000 Storage Manager software 

IBM System Storage DS4000 Storage Manager 10.10 consists of a set of client and 

host tools that enable you to manage the following IBM DS4000 storage 

subsystems from a storage management station. 
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See “Supported controller firmware versions” on page 2 for the latest firmware 

versions that are supported by each storage subsystem model. 

DS4000 Storage Manager client software packages 

DS4000 Storage Manager contains the following client software packages: 

SMruntime software 

DS4000 Storage Manager Java™™ compiler 

SMesm software 

DS4000 Storage Manager ESM firmware delivery package 

SMclient software 

DS4000 Storage Manager client package

DS4000 Storage Manager contains the following host software packages: 

SMagent software 

DS4000 Storage Manager agent package 

SMutil software 

DS4000 Storage Manager utility package

In addition to this document, see the IBM DS4000 Storage Manager Concepts 

Guide for more information about DS4000 Storage Manager software. 

SMruntime software package:   The DS4000 Storage Manager runtime software, 

SMruntime, is a Java compiler for the DS4000 Storage Manager client software, 

SMclient. SMruntime must be installed before SMclient is installed. 

SMesm software package:   The DS4000 Storage Manager Esm software is 

needed for automatic ESM firmware synchronization. It must be installed before 

SMclient is installed. 

SMclient software package:   The DS4000 Storage Manager client software, 

SMclient, is a Java-based graphical user interface (GUI). 

SMclient enables you to configure, manage and monitor DS4000 storage 

subsystems and storage expansion enclosures in a storage subsystem, either 

through a host system or through a storage management station. 

Specifically, SMclient enables you to perform the following tasks: 

v   Configure disk arrays and logical volumes 

v   Assign names to arrays and volume groups 

v   Assign logical volumes to storage partitions 

v   Replace and rebuild failed disk drives 

v   Expand the size of arrays 

v   Expand the size of logical volumes 

v   Change RAID-type arrays 

v   Configure and add additional host partitions with the premium partitioning feature 

v   Monitor the status of DS4000 storage subsystems 

v   Perform troubleshooting and maintenance tasks, such as downloading controller, 

ESM and drive firmware and NVSRAM 

v   View the major events log (MEL) 

v   Assign redundant RAID controllers 

v   Expand storage capacity using storage expansion enclosures.
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Note:  For important information about using the DS4000 EXP100 SATA storage 

expansion enclosure, see IBM TotalStorage DS4000 EXP100 Storage 

Expansion Enclosure Installation and User’s Guide. 

The SMclient contains two main components: 

Enterprise Management 

This component enables you to add, remove, and monitor storage 

subsystems in the management domain. 

Subsystem Management 

This component enables you to manage the components of an individual 

storage subsystem.

SMagent software package:   The DS4000 Storage Manager software agent 

package, SMagent, contains optional host-agent software, which you can use to 

manage storage subsystems through the host fibre channel connection. 

Notes:  

1.   You must have a failover driver installed in order to use SMagent. 

2.   SMagent is not supported with controller firmware version 05.42.xx.xx or with 

prior versions.

SMagent takes requests from a storage management station that is connected to 

the host through a network connection, and passes the requests to the storage 

subsystem controllers through the fibre channel I/O path. 

For more information about managing storage subsystems through SMagent, see 

“In-band (host-agent) management method” on page 9. 

SMutil software package:   You can use the DS4000 Storage Manager utility, 

SMutil, to register and map new logical drives to the operating system, and to verify 

mapping. 

Note:  Before installing this package on an HP-UX, Solaris, or Linux host server, 

check the chapter for your host OS to determine if it is needed.
Install SMutil on all HP-UX, Solaris, and Linux host servers that are attached to a 

storage subsystem. (The host servers are attached to the storage subsystem 

through the fibre channel.) 

Software installation sequence 

Install the DS4000 Storage Manager software packages in the sequences shown in 

Table 3. 

 Table 3. Installation sequences of DS4000 Storage Manager software packages by host type 

Step AIX  HP-UX Solaris Linux on 

POWER  

1 SMruntime SMruntime SMruntime SMruntime 

2 SMesm SMesm SMesm SMesm 

3 SMclient SMclient SMclient SMclient 

4 SMagent SMagent SMagent SMagent 

5 SMutil SMutil SMutil SMutil 

6 Controller 

firmware and 

NVSRAM 

Controller 

firmware and 

NVSRAM 

Controller 

firmware and 

NVSRAM 

Controller 

firmware and 

NVSRAM 
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Table 3. Installation sequences of DS4000 Storage Manager software packages by host 

type (continued) 

Step AIX  HP-UX Solaris Linux on 

POWER  

7 ESM firmware ESM firmware ESM firmware ESM firmware 

8 Drive firmware Drive firmware Drive firmware Drive firmware 

Location of 

procedures 

“Installing 

DS4000 Storage 

Manager” on 

page 29 

“Installing 

DS4000 Storage 

Manager” on 

page 84 

“Installing 

DS4000 Storage 

Manager” on 

page 108 

“Storage Manager 

installation and 

configuration” on 

page 162
  

The storage management station 

The storage management station is the system that is responsible for managing all, 

or a portion of, a storage network. It communicates with the network management 

agents that reside in the managed nodes using a network management protocol, 

such as Simple Network Management Protocol (SNMP). 

Storage management commands are sent to the storage subsystem controllers, 

where the controller firmware validates and runs the commands, and then returns 

status and configuration information to the client software. 

A storage management station can be either of the following configurations: 

v   A remote system, connected to an Ethernet network, that is used to manage one 

or more storage subsystems 

v   A host that is connected to the storage subsystem with a fibre channel 

input/output (I/O) path which is also used to manage the attached storage 

subsystems

Note:  Even though you can install the storage management software on a host, the 

host still uses the Transmission Control Protocol/Internet Protocol (TCP/IP) to 

communicate with the host-agent. The host-agent communicates with the 

controller over the fibre channel connection through the access volume. 

Finding Storage Manager software and controller firmware 

DS4000 Storage Manager software and controller firmware are available on the 

product CD. You can also download DS4000 Storage Manager software and 

firmware from the Web. See 

www-1.ibm.com/servers/storage/support/disk/ 

1.   At the support Web site, click the link for your storage subsystem (for example, 

DS4800). 

2.   When the subsystem page opens, click the Download tab, then click Storage 

Manager, firmware, HBA and tools (including readmes). 

3.   For controller firmware, click the Firmware tab. For Storage Manager software, 

click the Storage Mgr tab then click on the appropriate link for your host 

operating system under the Current Versions and readmes column.

DS4000 Storage Manager online help 

After you have completed all the installation and configuration procedures that are 

provided in this document, refer to the following online help systems. The online 

help contains information that is common to all operating system environments. 
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You can access the help systems from the Enterprise Management and Subsystem 

Management windows in DS4000 Storage Manager by clicking Help on the toolbar 

or pressing F1. 

Enterprise Management Help window  

Use this online help system to learn more about working with the entire 

management domain. 

Subsystem Management Help window  

Use this online help system to learn more about managing individual 

storage subsystems.

New features and enhancements 

DS4000 Storage Manager 10.10 supports controller firmware versions 05.30.xx.xx - 

07.10.xx.xx. 

Note:  For information about supported host operating systems and operating 

system requirements, see the Storage Manager readme file for your 

operating system. See “Readme files and concepts” on page 1 for 

instructions that describe how to find the readme files online.

New  features of Storage Manager 10.10:  

Storage Manager 10.10 (controller firmware 07.10.xx.xx): New features:   Controller 

firmware version 07.10.xx.xx supports the following: 

v   DS4800 Storage Subsystems models 

v   DS4700 Storage Subsystems models 

v   DS4200 Express Storage Subsystems 

v   RAID 6 on DS4700, DS4200 only 

–   RAID 6 using a p+q implementation

v    Support for greater than 2TB volumes 

v   Support for RAID 0 and 1 volume groups with more than 30 drives 

v   Increase maximum number of partitions 

–   128 for DS4200 and DS4700 

–   512 for DS4800

v   HP-UX v11.23 full solution 

–   Provides a full solution (all client software) for 64-bit HP-UX v11.23 (Itanium2 

processor)

v   Increased queue depth 

–   Increases the controller queue depth to 4096 for the DS4800 controllers and 

to 2048 for DS4700 and DS4200 controllers

v    Increased number of Global Hot Spares 

–   Lifts any previous limits on the number of Global Hot Spares allowed per 

array

v   Drive Migration Warning 

–   When migrating configured volume groups to an existing array, there will be a 

warning given if the number of volumes being added will overrun the 

maximum number of volumes allowed on this particular array.

v    Configurable failed drive replacement 

–   You will be allowed to specify that a hot spare be a permanent member of a 

volume group, thus eliminating the copy back portion once the failed drive has 

been replaced. The replacement drive will be in an unassigned state.
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v   RAID redundant data verification prior to read 

–   Enables verification of redundant RAID data consistency before returning the 

requested read data back to the host. This feature should be enabled on a 

volume basis. It will automatically be disabled when a volume is degraded. If 

a mismatch is detected, the controller will return a Media error—unrecoverable 

read error (03/11/00). The array will not attempt to correct or recalculate parity 

automatically. This will support all raid levels.

v    8K cache block size 

v   Increase to 16 snapshots per volume for DS4800 

v   Increase the number of snapshots on DS4700 

v   DS4700 Path Redundancy Improvement 

–   Board turn-on DS4700 to allow the alternate controller to access drive 

channels, when a controller is held in reset or is undergoing SOD processing

v    Increase number of mirrors supported 

–   Increase the number of mirrors supported on the DS4800 from 64 to 128 and 

on the DS4700 from 32 to 64

v   Create Unmanageable Icon 

–   Create a new icon in the Enterprise Management Window to differentiate 

between Unresponsive and Unmanageable. The Unmanageable would be any 

array for which there is no corresponding JAR file.

v    Portable Volume Groups, SAFE changes 

–   New export and import behavior, which will also include SAFE import changes 

of premium features.

DS4000 limitations 

Please be aware of the following limitations: 

v   DS4800 storage subsystems do not support DS4000 EXP700 fibre channel 

storage expansion enclosures. You must upgrade to EXP710 storage expansion 

enclosures or use EXP810 storage expansion enclosures. 

v   DS4300 Turbo storage subsystems do not support DS4000 EXP500 fibre 

channel storage expansion enclosures. 

v   DS4100 storage subsystems do not support the FC/SATA Intermix premium 

feature.

For host OS-specific limitations, see the appropriate chapter for your host operating 

system. 

Storage subsystem management methods 

The storage management software provides the following two methods for 

managing storage subsystems: 

In-band (host-agent) management method 

Using this method, you manage the storage subsystems through the fibre 

channel I/O path to the host. 

Out-of-band (direct) management method 

Using this method, you manage the storage subsystems directly over the 

network through the Ethernet connection to each controller.

The management methods are described in the next sections. 
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In-band (host-agent) management method 

When you use the in-band management method, you manage the storage 

subsystems through the fibre channel I/O path to the host. 

The management information can be processed by the host or passed to the 

storage management station through the network connection. Figure 1 shows the 

in-band management method. 

 

 Restrictions: 

v   If both fibre channel connections to the controllers are lost, the SMclient software 

cannot be accessed for problem determination. 

v   In-band management is not supported with controller firmware version 5.42.xx.xx.

In-band management method advantages:   Using the in-band management 

method provides the following advantages: 

v   You do not need to run Ethernet cables to the controllers. 

v   You do not need a Dynamic Host Configuration Protocol (DHCP) bootstrap 

protocol (BOOTP) server to connect the storage subsystems to the network. 

v   You do not need to configure the controller network (as described in the 

installation chapters for each operating system). 

Network

Host computer

Controller

Controller

Controller

Controller

Fibre Channel
I/O path

Management station
(one or more)

Running the
host-agent software

Storage subsystems

Note: The host can also act as a
management station.

Storage subsystems

SJ000707

  

Figure 1. In-band managed storage subsystems
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v   When adding devices, you need to specify a host name or Internet Protocol (IP) 

address for the host only, not for the individual controllers in a storage 

subsystem. Storage subsystems that are attached to the host are automatically 

discovered.

In-band management method disadvantages:   Using the in-band management 

method has the following disadvantages: 

v   If both fibre channel connections to the controllers are lost, the SMclient software 

cannot be accessed for problem determination. 

v   Unlike out-of-band management, in which the fibre channel connections are 

dedicated for I/O, in-band management uses the fibre channel for both I/O and 

status reporting. Therefore, in-band management uses more bandwidth on the 

fibre channel than out-of-band management, and this can have an impact on 

performance. 

v   You are limited to configuring one less LUN than the maximum number allowed 

by the operating system and host adapter that you are using. 

v   The host-agent requires a special logical drive, called an access volume, to 

communicate with the controllers in the storage subsystem.

Important: The access volume uses one of the LUNs. If your host already has the 

maximum number of LUNs configured, either use the out-of-band management 

method or give up a LUN for use as the access volume. For information about your 

specific configuration, see the appropriate chapter in this document for your 

operating system environment. 

Out-of-band (direct) management method 

When you use the out-of-band (direct) management method, you manage storage 

subsystems directly over the network through the Ethernet connection to each 

controller. 

To manage the storage subsystem through the Ethernet connections, you must 

define the IP address and host name for each controller and attach a cable to the 

Ethernet ports on each of the storage subsystem controllers. Figure 2 on page 11 

shows the out-of-band management method. 
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If you use the out-of-band management method, see “Setting up IP addresses for 

DS4000 storage controllers” on page 13. 

Out-of-band management method advantages:   Using the out-of-band 

management method provides the following advantages: 

v   Unlike in-band management, which uses the fibre channel connections for both 

I/O and status reporting, out-of-band management dedicates the fibre channel for 

I/O only. Therefore, out-of-band management can result in higher performance 

than host-agent management. 

v   Because status reporting is conducted over Ethernet connections, the SMclient 

software can be accessed for problem determination if both fibre channel 

connections to the controllers are lost. 

v   The Ethernet connections to the controllers enable a storage management 

station running the SMclient software to manage storage subsystems that are 

connected to a host.`

Out-of-band management method disadvantages:   Using the out-of-band 

management method has the following disadvantages: 

v   It requires two Ethernet cables to connect both storage subsystem controllers to 

the network. 

v   When you configure IP addresses for new devices, you must either assign a 

static IP address or host name for each controller, or place the devices on a 

network with a DHCP or BOOTP server. 

Ethernet

Host computer

Fibre Channel
I/O path

Management station
(one or more)

Controller

Controller

Controller

Controller

Storage subsystems

SJ000708

  

Figure 2. Out-of-band managed storage subsystems
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v   Other network preparation tasks might be required. For more information, see the 

system installation guide for your network server.

Reviewing a sample network 

Figure 3 on page 13 shows an example of a network that contains both an 

out-of-band storage subsystem (Network A) and an in-band managed storage 

subsystem (Network B). 

Out-of-band-managed storage subsystem: Network A is an out-of-band-managed 

storage subsystem. Network A contains the following components: 

v   A DHCP or BOOTP server 

v   A network management station (NMS) for Simple Network Management Protocol 

(SNMP) traps 

v   A host that is connected to a storage subsystem through a fibre-channel I/O path 

v   A management station that is connected by an Ethernet cable to the storage 

subsystem controllers

Note:  If the controllers, static IP addresses, or default IP addresses are used, you 

do not need to setup the DHCP/BOOTP server. 

In-band storage subsystem: Network B is an in-band-managed storage 

subsystem. Network B contains the following components: 

v   A host that is connected to a storage subsystem through a fibre-channel I/O path 

v   A management station that is connected by an Ethernet cable to the host 

computer
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Setting up IP addresses for DS4000 storage controllers 

Complete the following procedures after you install SMruntime and SMclient, as 

described in the installation section for your host operating system. 

You must set up a DHCP or BOOTP server and network with the following 

components: 

v   A DHCP or BOOTP server 

v   A network management station (NMS) for Simple Network Management Protocol 

(SNMP) traps 

v   A host that is connected to a storage subsystem through a fibre-channel I/O path 

v   A management station that is connected by an Ethernet cable to the storage 

subsystem controllers

Note:  You can avoid DHCP/BOOTP server and network tasks by assigning static 

IP addresses to the controller. If you do not wish to assign static TCP/IP 

addresses with the DS4000 Storage Manager, using the DS4000 default 

TCP/IP addresses, see the IBM support Web site at: 

www.ibm.com/pc/support/ 

Refer to Retain Tip 

# H171389 Unable To Setup Networking Without 

DHCP/BOOTP.

  

Figure 3. Sample network using both out-of-band and in-band managed storage subsystems
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Setting up the DHCP/BOOTP server and network 

Complete the following steps to set up the DHCP/BOOTP server and network: 

1.   Get the MAC address from each controller blade. 

2.   Complete whichever of the following steps is appropriate for your server: 

v   On a DHCP server, create a DHCP record for each of the MAC addresses. 

Set the lease duration to the longest time possible. 

v   On a BOOTP server, edit the bootptab file to add in the entries that associate 

the MAC address tab with the TCP/IP address.

3.   Connect the DS4000 storage subsystem Ethernet ports to the network. 

4.   Boot the DS4000 storage subsystem.

When you are finished, complete the steps in the next section, “Steps for assigning 

static TCP/IP addresses to the DS4000 controllers.” 

Steps for assigning static TCP/IP addresses to the DS4000 

controllers 

Complete the following steps to assign static TCP/IP addresses to the DS4000 

storage subsystem controllers, using default TCP/IP addresses that are assigned to 

the DS4000 storage subsystem controllers during manufacturing: 

1.   Make a direct management connection to the DS4000 storage subsystem, using 

the default TCP/IP addresses: 

v   Controller A: 192.168.128.101 

v   Controller B: 192.168.128.102

2.   Start SMclient. The Enterprise Management window opens. 

3.   In the Enterprise Management window, click on the name of the default storage 

subsystem. The Subsystem Management window opens. 

4.   In the Subsystem Management window, right-click the controller icon and select 

Change → Network Configuration in the pull-down menu. The Change Network 

Configuration window opens. 

5.   In the Change Network Configuration window, click on the Controller A and 

Controller B tabs and type the new TCP/IP addresses in their appropriate fields. 

Click OK. 

6.   Close the Subsystem Management window, wait five minutes, then delete the 

default DS4000 storage subsystem entry in the Enterprise Management window. 

7.   Add a new storage subsystem entry in the Enterprise Management window, 

using the new TCP/IP address.

Note:  To manage storage subsystems through a firewall, configure the firewall to 

open port 2463 to TCP data. 

DS4000 Storage Manager performance planning 

DS4000 storage systems provide a high degree of flexibility to meet today’s 

demanding storage applications. As such, care should be taken to plan 

configurations that meet specific application performance requirements. 

Like most storage vendors, IBM publishes data sheets and specifications for the 

capabilities of the storage subsystem. These are intended for use as reference 

points for raw capabilities, but do not necessarily imply that actual performance 

specifications will be achieved for all configurations and operating environments. 

Many factors that are external to the DS4000 storage subsystem, such as server 

processor and memory, host bus adapters, command queue depth settings, and I/O 

size, can impact performance. 
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You must plan the configuration and setup of the DS4000 for your operating 

environment. If proper planning is not performed, poor performance can result, such 

as low throughput or high disk latencies (response times). 

If your system uses controller firmware versions 5.4x.xx.xx or later, you can create 

storage partitions with greater than 32 logical drives (up to 256). Take this factor 

into account during configuration planning. Depending on the I/O load requirements, 

it might be beneficial to spread volumes out on multiple partitions, if your operating 

system allows it. 

Note:  Not all operating system environments can support 256 logical drives per 

partition. See Table 4: 

 Table 4. Maximum number of logical drives per partition 

Operating system Maximum number of LUNs per partition 

AIX 256 

HP-UX 11.0 32 

HP-UX 11.i, 128 

HP-UX 11v2 128 

Solaris 8 and 9 256 with DMP 

32 with RDAC 

SUSE Linux Enterprise Server 9 256 

Red Hat Enterprise Linux 3 256 

Red Hat Enterprise Linux 4 256
  

The following example shows three possible configurations that have more than 32 

logical drives. 

Performance planning: Configuration examples 

If your system is running DS4000 controller firmware version 05.4.xx.xx or later, you 

can configure all 64 logical disks into one storage partition with two HBAs. You can 

also configure 256 logical disks into one partition with two HBAs. See Table 5. 

Note:  Systems running DS4000 controller firmware version 05.3x.xx.xx or earlier 

require two storage partitions, each with 32 logical drives and four HBAs, to 

connect 64 logical disks to a host. 

 Table 5. Examples of possible configurations with more than 32 logical drives 

Configuration 

number 

DS4000 firmware 

version 

HBAs  Storage 

partitions 

Logical 

drives 

1 05.3.xx.xx 4 2 64 

2 05.4.xx.xx 2 1 64 

3 05.4.xx.xx or 

06.1x.xx.xx 

2 1 256

  

You might expect the following performance results with the configurations listed in 

Table 5: 

v   Configuration 1 might perform better than Configuration 2, which has more logical 

drives per storage partition. 

v   Depending on the application, Configuration 3 might perform poorly because of 

the large number of logical drives per partition. Applications that do not require 
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frequent use of (or connectivity to) many logical drives might respond quite well 

and meet performance expectations. Other applications, such as those that 

require simultaneous access to all volumes over extended periods of time, will 

likely experience lower throughput and high latencies on the individual logical 

drives. 

For excellent information about how to plan your configuration, see the following 

documents: 

v   IBM System Storage DS4000 Storage Manager Concepts Guide 

v   IBM TotalStorage: DS4000 Best Practices Guide

DS4000 Storage Manager premium features 

DS4000 Storage Manager supports the following premium features, which are 

separately available for purchase from IBM or an IBM Business Partner: 

Copy Services 

The following copy services are available with Storage Manager 10.10: 

v   FlashCopy® 

v   VolumeCopy 

v   Enhanced Remote Mirror Option

For more detailed information about the copy services features, see the 

following publications: 

v   IBM System Storage DS4000 Storage Manager Copy Services User’s 

Guide 

v   IBM System Storage DS4000 Storage Manager Concepts Guide

Storage Partitioning 

Storage Partitioning is standard on all DS4000 storage subsystems that are 

supported by DS4000 controller firmware versions 06.10.xx.xx–07.10.xx.xx. 

For more information about Storage Partitioning, see the “Storage 

partitioning overview” on page 40. 

FC/SATA Intermix premium feature 

The IBM System Storage DS4000 Fibre Channel and Serial ATA Intermix 

premium feature supports the concurrent attachment of fibre channel and 

SATA storage expansion enclosures to a single DS4000 controller 

configuration. 

 For more detailed information about the FC/SATA Intermix premium 

features, see the following publication: 

v   IBM System Storage DS4000 Fibre Channel and Serial ATA Intermix 

Premium Feature Installation Overview.

FC/SATA Intermix premium feature 

The IBM System Storage DS4000 Fibre Channel and Serial ATA Intermix premium 

feature supports the concurrent attachment of fibre channel and SATA storage 

expansion enclosures to a single DS4000 controller configuration. 

This Intermix premium feature enables you to create and manage distinct arrays 

that are built from either fibre channel disks or SATA disks, and allocate logical 

drives to the appropriate applications using a single DS4000 storage subsystem. 

For important information about using the Intermix premium feature, including 

configuration, firmware versions required for specific Intermix configurations, and 
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setup requirements, see the IBM System Storage DS4000 Fibre Channel and Serial 

ATA Intermix Premium Feature Installation Overview. 

Please see your IBM representative or reseller for information regarding future 

DS4000 storage subsystem support for the FC/SATA Intermix premium feature. 

Enabling the DS4000 FC/SATA Intermix premium feature:   Storage Manager 

10.10 supports the DS4000 FC/SATA Intermix premium feature with all 

06.1x.xx.xx–07.10.xx.xx controller firmware versions. Depending on the level of 

controller firmware installed on your storage subsystem, you need to follow different 

procedures to enable the premium feature, which is done using a premium feature 

key. To install the DS4000 FC/SATA Intermix Premium Feature Key, follow the 

instructions provided in the IBM System Storage DS4000 Fibre Channel and Serial 

ATA Intermix Premium Feature Installation Overview 

DS4000 controller firmware version 07.10.xx.xx 

On storage subsystems (DS4800 and DS4700) using DS4000 controller 

firmware version 07.10.xx.xx, the DS4000 FC/SATA Intermix premium 

feature is enabled using a premium feature key. 

DS4000 controller firmware version 06.23.xx.xx 

On storage subsystems using DS4000 controller firmware versions 

06.23.xx.xx and later, the DS4000 FC/SATA Intermix premium feature is 

enabled using a premium feature key. 

DS4000 controller firmware version 06.19.xx.xx 

On storage subsystems (only DS4300 and DS4500) using DS4000 

controller firmware version 06.19.xx.xx, the DS4000 FC/SATA Intermix 

premium feature is enabled using a premium feature key. 

DS4000 controller firmware version 06.16.xx.xx 

On storage subsystems using DS4000 controller firmware versions 

06.16.xx.xx and later, the DS4000 FC/SATA Intermix premium feature is 

enabled using a premium feature key. 

DS4000 controller firmware versions 06.12.xx.xx and later 

On storage subsystems using DS4000 controller firmware versions 

06.12.xx.xx and later, the DS4000 FC/SATA Intermix premium feature is 

enabled using a premium feature key. 

DS4000 controller firmware version 06.10.xx.xx 

On storage subsystems using DS4000 controller firmware version 

06.10.xx.xx, the DS4000 FC/SATA Intermix premium feature is enabled 

using an NVSRAM file. 

 Download the appropriate NVSRAM version to enable the DS4000 

FC/SATA Intermix premium feature. 

Upgrading DS4000 controller firmware on systems with FC/SATA Intermix 

already enabled 

If you are currently using DS4000 controller firmware 06.10.xx.xx and want 

to upgrade to 06.12.xx.xx or a later version, and you already have the 

FC/SATA Intermix premium feature enabled on your subsystem, you need 

to complete the steps in this section. 

 Complete the following steps to upgrade the controller firmware to 

06.12.xx.xx or later: 

1.   Upgrade the controller firmware and NVSRAM to 06.12.xx.xx or later 

version. 
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Note:  After the firmware is upgraded, the recovery guru will display the 

error “premium feature out-of-compliance.” The premium feature 

that is out-of-compliance is the DS4000 FC/SATA Intermix 

premium feature. You will not be able to create any arrays or 

logical drives or modify the LUNs until after you complete step 2. 

2.   Enable the DS4000 FC/SATA Intermix premium feature using the 

premium feature key file. Use the instructions in the DS4000 FC/SATA 

Intermix premium feature activation card to generate the premium 

feature key file. This restores the DS4000 subsystem to full functionality.

Enabling premium features 

You must perform the following tasks to enable a premium feature on your storage 

subsystem: 

v   “Obtaining the feature enable identifier” 

v   “Generating the feature key file” 

v   “Enabling the premium feature” 

v   “Verifying that the premium feature is enabled” on page 19

To obtain the storage subsystem premium feature identifier string, ensure that your 

controller unit and storage expansion enclosures are connected, powered on, and 

managed using the SMclient. Continue with the next section. 

Obtaining the feature enable identifier:   Each storage subsystem has its own 

unique feature enable identifier. This identifier ensures that a particular feature key 

file is applicable only to that storage subsystem. Complete the following steps to 

obtain the feature enable identifier: 

1.   Click Start → Programs → Storage Manager 10 Client. The Enterprise 

Management window opens. 

2.   In the Enterprise Management window, double-click the storage subsystem for 

which you want to enable the premium feature. The Subsystem Management 

window opens for the selected storage subsystem. 

3.   In the Subsystem Management window, click Storage Subsystem → Premium 

Features → List. The List Premium Features window opens and displays the 

feature enable identifier. 

4.   Record the feature enable identifier. 

5.   Close the List Premium Features window. 

6.   Continue to next section, “Generating the feature key file.”

Note:  To check the status of an existing premium feature, select Storage 

Subsystem → Premium Features → List from the pull-down menu.

Generating the feature key file:   You can generate the feature key file by using 

the Premium Feature Activation tool that is located at the following Web site: 

www-912.ibm.com/PremiumFeatures/jsp/keyInput.jsp 

1.   Complete the steps in the Web site. Feature key file is e-mailed to you. 

2.   On your hard drive, create a new directory that you can find easily. (For 

example, name the directory FlashCopy feature key.) 

3.   Save the feature key file in the new directory.

Enabling the premium feature:   In the Storage Manager subsystem management 

window: 
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1.   In the menu, click Premium Features → Enable. 

2.   Browse to the appropriate key file in the directory you saved it to in the previous 

task, “Generating the feature key file” on page 18. 

3.    Click OK. 

4.    Confirm that the premium feature is enabled. See the next section, “Verifying 

that the premium feature is enabled.”

Verifying that the premium feature is enabled:   Perform the following steps to see a 

list of those premium features that are enabled on your storage subsystem: 

1.   In the Subsystem Management window, click Storage Subsystem → Premium 

Features → List. 

The List Premium Features window opens (see Figure 4). 

 

 The dialog lists the following items: 

v   The premium features that are enabled on the storage subsystem 

v   The feature enable identifier

2.   Click Close to close the window.

Disabling premium features:   In normal system operations, you do not need to 

disable the premium features. However, if you want to disable a premium feature, 

make sure that you have the key file or the IBM DS4000 premium feature 

entitlement card with the premium feature activation code for generating the key file. 

You need this key file to re-enable the premium feature at a later time. 

Perform the following steps to disable a premium feature on the storage subsystem: 

d
s
s
0
0
0
0
8

  

Figure 4. Listing premium features
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1.   In the Subsystem Management window, click Storage Subsystem → Premium 

Features → Disable. 

The Disable Premium Feature window opens, listing all the premium features 

that are enabled. 

2.   Select one item in the list, and then click OK. 

A confirmation dialog displays that states that disabling a premium feature is not 

recommended. 

3.   Click Yes. 

The Working dialog displays while the feature is being disabled. When the 

feature has been disabled, the Working dialog closes.

Notes:  

1.   If you want to enable the premium feature in the future, you must reapply the 

Feature Key file for that feature. 

2.   You can disable the Remote Mirror Option without deactivating the feature. If the 

feature is disabled but activated, you can perform all mirroring operations on 

existing remote mirrors. However, when the feature is disabled you cannot 

create any new remote mirrors. For more information about activating the 

Remote Mirror Option, see the DS4000 Storage Manager Copy Services Guide 

or see “Using the Activate Remote Mirroring Wizard” in the Storage Manager 

online help. 

3.   If a premium feature becomes disabled, you can access the Web site and 

repeat this process.

For any additional assistance, contact your local IBM service provider. Make sure 

you have available the information listed in “Enabling the premium feature” on page 

18. 

DS4000 hardware and firmware requirements for AIX, HP-UX, Solaris, 

and Linux on POWER 

Table 6 on page 21 lists the DS4000 EXP storage expansion enclosures and other 

hardware that are supported with DS4000 Storage Manager. Check the Storage 

Manager readme file for your specific operating system to determine the latest 

supported firmware versions for the devices listed in the table. 

Note:  See“Finding the Storage Manager readme files online” on page 24 for steps 

that will help you find the readme files on the Web. (If you do not have 

access to the Web, you can check the Storage Manager readme file that is 

located on your DS4000 Installation CD.)
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Table 6. Supported DS4000 expansion enclosures and other hardware for AIX, HP-UX, 

Solaris, and Linux on POWER  systems 

Hardware Product Name  Model 

Storage 

Expansion 

Enclosure 

IBM System Storage DS4000 EXP810 Storage 

Expansion Enclosure 

1812-81A/H 

HP-UX only supports 

models 1812-81A/H 

IBM TotalStorage DS4000 EXP100 SATA 

Storage Expansion Enclosure 

1710-10U or 10X 

IBM TotalStorage DS4000 EXP710 Fibre 

Channel Storage Expansion Enclosure 

1740-710 

IBM TotalStorage DS4000 EXP700 Fibre 

Channel Storage Expansion Enclosure 

1740-1RU or 1RX 

IBM TotalStorage DS4000 EXP500 Fibre 

Channel Storage Expansion Enclosure 

3560-1RU or 1RX 

IBM System Storage DS4000 EXP420 SATA 

Storage Expansion Enclosure 

1812-8VA/H 

AIX  Host Bus  

Adapters 

IBM HA Emulex LP7000 FC 6227 

IBM HA Emulex LP9000 FC 6228 

IBM HA Emulex LP9802-F2 FC 6239 

IBM HA Emulex 

LP9002 

FC 6226 

FC 0611 

FC 0612 

IBM HA Emulex 

LP9802 

FC 6239 

FC 0625 

FC 0626 

IBM HA Emulex 

LP10000 (can also be in eClipz server) 

(AIX 5.2 and 5.3 only) 

FC 5716 

FC 1977 

FC 1957 

IBM HA Emulex 

LP11000 

(AIX 5.2 and 5.3 only) 

42D0405 

FC 5758 

FC 1905 

IBM HA Emulex 

LP11002 

(AIX 5.2 and 5.3 only) 

42D0407 

FC 5759 

FC 1910 

IBM HA Emulex 

LPe11000 (eClipz server only) 

42C2069 

FC 5773 

IBM HA Emulex 

LPe11002 (eClipz server only) 

42C2071 

FC 5774 

BladeCenter blades JS20, JS21 

IBM HA Emulex 

LP1105BC (JS21 only) 

39Y9186 

FC 2925 

IBM HA Emulex 

LP1105BCv (JS21 only) 

43W6859 

QLogic 4Gb CFFv 41Y8527 

FC 2970 

QLogic 4Gb SFF 26R0890 

FC 1577 

QLogic 4Gb StFF 26R0884 

FC 1597 
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Table 6. Supported DS4000 expansion enclosures and other hardware for AIX, HP-UX, 

Solaris, and Linux on POWER  systems (continued) 

Hardware Product Name Model 

HP-UX  Host Bus  

Adapters 

HP FC Adapter for 

HP-UX 11.0 

A5158A, A6795A 

HP FC Adapter for 

HP-UX 11i 

A5158A, A6795A 

Solaris Host Bus  

Adapters 

JNI FC Adapter FCE-6410-N 33 Mhz 

JNI FC Adapter FCE2-6412 66 Mhz 

64 bit 

JNI FC Adapter FCE-6460-PCI 64 bit 

JNI FC Adapter FCE-1473 S-bus 64 

bit 

JNI FC Adapter FCC2-6562 

JNI FC Adapter FCX-6562 

JNI FC Adapter FCC\X2-6562 

QLogic Adapter 234x 

Emulex Adapter LP9001 

Emulex Adapter LP9802 

Emulex Adapter LP10000 
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Table 6. Supported DS4000 expansion enclosures and other hardware for AIX, HP-UX, 

Solaris, and Linux on POWER  systems (continued) 

Hardware Product Name  Model 

Linux Host Bus  

Adapters 

Please check the 

DS4000 Storage 

Manager readme 

file for Linux on 

POWER for 

additional 

supported HBAs. 

IBM HA Emulex LP9000 FC 6228 

IBM HA Emulex LP9002-F2 FC 6239 

IBM JS20 Fibre 

Channel daughter card 

73P6112 

FC 1.06 

IBM HA Emulex LP9802-F2 FC 6239 

IBM HA Emulex 

LP11002 

FC 5759 

IBM HA Emulex 

LP9002 

FC 6226 

FC 0611 

FC 0612 

IBM HA Emulex 

LP9802 

FC 6239 

FC 0625 

FC 0626 

IBM HA Emulex 

LP10000 (can also be in eClipz server) 

FC 5716 

FC 1977 

FC 1957 

IBM HA Emulex 

LP11000 

42D0405 

FC 5758 

FC 1905 

IBM HA Emulex 

LP11002 

42D0407 

FC 5759 

FC 1910 

IBM HA Emulex 

LPe11000 (eClipz server only) 

42C2069 

FC 5773 

IBM HA Emulex 

LPe11002 (eClipz server only) 

42C2071 

FC 5774 

BladeCenter blades JS20, JS21 

IBM HA Emulex 

LP1105BC (JS21 only) 

39Y9186 

FC 2925 

IBM HA Emulex 

LP1105BCv (JS21 only) 

43W6859 

QLogic 4Gb CFFv 41Y8527 

FC 2970 

QLogic 4Gb SFF 26R0890 

FC 1577 

QLogic 4Gb StFF 26R0884 

FC 1597 
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Table 6. Supported DS4000 expansion enclosures and other hardware for AIX, HP-UX, 

Solaris, and Linux on POWER  systems (continued) 

Hardware Product Name Model 

Switches IBM TotalStorage SAN Switch 2109-S08 

2109-S16 

IBM TotalStorage SAN Switch 2109-F16 

IBM TotalStorage SAN Switch 2109-M12 

IBM TotalStorage SAN Switch 2109-F32 

IBM TotalStorage SAN Switch 2109-F08 

McData Switch 2032-064 

2032-140 

McData Switch 2031-016 

McData Switch 2031-216 

2031-224 

CNT Switch 2042-001 

Cisco Switch 2062-D01 

2062-D07 

2062-T07 

  

See also: 

In addition to the readme file, for up-to-date information please refer to the following 

Web pages: 

Switches 

www.ibm.com/servers/storage/support/san/index.html 

Interoperability 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html

For important information about using the DS4000 EXP100 SATA storage expansion 

enclosure, see the IBM TotalStorage DS4000 EXP100 Storage Expansion 

Enclosure Installation and User’s Guide. 

 Important for HP-UX:  IBM strongly recommends that you install controller firmware 

and NVSRAM versions 06.12.xx.xx or later. These versions 

contain fixes that are not available with earlier versions. 

Finding the Storage Manager readme files online 

To find the latest DS4000 Storage Manager readme file online, complete the 

following steps: 

1.   For the most recent Storage Manager readme files for your operating system, 

see the following Web site: 

www-1.ibm.com/servers/storage/support/disk/ 

2.   Click the link for your storage subsystem. 

3.   When the subsystem page opens, click the Download tab. 

4.   When the download page opens, click the link for Storage Manager. 

5.   When the next page opens, click the Storage Mgr tab. A table displays. 
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6.   In the table, find the entry for IBM DS4000 Storage Manager for your operating 

system, and click the corresponding link under the Current version and 

readmes column.
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Chapter  2.  Installing  and  configuring  storage  management  

software  on  AIX  host  systems  

This chapter provides the following information for AIX operating systems: 

v   “AIX restrictions” on page 28 

v   “Installing DS4000 Storage Manager” on page 29 

v   “Configuring storage subsystems” on page 35 

v   “Creating storage partitions” on page 40 

v   “Creating direct and SAN-attached configurations” on page 44 

v   “Installing the RDAC failover driver” on page 45 

v   “Identifying devices on AIX hosts” on page 47 

v   “Verifying the installation and configuration” on page 50 

v   “Viewing and setting Object Data Manager (ODM) attributes” on page 60 

v   “Additional AIX configuration information” on page 68 

v   “Replacing hot swap HBAs” on page 72 

v   “Resolving disk array errors” on page 79 

v   “Redistributing logical drives in case of failure” on page 81

Hardware, software and host system requirements 

This section provides information about the hardware and software requirements for 

the AIX host system. 

Note:  For the latest installation requirements and user information about Storage 

Manager, AIX file sets, and hardware components, see the Storage Manager 

readme file for AIX that is located on the DS4000 Installation CD. You can 

also find the readme file online, as described in “Finding the Storage 

Manager readme files online” on page 24. 

AIX system requirements 

This section lists the minimum hardware and software requirements for an AIX host 

in a DS4100, DS4200 Express, DS4300, DS4400, DS4500, DS4700, or DS4800 

storage subsystem that is managed by DS4000 Storage Manager. 

Note: For more information about using AIX with Series p and POWER servers, 

see the Series p and AIX Information Center at the following Web site: 

publib.boulder.ibm.com/infocenter/pseries/index.jsp? 

Hardware requirements 

The following hardware is required at minimum: 

Any RS/6000®, RS6000 SP™ or IBM ERserver, Series p™, or POWER server that 

supports FC 6228, FC 6239, FC 5716, FC 5758, or FC 5759 host bus adapters 

Software requirements 

The following operating system software is required: 

v   AIX 5.2, 5.3 or Virtual I/O Server 

v   The required minimum AIX file sets, associated with AIX RDAC driver 

installations, that are listed in the Storage Manager readme file for AIX.
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Note:  For information about Virtual I/O Server requirements, see the following Web 

site: http://www14.software.ibm.com/webapp/set2/sas/f/vios/home.html 

AIX restrictions 

The following restrictions apply to AIX configurations: 

SAN and connectivity restrictions 

v   AIX hosts can support multiple host bus adapters (HBAs) and DS4000 

devices; however, there is a restriction on the number of HBAs that can 

be connected to a single DS4000 storage subsystem. You can configure 

up to two HBAs per partition and up to two partitions per DS4000 storage 

subsystem. Additional HBAs can be added for additional DS4000 storage 

subsystems and other SAN devices, up to the limits of your specific 

subsystem platform. 

v   AIX imposes the following limitations on disk volume sizes: 

–   1 TB, on 32-bit 4.3.3, 5.1, or 5.2 

–   2 TB, on 64-bit 5.1 (1 TB for anything reliant on boot info) 

–   2 TB, on 64-bit 5.2 (2 TB when using LVM bad block relocation) 

–   greater than 2 TB, on 64-bit 5.2 and 5.3 with controller firmware 

07.10.xx.xx and above

Even where larger volumes are supported, the AIX boot logical volume 

must reside within the first 2 TB of the volume. Hardware devices or 3rd 

party software may further limit volume sizes. Customers should contact 

their hardware or software vendor for additional information. 

v   Direct-attach configurations are restricted to single-initiator configurations 

only. You can make only one connection to each minihub on a DS4500 

storage subsystem.

Note:  DS4800, DS4700, DS4300, DS4200, and DS4100 storage 

subsystems do not have minihubs. 

v   Single-switch configurations are allowed, but each HBA and DS4000 

controller combination must be in a separate SAN zone. 

v   Other storage devices, such as tape devices or other disk storage, must 

be connected through separate HBAs and SAN zones. 

v   Single HBA configurations are allowed, but each single HBA configuration 

requires that both controllers in the DS4000 be connected to the HBA, 

either through a switch or daisy-chain (direct-attach only). If they are 

connected through a switch, both controllers must be within the same 

SAN zone as the HBA.

Attention:  Having a single HBA configuration can lead to loss of access 

data in the event of a path failure.

Note:  DS4800, DS4700, DS4300, DS4200, and DS4100 storage 

subsystems do not support daisy-chain configurations.

Restrictions when booting up your system 

v   When you boot your system from a DS4000 device, both paths to the 

DS4000 storage subsystem must be up and running. 

v   The system cannot use path failover during the AIX boot process. Once 

the AIX host has started, failover operates normally.
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Recommendation: It is recommended that you do not boot your system 

from a SATA device. 

Partitioning restrictions 

v   The maximum number of partitions per AIX host, per DS4000 storage 

subsystem, is two.

Exception:  With DS4800 and DS4700 Model 72, the maximum number 

of partitions for a host is four per storage subsystem. 

v    All logical drives that are configured for AIX must be mapped to an AIX 

host group. 

Note:  If you are using the default host group, ensure that the default 

host type is AIX.
For more information, see “Creating storage partitions” on page 40. 

v   On each controller, you must configure at least one LUN with an ID 

between 0 and 31 that is not a UTM or access logical drive.

Interoperability restrictions 

v   Concurrent download is not supported with some controller firmware 

versions, such as 06.14.xx.xx or 06.15.xx.xx. Please see the latest 

Storage Manager readme file for AIX to find out which firmware versions 

support concurrent download. 

v   DS4100 and DS4300 single-controller storage subsystems are not 

supported with AIX hosts. (DS4100 dual-controller and DS4300 Base and 

Turbo dual-controller storage subsystems are supported.) 

v   EXP700 storage expansion enclosures are not supported with DS4800.

Installing DS4000 Storage Manager 

Preparing for software installation 

Before you install the DS4000 software, here are some additional items you may 

need to assemble in preparation for the installation. 

v   For the AIX operating system, make certain you are running the OS-required 

maintenance level. (Check the readme.txt file for lists of required maintenance 

levels, as well as for any additional fixes.) 

v   HBA drivers 

v   The most up-to-date controller firmware for your particular storage subsystem 

(see Table 2 on page 2 to determine the firmware version you need) 

v   IP addresses for RAID controllers (for out-of-band management, only) 

v   Additional documentation for switches and HBAs, if needed 

v   Appropriate host CD for your operating system, which includes the most 

up-to-date DS4000 software and controller firmware for your particular storage 

subsystem 

Depending on the DS4000 model you order, your DS4000 will ship with either the 

Microsoft® Windows host software attachment kit or with your choice of host 

software kits (Windows, AIX, Linux, NetWare, SUN Solaris, HP-UX, or Linux on 

POWER). The host software kit grants you permission to attach host servers 

using the appropriate operating system for the DS4000. The kit includes the most 

up-to-date DS4000 software and controller firmware for your particular storage 

subsystem. 
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For the latest controller firmware, check the IBM support Web site for DS4000 

storage products.

http://www.ibm.com/servers/storage/support/disk/ 

Note:  If you install Storage Manager 10.10 using the Storage Manager Installation 

Agent, the installer will display an ″IBM System Storage DS4000/FAStT 

Storage Manager″ splash screen with a drop down menu. From this drop 

down menu you can select a language option. (Language selection is 

optional if you are performing an English language installation.) The 

language option you select will determine the language version of the 

License Agreement that will be displayed. Once you have selected a 

language, click the OK button. The next screen will display the License 

Agreement in the preferred language. Select ″I accept the terms of the 

License Agreement,″ and click Next to continue with the installation 

 You can install all of the DS4000 Storage Manager software packages automatically 

by using the Storage Manager installation wizard, or you can install each package 

manually. This section contains the following procedures: 

v   “Installing Storage Manager using the installation wizard” 

v   “Installing Storage Manager packages manually” on page 31 (original method)

Failover drivers 

An AIX host system requires the AIX Redundant Disk Array Controller (RDAC) 

failover driver for fibre channel path redundancy. 

The failover driver monitors I/O paths. If a component failure occurs in one of the 

fibre channel paths, the failover driver reroutes all I/O to another path. 

Note:  The AIX RDAC driver files are not included on the DS4000 Storage Manager 

installation CD. To install them, you must download the files from the Web 

site listed in “Installing the RDAC failover driver” on page 45 and follow the 

instructions you find there. 

Installing Storage Manager using the installation wizard 

The DS4000 Storage Manager installation wizard installs the following software 

packages on the AIX host: 

v   SMruntime 

v   SMesm 

v   SMclient 

v   SMagent 

v   SMutil

Requirements:  

1.   DS4000 Storage Manager version 10.10 

2.   xservices must be operational 

If you are installing Storage Manager 10.10 on AIX and your system does not meet 

the requirements for using the wizard, does not have a graphics card installed, or if 

you do not want to use the wizard to install the software, you can perform the 

installation without a GUI by typing the sh <installer-package-name.bin> -i 

console command in the command line interface. You can also skip this section and 
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install the stand-alone host software packages using the procedures described in 

“Installing Storage Manager packages manually.” All the packages are included with 

the installation CD. 

Notes:  

1.   If you use the wizard to install Storage Manager, you might need to increase the 

size of some partitions to accommodate the installation. These partitions will be 

identified during the installation process. 

2.   Do not install the software packages in the same subsystem by using both the 

installation wizard and the manual installation method. 

Complete the following steps to install the DS4000 Storage Manager software using 

the installation wizard. Adjust the steps as necessary for your specific installation. 

1.   Download the following file from the DS4000 Storage Manager CD, or from the 

DS4000 support Web site, to a directory on your system: 

SMIA-AIX-10.10.xx.xx.bin 

2.   Open the file on your system. The Storage Manager Installation wizard’s 

Introduction window opens. 

3.   Follow the instructions in each window of the wizard. When you select the 

installation type, you can choose one of the following options: 

v   Typical (Full) Installation—Installs all Storage Manager software packages 

v   Management Station—Installs SMruntime and SMclient 

v   Host—Installs SMruntime, SMagent and SMutil 

v   Custom—Allows you to select which packages you want to install

Note:  During the installation, you will see the question Automatically Start 

Monitor?. This refers to the Event Monitor service. If you want to enable 

automatic ESM firmware synchronization, the Event Monitor must be 

enabled. To enable the Event Monitor, elect Automatically Start 

Monitor. For more information, see “Automatic ESM firmware 

synchronization” on page 232.
Result: The DS4000 Storage Manager software is installed on your system.

Installing Storage Manager packages manually 

Use the following procedures, in the order listed, to install the DS4000 Storage 

Manager software on an AIX storage management station. 

1.   “Installing the client software” 

2.   “Installing SMagent (optional)” on page 33

Installing the client software 

For the specific installation order, see Table 3 on page 5. 

Note:  SMclient is dependent on SMruntime, which is a Java compiler for SMclient. 

SMruntime must be installed first.

Prerequisites:   Before installing the software, ensure that the following conditions 

are met: 

v   The AIX host on which you are installing SMruntime meets the minimum 

hardware and software requirements described in “Hardware, software and host 

system requirements” on page 27 and http://www14.software.ibm.com/webapp/
set2/sas/f/vios/home.html. 

v   The correct file sets are present on the system. 
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Note:  If the file sets are not present, check the Storage Manager readme file for 

AIX for the minimum file set versions required for your AIX operating 

system. (See “Readme files and concepts” on page 1.) Then, follow the 

instructions in “Steps for downloading the AIX file sets” on page 46 to 

download them from the appropriate Web site. 

v   The DS4000 Storage Manager files are available in a directory on the system.

Steps for installing SMruntime software:   Modify the commands as needed for 

your installation. No restart is required during the installation process. 

1.   Install SMruntime by typing the following command: 

 # installp -a  -d /path_name 

/SMruntime.AIX-10.10.xx.xx.bff SMruntime.aix.rte 

  

where path_name is the directory path to the SMruntime package. 

2.   Verify that the installation was successful by typing the following command: 

 

 # lslpp -ah SMruntime.aix.rte 

  

The verification process returns a table that describes the software installation, 

including the install package file name, version number, action and action status. If 

the verification process returns an error, contact your IBM service representative. 

Steps for installing SMesm software (required if installing SMclient):   Modify 

the commands as needed for your installation. No restart is required during the 

client installation process. 

1.   Install SMesm by typing the following command: 

 # installp -a  -d /path_name/ 

SMesm.AIX-10.10.xx.xx.bff SMesm.aix.rte 

  

where path_name is the directory path to the SMesm package. 

2.   Verify that the installation was successful by typing the following command: 

 # lslpp -ah SMesm.aix.rte 

  

The verification process returns a table that describes the software installation, 

including the install package file name, version number, action and action status. If 

the verification process returns an error, contact your support representative. 

Steps for installing SMclient software:   Modify the commands as needed for 

your installation. No restart is required during the client installation process. 

1.   Install SMclient by typing the following command: 

 # installp -a  -d /path_name/ 

SMclient.AIX-10.10.xx.xx.bff SMclient.aix.rte 

  

where path_name is the directory path to the SMclient package. 

2.   Verify that the installation was successful by typing the following command: 

 # lslpp -ah SMclient.aix.rte 
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The verification process returns a table that describes the software installation, 

including the install package file name, version number, action, and action status. If 

the verification process returns an error, contact your support representative. 

Installing SMagent (optional) 

SMagent is required for in-band management only. It is not required for out-of-band 

management. 

Prerequisites:   Before installing SMagent, ensure that the following conditions are 

met: 

v   This is the AIX server that you identified as the storage management station. 

v   This machine meets the minimum hardware and software requirements described 

in . 

v   SMruntime has been installed.

Steps for installing SMagent software:   Modify these commands as needed for 

your installation. No restart is required during the client installation process.

Note:  The installation process adds an entry to the /etc/inittab file that starts 

SMagent each time the system is booted. 

1.   Install SMagent by typing the following command: 

 # installp -a  -d /path_name/ 

SMagent.AIX-10.10.xx.xx.bff SMagent.aix.rte 

  

where path_name is the directory path to the SMagent package. 

2.   Verify that the installation was successful by typing the following command: 

 # lslpp -ah SMagent.aix.rte 

  

Starting or stopping SMagent software:   Use the following command to manually 

start SMagent: 

 # SMagent start 

  

Use the following command to manually stop SMagent: 

 # SMagent stop 

  

Steps for installing SMutil software:   Modify the commands as needed for your 

installation. No restart is required during the client installation process. 

1.   Install SMutil by typing the following command: 

 # installp -a  -d /path_name/ 

SMutil.AIX-10.10.xx.xx.bff SMutil.aix.rte 

  

where path_name is the directory path to the SMutil package. 

2.   Verify that the installation was successful by typing the following command: 

 # lslpp -ah SMutil.aix.rte 

 

 

Chapter 2. Installing and configuring storage management software on AIX host systems 33



The verification process returns a table that describes the software installation, 

including the install package file name, version number, action, and action status. If 

the verification process returns an error, contact your support representative. 

SAN boot with AIX 

Assumptions 

This procedure assumes the following: 

v   No installation is present. 

v   After the installation is complete, the boot and swap devices will run on a 

DS4000 storage subsystem. 

v   For specific information about disk volume sizes, see “AIX restrictions” on page 

28.

Preparing for the SAN boot procedure 

Complete the following steps before you begin the installation. 

1.   Be familiar with the following topics: 

v   How to connect to and operate an IBM Series p server 

v   How to create LUNs on the DS4000 storage subsystem 

v   How to set up a SAN network or direct-attached SAN storage devices, so 

that the configured server can access the DS4000 LUNs 

v   How the AIX kernel boot process functions, and what processes and 

procedures are used to boot an AIX distribution for a local storage device. 

For more information, see the AIX 5L™ 5.3 Installation Guide. 

http://publib.boulder.ibm.com/infocenter/pseries/v5r3/topic/com.ibm.aix.install/
doc/insgdrf/insgdrf.pdf

2.   Make sure your hardware installation is complete, including all external devices. 

(See the documentation provided with your system for installation instructions.) 

3.   Verify that the fibre channel HBAs are mapped to the correct DS4000 drives 

using the Smclient GUI. 

4.   In dual-path systems, IBM recommends that you have both paths available 

during the SAN boot operating system installation process. 

5.   Ensure that the size of the boot device that you plan to use is at least 2.2 GB. 

Future growth potential would dictate a minimum of 18GB. 

6.   Ensure that you have your AIX 5.2 or AIX 5.3 operating system installation CD.

Note:   For simplicity, the procedure described in this document assumes that the 

boot, root, and swap devices are all located on the same device; however, 

this is not a requirement for the installation. 

Steps for performing the SAN boot procedure 

The installation media (source for installation) that is used in the following steps is a 

set of release CDs. 

Important: 

Not all of the details about installation and partitioning are documented in this 

procedure. To determine which packages are needed for the type of system you are 

installing, you must refer to your system’s installation procedures. 
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Note:  Complete the following steps. 

 1.   Ensure all external devices (i.e. storage) are powered on. 

 2.   Power on server, and insert AIX Volume 1 CD into CDROM/DVD. 

 3.   Boot to the System Management Services menu (SMS). 

 4.   From the SMS menu, select your installation source (CD), and boot 

from the AIX Volume 1 Product CD . (See your server’s installation 

manual for detailed instructions.) 

 5.   When the Welcome to Base Operating System Installation and 

Maintenance window displays, type 2 in the Choice field to select 

Change/Show Installation Settings and Install, and press Enter. 

 6.   When the Change Method of Installation window displays, select 1 for 

New and Complete Overwrite, and press Enter. 

 7.   When the Change Disk(s) window displays, you can change/select the 

destination disk for the installation. At this point, you can select the 

appropriate DS4000 hdisk(s) and deselect any other drives (for 

example, SCSI). 

 8.   When you have finished selecting the disk(s) and verified your choices 

are correct, type 0 in the Choice field, and press Enter. The Installation 

and Settings window displays with the selected disks listed under 

System Settings. 

 9.   Make any other changes your OS installation requires and proceed with 

installation. 

10.   Refer to the AIX Installation Guide for completing the installation. 

http://publib.boulder.ibm.com/infocenter/pseries/v5r3/topic/
com.ibm.aix.install/doc/insgdrf/insgdrf.pdf

Configuring storage subsystems 

If you have purchased a Storage Partitioning premium feature, ensure that the 

premium feature is enabled. For more information, see “Enabling premium features” 

on page 18. 

Complete the following procedures to configure DS4000 Storage Manager for an 

AIX system. This can be done from the DS4000 SMclient software running on either 

an AIX or a non-AIX system. 

Adding storage subsystems to SMclient 

Complete the following steps to add storage subsystems to DS4000 SMclient: 

1.   To set up the storage subsystem for AIX and DS4000 SMclient, the subsystem 

must be physically configured for direct management through the Ethernet 

connections on each controller. Install SMclient before configuring the 

subsystem.

Note:  See “Setting up IP addresses for DS4000 storage controllers” on page 

13 for information about assigning IP addresses to the controllers. 

2.   After the disk subsystem is configured on the network, start SMclient on the 

host server by typing the following command: 

 # /usr/SMclient/SMclient 

  

The Enterprise Management window opens. 

3.   Complete the following steps to specify the IP addresses of the controllers: 
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a.   In the Enterprise Management window, click Edit → Add Storage 

Subsystem. 

b.   In the Add Storage Subsystem window, type the IP addresses of each 

controller in the storage subsystem, and click Add. The name of the storage 

subsystem displays in the Enterprise Management window. (If this is the first 

time the controller has been added to the Enterprise Management window, it 

will need to be assigned a name.)

Note:  Failure to add both controllers results in a partially-managed system, 

where all functions may not be available.

The name of the storage subsystem displays in the Enterprise Management 

window. 

4.   Double-click the name of the storage subsystem to open its Subsystem 

Management window.

Upgrading controller firmware and NVSRAM 

The procedures in this section describe how to download and install DS4000 

controller firmware and NVSRAM.

Note:  If you are upgrading a DS4800, DS4700, or a DS4200 storage subsystem to 

controller firmware version 07.10.xx.xx, see Appendix D, “Using the IBM 

System Storage DS4000 Controller Firmware Upgrade Tool,” on page 235. 

Overview 

Read the information in the following sections before you begin the download 

procedures: 

v   “Using concurrent download” 

v   “Using traditional or staged download” on page 37

Using concurrent download:   Depending on your system’s current firmware and 

AIX device driver levels, you might be able to use concurrent download. Concurrent 

download is a method of downloading firmware to the controllers that does not 

require you to stop I/O to the controllers during the process.

Attention:  

1.   Concurrent download is not supported with controller firmware versions 

06.14.xx.xx or 06.15.xx.xx, and might not be supported with other firmware 

versions. Please see the latest Storage Manager readme file for AIX to find out 

which firmware versions support concurrent download. 

2.   You cannot use concurrent firmware download if you change the default setting 

of the Object Data Manager (ODM) attribute switch_retries. The default is 5. 

See “Viewing and setting Object Data Manager (ODM) attributes” on page 60 

for more information. 

3.   If you do not have the correct firmware versions to use concurrent download, 

you must ensure that all I/O to the controllers is stopped before you upgrade the 

firmware. 

To find out whether you can use concurrent download, see Table 7 on page 39 

and the latest Storage Manager readme file for AIX. 

4.   Upgrading from pre-07.10.xx.xx to 07.10.xx.xx is not concurrent. You must use 

the upgrade utility and stop all I/O. See Appendix D, “Using the IBM System 

Storage DS4000 Controller Firmware Upgrade Tool,” on page 235.
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Using traditional or staged download:   There are two methods for downloading 

the firmware to the controllers: 

v   “Traditional download” 

v   “Staged download”

Traditional download:   The traditional download process takes significantly longer 

and must be done in one phase, rather than in two phases as with the staged 

controller firmware download. Therefore the preferred method of controller firmware 

download is the staged controller firmware download. 

Staged download:   With staged firmware download, the download process occurs 

in two distinct phases: firmware transfer and firmware activation. You can perform 

the time-consuming task of loading the firmware online so that it is functionally 

transparent to the application. You can then defer the activation of the loaded 

firmware to a convenient time. 

Some reasons for activating firmware files at a later time include the following: 

v   Time of day—Activating can take a long time, so you might want to wait until I/O 

loads are lighter because the controllers will go offline briefly to activate the new 

firmware. 

v   Type of package—You might want to test the new firmware package on one 

storage subsystem before activating it on other storage subsystems. 

v   Multiple controllers—You can download controller firmware from the storage 

management software to all storage subsystem controllers for later activation.

Notes:  

1.   You cannot use staged download to upgrade DS4000 controller firmware 

version 05.xx.xx.xx to version 06.1x.xx.xx. You can only use staged download if 

the DS4000 controller firmware version is already 06.1x.xx.xx, and you are 

downloading another version of 06.1x.xx.xx firmware. 

2.   Staged controller firmware download is not supported on DS4400 storage 

subsystems. 

3.   Staged download is not supported when upgrading to version 07.10.xx.xx. You 

must use the upgrade utility. See Appendix D, “Using the IBM System Storage 

DS4000 Controller Firmware Upgrade Tool,” on page 235. 

Important: Do not perform other storage management tasks, such as creating or 

deleting logical drives, reconstructing arrays, and so on, while downloading the 

DS4000 storage subsystem controller firmware. It is recommended that you close 

all storage management sessions (except for the session that you use to upgrade 

the firmware) to the DS4000 storage subsystem that you plan to update. 

Preparing for firmware or NVSRAM download 

To prepare for download, review and complete all of the steps in this section before 

you start the download procedures. 

Check current versions of controller firmware and NVSRAM:   Versions of 

controller firmware and NVSRAM that are provided with this product might be later 

releases than those described in this document. 

To check the controller firmware and NVSRAM versions that are currently installed 

on your system, complete the following steps: 

1.   In the Subsystem Management window, click Storage Subsystem → View 

Profile. The Storage Subsystem Profile window displays. 
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2.   In the Storage Subsystem Profile window, click the Controllers tab to view the 

current versions of controller firmware and NVSRAM. 

3.   Click Close to close the Storage Subsystem Profile window. 

4.   To find whether the versions of controller firmware and NVSRAM that are 

currently on your storage subsystem are the latest versions, see the Storage 

Manager readme file for AIX at the following Web site: 

www-1.ibm.com/servers/storage/support/disk/ 

Click the link for your storage subsystem. When the storage subsystem page 

opens, click the Download tab. 

You can also find controller firmware versions listed in Table 2 on page 2. 

5.   If you find that you do not have the latest versions of the firmware and 

NVSRAM, download the correct versions from this Web site to a directory on 

your system, then follow the preparation and upgrade procedures that are 

described in this section.

Save the storage subsystem configuration:   Saving the storage subsystem 

configuration to a script file is necessary in order to restore the configuration in the 

event of a catastrophic failure. 

Attention:  Do not use this option if the storage subsystem is undergoing an 

operation that changes any configuration settings. (If any logical drive 

listed in the Logical View of the Subsystem Management window has a 

clock icon, then a configuration change is occurring, and you must wait 

to save the configuration.) 

You can also save the storage subsystem profile, by selecting Storage 

Subsystem → View Profile in the Subsystem Management window, and 

clicking Save As. Then, in the Save Profile window, select the sections 

of the profile that you want to save, specify a name and location for the 

text file, and click Save. 

Save the storage subsystem configuration by completing the following steps: 

1.   In the Subsystem Management window, click Storage Subsystem → 

Configuration → Save. The Save Configuration window displays. 

2.   In the Save Configuration window, select the elements of the configuration that 

you want to save, and click Yes. A save dialog displays. 

3.   In the save dialog, specify a name for the script file and select its location.

Notes®:  

v   The .cfg extension is used by default for the script file if you do not 

specify a file extension. 

v   Do not store your DS4000 Storage Subsystem configuration script 

file in the same location as the logical drives that are defined on 

your DS4000 Storage Subsystem. If you do, and the logical drives 

fail during the subsequent migration, you will lose data.

4.   Click Save. The Configuration Saved window displays. 

5.   Review the information in the Configuration Saved window, then click OK to 

return to the Subsystem Management window.

Determine whether you can use concurrent download:   You can use concurrent 

download only if you are upgrading from one version of controller firmware to a later 

release of the same version. For example, if you are upgrading from 06.10.xx.xx to 

06.12.xx.xx, you can use concurrent download; however, if you are upgrading from 
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05.xx.xx.xx to 06.1x.xx.xx or 06.xx.xx.xx to 07.10.xx.xx, you cannot use concurrent 

download. You need to stop I/O before upgrading controller firmware.

Notes:  

1.   You cannot use concurrent download to perform an upgrade from controller 

firmware version 06.xx.xx.xx to version 07.10.xx.xx. You must use the IBM 

System Storage DS4000 Controller Firmware Upgrade Tool to upgrade from 

version 06.xx.xx.xx to version 07.10.xx.xx. See Appendix D, “Using the IBM 

System Storage DS4000 Controller Firmware Upgrade Tool,” on page 235. 

Concurrent download is supported, once the upgrade to version 07.10.xx.xx has 

successfully completed. 

2.   Some controller firmware versions might not support concurrent download. See 

the latest Storage Manager readme file for AIX to find out which firmware 

versions support concurrent download. 

3.   Single-controller (SCU) storage subsystem models do not support concurrent 

download.

 Table 7. Firmware versions that support concurrent download (AIX) 

DS4000 storage subsystem: Controller firmware version: 

DS4100 06.10.xx.xx, 06.12.xx.xx 

DS4200 06.16.88.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4300 base and Turbo 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4400 06.10.xx.xx. 06.12.xx.xx 

DS4500 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4700 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4800 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

All other DS4000 storage subsystems 05.30.xx.xx, 06.10.xx.xx, 06.12.xx.xx
  

Steps for upgrading the controller firmware 

Complete the following steps to install a new firmware version on the controllers: 

1.   Download the correct version of the firmware from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 37. Place 

the file in a designated directory on the host system. 

2.   Check your system’s current firmware and device driver levels to determine 

whether you need to stop I/O before upgrading the firmware, using the 

information that is listed in Table 7 and in the Storage Manager readme file for 

AIX. 

Attention: If you do not have the correct firmware and device driver levels for 

concurrent download, you must stop I/O to the controllers before you upgrade 

the firmware. 

3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller Firmware. The Download Firmware window displays. 

5.   Click Browse to select the firmware file that you previously downloaded to a 

directory on the host. 

6.   If you want to perform a staged firmware download, select the check box next to 

″Transfer files but don’t activate them (activate later).″ If you want to perform a 

traditional firmware download, do not select the check box, and the firmware will 

load immediately. 
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7.   Click Transfer. The Confirm Download window displays. 

8.   Click Yes to start the download. 

9.   Verify that the firmware was successfully installed.

Steps for upgrading the NVSRAM 

Complete the following steps to install a new version of NVSRAM on the controllers. 

NVSRAM will be activated immediately. 

1.   Download the correct NVSRAM version from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 37. Place 

the file in a designated directory on the host system. 

2.   Stop I/O. 

3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller NVSRAM. The Download NVSRAM window displays. 

5.   Click Browse to select the NVSRAM file that you previously downloaded to a 

directory on the host. 

6.   Click OK. The Confirm Download window displays. 

7.   Click Yes to start the download. 

8.   Verify that the NVSRAM was successfully installed. 

9.   Start I/O.

Creating storage partitions 

To create storage partitions, you must complete the following procedures in this 

section: 

1.   “Steps for defining an AIX host group” on page 41 

2.   “Steps for defining the host and host port” on page 41 

3.   “Steps for verifying that the host ports match the host” on page 42 

4.   “Mapping LUNs to a storage partition” on page 43

Storage partitioning overview 

When you begin to create your storage partitions using the procedures in this 

section, be aware of the following information: 

v   If your subsystem is running controller firmware 06.12.00.00 or higher, the 

Storage Manager task assistant provides a Storage Partitioning wizard that you 

can use to define your host and host ports, and map LUNs to the storage 

partitions. If your subsystem is running controller firmware 05.xx.xx.xx, you 

cannot use the wizard. Both types of procedures are documented in this section. 

v   The procedures in this section assume that you have already created a physical 

connection between the host and the storage subsystem controllers, and that you 

have also connected and zoned the SAN switch (if any). If you have not 

completed these connections, please note that Storage Manager will not be able 

to list the WWPNs of the HBAs during these procedures. In this case you will 

need to type the WWPNs into the appropriate fields during the steps for defining 

a host and host ports. 

v   Create the AIX host group at the storage subsystem level. Do not create host 

groups at the default group level. 

Exceptions: If you are running a DS4100 or a DS4300 configuration without 

partitioning enabled, you can use the default host group. 
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v   In a cluster partition, perform logical drive mappings on the host group level so 

that all the hosts can see the same storage. In a normal partition, perform logical 

drive mappings on the host level.

Steps for defining an AIX host group 

A host group is an entity in the Storage Partitioning topology that defines a logical 

collection of host computers that require shared access to one or more logical 

drives. You can grant individual hosts in a defined host group access to storage 

partitions, independently of the host group. 

Complete the following steps to define a host group: 

1.   Click the Mappings View tab on the Subsystem Management window. 

2.   In the Topology section of the Mappings window, highlight the name of the 

storage subsystem, and click Mappings → Define → Host Group.

Note:  Make sure that the storage subsystem is highlighted in the left panel of 

the Subsystem Management window. Do not highlight Undefined 

Mappings. 

3.   Type the name of the new host group (for example, AIX). Click Add, and then 

click Close.

Steps for defining the host and host port 

Complete the steps that are appropriate for your storage subsystem controller 

firmware type: 

v   “Controller firmwares 07.10.xx.xx and 06.xx.xx.xx” 

v   “Controller firmware 05.xx.xx.xx” on page 42

Controller firmwares 07.10.xx.xx and 06.xx.xx.xx 

If your subsystem has controller firmware 07.10.xx.xx installed, complete the 

following steps to define the host and host ports by using the Define a host and 

host ports wizard: 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, right-click the new host group and select Define Host. The Introduction 

(Define Host) window opens. 

2.   Click Next. The Specify Host Name/HBA Attribute (Define Host) window opens. 

3.   Type the host name in the Specify Host Name/HBA Attribute (Define Host) 

window. In the left panel, select the correct WWPN of the HBA host port. Click 

Add.

Note:  If you there is not yet a physical connection between the host and the 

DS4000 controllers, as described in the “Storage partitioning overview” 

on page 40, the WWPNs will not display. In this case, you must type the 

correct WWPN into the field. 

4.   You must now provide an alias name for the host port. Click Edit, then type an 

alias name (for example, Port1). 

5.   On configurations with two or more HBAs, repeat step 1 and step 2 for each 

host port that you need to define, then proceed to step 4. 

6.   Click Next. The Specify Host Type window opens. 

7.   Select the correct host type, AIX, from the drop down menu and click Next. The 

Review window opens. 

Failure to change the host type from the default to AIX will cause undesired 

results. 
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8.   Review the information for accuracy, and make any necessary changes. Then 

click Next. 

9.   After Storage Manager finishes defining the host and host ports, a dialog 

window opens. If you need to define another host, select Define another host. 

To finish, click Exit. The wizard closes.

Controller firmware 05.xx.xx.xx 

If your subsystem has controller firmware 05.xx.xx.xx installed, complete the 

following steps to define a host and host ports.

Note:  IBM recommends upgrading your controllers to the latest controller firmware 

that is available for your storage subsystem. 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, highlight the new host group and click Mappings → Define → Host. 

2.   Define the new host. Type the name of the AIX host to which the storage 

subsystem is attached. 

a.   Click Add, and then click Close. 

b.   Highlight the host that you just added, then right-click and select Define 

Host Port. 

c.   Type or select the desired host port for the first HBA, and then change the 

host type to AIX. Click Add.

Note:  Failure to change the host type from the default to AIX will cause 

undesired results. 

d.   If you are configuring additional HBAs to this partition, choose the host port 

for the next HBA and click Add, and then click Close.

Recommendation:  Before closing the window, record the name of each 

host port along with the WWPN of its corresponding 

HBA, and save the information to a file for future 

reference.

Steps for verifying that the host ports match the host 

After you set up an AIX host group, complete the following steps to verify that the 

host ports match the AIX host: 

1.   Type the following command: 

 lsdev -Cc adapter | grep fcs 

  

A list that contains all the HBAs that are in the system is displayed, as shown in 

the following example: 

 # lsdev -Cc adapter |grep fcs 

fcs0    Available 20-58    FC Adapter 

fcs1    Available 30-70    FC Adapter 

fcs2    Available 40-60    FC Adapter 

fcs3    Available 90-58    FC Adapter 

fcs4    Available B0-70    FC Adapter 

fcs5    Available C0-60    FC Adapter 

  

2.   Identify the fcs number of the HBA that is connected to the DS4000. 

3.   Type the following command: 

 lscfg -vl fcs# |grep Network 
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where fcs# is the fcs number of the HBA that is connected to the DS4000. 

The network address number of the HBA is displayed, as in the following 

example: 

 

 # lscfg -vl fcs0|grep Network 

        Network Address.............10000000C925514C 

  

Note:  A network address is also known as a worldwide port name (WWPN). 

4.   Verify that the network address number matches the host port number that 

displays in host partition table of the DS4000 SMclient. 

5.   Repeat this procedure to verify the second host port.

Mapping LUNs to a storage partition 

This section contains the following procedures: 

v   “Mapping LUNs to a new partition” 

v   “Adding LUNs to an existing partition” on page 44

Mapping LUNs to a new partition 

When mapping LUNs for the first time to a newly-created partition, complete the 

procedure in this section that is appropriate to your storage subsystem controller 

firmware type. 

v   “Controller firmwares 07.10.xx.xx and 06.xx.xx.xx” 

v   “Controller firmware 05.xx.xx.xx” on page 44

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition. 

Controller firmwares 07.10.xx.xx and 06.xx.xx.xx:   When mapping LUNs for the 

first time to a newly-created partition, complete the following steps to map LUNs to 

the partition. 

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition.

Important::  If your subsystem is running controller firmware 07.10.xx.xx, you can 

use the Storage Partitioning wizard feature of the Storage Manager 

task assistant, instead of this procedure, to map LUNs to a new 

storage partition. 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Storage Partitioning. The Define Storage Partitioning 

window opens. 

3.   In the Define Storage Partitioning window, select Host, then click Next. 

4.   Select the logical drive by name, on the right side of the window. 

5.   Accept the default LUN ID, or change it, then click Add. 

6.   Repeat step5 for each LUN that you want to map to the partition.
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Controller firmware 05.xx.xx.xx:   Complete the following steps to map LUNs to a 

new partition: 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, right-click the host on which you want to map LUNs, and select Define 

Storage Partitioning. The Define Storage Partitioning window opens. 

2.   In the Define Storage Partitioning window, select Host, then click Next. 

3.   Select the logical drive by name, on the right side of the window. 

4.   Accept the default LUN ID, or change it, then click Add. 

5.   Repeat step 4 for each LUN that you want to map to the partition.

Adding LUNs to an existing partition 

When adding LUNs to an existing partition, complete the following steps to map the 

new LUNs to the partition. 

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition. 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Additional Mappings. The Define Additional Mapping 

window opens. 

3.   In the Define Additional Mapping window, select the following options, and then 

click Add: 

v   Host group or host 

v   Logical unit number (LUN)(0-255) 

v   Logical drive

Repeat these steps for each LUN that you want to add to the partition. 

Creating direct and SAN-attached configurations 

DS4000 Storage Manager supports IBM DS4000 Fibre Channel Storage 

Subsystems in direct-attached AIX configurations or in a SAN environment through 

switches in AIX configurations. 

Creating a direct-attached configuration 

Before you begin: Ensure that: 

v   One or two AIX servers can be connected to the DS4000 storage subsystems. 

v   No external hubs are being used. 

v   Two-server DS4400 or DS4500 configurations require four host-side minihubs, 

each with exactly one fibre channel connection from each HBA to a minihub. 

Note: DS4800, DS4700, DS4300, DS4200 Express, and DS4100 storage 

subsystems do not have minihubs. 

v   Single HBA configurations are allowed. If you have a single HBA in a 

direct-attached configuration, both controllers in the DS4000 must be connected 

to the HBA through a daisy-chain. 

Attention: Having a single HBA configuration can lead to loss of access data in 

the event of a path failure.

Note:  DS4800, DS4700, DS4300, DS4200, and DS4100 storage subsystems do 

not support daisy-chain configurations.
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Complete the following steps to set up a direct-attached configuration: 

1.   Connect the HBAs to each controller or minihub port of the DS4000 storage 

subsystem. 

2.   Configure and verify the configuration, using the procedures that are described 

in “Identifying devices on AIX hosts” on page 47 and “Verifying the installation 

and configuration” on page 50.

Creating a SAN-attached configuration 

Before you begin: Ensure that: 

v   Multiple fibre channel HBAs within the same server must not be able to discover 

the same DS4000 controller port. 

v   The IBM Fibre Channel HBAs are isolated from each other if they are connected 

to the same switch that is connected to the same DS4000 controller port. 

v   Each fibre channel HBA and controller port must be in its own fabric zone, if they 

are connecting through a single fibre channel switch, such as 2109-F16. 

Multiple DS4000 devices can be configured to the same set of fibre channel 

HBAs through a fibre channel switch.

Note:  Single HBA configurations are allowed. If you have a single HBA in a 

SAN-attached configuration, both controllers in the DS4000 must be fibre 

channel connected to the HBA through a switch, and both controllers must 

be within the same SAN zone as the HBA. For more information about 

zoning and enabling zones, see Appendix F, “Connecting HBAs in a FC 

switch environment,” on page 245. 

Attention: Having a single HBA configuration can lead to loss of access 

data in the event of a path failure. 

Complete the following steps to set up a SAN-attached configuration: 

1.   Connect the HBAs to the switch or switches. 

2.   Connect the DS4000 storage subsystems to the switch or switches. 

3.   Set the required zones on the fibre channel switch or switches, if applicable.

Note:  For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245. 

4.   Configure and verify the configuration. 

5.   Use the cfgmgr command to enable the HBAs to log in to the switch.

Installing the RDAC failover driver 

After you install the client software and configure your storage subsystems, use 

these instructions to install the appropriate DS4000 Storage Manager RDAC device 

driver. 

You must install RDAC on all AIX hosts in your storage subsystem. This section 

describes how to check the current RDAC driver program driver version level, 

update the RDAC device driver, and verify that the RDAC update is complete. 

Prerequisites 

This section lists the prerequisites for installing the RDAC driver version levels on 

an AIX system and describes how to verify the current RDAC drive driver version 

level. 
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Installing the RDAC driver 

Complete both procedures in this section to install the RDAC driver: 

1.   “Steps for downloading the AIX file sets” 

2.   “Steps for installing the RDAC driver” on page 47

Steps for downloading the AIX file sets 

The AIX file sets are not included on the DS4000 Storage Manager installation CD. 

You can install them from the AIX Operating System CD, if the correct versions are 

included, or use this procedure to download them from the IBM Fix Central Web 

site. 

Table Table 8 shows file sets that are required for RDAC, for fibre channel host 

attachment, and for the HBAs that are attached to your system. In addition to the 

required file sets, optional file sets are also available at the download site. 

Please consult your IBM technical support representative if you have any questions 

about required file sets. 

 Table 8. AIX file sets required for RDAC,  fibre channel attachment, and HBAs 

RDAC  devices.fcp.disk.array.rte 

Fibre channel attachment devices.pci.df1000f7.com 

HBAs  FC 6227 devices.pci.df1000f7.rte 

FC 6228 devices.pci.df1000f9.rte 

FC 6239 devices.pci.df1080f9.rte 

FC 5716 devices.pci.df1000fa.rte 

FC 5758 or 

FC 5759 

devices.pci.df1000fd.rte 

AIX  5.2 devices.pci.df1000fd.rte 5.2.0.95 

devices.pci.df1000fa.rte 5.2.0.95 

devices.pci.df1000f9.rte 5.2.0.75 

devices.pci.df1000f7.rte 5.2.0.75 

devices.pci.df1080f9.rte 5.2.0.75 

AIX  5.3 devices.pci.df1000f7.rte 5.3.0.30 

devices.pci.df1000fa.rte 5.3.0.50 

devices.pci.df1000fd.rte 5.3.0.50 

devices.pci.df1000f9.rte 5.3.0.30 

devices.pci.df1080f9.rte 5.3.0.30
  

Before you begin:  Check the Storage Manager readme file for AIX for the 

minimum file set versions required for your AIX operating 

system. See “Readme files and concepts” on page 1 to learn 

how to find the readme files on the Web. 

Complete the following steps to download the latest AIX file set. 

1.   Open the IBM Fix Central Web site by clicking the following link, or by copying 

and pasting the link into a browser window: 
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www-912.ibm.com/eserver/support/fixes/fcgui.jsp 

2.   In the Product family drop down menu, select UNIX servers. 

3.   In the Product drop down menu, select AIX operating system. 

4.   Select your AIX version. 

5.   In the Fix type drop down menu, select Specific fixes. Click Continue. 

6.   In the Search string field, type or paste the name of the file set (for example, 

devices.fcp.disk.array.rte). 

7.   Select the latest version in the search results display, and follow the instructions 

on the Web site to download the file set. 

8.   Repeat these steps for each file set that you need to download.

Important:  

1.   With AIX 5.3, download the complete maintenance package and update all 

PTFs together. Do not install each PTF separately. 

2.   If you have 2102-F10 storage array devices connected to your system, do not 

install devices.fcp.disk.array.rte versions 5.1.0.58 or 5.2.0.17 or later. These 

versions do not support 2102-F10 devices. Contact your IBM technical support 

representative for assistance. 

Steps for installing the RDAC driver 

Complete the following steps to update the RDAC driver version 

(devices.fcp.disk.array.rte) on an AIX system. Repeat these steps for all AIX 

systems that are connected to the storage subsystem. 

Before you begin: Verify whether your AIX systems have the most recent RDAC 

file sets by checking the Storage Manager readme file for AIX, or by completing 

step 1 through step 6 of “Steps for downloading the AIX file sets” on page 46. You 

need to perform this installation only on AIX systems that do not have the most 

recent RDAC file sets. 

1.   Download the most recent file sets by completing the procedure described in 

“Steps for downloading the AIX file sets” on page 46. 

2.   Verify that the correct version of the software was successfully installed by 

typing the following command: 

 # lslpp -ah <file set name> 

  

Example: # lslpp -ah devices.fcp.disk.array.rte 

The verification process returns a table that describes the software installation, 

including the installation package file set name, version number, action, and 

action status. If the verification process returns an error, contact your IBM 

technical support representative. If it does not return an error, then you are 

finished installing the updated RDAC driver on this AIX system. 

3.   For each AIX host that is to be attached to a DS4000 storage subsystem, 

repeat the above steps in order to install and verify the RDAC driver. 

After you have finished installing RDAC, you can perform the initial device 

discovery, which is described in the next section. 

Identifying devices on AIX hosts 

The RDAC driver creates the following devices that represent the DS4000 storage 

subsystem configuration, as shown in Figure 5 on page 48: 
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dar The disk array router (dar) device represents the entire array, including the 

current and the deferred paths to all LUNs (hdisks). 

dac The disk array controller (dac) devices represent a controller within the 

storage subsystem. There are two dacs in the storage subsystem. 

hdisk Each hdisk device represents an individual LUN on the array. 

utm The universal transport mechanism (utm) device is used only with in-band 

management configurations, as a communication channel between the 

SMagent and the DS4000. 

Note:  You might see the utm device listed in command output, whether or 

not you have an in-band management configuration. For example, a 

utm might be listed when you run the lsattr command on a dac.

   

Performing initial device discovery 

Complete these steps to perform the initial device discovery. 

Before you begin: Ensure that the DS4000 storage subsystem has been set up, 

LUNs have been assigned to the host, and the RDAC driver has been installed. 

1.   Type the following command to probe for the new devices: 

 # cfgmgr -v 

  

Note:  In a SAN configuration, the devices do not log into the SAN switch until 

you run cfgmgr. 

2.   Type the following command: 

 # lsdev -Cc disk 
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Figure 5. DS4000/AIX system configuration
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3.   Examine the output of the lsdev -Cc disk command to ensure that the RDAC 

software recognizes the DS4000 logical drives, as shown in the following list: 

v   Each DS4200 logical drive is recognized as an “1814 DS4200 Disk Array 

Device.” 

v   Each DS4300 logical drive is recognized as an “1722-600 (600) Disk Array 

Device.” 

v   Each DS4400 logical drive is recognized as an “1742-700 (700) Disk Array 

Device.” 

v   Each DS4500 logical drive is recognized as an “1742-900 (900) Disk Array 

Device.” 

v   Each DS4700 logical drive is recognized as an “1814 DS4700 Disk Array 

Device.” 

v   Each DS4800 logical drive is recognized as an “1815 DS4800 Disk Array 

Device.” 

The following example shows the output of the lsdev -Cc disk command for a 

set of DS4500 LUNs: 

 # lsdev -Cc disk 

hdisk0 Available 10-88-00-8,0 16 Bit LVD SCSI Disk Drive 

hdisk58  Available 06-08-02     1742-900 (900) Disk Array Device 

hdisk59  Available 0A-08-02     1742-900 (900) Disk Array Device 

hdisk60  Available 06-08-02     1742-900 (900) Disk Array Device 

hdisk62  Available 06-08-02     1742-900 (900) Disk Array Device 

  

The following example shows the output of the lsdev -Cc disk command for a 

set of DS4000 LUNs on an AIX 5.3 system: 

 # lsdev -Cc disk 

hdisk24  Available 06-08-02     1722-600    (600)    Disk Array Device (DS4300) 

hdisk25  Available 0A-08-02     1722-600    (600)    Disk Array Device (DS4300) 

hdisk26  Available 0A-08-02     1814       DS4700    Disk Array Device (DS4700) 

hdisk27  Available 0A-08-02     1814       DS4700    Disk Array Device (DS4700) 

hdisk77  Available 0A-08-02     1742-900    (900)    Disk Array Device (DS4500) 

hdisk78  Available 06-08-02     1742-900    (900)    Disk Array Device (DS4500) 

hdisk79  Available 06-08-02     1815       DS4800    Disk Array Device (DS4800) 

hdisk80  Available 0A-08-02     1815       DS4800    Disk Array Device (DS4800) 

hdisk142 Available 1V-08-02     1814       DS4200    Disk Array Device 

hdisk143 Available 1V-08-02     1814       DS4200    Disk Array Device 

  

Important: You might discover that the configuration process has created two 

dacs and two dars on one DS4000 subsystem. This situation can occur when 

your host is using a partition that does not have any associated LUNs. When 

that happens, the system cannot associate the two dacs under the correct dar. 

If there are no LUNs, the system generates two dacs as expected, but it also 

generates two dars. 

The following list shows the most common causes: 

v   You create a partition and attach the LUNs to it, but you do not add the host 

ports to the partition. Therefore, the host ports remain in the default partition. 

v   You replace one or more HBAs, but do not update the worldwide name 

(WWN) of the partition for the HBA. 

v   You switch the DS4000 from one set of HBAs to another as part of a 

reconfiguration, and do not update the WWNs.
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In each of these cases, resolve the problem, and run cfgmgr again. The system 

removes the extra dar, or moves it from the Available state to the Defined state. (If 

the system moves the dar into the Defined state, you can then delete it.) 

Note:  When you perform the initial device identification, the Object Data Manager 

(ODM) attributes of each device are updated with default values. In most 

cases and for most configurations, the default values are satisfactory. 

However, there are some values that can be modified for maximum 

performance and availability. See “Viewing and setting Object Data Manager 

(ODM) attributes” on page 60. 

See “Using the lsattr command to view ODM attributes” on page 67 for 

information about using the lsattr command to view attribute settings on an 

AIX system. 

Verifying the installation and configuration 

After you have performed the initial device identification, complete the following 

procedures to verify that all of your DS4000 device names and paths are correct 

and that AIX recognizes your dars, dacs, and hdisks. 

v   “Identifying the controller ID numbers” 

v   “Identifying device names and bus numbers” on page 51 

v   “Identifying logical drives by operating system device names” on page 57 

v   “Identifying FlashCopy logical drive types” on page 59

Tip:  Verify your installation and configuration before you mount your file systems 

and install your applications. 

Identifying the controller ID numbers 

Choose one of the following options to identify the controller ID number of a dac: 

v   “Using the lsattr -El command” 

v   “Using the SMclient Controller Properties window” on page 51

Using the lsattr -El command 

1.   Type the lsattr -El command, as follows: 

 # lsattr -El dacname 

  

where dacname is the name of the dac whose controller ID number you want to 

identify. 

2.   Find the value of the controller_SN attribute, as shown in the following 

example. This value is the controller ID number of dac1. 
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# lsattr -El dac1 

GLM_type        low                GLM type                 False 

alt_held_reset  no                 Alternate held in reset  False 

cache_size      1024               Cache Size in MBytes     False 

controller_SN   1T14148774         Controller serial number False 

ctrl_type       1742-0900          Controller Type          False 

location                           Location Label           True 

lun_id          0x0                Logical Unit Number      False 

node_name       0x200400a0b80f434d FC Node Name             False 

passive_control no                 Passive controller       False 

scsi_id         0x11a00            SCSI ID                  False 

utm_lun_id      none               Logical Unit Number      False 

ww_name         0x200500a0b80f434e World Wide Name          False 

  

Using the SMclient Controller Properties window 

1.   In the Logical/Physical view of the Subsystem Management window, right-click a 

controller and select Properties. The Controller Properties window opens. 

2.   In the Controller Properties window, find the value of the Serial number 

attribute. In the example shown in Figure 6, the controller in slot A has the 

controller ID number (serial number) 1T14148774, and is represented by dac1.
   

Identifying device names and bus numbers 

As mentioned previously in this chapter, the RDAC software uses dars to represent 

the disk array routers, dacs to represent the disk array controllers, and hdisks to 

represent the logical drives. 

After these operating system device names are found, you can use one or more of 

the following methods in AIX to get information about device names, bus numbers, 

and other attributes. You can then use this information to correlate the device 

names with their logical drives and preferred and alternate paths: 

d
s
s
0
0
0
0
2

  

Figure 6. Controller Properties window
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“Using the lsdev command” 

The lsdev command displays devices and their characteristics. lsdev also 

shows the state of the devices at startup time, or the last time that the 

cfgmgr -v command was run. 

“Using the fget_config command” on page 53 

The fget_config command displays controllers and hdisks that are 

associated with a specified DS4000 (dar). fget_config also shows the 

current state and logical drive (hdisk) ownership. 

“Using the lsattr command” on page 56 

The lsattr command displays device attributes and possible values. 

Attributes are only updated at startup time, or the last time that the cfgmgr 

-v command was run.

Using the lsdev command 

The examples in this section show you how to use the lsdev command to show the 

status of dars, dacs and hdisks. 

lsdev command, example 1:   Figure 7 shows the use of the lsdev command 

combined with the grep command to view the status of the dar, which represents a 

DS4000 storage subsystem. 

In the example, dar0 is a machine type 1742, which is a DS4400. It is in the 

Available state, which is the state at the time when the device was last configured 

by AIX.
 

lsdev example 2:   Figure 8 shows the use of the lsdev command combined with 

the grep command to view the status of two dacs, which represent the DS4000 

storage subsystem controllers. 

In the example, as in the previous example, a DS4400 is shown in an Available 

state. Each dac has its own location code, or path, which are represented by the 

values 11-08-01 and 14-08-01. Each AIX system has its own set of location codes 

that describe the internal path of that device, including bus and host-adapter 

locations. 

See the service manual for your system type to identify device locations.
 

lsdev example 3:   Figure 9 on page 53 shows the use of the lsdev command 

combined with the grep command to view the status and location codes of eight 

DS4400 hdisks. 

 # lsdev -C |grep dar0 

dar0       Available               1742     (700) Disk Array Router 

  

Figure 7. lsdev command, example 1

 # lsdev -C |grep dac 

dac0       Available 11-08-01      1742     (700) Disk Array Controller 

dac1       Available 14-08-01      1742     (700) Disk Array Controller 

  

Figure 8. lsdev command, example 2
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In the example, note that the location codes of the odd-numbered hdisks 

correspond to the location code of dac0 that is listed in the previous example, and 

that the location codes of the even-numbered hdisks correspond to the location 

code of dac1. This means that the preferred I/O path for hdisks 1, 3, 5, and 7 is 

through dac0, and the failover path is through dac1. Conversely, the preferred path 

for hdisks 2, 4, 6, and 8 is through dac1, and failover path is through dac0.
 

lsdev example 4:   Figure 10 shows the use of the lsdev command combined with 

the grep command to search for the first two numbers of the location code. The 

resulting display shows all the devices that are on the preferred fabric path from the 

HBA to the hdisk. 

 

 # lsdev -C|grep 11-08 

fcs0       Available 11-08         FC Adapter 

fscsi0     Available 11-08-01      FC SCSI I/O Controller Protocol Device 

dac0       Available 11-08-01      1742     (700) Disk Array Controller 

hdisk1     Available 11-08-01      1742     (700) Disk Array Device 

hdisk3     Available 11-08-01      1742     (700) Disk Array Device 

hdisk5     Available 11-08-01      1742     (700) Disk Array Device 

hdisk7     Available 11-08-01      1742     (700) Disk Array Device 

hdisk8     Available 11-08-01      1742     (700) Disk Array Device 

  

Using the fget_config command 

You can use the fget_config command to display current configuration information 

for a DS4000 subsystem. 

Use the following command syntax for the fget_config command: 

 fget_config -A | -l | -v dar_name 

  

- A Displays output for all the configured dars in the subsystem. If you use this 

parameter, do not specify a dar name. 

- l Displays output only for the dar that you specify. 

- v Displays more information about the dar or dars, such as the user array 

names that were created when you configured the DS4000 subsystem.

fget_config example 1:   Figure 11 on page 54 shows a sample output from the 

fget_config -l dar3 command. A dac can be Active, Passive, or Offline. Only 

dacs that are in Active state are used for I/O. In the output, you can see that dar3 

 # lsdev -Cc |grep hdisk 

hdisk0     Available 40-60-00-4,0 16 Bit LVD SCSI Disk Drive 

hdisk1     Available 11-08-01      1742     (700) Disk Array Device 

hdisk2     Available 14-08-01      1742     (700) Disk Array Device 

hdisk3     Available 11-08-01      1742     (700) Disk Array Device 

hdisk4     Available 14-08-01      1742     (700) Disk Array Device 

hdisk5     Available 11-08-01      1742     (700) Disk Array Device 

hdisk6     Available 14-08-01      1742     (700) Disk Array Device 

hdisk7     Available 11-08-01      1742     (700) Disk Array Device 

hdisk8     Available 14-08-01      1742     (700) Disk Array Device 

  

Figure 9. lsdev command, example 3

Figure 10. lsdev command, example 4
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consists of dac6 and dac9. 

 

fget_config example 2:   Figure 12 shows a sample output from the fget_config 

-vl dar3 command. Note that using the -v parameter causes the user array name 

and the LUN names to be displayed:
 

fget_config example 3:   Figure 13 on page 55 shows a sample output from the 

fget_config -A command. Note that using the -A parameter causes all the dars to 

be displayed:
 

 # fget_config -l dar3 

  

dac6 ACTIVE dac9 ACTIVE 

hdisk26  dac9 

hdisk27  dac6 

hdisk28  dac9 

hdisk29  dac6 

hdisk30  dac9 

hdisk31  dac6 

hdisk32  dac9 

hdisk33  dac9 

hdisk83  dac6 

  

Figure 11. fget_config command, example 1

 #  fget_config -vl dar3 

  

User array name = ’D59 DS4500 #1’ 

dac6 ACTIVE dac9 ACTIVE 

  

Disk     DAC   LUN Logical Drive 

utm             10 

hdisk26  dac9    1 multipart11 

hdisk27  dac6    2 multipart12 

hdisk28  dac9    3 multipart13 

hdisk29  dac6    4 multipart14 

hdisk30  dac9    5 multipart15 

hdisk31  dac6    6 multipart16 

hdisk32  dac9    7 multipart17 

hdisk33  dac9    9 multipart19 

hdisk83  dac6    8 multipart18 

  

Figure 12. fget_config command, example 2
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fget_config example 4:   Figure 14 on page 56 shows a sample output from the 

fget_config -Av command. Note that using the -v parameter causes the user array 

names and the LUN names to display:
 

 #   fget_config -A 

  

---dar0--- 

  

dac3 ACTIVE dac0 ACTIVE 

hdisk4   dac3 

hdisk5   dac0 

hdisk6   dac3 

hdisk7   dac0 

hdisk8   dac3 

hdisk10  dac0 

hdisk11  dac3 

hdisk12  dac0 

hdisk13  dac3 

hdisk14  dac0 

  

---dar1--- 

  

dac1 ACTIVE dac4 ACTIVE 

hdisk15  dac1 

hdisk16  dac1 

hdisk17  dac4 

hdisk18  dac1 

hdisk19  dac4 

hdisk20  dac1 

hdisk21  dac4 

hdisk22  dac1 

hdisk23  dac4 

hdisk24  dac1 

  

  

  

---dar2--- 

  

dac2 ACTIVE dac5 ACTIVE 

hdisk25  dac5 

  

---dar3--- 

  

dac6 ACTIVE dac9 ACTIVE 

hdisk26  dac9 

hdisk27  dac6 

hdisk28  dac9 

hdisk29  dac6 

hdisk30  dac9 

hdisk31  dac6 

hdisk32  dac9 

hdisk33  dac9 

hdisk83  dac6 

  

Figure 13. fget_config command, example 3
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Using the lsattr command 

You can also use the lsattr command to find out which controller owns a particular 

hdisk. 

Figure 15 on page 57 shows portions of the outputs from several lsattr commands. 

In the example, hdisk1 belongs to the controller represented by dac0. The hdisk has 

the same SCSI ID as the controller (dac) that owns it.
 

 #    fget_config -Av 

  

---dar0--- 

  

User array name = ’D59S Flute-2 

(DS4500) #1’ 

dac3 ACTIVE dac0 PASSIVE 

  

Disk     DAC   LUN Logical Drive 

hdisk4   dac3    0 dualpart0 

hdisk5   dac3    1 dualpart1 

hdisk6   dac3    2 dualpart2 

hdisk7   dac3    4 dualpart4 

hdisk8   dac3    5 dualpart5 

hdisk10  dac3    8 dualpart8 

hdisk11  dac3    9 dualpart9 

hdisk12  dac3   10 dualpart10 

hdisk13  dac3   11 dualpart11 

hdisk14  dac3   12 dualpart12 

  

---dar1--- 

  

User array name = ’D59 DS4500 #1’ 

dac1 ACTIVE dac4 ACTIVE 

  

Disk     DAC   LUN Logical Drive 

utm             10 

hdisk15  dac1    0 multipart20 

hdisk16  dac1    1 multipart1 

hdisk17  dac4    2 multipart2 

hdisk18  dac1    3 multipart3 

hdisk19  dac4    4 multipart4 

hdisk20  dac1    5 multipart5 

hdisk21  dac4    6 multipart6 

hdisk22  dac1    7 multipart7 

hdisk23  dac4    8 multipart8 

hdisk24  dac1    9 multipart9 

  

  

  

---dar2--- 

  

User array name = ’D59S DS4500 #2’ 

dac2 ACTIVE dac5 ACTIVE 

  

Disk     DAC   LUN Logical Drive 

utm             31 

hdisk25  dac5    0 1 

  

---dar3--- 

  

User array name = ’D59 DS4500 #1’ 

dac6 ACTIVE dac9 ACTIVE 

  

Disk     DAC   LUN Logical Drive 

utm             10 

hdisk26  dac9    1 multipart11 

hdisk27  dac6    2 multipart12 

hdisk28  dac9    3 multipart13 

hdisk29  dac6    4 multipart14 

hdisk30  dac9    5 multipart15 

hdisk31  dac6    6 multipart16 

hdisk32  dac9    7 multipart17 

hdisk33  dac9    9 multipart19 

hdisk83  dac6    8 multipart18 

  

Figure 14. fget_config command, example 4
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Identifying logical drives by operating system device names 

The lsattr command provides detailed information about a logical drive, including 

information that allows you to map the system device name to the logical drive on 

the DS4000 storage subsystem. 

The following example shows the output of an lsattr command for a LUN named 

hdisk4:

 # lsattr -El dac0 

GLM_type        low                GLM type                 False 

alt_held_reset  no                 Alternate held in reset  False 

cache_size      1024               Cache Size in MBytes     False 

controller_SN   1T23559428         Controller serial number False 

ctrl_type       1742-0900          Controller Type          False 

location                           Location Label           True 

lun_id          0x0                Logical Unit Number      False 

node_name       0x200400a0b80f434d FC Node Name             False 

passive_control no                 Passive controller       False 

scsi_id         0x11100            SCSI ID                  False 

utm_lun_id      none               Logical Unit Number      False 

ww_name         0x200400a0b80f434e World Wide Name          False 

  

  

# lsattr -El dac1 

GLM_type        low                GLM type                 False 

alt_held_reset  no                 Alternate held in reset  False 

cache_size      1024               Cache Size in MBytes     False 

controller_SN   1T23559493         Controller serial number False 

ctrl_type       1742-0900          Controller Type          False 

location                           Location Label           True 

lun_id          0x0                Logical Unit Number      False 

node_name       0x200400a0b80f434d FC Node Name             False 

passive_control no                 Passive controller       False 

scsi_id         0x11a00            SCSI ID                  False 

utm_lun_id      none               Logical Unit Number      False 

ww_name         0x200500a0b80f434e World Wide Name          False 

  

  

# lsattr -El hdisk1 

----------- Parts removed: 

scsi_id       0x11100              SCSI ID                  False 

size          4096                 Size in Mbytes           False 

write_cache   yes                  Write Caching enabled    False 

  

  

Figure 15. lsattr command example
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# lsattr -El hdisk4 

pvid          none                             Physical volume identifier             False 

q_type        simple                           Queuing Type                           False 

queue_depth   30                               Queue Depth                            True 

reserve_lock  yes                              RESERVE device on open                 True 

write_cache   yes                              Write Caching enabled                  True 

size          6062                             Size in Mbytes                         False 

raid_level    0                                RAID Level                             False 

rw_timeout    30                               Read/Write Timeout value               True 

reassign_to   120                              Reassign Timeout value                 True 

scsi_id       0x11000                          SCSI ID                                False 

lun_id        0x0002000000000000               Logical Unit Number                    False 

cache_method  fast_write                       Write Caching method                   True 

prefetch_mult 0                                Multiple of blocks to prefetch on read True 

ieee_volname  600A0B80000F14AF000003D140C046A2 IEEE Unique volume name                False 

  

  

In the example, you can see that hdisk4 is a 6 GB LUN of type RAID 0, with a LUN 

ID of 2, and an IEEE volume name of 600A0B80000F14AF000003D140C046A2. 

You can make a more exact correlation using the distinctive ieee_volname attribute. 

The value of this attribute on the AIX host is the same as the value of the Logical 

Drive ID on the DS4000 subsystem. You can see the Logical Drive ID in the 

Change Mapping window of DS4000 Storage Manager, which is shown in Figure 16 

on page 59. 

To view the Change Mapping window, click the Mappings view tab in the 

Subsystem Management window. Right-click the name of the logical drive whose 

attributes you want to see, and select Change Mapping. 
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You can also identify the system disk name by viewing the Subsystem ID (SSID) 

attribute in the Logical Drive Properties window of DS4000 Storage Manager. The 

value of the Subsystem ID (SSID) attribute on the DS4000 subsystem is the same 

as the value of the lun_id attribute on the AIX host. 

To open the Logical Drive Properties window, right-click the name of the logical 

drive in the Logical/Physical view of the Subsystem Management window and select 

Properties. 

Identifying FlashCopy logical drive types 

Complete the following steps to identify FlashCopy logical drive types: 

1.   Run the following command to list available logical drives: 

 # lsdev -Cc disk 

  

A list of available logical drives displays, as shown in the following example: 

 [root@hostname] / # lsdev -Cc disk |pg 

hdisk0  Available 40-60-00-4,0 16 Bit LVD SCSI Disk Drive 

hdisk1  Available 40-60-00-8,0 16 Bit LVD SCSI Disk Drive 

hdisk2  Available 11-08-01     1742-900     (900) Disk Array Device 

hdisk3  Available 11-08-01     1742-900     (900) Disk Array Device 

hdisk4  Available 11-08-01     1742-900     (900) Disk Array Snapshot 

  

The FlashCopy array is identified by the term Disk Array Snapshot. 

2.   Run the following command to display the state of each controller in a DS4000 

array: 

d
s
s
0
0
0
0
1

  

Figure 16. Change Mappings window
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# fget_config -Av 

  

A list displays, as shown in the following example: 

 [root@hostname] / # fget_config -Av 

  

---dar0--- 

  

User array name = ’DS4000 System 1’ 

dac0 ACTIVE dac1 ACTIVE 

dac0-hdisk2      Raid-0-0B 

dac1-hdisk3      Raid-0-1B 

dac1-hdisk4      Raid-3-0A-1    Snapshot Volume 

  

The FlashCopy logical drive is identified by the term Snapshot Volume.

For more information about the lsdev and fget_config commands, see “Identifying 

device names and bus numbers” on page 51. 

Viewing  and setting Object Data Manager (ODM) attributes 

Some of the ODM attributes are for information purposes only. These 

information-only attributes show how the DS4000 storage subsystem is configured, 

or its current state. You can modify other attributes using SMIT or by using the AIX 

chdev -p command. 

Attribute definitions 

The following tables list definitions and values of the ODM attributes for dars, dacs 

and hdisks: 

v   Table 9: Attributes for dar devices 

v   Table 10 on page 62: Attributes for dac devices 

v   Table 11 on page 63: Attributes for hdisk devices

Notes:  

1.   Attributes with True in the Changeable column can be modified from their default 

settings. 

2.   Attributes with False in the Changeable column are for informational or state 

purposes only. However, some attributes with False in the Changeable column 

can be modified using DS4000 Storage Manager. 

3.   The lsattr -El (uppercase E, lowercase L) command is another way to 

determine which attributes can be modified. Attributes that can be modified 

display True in the last column of the lsattr -El output. You can also display the 

default values by using the lsattr -Dl command. See “Using the lsattr command 

to view ODM attributes” on page 67 for more information.

 Table 9. Attributes for dar devices 

Attribute Definition Changeable (T/F) Possible value 

act_controller List of controllers in 

the active state at the 

time of configuration. 

False Set at configuration 

time by the RDAC 

software. 

all_controller List of controllers that 

comprise this array; 

usually there are two 

dac devices. 

False Set at configuration 

time by the RDAC 

software. 
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Table 9. Attributes for dar devices (continued) 

Attribute Definition Changeable (T/F) Possible value 

held_in_reset Name of the controller 

that was in the 

held-in-reset state at 

the time of 

configuration, or none 

if no controllers were 

in that state. 

True Set at configuration 

time by the RDAC 

software. Should not 

be changed. 

load_balancing Indicator that shows 

whether load 

balancing is enabled 

(yes) or disabled 

(no); see the 

definition of the 

balance_freq attribute 

for more information. 

True Yes or No. 

Attention: You 

should only set the 

load_balancing 

attribute to yes in 

single-host 

configurations. 

autorecovery Indicator that shows 

whether the device 

returns the array to 

dual-active mode 

when it detects proper 

operation of both 

paths and controllers 

(yes) or not (no). 

True Yes or No. See 

restrictions on use. 

hlthchk_freq Number that specifies 

how often health 

checks are 

performed, in 

seconds. 

True 1 - 9999. Should not 

be changed 

aen_freq Number that specifies 

how often polled AEN 

checks are 

performed, in 

seconds. 

True 1 - 9999. Should not 

be changed 

balance_freq If load_balancing is 

enabled, number that 

specifies how often 

the system performs 

load-balancing on the 

array, in seconds. 

True 1 - 9999 - should not 

be changed 

fast_write_ok Indicator that shows 

whether fast-write 

write-caching is 

available for this 

system (yes) or not 

(no). 

False Yes or No. State of 

DS4000 configuration. 

cache_size Cache size for both 

controllers, in 

megabytes; 0 if the 

sizes do not match. 

False 512 or 1024. Set by 

DS4000. 
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Table 9. Attributes for dar devices (continued) 

Attribute Definition Changeable (T/F) Possible value 

switch_retries Number that specifies 

how many times to 

retry failed switches, 

in integers. 

True 0 - 255. 

Default: 5 

For most 

configurations, the 

default is the best 

setting. If you are 

using HACMP™, it can 

be helpful to set the 

value to 0. 

Attention: You 

cannot use 

concurrent firmware 

download if you 

change the default 

setting.
  

 Table 10. Attributes for dac devices 

Attribute Definition Changeable (T/F) Possible value 

passive_control Indicator that shows 

whether this controller 

was in passive state 

at the time of 

configuration (yes) or 

not (no). 

False Yes or No. State of 

DS4000 configuration. 

alt_held_reset Indicator that shows 

whether the alternate 

controller was in the 

held-in-reset state at 

the time of 

configuration (yes) or 

not (no). 

False Yes or No. State of 

DS4000 configuration. 

controller_SN Serial number of this 

controller. 

False Set by DS4000. 

ctrl_type Type of array this 

controller belongs to. 

A value of value of 

1722 indicates 

DS4300; a value of 

1742 indicates 

DS4400; a value of 

1742-900 indicates 

DS4500. 

False 1742, 1722, 

1742-900. Set by 

DS4000. 

cache_size Cache size of this 

controller, in 

megabytes. 

False 512, 1024. Set by 

DS4000. 

scsi_id SCSI identifier of this 

controller. 

False Set by SAN, reported 

by AIX. 

lun_id Logical unit number of 

this controller. 

False Set by DS4000. 
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Table 10. Attributes for dac devices (continued) 

Attribute Definition Changeable (T/F) Possible value 

utm_lun_id Logical unit number of 

this controller, or 

none if UTM (access 

logical drives) is not 

enabled. 

False 0 - 31. Set by 

DS4000 Storage 

Manager. 

node_name Name of the fibre 

channel node. 

False Set by DS4000 

location User-defined location 

label for this 

controller; the system 

does not use this 

value. 

True Set by DS4000 

Storage Manager. 

ww_name  Fibre channel 

worldwide name of 

this controller. 

False Set by DS4000. 

GLM_type GLM type used for 

this controller. 

False High or Low. Set by 

DS4000.
  

 Table 11. Attributes for hdisk devices 

Attribute Definition Changeable (T/F) Possible value 

pvid AIX physical volume 

identifier, or none if 

not set. 

False Set by AIX. 

q_type Queueing type for this 

device; must be set to 

simple. 

False Set by AIX. Must be 

“simple”. 

queue_depth Number that specifies 

the depth of the 

queue based on 

system configuration; 

reduce this number if 

the array is returning 

a BUSY status on a 

consistent basis. 

True 1 - 64 

Note: See “Setting 

the queue depth for 

hdisk devices” on 

page 65 for important 

information about 

setting this attribute. 

PR_key_value Required only if the 

device supports any 

of the persistent 

reserve policies. This 

attribute is used to 

distinguish between 

different hosts. 

True 1-64, or None. 

Note: You must set 

this attribute to 

non-zero before the 

reserve_policy 

attribute is set. 

reserve_policy Persistent reserve 

policy, which defines 

whether a reservation 

methodology is 

employed when the 

device is opened. 

True no_reserve 

PR_shared, 

PR_exclusive, or 

single_path 
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Table 11. Attributes for hdisk devices (continued) 

Attribute Definition Changeable (T/F) Possible value 

max_transfer Maximum transfer 

size is the largest 

transfer size that can 

be used in sending 

I/O. 

True Numeric value; 

Default = 1 MB 

Note: Usually 

unnecessary to 

change default, 

unless very large I/Os 

require increasing the 

value. 

write_cache Indicator that shows 

whether write-caching 

is enabled on this 

device (yes) or not 

(no); see the 

definition of the 

cache_method 

attribute for more 

information. 

False Yes or No. 

size Size of this logical 

drive. 

False Set by DS4000. 

raid_level Number that specifies 

the RAID level of this 

device. 

False 0, 1, 3, 5. Set by 

DS4000 Storage 

Manager. 

rw_timeout Number that specifies 

the read/write timeout 

value for each 

read/write command 

to this array, in 

seconds; usually set 

to 30. 

True 30 - 180. Should not 

be changed from 

default. 

reassign_to Number that specifies 

the timeout value for 

FC reassign 

operations, in 

seconds; usually set 

to 120. 

True 0 - 1000. Should not 

be changed from 

default. 

scsi_id SCSI identifier at the 

time of configuration. 

False Set by SAN, reported 

by AIX. 

lun_id Logical unit number of 

this device. 

False 0 - 255. Set by 

DS4000 Storage 

Manager. 
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Table 11. Attributes for hdisk devices (continued) 

Attribute Definition Changeable (T/F) Possible value 

cache_method If write_cache is 

enabled, the 

write-caching method 

of this array; set to 

one of the following: 

v   default. Default 

mode; the word 

″default″ is not 

seen if write_cache 

is set to yes. 

v   fast_write. 

Fast-write 

(battery-backed, 

mirrored 

write-cache) mode. 

v   fw_unavail. 

Fast-write mode 

was specified but 

could not be 

enabled; 

write-caching is not 

in use. 

v   fast_load. 

Fast-load 

(non-battery-
backed, 

non-mirrored 

write-cache) mode. 

v   fl_unavail. 

Fast-load mode 

was specified but 

could not be 

enabled. 

False Default, fast_write, 

fast_load, fw_unavail, 

fl_unavail. 

prefetch_mult Number of blocks to 

be prefetched into 

read cache for each 

block read. 

False 0 - 100. 

ieee_volname IEEE unique logical 

drive name identifier 

for this logical drive. 

False Set by DS4000.

  

Setting the queue depth for hdisk devices 

Setting the queue_depth attribute to the appropriate value is important for system 

performance. If you have a large DS4000 configuration with many logical drives and 

hosts attached, use this setting for high performance. 

This section provides methods for calculating your system’s maximum queue depth, 

which you can use as a guideline to help you determine the best queue depth 

setting for your configuration. 

Calculating maximum queue depth:   The formula for calculating the maximum 

queue depth for your system depends on which firmware version is installed on the 

controller. Use one of the following formulas to calculate the maximum queue depth 

for your system. 
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Important:  

1.   The maximum queue depth might not be an optimal setting in all cases. Use the 

maximum queue depth as a guideline, and adjust the setting as necessary for 

your specific configuration. 

2.   In systems with one or more SATA devices attached, you might need to set the 

queue depth attribute to a lower value than the maximum queue depth.

v  Formula for controller firmware versions 06.1x.xx.xx or 05.4x.xx.xx 

 On DS4000 storage systems that are running DS4000 controller firmware 

versions 05.4x.xx.xx, 06.1x.xx.xx, or later, use the following formula to 

determine the maximum queue depth: 

2048 / (number-of-hosts * LUNs-per-host ) 

For example, a system with four hosts, each with 32 LUNs, would have a 

maximum queue depth of 16: 

2048 / ( 4 * 32 ) = 16 

v Formulas for controller firmware version 07.10.xx.xx 

 On DS4800 and DS4700/DS4200 storage systems that are running DS4000 

controller firmware version 07.10.xx.xx, use the following formulas to 

determine the maximum queue depth: 

DS4800: 4096 / (number-of-hosts * LUNs-per-host ) 

For example, a DS4800 system with four hosts, each with 32 LUNs, would 

have a maximum queue depth of 32: 

4096 / ( 4 * 32 ) = 32 

DS4700/DS4200: 2048 / (number-of-hosts * LUNs-per-host ) 

For example, a DS4700 system or a DS4200 system with four hosts, either 

with 32 LUNs, would have a maximum queue depth of 16: 

2048 / ( 4 * 32 ) = 16

v  Formula for controller firmware versions 06.1x.xx.xx or 05.4x.xx.xx 

 On DS4000 storage systems that are running DS4000 controller firmware 

versions 05.4x.xx.xx, 06.1x.xx.xx, or later, use the following formula to 

determine the maximum queue depth: 

2048 / (number-of-hosts * LUNs-per-host ) 

For example, a system with four hosts, each with 32 LUNs, would have a 

maximum queue depth of 16: 

2048 / ( 4 * 32 ) = 16 

v Formula for controller firmware version 05.30.xx.xx 

 On DS4000 storage systems that are running DS4000 controller firmware 

version 05.30.xx.xx or earlier, use the following formula to determine the 

maximum queue depth: 

512 / (number-of-hosts * LUNs-per-host ) 

For example, a system with four hosts, each with 32 LUNs, would have a 

maximum queue depth of 4: 

512 / ( 4 * 32 ) = 4
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Setting queue depth attribute:   You can set the queue_depth attribute using the 

chdev -l command, as shown in the following example: 

 # chdev -l hdiskX -a queue_depth=y -P 

  

where X is the name of the hdisk and y is the queue depth setting.

Note:  Use the -P flag to make the changes permanent in the Customized Devices 

object class. 

Using the lsattr command to view ODM attributes 

To view the Object Data Manager (ODM) attribute settings for dars, dacs, and 

hdisks, use the lsattr command, as follows: 

v   To view the default settings, type lsattr -Dl. 

v   To view the attributes that are currently set on the system, type lsattr -El.

The lsattr -El output examples shown in Figure 17, Figure 18, and Figure 19 on 

page 68 display the ODM attribute settings for a dar, a dac and an hdisk.
   

 # lsattr -El dar0 

act_controller dac0,dac1 Active Controllers                          False 

aen_freq       600       Polled AEN frequency in seconds             True 

all_controller dac0,dac1 Available Controllers                       False 

autorecovery   no        Autorecover after failure is corrected      True 

balance_freq   600       Dynamic Load Balancing frequency in seconds True 

cache_size     128       Cache size for both controllers             False 

fast_write_ok  yes       Fast Write available                        False 

held_in_reset  none      Held-in-reset controller                    True 

hlthchk_freq   600       Health check frequency in seconds           True 

load_balancing no        Dynamic Load Balancing                      True 

switch_retries 5         Number of times to retry failed switches    True 

  

Figure 17. Example 1: Displaying the attribute settings for a dar

 # lsattr -El dac0 

GLM_type        low                GLM type                 False 

alt_held_reset  no                 Alternate held in reset  False 

cache_size      128                Cache Size in MBytes     False 

controller_SN   1T24594458         Controller serial number False 

ctrl_type       1722-600           Controller Type          False 

location                           Location Label           True 

lun_id          0x0                Logical Unit Number      False 

node_name       0x200200a0b80f14af FC Node Name             False 

passive_control no                 Passive controller       False 

scsi_id         0x11000            SCSI ID                  False 

utm_lun_id      0x001f000000000000 Logical Unit Number      False 

ww_name         0x200200a0b80f14b0 World Wide Name          False 

  

Figure 18. Example 2: Displaying the attribute settings for a dac
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Note:  In Figure 19, the ieee_volname and lun_id attribute values are shown 

abbreviated. An actual output would show the values in their entirety. 

Additional AIX configuration information 

This section contains the following procedures: 

v   “Disabling DS4000 cache mirroring” 

v   “Using fast I/O failure for fibre channel devices” on page 69 

v   “Using dynamic tracking of fibre channel devices” on page 70 

v   “Using dynamic capacity expansion and dynamic volume expansion” on page 70

Disabling DS4000 cache mirroring 

Cache mirroring is enabled on the DS4000 storage subsystem by default. However, 

you might want to disable this function in certain environments where high 

performance is a critical factor (such as streaming media applications). 

For most applications, cache mirroring should remain enabled. 

Attention: You must be careful when you disable cache mirroring, particularly when 

the write cache function is enabled. 

v   If a controller failure or a power down occurs, data that is in the write cache (but 

not written to the physical disk media) might be lost. This can result in corrupted 

files, file systems, or databases. 

v   On AIX 5.2, and 5.3, cache mirroring is not automatically re-enabled the next 

time the system is restarted or when you run the cfgmgr command.

Steps for disabling cache mirroring 

In DS4000 Storage Manager, complete the following steps to disable cache 

mirroring. 

Before you begin: If write cache is enabled, make backups of all data before 

disabling cache mirroring. 

1.   In the Logical/Physical view of the Subsystem Management window, right-click 

the logical drive on which you want to disable cache mirroring, and select 

Change → Cache Settings. 

 lsattr -El hdisk174 

cache_method   fast_write             Write Caching method                   False 

ieee_volname   600A0B8...1063F7076A7  IEEE Unique volume name                False 

lun_id         0x0069...000000        Logical Unit Number                    False 

prefetch_mult  12                     Multiple of blocks to prefetch on read False 

pvid           none                   Physical volume identifier             False 

q_type         simple                 Queuing Type                           False 

queue_depth    2                      Queue Depth                            True 

raid_level     5                      RAID Level                             False 

reassign_to    120                    Reassign Timeout value                 True 

reserve_lock   yes                    RESERVE device on open                 True 

rw_timeout     30                     Read/Write Timeout value               True 

scsi_id        0x11f00                SCSI ID                                False 

size           2048                   Size in Mbytes                         False 

write_cache    yes                    Write Caching enabled                  False 

  

Figure 19. Example 3: Displaying the attribute settings for an hdisk
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2.   In the Change Cache Settings window, clear the Enable write caching with 

mirroring check box. 

3.   Click OK.

Notes:  

1.   When a LUN is opened that is running with write cache enabled and cache 

mirroring disabled, an FCP array warning message displays. The warning 

displays again every 24 hours until cache mirroring is enabled again. See 

FCP_ARRAY_ERR25, which is described in “Resolving disk array errors” on 

page 79.

Using fast I/O failure for fibre channel devices 

I/O failover occurs when a fibre channel adapter driver detects a link failure on the 

fabric between the switch and the DS4000 storage subsystem. You can change the 

failover characteristics by setting the fscsi device attribute fc_err_recov to one of 

the following settings. 

fast_fail Enables fast I/O failure. 

 If the fibre channel adapter driver detects that a link was lost 

between the switch and the DS4000, it waits a few seconds to 

allow the fabric to stabilize. If fast_fail is specified, the adapter then 

begins failing all I/O at the adapter driver if it detects that the device 

is not on the fabric. Any new I/O or future retries of the failed I/O 

are failed immediately. 

Fast I/O failure can be useful in multipath configurations. It can 

decrease the I/O fail times due to the loss of a link between the 

storage device and the switch, and can allow faster failover to 

alternate paths. 

delayed_fail Default setting. 

 If delayed_fail is specified, I/O failure proceeds as normal; retries 

are not immediately failed, and failover takes longer than it does if 

fast_fail is specified. 

In single-path configurations, especially configurations with a single 

path to a paging device, the delayed_fail setting should be used.

Example: You can enable fast I/O failure by setting this attribute, as shown in the 

following example. Be sure to stop all I/O and put the fscsi device into a Defined 

state before you set the attribute. 

 chdev -l fscsi0 -a fc_err_recov=fast_fail
  

Notes:  

1.   The fast_fail attribute only affects failover that occurs between the switch and 

the DS4000 storage subsystem. It does not affect failover that occurs between 

the host and the switch. 

2.   Set the fast_fail attribute on each HBA that is configured to the DS4000 storage 

subsystem. 

3.   You can use fast I/O failure only in a SAN environment. You cannot use it in a 

direct-attach environment.
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Using dynamic tracking of fibre channel devices 

You can dynamically track fibre channel devices, which allows the dynamic 

movement of a fibre channel path between the fabric switch and the DS4000 

subsystem by suspending I/O for 15 seconds while the move occurs. 

Exception: You can only use dynamic tracking on AIX 5.2 and 5.3. 

You can enable or disable dynamic tracking by setting the fscsi device attribute 

dyntrk to one of the following settings: 

yes Enables dynamic tracking. 

 If dynamic tracking is enabled, the fibre channel adapter detects when the 

fibre channel node port ID of a device changes. It reroutes the traffic that is 

destined for that device to the new worldwide port name (WWPN) while the 

devices are still online. 

For example, you can move a cable from one switch port to another while 

the devices are still online, and no failover occurs if you complete the move 

within 15 seconds. After 15 seconds, failover occurs. 

Tip: The ports must be in the same zone on the same switch. 

no Default setting. 

 If dynamic tracking is not enabled, you must take the devices offline before 

you move a cable from one port to another. Otherwise, failover occurs.

Example: You can enable dynamic tracking by setting this attribute, as shown in 

the following example. Be sure to stop all I/O and put the fscsi device into a 

Defined state before you set the attribute. 

 chdev -l fscsi0 -a dyntrk=yes
  

Notes:  

1.   Set the dyntrk attribute on each HBA that is configured to the DS4000 storage 

subsystem. 

2.   You can use dynamic tracking only in a SAN environment. You cannot use it in 

a direct-attach environment.

Using dynamic capacity expansion and dynamic volume expansion 

Dynamic volume expansion (DVE) is dynamic on the DS4000, but it requires 

manual intervention for AIX to recognize the new logical drive capacity. This section 

explains how to use DVE with AIX. 

Exception: You can only use DVE on AIX 5.2 and 5.3. 

Before you begin: Ensure that there is available free capacity within the array. You 

can check free capacity availability using DS4000 Storage Manager, in the 

Logical/Physical view of the Subsystem Management window. If there is not enough 

free capacity, and extra drives are available, perform a dynamic capacity expansion 

(DCE) operation before you perform the DVE operation. A DCE operation increases 

the capacity of the array by adding physical disks. 

Performing a dynamic capacity expansion operation 

Complete the following steps to perform a DCE: 
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1.   In the Logical/Physical view of the Subsystem Management window, right-click 

the logical drive whose capacity you want to increase, and select Increase 

Capacity. The Increase Logical Drive Capacity—Additional Instructions window 

opens. 

2.   Read the additional instructions and click OK. The Increase Logical Drive 

Capacity window opens. 

3.   Type the amount that you want to increase the logical drive, and click OK.

You see an hourglass on every logical drive within the array. You must wait for the 

process to complete before you can begin any AIX intervention. 

Tip: If the DS4000 is busy, the process might take several hours to complete. 

 After you have ensured that there is sufficient free capacity within the array, you can 

perform DVE, as described in the next topic. 

Requirement: You must either reboot the system or run the cfgmgr command 

before you can view the additional capacity using the ODM attribute. 

Performing a dynamic volume expansion operation 

Complete the following steps to perform a DVE on the AIX host. For more 

information about expanding Logical VolumeManager (LVM) logical drives, see the 

man page for the chvg command . 

1.   Unmount the file systems from the LVM logical drive group that has been 

expanded, by typing the following command: 

 

 umount mount_point 

  

where mount_point is the name of the filesystem that is being unmounted. 

2.   Change the logical drive group by typing the following command: 

 

 chvg -g logical drive group name 

  

where the logical drive group name is the name of the associated LVM logical 

drive group.

Note:  If you see a warning that the logical drive group cannot be imported to 

AIX 5.1 or lower, ignore the warning. It is an error. You can import the 

logical drive group to AIX 5.1 (or lower.) 

3.   Mount the file systems.

Notes:  

1.   You might have to run the varyoffvg command, and then the varyonvg 

command, on the logical drive group for LVM to see the size change on the 

disk. However, the new capacity is available for use by the operating system. 

2.   You cannot resize while the logical drive group is activated in classic or 

enhanced concurrent mode. 

3.   You cannot resize the root logical drive group.
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Replacing hot swap HBAs 

This section describes the procedure for hot-swapping fibre channel host bus 

adapters (HBAs) on an AIX host. 

The hot swap procedure requires knowledge in the following areas: 

v   AIX administration 

v   AIX hardware procedures for PCI card replacement. 

v   IBM System Storage DS4000 Storage Manager 

v   Fibre channel zoning procedures (required if a switch is used to interconnect 

DS4000 storage subsystem and the AIX host, and zoning is based on WWPN)

Caution:  If the procedures are not followed as they are documented in this section, 

loss of data availability can occur. IBM recommends that you read and 

understand all of the requirements and steps in this section before you 

begin the HBA hot swap procedure. 

This section contains the following information: 

v   “Requirements” 

v   “Known issues and restrictions” 

v   “Preparing for the HBA hot swap” on page 73 

v   “Replacing the hot swap HBA” on page 76 

v   “Mapping the new WWPN to the DS4000 storage subsystem” on page 77 

v   “Completing the HBA hot swap procedure” on page 77

Requirements 

The following are the minimum AIX operating system and file set versions that are 

required to support hot swap: 

 Table 12. Minimum AIX operating systems and file set versions required for supporting HBA  

hot swap 

Operating system Package name Minimum file set version 

AIX 5.1 devices.fcp.disk.array.rte 5.1.0.65 

AIX 5.2 devices.fcp.disk.array.rte 5.2.0.60 

AIX 5.3 devices.fcp.disk.array.rte 5.3.0.20
  

Known issues and restrictions 

Please note the following known issues and restrictions when you perform a hot 

swap operation: 

Caution:  Any deviations from these notes and procedures might cause a loss of 

data availability. 

v   The autorecovery attribute of the dar must be set to no. Autorecovery is a 

dynamically set feature that can be turned back on after the hot swap procedure 

is complete. Failure to disable autorecovery mode during a hot swap procedure 

can cause loss of access to data. 

v   Do not redistribute logical drives to the preferred path until you verify that the 

HBA replacement succeeded and that the subsequent configuration was 

performed correctly. Redistributing the logical drives before verifying successful 

hot swap and configuration can cause a loss of access to data. 
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v   The only supported hot swap scenario is the following operation: 

–   Replacing a defective HBA with the same model HBA, and in the same PCI 

slot.

Do not insert the defective HBA into any other system, even if the HBA is found 

not to actually be defective. Always return the HBA to IBM. 

Important:  No other variations of replacement scenarios are currently supported. 

v   Hot swap is not supported in single-HBA configurations.

Preparing for the HBA hot swap 

Complete the procedures in this section to prepare for the hot swap. 

Collecting system data 

In preparation for the hot swap procedure, complete the following steps to collect 

data from the system: 

1.   Type the following command: 

 # lsdev -C |grep fcs 

  

The output is similar to the following example: 

 fcs0         Available 17-08        FC Adapter 

fcs1         Available 1A-08        FC Adapter 

  

2.   Type the following command: 

 # lsdev -C |grep dac 

  

The output is similar to the following example: 

 dac0         Available 17-08-02     1815     DS4800 Disk Array Controller 

dac1         Available 1A-08-02     1815     DS4800 Disk Array Controller 

  

3.   Type the following command for each of the fcs devices: 

 # lscfg -vpl fcsX 

  

where X is the number of the fcs device. The output looks similar to the 

following example: 
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lscfg -vpl fcs0 

 fcs0             U0.1-P1-I1/Q1  FC Adapter 

  

          Part Number.................09P5079 

          EC Level....................A 

          Serial Number...............1C21908D10 

          Manufacturer................001C 

          Feature Code/Marketing ID...2765 

          FRU Number..................09P5080 

          Network Address.............10000000C92D2981 

          ROS Level and ID............02C03951 

          Device Specific.(Z0)........2002606D 

          Device Specific.(Z1)........00000000 

          Device Specific.(Z2)........00000000 

          Device Specific.(Z3)........03000909 

          Device Specific.(Z4)........FF401210 

          Device Specific.(Z5)........02C03951 

          Device Specific.(Z6)........06433951 

          Device Specific.(Z7)........07433951 

          Device Specific.(Z8)........20000000C92D2981 

          Device Specific.(Z9)........CS3.91A1 

          Device Specific.(ZA)........C1D3.91A1 

          Device Specific.(ZB)........C2D3.91A1 

          Device Specific.(YL)........U0.1-P1-I1/Q1 

  

  

   PLATFORM SPECIFIC 

  

     Name:  fibre-channel 

     Model:  LP9002 

     Node:  fibre-channel@1 

     Device Type:  fcp 

     Physical Location: U0.1-P1-I1/Q1 

  

  

4.   Type the following command: 

 # lsdev -C |grep ^dar 

  

The output looks similar to the following example: 

 # dar0         Available               1815     DS4800 Disk Array Router 

  dar1         Available               1815     DS4800 Disk Array Router 

  

5.   Type the following command to list the attributes of each dar found on the 

system: 

 # lsattr -El darX 

  

where X is the number of the dar. The output looks similar to the following 

example: 

 

74 DS4000 Storage Manager Version 10 Installation and Support Guide for AIX, HP-UX, Solaris, and Linux on POWER



lsattr -El dar0 

 act_controller  dac0,dac2  Active Controllers                           False 

 all_controller  dac0,dac2  Available Controllers                        False 

 held_in_reset   none       Held-in-reset controller                     True 

 load_balancing  no         Dynamic Load Balancing                       True 

 autorecovery    no         Autorecover after failure is corrected       True 

 hlthchk_freq    600        Health check frequency in seconds            True 

 aen_freq        600        Polled AEN frequency in seconds              True 

 balance_freq    600        Dynamic Load Balancing frequency in seconds  True 

 fast_write_ok   yes        Fast Write available                         False 

 cache_size      1024       Cache size for both controllers              False 

 switch_retries  5          Number of times to retry failed switches     True 

  

Verifying that autorecovery is disabled 

Before you perform the hot swap, you must complete the following steps to ensure 

that autorecovery is disabled on every dar that is involved with the HBA you want to 

hot swap: 

1.   Identify all the dac(s) that are involved with the HBA by typing the following 

command: 

 # lsdev -C|grep 11-08 

  

The output looks similar to the following example: 

 # lsdev -C|grep 11-08 

fcs0       Available 11-08         FC Adapter 

fscsi0     Available 11-08-01      FC SCSI I/O Controller Protocol Device 

dac0       Available 11-08-01      1742     (700) Disk Array Controller 

hdisk1     Available 11-08-01      1742     (700) Disk Array Device 

hdisk3     Available 11-08-01      1742     (700) Disk Array Device 

hdisk5     Available 11-08-01      1742     (700) Disk Array Device 

hdisk7     Available 11-08-01      1742     (700) Disk Array Device 

hdisk8     Available 11-08-01      1742     (700) Disk Array Device 

  

2.   Consult the lsattr command output that you collected in step 5 on page 74 of 

the procedure “Collecting system data” on page 73. In the lsattr output, identify 

the dar(s) that list the dacs you identified in step 1 of this procedure. 

3.   For each dar that you identified in step 2, type the following command: 

 #  lsattr -El darX |grep autorecovery 

  

where X is the number of the dar. The output looks similar to the following 

example: 

 #  lsattr -El dar0 |grep autorecovery 

autorecovery   no        Autorecover after failure is corrected      True 

  

4.   In the lsattr command output, verify that the second word is no. If the second 

word is set to yes, then autorecovery is currently enabled. 

Important:  For each dar on which autorecovery is enabled, you must disable it 

by setting the autorecovery ODM attribute to no. See “Viewing and 

setting Object Data Manager (ODM) attributes” on page 60 to learn 

how to change attribute settings. Do not proceed with the hot swap 

procedure until you complete this step and verify that autorecovery 

is disabled.
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Replacing the hot swap HBA 

After you complete the procedures in “Preparing for the HBA hot swap” on page 73, 

complete the following steps to replace the hot swap HBA: 

 1.   Place the HBA that you want to replace into the Defined state by typing the 

following command: 

 # rmdev -Rl fcsX 

  

where X is the number of the HBA. The output is similar to the following 

example: 

 rmdev -Rl fcs0 

   fcnet0 Defined 

   dac0 Defined 

   fscsi0 Defined 

   fcs0 Defined 

  

 2.   In the AIX smit menu, initiate the process that is required for the HBA hot swap 

by selecting smit → Devices → PCI Hot Plug Manager → Replace/Remove a 

PCI Hot Plug Adapter. 

 3.   In the Replace/Remove a PCI Hot Plug Adapter window, select targeted HBA. 

A window displays that contains instructions for replacing the HBA. 

 4.   Replace the HBA by following the smit instructions. 

Note:  Do not reinstall the fibre channel cable at this time. 

 5.   If the steps in this procedure are completed successfully up to this point, you 

obtain the following results: 

v   The defective HBA is removed from the system. 

v   The replacement FC HBA is powered on. 

v   The associated fcsX device is in the Defined state.

Before continuing, verify that these results have been obtained. 

 6.   Install the fibre channel loop back on the replacement HBA. 

 7.   Place the HBA into the Active state by typing the following command: 

 # cfgmgr 

  

Note:  The new HBA is placed in the default group. If the default group has 

hdisks assigned to it then the HBA will generate a new dar and dac, 

which will cause a split. Issue the rmdev command to remove the new 

dar and dac after mapping the WWPN. 

 8.   Verify that the fcs device is now available by typing the following command: 

 # lsdev -C |grep fcs 

  

 9.   Verify or upgrade the firmware on the replacement HBA to the appropriate 

level by typing the following command: 

 # lscfg -vpl fcsX 

  

where X is the number of the fcs.
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Note:  You can determine the HBA firmware level by referring to the fcsX 

device data that you gathered during the procedure at the start of this 

section, “Collecting system data” on page 73. 

10.   Record the 16-digit number that is associated with Network Address, as it was 

displayed in the output of the command you used in step 9 on page 76. This 

Network Address number will be used in the next procedure, manually map the 

replacement HBA’s WWPN to the Storage subsystem(s). 

11.   Place the HBA back into the Defined state by typing the following command: 

 # rmdev -Rl fcsX 

  

When you have completed this procedure, continue to the next procedure, 

“Mapping the new WWPN to the DS4000 storage subsystem.” 

Mapping the new WWPN to the DS4000 storage subsystem 

For each DS4000 storage subsystem that is affected by the hot swap, complete the 

following steps to map the worldwide port name (WWPN) of the HBA to the storage 

subsystem: 

1.   Start DS4000 Storage Manager and open the Subsystem Management window. 

2.   In the Mapping View of the Subsystem Management window, select Mappings 

→ Show All Host Port Information. The Host Port Information window displays. 

3.   Using the data that you collected during the procedure “Collecting system data” 

on page 73, find the entry in the Host Port Information window that matches the 

WWPN of the “defective” HBA (the HBA that you removed), and record the alias 

name. Then, close the Host Port Information window. 

4.   In the Mapping View, select the alias name of the HBA host port that you just 

recorded. 

5.   Select Mappings → Replace Host Port. The Replace Host Port window opens. 

6.   In the Replace Host Port window, verify that the current HBA Host Port 

Identifier, which is listed at the top of the window, exactly matches the WWPN of 

the HBA that you removed. 

7.   Type the 16-digit WWPN, without the : (colon), of the replacement HBA in the 

New Identifier field, and click OK.

When you have completed these steps continue to the next procedure, “Completing 

the HBA hot swap procedure.” 

Completing the HBA hot swap procedure 

Complete the following steps to finish replacing the hot swap HBA: 

1.   Remove the fibre channel loop back plug, and insert the fibre channel cable that 

was previously attached to the HBA that you removed. 

2.   If HBA is attached to a fibre channel switch, and the zoning is based on WWPN, 

modify the zoning information to replace the WWPN of the former HBA with the 

WWPN of the replacement HBA. (Run cfgmgr at this time to allow the HBA to 

register its WWPN in the fibre channel switch.)

Important:  Skip this step if the HBA is directly attached to the DS4000 

subsystem, or if the fibre channel switch zoning is based on port 

numbers instead of WWPNs. If you do need to modify the zoning, 

failure to correctly do so will prevent the HBA from accessing the 

storage subsystem. 

3.   Run the cfgmgr command. 
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4.   Type the following commands to verify that the replaced fcsX device and its 

associated dac(s) are placed in the Available state: 

 # lsdev -C |grep fcs 

  

lsdev -C |grep dac 

  

5.   Type the following step to verify that no additional dar(s) have been created and 

that the expected dar(s) are in the Available state. (Refer to the data that you 

collected during the procedure “Collecting system data” on page 73 to compare 

the original number of dar(s) to the number that is now reported by the system.) 

 # lsdev -C |grep dar 

  

Caution:  The presence of additional dar(s) in the lsdev output indicates a 

configuration problem. If this occurs, do not continue this procedure 

until you correct the problem, Loss of data availability can occur. 

6.   For each dar, type the following command to verify that affected dar attributes 

indicate the presence of two active dac(s): 

 # lsattr -El darX|grep act_controller 

  

where X is the number of the dar. The output looks similar to the following: 

 lsattr -El dar0|grep act_controller 

act_controller dac0,dac2 Active Controllers                          False 

  

Caution:  If two dacs are not reported for each affected dar, loss of data 

availability can occur. Do not continue this procedure if two dac(s) are 

not reported for each dar. Correct the problem before continuing. 

7.   Using the Storage Manager procedure that is described in “Redistributing logical 

drives in case of failure” on page 81, manually redistribute volumes to preferred 

paths. 

8.   Verify that disks stay on preferred path by using one or both of the following 

methods: 

Using AIX system 

Run the fget_config -Av command, and verify that drives are on 

expected path 

Using Storage Manager  

In the Enterprise Management window, verify that the storage 

subsystem(s) are Optimal. If they are not Optimal, verify that any drives 

that are part of the subsystems involved with hot swap process are not 

listed in the Recovery GURU.

9.   If necessary, enable autorecovery of the affected dar(s) at this time. (See 

“Viewing and setting Object Data Manager (ODM) attributes” on page 60 to 

learn how to change attribute settings.)

Result: The fibre channel HBA hot swap is now complete. 
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Resolving disk array errors 

This section shows a list of possible disk array errors that could be reported in the 

AIX error log. You can view the AIX error log by running the errpt -a command. 

You can also check your DS4000 Storage Manager Major Event log (MEL) to find 

out whether there is any correlation between the host, SAN, and DS4000 storage 

subsystem. 

You might need to validate your configuration or replace defective hardware to 

correct the situation.

Note:  For more information about troubleshooting, see the Installation, User’s and 

Maintenance Guide for your DS4000 storage subsystem. 

v   FCP_ARRAY_ERR1 ARRAY OPERATION ERROR 

A permanent hardware error involving the disk array media. 

v   FCP_ARRAY_ERR2 ARRAY OPERATION ERROR 

A permanent hardware error. 

v   FCP_ARRAY_ERR3 ARRAY OPERATION ERROR 

A permanent error detected by the array adapter. 

v   FCP_ARRAY_ERR4 ARRAY OPERATION ERROR 

A temporary error within the array, communications, adapter, and so on. 

v   FCP_ARRAY_ERR5 UNDETERMINED ERROR 

An undetermined error has occurred. 

v   FCP_ARRAY_ERR6 SUBSYSTEM COMPONENT FAILURE 

A degradation condition has occurred other than a disk drive. 

v   FCP_ARRAY_ERR7 CONTROLLER HEALTH CHECK FAILURE 

A health check on the passive controller has failed. 

v   FCP_ARRAY_ERR8 ARRAY CONTROLLER SWITCH 

One array controller has become unavailable, so I/O has moved to the other 

controller. 

v   FCP_ARRAY_ERR9 ARRAY CONTROLLER SWITCH FAILURE 

An array controller switch has failed. 

v   FCP_ARRAY_ERR10 ARRAY CONFIGURATION CHANGED 

A logical unit has been moved from one controller to the other (most likely by the 

action of an alternate host). 

v   FCP_ARRAY_ERR11 IMPROPER DRIVE TYPE FOR DUAL ACTIVE MODE 

This error should not be possible on the 2102 array, and exists for history 

reasons only. FCP_ARRAY_ERR11 might be reused for a different error in the 

future. 

v   FCP_ARRAY_ERR12 POLLED AEN FAILURE 

An automatic error notification has failed. 

v   FCP_ARRAY_ERR13 ARRAY INTER-CONTROLLER COMMUNICATION 

FAILURE 

The controllers are unable to communicate with each other. This could result 

from one of the controllers being rebooted while the error log was being 

generated. However, it could be a much more serious error that indicates a 

problem with the fibre channel connections. 

v   FCP_ARRAY_ERR14 ARRAY DRIVE FAILURE 
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A serious or unrecoverable error has been detected on a physical disk within the 

DS4000 subsystem. A system engineer might be able to obtain the exact cause 

from an analysis of the sense data. 

v   FCP_ARRAY_ERR15 CACHE BATTERY LOW/DATA LOSS POSSIBLE 

If a controller card is replaced, it is likely that the cache batteries will be flat. It 

can take two days for the cache batteries to be fully recharged. During this time 

errors are logged in the error log. Do not replace the controller. 

v   FCP_ARRAY_ERR16 CACHE BATTERY CHARGE BELOW 87.5% 

If a controller card is replaced, it is likely that the cache batteries will be flat. It 

can take two days for the cache batteries to be fully recharged. During this time 

errors are logged in the error log. Do not replace the controller. 

v   FCP_ARRAY_ERR17 WORLDWIDE NAME CHANGED 

A controller has changed worldwide names (most likely either it was replaced 

without placing it in the reset state first, or the cabling was changed so that a 

different controller with the same SCSI ID is on the loop). 

v   FCP_ARRAY_ERR18 RESERVATION CONFLICT 

An operation failed because the disk array logical drive (LUN) is reserved by 

another host. 

v   FCP_ARRAY_ERR19 SNAPSHOT VOLUME’S REPOSITORY FULL 

The repository capacity limit has been reached. To resolve this error you can 

increase the repository capacity. 

v   FCP_ARRAY_ERR20 SNAPSHOT OPERATION STOPPED BY ADMIN 

The FlashCopy (snapshot) operation has been disabled or stopped. To resolve 

this error you can recreate the FlashCopy. 

v   FCP_ARRAY_ERR21 SNAPSHOT REPOSITORY METADATA ERROR 

There was a problem with the metadata of the FlashCopy (snapshot) repository 

during the FlashCopy operation. To resolve this error you can recreate the 

FlashCopy. 

v   FCP_ARRAY_ERR22 REMOTE VOL MIRRORING: ILLEGAL I/O ORIGIN 

The primary logical drive received I/O from a remote array, or the secondary 

logical drive received I/O from other than the primary logical drive. To resolve this 

error you can try the operation again. 

v   FCP_ARRAY_ERR23 SNAPSHOT OPERATION NOT ALLOWED 

The repository capacity limit has been reached, so the FlashCopy (snapshot) 

operation has failed. To resolve this error you can delete or recreate the 

FlashCopy. 

v   FCP_ARRAY_ERR24 SNAPSHOT VOLUME’S REPOSITORY FULL 

The repository capacity limit has been reached. To resolve this error you can 

delete or recreate the FlashCopy (snapshot). 

v   FCP_ARRAY_ERR25 CACHED DATA WILL BE LOST IF CONTROLLER FAILS 

This message is a warning that a disk array logical drive (LUN) is running with 

write cache enabled and cache mirroring disabled. The warning displays when 

the LUN is opened, and it displays again every 24 hours until cache mirroring is 

enabled again. 

If a controller failure or a power down occurs while the LUN is running in this 

mode, data that is in the write cache (but not written to the physical disk media) 

might be lost. This can result in corrupted files, file systems, or databases. 

v   FCP_ARRAY_ERR26 LOGICAL VOLUME IS WRITE PROTECTED 
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The status of the logical drive is read-only. The probable reason is that it is a 

secondary logical drive of a FlashCopy, VolumeCopy, or remote mirror pair. 

Check which relationship applies to the logical drive. 

–   For FlashCopy, a status of read-only on the secondary logical drive usually 

indicates that the repository is full. 

–   For VolumeCopy, both the primary and secondary logical drives are read-only 

during the copy. The secondary logical drive is read-only when the copy is 

stopped but the copy pair had not been deleted. 

–   For remote mirroring, the secondary logical drive is always read-only, as long 

as the mirror is active.

v    FCP_ARRAY_ERR27 SINGLE CONTROLLER RESTARTED 

The subsystem is operating as a single controller, and an error has been 

repaired. The error might have been a communication or hardware problem, or it 

might have occurred because a LUN was moved to a controller that does not 

have a path to the current host 

If this is a dual-controller subsystem, find the reason that the subsystem is 

operating in single-controller mode, and resolve the problem. Possible reasons 

include: 

–   An HBA, switch port, switch, DS4000 port or DS4000 controller was 

unavailable during the last system reboot or the last time the cfgmgr 

command was run. 

–   A user removed a path (dac) as part of a fibre channel adapter hot swap 

operation.

v   FCP_ARRAY_ERR28 SINGLE CONTROLLER RESTART FAILURE 

The subsystem is operating as a single controller, and the error has not been 

repaired. There is a problem with the path between this host and the subsystem 

or with the subsystem itself. The host has attempted to communicate with the 

subsystem and that communication has failed. 

If the number of retries that is specified in the ODM attribute switch_retries is 

reached, the I/O is failed back to the user. 

Repair the error. Then, if this is a dual-controller subsystem, find the reason that 

the subsystem is operating in single-controller mode, and resolve that problem. 

Possible reasons include: 

–   An HBA, switch port, switch, DS4000 port or DS4000 controller was 

unavailable during the last system reboot or the last time the cfgmgr 

command was run. 

–   A user removed a path (dac) as part of a fibre channel adapter hot swap 

operation.

Redistributing logical drives in case of failure 

If you enabled autorecovery on the AIX host, you do not need to redistribute logical 

drives manually after a controller failover. However, if you have a heterogeneous 

host environment, you might need to redistribute logical drives manually. Hosts that 

do not support some form of autorecovery, or AIX hosts that have autorecovery 

disabled, will not automatically redirect logical drives to the preferred paths. 

Complete the following steps to manually redistribute logical drives to their paths: 

1.   Repair or replace any faulty components. For more information, see the 

Installation, User’s and Maintenance Guide for the appropriate DS4000 storage 

subsystem. 
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2.   Using the Subsystem Management window, redistribute logical drives to their 

preferred paths by clicking Advanced → Recovery → Redistribute Logical 

Drives.

Note:  If a large number of LUNs is configured on the DS4000 system, 

redistributing logical drives might take 60 minutes or more to complete, 

depending on how busy the system is. 

3.   Run the fget_config command to verify the active paths, as shown in this 

example: 

 # fget_config -l dar0 

dac0 ACTIVE dac1 ACTIVE 

dac0-hdisk1 

dac0-hdisk2 

dac0-hdisk3 

dac1-hdisk4 

dac1-hdisk5 

dac1-hdisk6 

dac1-hdisk7 

dac0-hdisk8 
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Chapter  3.  Installing  and  configuring  storage  management  

software  on  HP-UX  host  systems  

This chapter provides the following information for HP-UX operating systems: 

v   “HP-UX system requirements” 

v   “Installing DS4000 Storage Manager” on page 84 

v   “Configuring storage subsystems” on page 90 

v   “Creating storage partitions” on page 95 

v   “Creating direct-attached and SAN-attached configurations” on page 99 

v   “Enabling multipath I/O with PV-links” on page 100 

v   “Redistributing logical drives in case of failure” on page 105

HP-UX system requirements 

This section lists the minimum hardware and software requirements for an HP-UX 

host in a DS4200, DS4300, DS4400, DS4500, DS4700 or DS4800 storage 

subsystem that is managed by DS4000 Storage Manager 10.10. 

Hardware requirements 

The HP-UX system must be an HP 9000/Series 800 server with: 

v   440 MHz processor or faster 

v   1 GB memory 

v   0.7 MB available on /opt and root (or root-equivalent) privileges for installing 

SMutil and SMagent 

v   47.5 MB available disk space on /opt and at least 95 MB available on /tmp for 

installation in an SMruntime environment

Software requirements 

Ensure that the HP-UX host is running one of the following operating systems with 

the appropriate patches. Because patch levels can be superseded by more recent 

versions, refer to your operating system documentation or contact your operating 

system supplier to ensure that you have the correct patches. 

v   HP-UX 11.0 (64 bit) with the following patches, at minimum: 

–   PHKL_23939 

–   PHKL-27003 

–   PHKL_24027 

–   PHKL_27364 

–   To run HP-UX SDK for Java 2 Platform applications and applets using GUIs, 

you must also ensure that the HP C++ runtime libraries are installed on the 

HP-UX system; the latest version is available as patch PHSS_1658

v    HP-UX 11.i (64 bit): 

–   Operating System base: B.11.11 

–   Minimum patch level: December ’04

v    HP-UX 11.23: 

–   Operating System base: B.11.13 

–   Minimum patch level: September ’04
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v   For high-availability clusters of HP 9000/Series 800 computers, install the HP 

MC/Service Guard software package.

Ensure that the following maximum kernel parameters are configured, as shown in 

Table 13. 

 Table 13. HP-UX  kernel parameter configuration requirements 

Parameter Description Configuration 

max_thread_proc 64 Maximum threads per 

process 

1024 

maxfiles Soft-file limit per process 2048 

maxuser Influences other parameters 256 or greater 

ncallout Number of pending timeouts 4144
  

Note:  Updated readme files contain important configuration information that 

supersedes this document. To access the most recent DS4000 Storage 

Manager readme file for HP-UX, see “Finding the Storage Manager readme 

files online” on page 24. 

Installing DS4000 Storage Manager 

The DS4000 Storage Manager software includes the following software packages: 

SMruntime (required) 

SMruntime is a Java compiler for the DS4000 Storage Manager software 

packages. SMruntime must be installed before the other packages are 

installed. 

SMesm (required if installing SMclient) 

SMesm is the mechanism for delivering ESM firmware, which contains a 

defined set of ESM firmware files that are used by the auto-sync 

mechanism. 

SMclient (optional) 

SMclient is Storage Manager’s graphical user interface (GUI), which you 

use to manage your storage subsystems. If you are not using your HP-UX 

host as a storage management station (for example, if you are using a 

Windows management station with SMclient installed), then you do not 

need to install SMclient on your HP-UX host. 

SMagent (optional) 

SMagent contains host-agent software, which you can use to manage your 

subsystems if you are using an in-band management configuration 

(managing the storage subsystems through the fibre channel I/O path to the 

host). If you are using an out-of-band management configuration, you do 

not need to install SMagent. 

SMutil (required) 

SMutil is a utility that you can use to register and map new logical drives to 

the operating system. SMutil is required on HP-UX host systems.

You can install all of the DS4000 Storage Manager software packages automatically 

by using the Storage Manager installation wizard, or you can install each package 

manually. This section contains the following procedures: 

v   “Installing Storage Manager using the installation wizard” on page 85 

v   “Installing Storage Manager packages manually” on page 86 (original method)
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Installing Storage Manager using the installation wizard 

The DS4000 Storage Manager installation wizard can install all of the Storage 

Manager software packages automatically. If you prefer, you can install just the 

following required packages onto your HP-UX host: 

v   SMruntime 

v   SMutil

To choose the packages that you want to install, select Custom Installation during 

the installation procedure, as described in “Steps for installing Storage Manager 

using the installation wizard.” 

Installation wizard requirements 

To use the installation wizard, you must meet the following requirements: 

v   You are installing DS4000 Storage Manager 10.10 

v   Your HP-UX host has a graphics adapter card installed.

If you are installing Storage Manager 10.10 on HP-UX and your system does not 

meet the requirements for using the wizard, does not have a graphics card 

installed, or if you do not want to use the wizard to install the software, you can 

perform the installation without a GUI by typing the sh <installer-package-
name.bin> -i console command in the command line interface. You can also skip 

this section and install the stand-alone host software packages using the 

procedures described in “Installing Storage Manager packages manually” on page 

86. All the packages are included with the installation CD. 

Notes:  

1.   Installing Storage Manager 9.12, or a later version, can be done either with the 

installation wizard or manually. It is recommended, however, that for versions 

9.12 or higher, you use the installation procedure described in “Installing 

Storage Manager using the installation wizard.” 

2.   Do not install the software packages in the same server by using both the 

installation wizard and the manual installation method.

Steps for installing Storage Manager using the installation wizard 

Complete the following steps to install the DS4000 Storage Manager software using 

the installation wizard. Adjust the steps as necessary for your specific installation. 

1.   Download the following file from the DS4000 Storage Manager CD, or from the 

DS4000 support Web site, to a directory on your system: 

SMIA-HPUX-10.10.xx.xx.bin 

2.   Open the file on your system. The Storage Manager Installation wizard’s 

Introduction window opens. 

3.   Follow the instructions in each window of the wizard. When you select the 

installation type, you can choose one of the following options: 

v   Typical (Full) Installation—Installs all Storage Manager software packages 

v   Management Station—Installs SMruntime and SMclient 

v   Host—Installs SMruntime, SMagent and SMutil 

v   Custom—Allows you to select which packages you want to install

4.   Restart the system.

Result: The DS4000 Storage Manager software is installed on your system. 
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Installing Storage Manager packages manually 

Use the following procedures, in the order listed, to install DS4000 Storage 

Manager 10.10 (or earlier) software on an HP-UX storage management station or 

on an HP-UX host acting as a storage management station. 

1.   “Installing the client software” 

2.   “Installing the host software” on page 88

Installing the client software 

For the specific installation order, see Table 3 on page 5. 

Note:  SMclient is dependent on SMruntime, which is a Java compiler for the 

SMclient. SMruntime must be installed first. If you do not install SMruntime 

you will receive errors during the software install analysis phase.

Prerequisites:   Before installing the client software, ensure that the following 

conditions are met: 

v   This is the HP 9000-series server that you identified as the storage management 

station. 

v   This machine meets the minimum hardware and software requirements described 

in Appendix A, “MC/Service Guard configuration details,” on page 221. 

v   Neither the SMruntime software nor the SMclient software is installed on the host 

and you are ready to install them on this machine. 

v   The DS4000 Storage Manager installation files are available in a directory on the 

system.

Steps for installing SMruntime software (required):   Modify the commands as 

needed for your installation. No restart is required during the SMruntime installation 

process. 

1.   Insert the HP-UX installation CD in the CD-ROM drive. 

2.   Start the installation process by typing the following command: 

 # mount -o cdcase -F cdfs /path_name /cdrom 

# swinstall -s /cdrom/HP-UX/SMruntime_10xxxxx 

  

where path_name is the directory path to the SMruntime package. 

The Software Selection window opens and displays this message: 

 SMruntime 

  

3.   Select SMruntime. 

4.   Click Actions → Mark for installation. 

5.   Click Actions → Install (Analysis). 

6.   Click OK when the analysis is finished. 

7.   In the confirmation window, click Yes to start the installation. 

8.   When the application is finished, click Done in the Installation window and close 

the application. 

Note:  You must exit the swinstall command before running the swverify 

command to verify the installation. 

9.   Verify that the installation was successful by typing the following command: 

 # swverify -v SMruntime 
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If no failure is reported, the SMruntime installation has successfully completed. 

If a failure is reported, follow the instructions in the /var/adm/sw/swagent.log file. 

Result: The SMruntime installation of this HP-UX storage management station is 

complete. 

Steps for installing SMesm software (required if installing SMclient):   If you 

are using your HP-UX host as a storage management station, then you must install 

SMesm on the host. If you are using a different computer as your storage 

management station, install SMesm on that computer. 

Modify the commands as needed for your installation. No restart is required during 

the SMesm installation process. 

1.   Start the installation process by typing the following command: 

 # swinstall -s /cdrom/HP-UX/SMesm-HP-10xxxxx 

  

The Software Selection window opens and displays the following message: 

 SMesm 

  

2.   Select SMesm. 

3.   Click Actions → Mark for installation. 

4.   Click Actions → Install (Analysis) 

5.   Click OK when the analysis is finished. 

6.   In the Confirmation window, click Yes to start the installation. 

7.   When the application is finished, click Done in the Installation window and close 

the application.

Note:  You must exit the swinstall command before running the swverify 

command to verify installation. 

8.   Verify that the installation was successful by typing the following command: 

 # swverify -v SMesm 

  

If no failure is reported, you are done installing SMesm. If a failure is reported, 

follow the instructions in the /var/adm/sw/swutil.log file. 

Result: The SMesm installation of this HP-UX storage management station is 

complete.

Note:  To ensure redundancy in a cluster environment, you must install SMesm on 

at least one additional storage management station or cluster server. 

Steps for installing SMclient software (optional):   If you are using your HP-UX 

host as a storage management station, then you must install SMclient on the host. 

If you are using a different computer as your storage management station, install 

SMclient on that computer. 

Modify the commands as needed for your installation. No restart is required during 

the SMclient installation process. 

1.   Start the installation process by typing the following command: 

 # swinstall -s /cdrom/HP-UX/SMclient-HP-10xxxxx 
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The Software Selection window opens and displays the following message: 

 SMclient 

  

2.   Select SMclient. 

3.   Click Actions → Mark for installation. 

4.   Click Actions → Install (Analysis) 

5.   Click OK when the analysis is finished. 

6.   In the Confirmation window, click Yes to start the installation. 

7.   When the application is finished, click Done in the Installation window and close 

the application.

Note:  You must exit the swinstall command before running the swverify 

command to verify installation. 

8.   Verify that the installation was successful by typing the following command: 

 # swverify -v SMclient 

  

If no failure is reported, you are done installing SMclient. If a failure is reported, 

follow the instructions in the /var/adm/sw/swutil.log file. 

Result: The SMclient installation of this HP-UX storage management station is 

complete.

Note:  To ensure redundancy in a cluster environment, you must install SMclient on 

at least one additional storage management station or cluster server. 

Installing the host software 

If you are installing the optional SMagent, install the host software in the following 

order. If you are not installing SMagent, then SMutil is the only DS4000 Storage 

Manager host software that you need to install. 

v   DS4000 SMagent software (optional—for in-band management only) 

v   DS4000 SMutil software (required)

Note:  SMagent and SMutil are dependent on SMruntime, which is a Java compiler 

for the DS4000 Storage Manager software and must be installed first. If you 

do not install SMruntime you receive errors during the software install 

analysis phase.

Prerequisites:   Before installing the host software, ensure that the following 

conditions are met: 

v   This is the HP 9000-series server that you identified as the storage management 

station. 

v   This machine meets the minimum hardware and software requirements described 

in Appendix A, “MC/Service Guard configuration details,” on page 221. 

v   SMruntime has been installed.

Note:  SMagent is not supported with DS4000 controller firmware version 

5.42.xx.xx.

Steps for installing SMagent software (optional):   SMagent is required for 

in-band management only. It is not required for out-of-band management. 
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Modify the commands as needed for your installation. No restart is required during 

the SMagent installation process. 

1.   Start the installation process by typing the following command: 

 # swinstall -s /cdrom/HP-UX/SMagent-HP-10xxxxxx 

  

The Software Selection window opens and displays this message: 

 SMagent 

  

2.   Select SMagent. 

3.   From the toolbar, click Actions → Mark for installation. 

4.   Click Actions → Install (analysis). 

5.   Click OK when the analysis is finished. 

6.   In the Confirmation window, click Yes to start the installation. 

7.   When the installation is finished, click Done in the Installation window and close 

the application.

Note:  You must exit the swinstall command before running the swverify 

command to verify the installation. 

8.   Verify that the installation was successful by typing the following command: 

 # swverify -v SMagent 

  

If no failure is reported, you are done installing SMagent. If a failure is reported, 

follow the instructions in the /var/adm/sw/swagent.log file. 

Result: The SMagent installation on this HP-UX storage management station is 

complete. 

Steps for installing SMutil software (required):   Modify the commands as 

needed for your installation. No restart is required during the SMutil installation 

process. 

1.   Start the installation process by typing the following command: 

 # swinstall -s /cdrom/HP-UX/SMutil_10xxxxxx 

  

The Software Selection window opens and displays this message: 

 SMutil 

  

2.   Select SMutils. 

3.   Click Actions → Mark for Installation. 

4.   Click Actions → Install (Analysis). 

5.   Click OK when the analysis is finished. 

6.   In the Confirmation window, click Yes to start the installation. 

7.   When the application is finished, click Done in the Installation window and close 

the application. 

Note:  You must exit the swinstall command before running the swverify 

command to verify the installation.
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8.   Verify that the installation was successful by typing the following command: 

 # swverify -v SMutil 

  

If no failure is reported, you are done installing SMutil. If a failure is reported, 

follow the instructions in the /var/adm/sw/swutil.log file. 

Result: The SMutil installation of this HP-UX storage management station is 

complete. 

Configuring storage subsystems 

After you install DS4000 Storage Manager, you need to configure the subsystem. 

System configuration includes configuring logical drives and creating storage arrays 

using the Subsystem Management window of DS4000 Storage Manager. 

See “Configuring storage subsystems” on page 201 for additional information about 

storage configuration. 

Before you begin: Note the following information: 

v   All DS4000 storage subsystems have an access logical drive set to LUN 31.

Note:   Do not delete the access LUN or the access logical drive. 

v   AVT/ADT is enabled by default; leave it in that state for HP-UX hosts. 

v   Versions of controller firmware and NVSRAM that come with this product might 

be later releases than those described in this document. To ensure that you have 

the latest versions of the firmware and the NVSRAM, read the Storage Manager 

readme file for HP-UX that is provided with the product. See “Finding the Storage 

Manager readme files online” on page 24.

Note:  If you do not have the latest versions of controller firmware and NVSRAM, 

download them and complete the procedure described in “Upgrading 

controller firmware and NVSRAM” on page 91. If the version numbers are 

current, you can skip that procedure. 

v   If you have purchased a Storage Partitioning premium feature, ensure that the 

feature is enabled. See “Enabling premium features” on page 18 for more 

information.

Complete the following procedures to configure DS4000 Storage Manager for an 

HP-UX system. 

Adding storage subsystems to SMclient 

Complete the following steps to add storage subsystems to SMclient: 

1.   To set up the storage subsystem for HP-UX, the subsystem must be physically 

configured, at least initially, for direct management through the Ethernet 

connections on each controller as well as through the fibre channel connection. 

Install the DS4000 Storage Manager software (SMruntime, SMclient, SMagent, 

and SMutil) before configuring the subsystem. 

2.   After the disk subsystem is configured on the network, type the following 

command to run SMclient on either the host server, if it is on the same network 

as the storage subsystem, or on another machine in the network that has the 

DS4000 Storage Manager software installed: 

 # SMclient 
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3.   Complete the following steps to specify the IP addresses of the controllers: 

a.   In the Enterprise Management window, click Edit → Add Storage 

Subsystem. 

b.   In the Add Storage Subsystem window, type the IP addresses of each 

controller in the storage subsystem, and click Add. The name of the storage 

subsystem displays in the Enterprise Management window.

Note:  Failure to add both controllers results in a partially-managed system.

4.   In the Enterprise Management window, double-click the name of the storage 

subsystem to open its Subsystem Management window. 

5.   In the Subsystem Management window, click Storage Subsystem → View 

Profile and review the summary portion of the output.

Upgrading controller firmware and NVSRAM 

The procedures in this section describe how to download and install DS4000 

controller firmware and NVSRAM.

Notes:  

1.   If you are upgrading a DS4800, DS4700, or a DS4200 storage subsystem to 

controller firmware version 07.10.xx.xx, see Appendix D, “Using the IBM System 

Storage DS4000 Controller Firmware Upgrade Tool,” on page 235. 

2.   Upgrading to 07.10.xx.xx cannot be done concurrently.

Overview 

Read the information in the following sections before you begin the download 

procedures: 

v   “Using concurrent download” 

v   “Using traditional or staged download”

Using concurrent download:   Depending on your system’s current firmware, you 

might be able to use concurrent download. Concurrent download is a method of 

downloading firmware to the controllers that does not require you to stop I/O to the 

controllers during the process.

Note:  Some controller firmware versions might not support concurrent download. 

See the latest Storage Manager readme file for HP-UX to find out which 

firmware versions support concurrent download. 

Using traditional or staged download:   There are two methods for downloading 

the firmware to the controllers: 

v   “Traditional download” 

v   “Staged download”

Traditional download:   The traditional download process takes significantly longer 

and must be done in one phase, rather than in two phases as with the staged 

controller firmware download. Therefore the preferred method of controller firmware 

download is the staged controller firmware download. 

Staged download:   With staged firmware download, the download process occurs 

in two distinct phases: firmware transfer and firmware activation. You can perform 

the time-consuming task of loading the firmware online so that it is functionally 

transparent to the application. You can then defer the activation of the loaded 

firmware to a convenient time. 

 

Chapter 3. Installing and configuring storage management software on HP-UX host systems 91



Some reasons for activating firmware files at a later time include the following: 

v   Time of day—Activating can take a long time, so you might want to wait until I/O 

loads are lighter because the controllers will go offline briefly to activate the new 

firmware. 

v   Type of package—You might want to test the new firmware package on one 

storage subsystem before activating it on other storage subsystems. 

v   Multiple controllers—You can download controller firmware from the storage 

management software to all storage subsystem controllers for later activation.

Notes:  

1.   You cannot use staged download to upgrade DS4000 controller firmware 

version 05.xx.xx.xx to version 06.xx.xx.xx or version 07.10.xx.xx. You can only 

use staged download if the DS4000 controller firmware version is already 

06.xx.xx.xx or higher, and you are downloading another version of 06.xx.xx.xx 

firmware or higher. 

2.   Staged controller firmware download is not supported on DS4400 storage 

subsystems. 

Important: Do not perform other storage management tasks, such as creating or 

deleting logical drives, reconstructing arrays, and so on, while downloading the 

DS4000 storage subsystem controller firmware. It is recommended that you close 

all storage management sessions (except for the session that you use to upgrade 

the firmware) to the DS4000 storage subsystem that you plan to update. Also, the 

subsystem must be in Optimal state prior to loading firmware or NVSRAM. 

Preparing for firmware or NVSRAM download 

To prepare for download, review and complete all of the steps in this section before 

you start the download procedures. 

Check current versions of controller firmware and NVSRAM:   Versions of 

controller firmware and NVSRAM that are provided with this product might be later 

releases than those described in this document. 

To check the controller firmware and NVSRAM versions that are currently installed 

on your system, complete the following steps: 

1.   In the Subsystem Management window, click Storage Subsystem → View 

Profile. The Storage Subsystem Profile window displays. 

2.   In the Storage Subsystem Profile window, click the Controllers tab to view the 

current versions of controller firmware and NVSRAM. 

3.   Click Close to close the Storage Subsystem Profile window. 

4.   To find whether the versions of controller firmware and NVSRAM that are 

currently on your storage subsystem are the latest versions, read the Storage 

Manager readme file. The latest versions are listed in the readme file. (See 

“Finding the Storage Manager readme files online” on page 24.) 

5.   If you find that you do not have the latest versions of the firmware and 

NVSRAM, download the correct versions from this Web site to a directory on 

your system, then follow the preparation and upgrade procedures that are 

described in this section.

Save the storage subsystem configuration:   Saving the storage subsystem 

configuration to a script file is necessary in order to restore the configuration in the 

event of a catastrophic failure. 
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Attention:  Do not use this option if the storage subsystem is undergoing an 

operation that changes any configuration settings. (If any logical drive 

listed in the Logical View of the Subsystem Management window has a 

clock icon, then a configuration change is occurring, and you must wait 

to save the configuration.) 

You can also save the storage subsystem profile, by selecting Storage 

Subsystem → View Profile in the Subsystem Management window, and 

clicking Save As. Then, in the Save Profile window, select the sections 

of the profile that you want to save, specify a name and location for the 

text file, and click Save. 

Save the storage subsystem configuration by completing the following steps: 

1.   In the Subsystem Management window, click Storage Subsystem → 

Configuration → Save. The Save Configuration window displays. 

2.   In the Save Configuration window, select the elements of the configuration that 

you want to save, and click Yes. A save dialog displays. 

3.   In the save dialog, specify a name for the script file and select its location.

Notes:  

a.   The .cfg extension is used by default for the script file if you do not specify a 

file extension. 

b.   Do not store your DS4000 Storage Subsystem configuration script file in the 

same location as the logical drives that are defined on your DS4000 Storage 

Subsystem. If you do this, and the logical drives fail during the subsequent 

migration, you will lose data.

4.   Click Save. The Configuration Saved window displays. 

5.   Review the information in the Configuration Saved window, then click OK to 

return to the Subsystem Management window.

Determine whether you need to stop I/O:   You can use concurrent download 

only if you are upgrading from one version of controller firmware to a later release 

of the same version. For example, if you are upgrading from 06.10.xx.xx to 

06.2x.xx.xx, you can use concurrent download. However, if you are upgrading from 

05.xx.xx.xx to 06.2x.xx.xx, you cannot use concurrent download.

Notes:  

1.   Some controller firmware versions might not support concurrent download. See 

the latest Storage Manager readme file for HP-UX to find out which firmware 

versions support concurrent download. 

2.   Single-controller (SCU) storage subsystem models do not support concurrent 

download.

In addition, before you upgrade controller firmware, ensure that concurrent 

download is supported with your system’s current firmware versions, using the 

information that is listed in Table 14. 

 Table 14. Firmware versions that support concurrent download (HP-UX) 

DS4000 storage subsystem: Controller firmware version: 

DS4100 06.10.xx.xx, 06.12.xx.xx 

DS4200 06.16.88.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4300 base and Turbo 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4400 06.10.xx.xx. 06.12.xx.xx 
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Table 14. Firmware versions that support concurrent download (HP-UX) (continued) 

DS4000 storage subsystem: Controller firmware version: 

DS4500 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4700 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4800 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

All other DS4000 storage subsystems 05.30.xx.xx, 06.10.xx.xx, 06.12.xx.xx
  

Steps for upgrading the controller firmware 

Complete the following steps to install a new firmware version on the controllers: 

 1.   Download the correct version of the firmware from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 92. 

Place the file in a designated directory on the host system. 

 2.   Check your system’s current firmware versions to determine whether you need 

to stop I/O before upgrading the firmware, using the information that is listed in 

Table 14 on page 93. 

Attention: Some controller firmware versions might not support concurrent 

download. See the latest Storage Manager readme file for HP-UX to find out 

which firmware versions support concurrent download. 

 3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

 4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller Firmware. The Download Firmware window displays. 

 5.   Click Browse to select the firmware file that you previously downloaded to a 

directory on the host. 

 6.   If you want to perform a staged firmware download, select the check box next 

to ″Transfer files but don’t activate them (activate later).″ If you want to perform 

a traditional firmware download, do not select the check box, and the firmware 

will load immediately. 

 7.   Click OK. The Confirm Download window displays. 

 8.   Click Yes to start the download. 

 9.   Verify that the firmware was successfully installed. 

10.   After you verify that the firmware was successfully installed, then you can 

restart I/O to the subsystem.

Steps for upgrading the NVSRAM 

Complete the following steps to install a new version of NVSRAM on the controllers. 

NVSRAM will be activated immediately. 

1.   Download the correct NVSRAM version from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 92. Place 

the file in a designated directory on the host system. 

2.   Stop I/O. 

3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller NVSRAM. The Download NVSRAM window displays. 

5.   Click Browse to select the NVSRAM file that you previously downloaded to a 

directory on the host. 

6.   Click OK. The Confirm Download window displays. 

7.   Click Yes to start the download. 
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8.   Verify that the NVSRAM was successfully installed. 

9.   Start I/O.

Creating storage partitions 

To create storage partitions, you must complete the following procedures in this 

section: 

1.   “Steps for defining an HP-UX host group” 

2.   “Steps for defining the host and host port” on page 96 

3.   “Mapping LUNs to a storage partition” on page 97

Storage partitioning overview 

When you begin to create your storage partitions using the procedures in this 

section, be aware of the following information: 

v   If your subsystem is running controller firmware 06.12.xx.xx or higher, the 

Storage Manager task assistant provides a Storage Partitioning wizard that you 

can use to define your host and host ports, and map LUNs to the storage 

partitions. If your subsystem is running controller firmware 05.xx.xx.xx, you 

cannot use the wizard. Both types of procedures are documented in this section. 

v   The procedures in this section assume that you have already created a physical 

connection between the host and the storage subsystem controllers, and that you 

have also connected and zoned the SAN switch (if any). If you have not 

completed these connections, please note that Storage Manager will not be able 

to list the WWPNs of the HBAs during these procedures. In this case you will 

need to type the WWPNs into the appropriate fields during the steps for defining 

a host and host ports. 

v   Create the HP-UX host group at the storage subsystem level. Do not create host 

groups at the default group level. 

Exceptions: If you are running a DS4300 configuration without partitioning 

enabled, you can use the default host group.

Before you begin: Identify the worldwide port name for each of your HBAs. Look 

for the worldwide port name for the HBA and write down the number for future 

reference. Use the following command to find your HBAs listed in the dev directory 

as td0, td1, and so on, where X in the following example represents the td number. 

 #cd /dev/td 

#tdutil /dev/tdX 

  

Steps for defining an HP-UX host group 

A host group is an entity in the Storage Partitioning topology that defines a logical 

collection of host computers that require shared access to one or more logical 

drives. You can grant individual hosts in a defined host group access to storage 

partitions, independently of the host group. 

Complete the following steps to define a host group: 

1.   Click the Mappings View tab on the Subsystem Management window. 

2.   In the Topology section of the Mappings window, highlight the name of the 

storage subsystem, and click Mappings → Define → Host Group.
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Note:  Make sure that the storage subsystem is highlighted in the left panel of 

the Subsystem Management window. Do not highlight Undefined 

Mappings. 

3.   Type the name of the new host group (for example, HP-UX). Click Add, and 

then click Close.

Steps for defining the host and host port 

Complete the steps that are appropriate for your storage subsystem controller 

firmware type: 

v   “Controller firmwares 07.10.xx.xx and 06.xx.xx.xx” on page 41 

v   “Controller firmware 06.12.xx.xx and later” 

v   “Controller firmware 05.xx.xx.xx” on page 97

Controller firmware 07.10.xx.xx 

If your subsystem has controller firmware 07.10.xx.xx installed, complete the 

following steps to define the host and host ports by using the Define a host and 

host ports wizard: 

1.   In the Mappings tab, right-click on the desired host group and select Define → 

Host. 

2.   Select Yes, if using the partitioning feature. 

3.   Select either the correct WWPN or the HBA host port(s) for the new host.. 

4.   One-at-a-time, select the WWPNs for the host, and click Edit to give them 

aliases (for example, Host_A, Host_B). 

5.   Click Next. 

6.   If using the partitioning feature, click the dropdown box to select OS type.

Note:   Failure to change the host type from the default to HP-UX will cause 

undesired results. 

7.   Click Next. 

8.   Select Yes if you intend host to share LUNS with others in a host group; 

otherwise, select No. (If you select Yes, you will be prompted to enter a new 

hostgroup name or to specify an existing one.) 

9.   Click Next and Finish to exit the wizard.

Controller firmware 06.12.xx.xx and later 

If your subsystem has controller firmware 06.12.xx.xx or later installed, complete the 

following steps to define the host and host ports by using the Define a host and 

host ports wizard: 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, right-click the new host group and select Define Host. The 

Introduction (Define Host) window opens. 

2.   Click Next. The Specify Host Name/HBA Attribute (Define Host) window 

opens. 

3.   Type the host name in the Specify Host Name/HBA Attribute (Define Host) 

window. In the left panel, select the correct WWPN of the HBA host port. Click 

Add.

Note:  If you there is not yet a physical connection between the host and the 

DS4000 controllers, as described in the “Storage partitioning overview” 

on page 95, the WWPNs will not display. In this case, you must type the 

correct WWPN into the field.
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4.   You must now provide an alias name for the host port. Click Edit, then type an 

alias name (for example, Port1). 

5.   On configurations with two or more HBAs, repeat step 3 on page 96 and step 4 

for each host port that you need to define, then proceed to step 6. 

6.   Click Next. The Specify Host Type window opens. 

7.   Select the correct host type, HP-UX, from the drop down menu and click Next. 

The Review window opens.

Note:  Failure to change the host type from the default to HP-UX will cause 

undesired results. 

8.   Review the information for accuracy, and make any necessary changes. Then 

click Next.

Recommendation:  Record the name of each host port along with the WWPN 

of its corresponding HBA, and save the information to a file 

for future reference. 

9.   After Storage Manager finishes defining the host and host ports, a dialog 

window opens. If you need to define another host, select Define another host. 

To finish, click Exit. The wizard closes.

Controller firmware 05.xx.xx.xx 

If your subsystem has controller firmware 05.xx.xx.xx installed, complete the 

following steps to define a host and host ports.

Note:  IBM recommends upgrading your controllers to the latest controller firmware 

that is available for your storage subsystem. 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, highlight the new host group and click Mappings → Define → Host. 

2.   Define the new host. Type the name of the HP-UX host to which the storage 

subsystem is attached. 

a.   Click Add, and then click Close. 

b.   Highlight the host that you just added, then right-click and select Define 

Host Port. 

c.   Type or select the desired host port for the first HBA, and then change the 

host type to HP-UX. Click Add.

Note:  Failure to change the host type from the default to HP-UX will cause 

undesired results. 

d.   If you are configuring additional HBAs to this partition, choose the host port 

for the next HBA and click Add, and then click Close.

Recommendation:  Before closing the window, record the name of each 

host port along with the WWPN of its corresponding 

HBA, and save the information to a file for future 

reference.

Mapping LUNs to a storage partition 

This section contains the following procedures: 

v   “Mapping LUNs to a new partition” on page 98 

v   “Adding LUNs to an existing partition” on page 98
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Mapping LUNs to a new partition 

When mapping LUNs for the first time to a newly-created partition, complete the 

procedure in this section that is appropriate to your storage subsystem controller 

firmware type. 

v   “Controller firmware 06.12.xx.xx” 

v   “Controller firmware 05.xx.xx.xx”

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition. 

Note:  HP-UX operating systems do not currently support 256 LUNs per partition. 

v   HP-UX 11.10 supports up to 32 LUNs per partition. 

v   HP-UX 11.i supports up to 128 LUNs per partition. 

v   HP-UX 11v2 supports up to 128 LUNs per partition.

Controller firmware 06.12.xx.xx:   When mapping LUNs to a newly created 

partition for the first time, complete the following steps. 

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition.

Important::  If your subsystem is running controller firmware 06.12.xx.xx or higher, 

you can use the Storage Partitioning wizard feature of the Storage 

Manager task assistant, instead of this procedure, to map LUNs to a 

new storage partition. 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Storage Partitioning. The Define Storage Partitioning 

window opens. 

3.   In the Define Storage Partitioning window, select Host, then click Next. 

4.   Select the logical drive by name, on the right side of the window. 

5.   Accept the default LUN ID, or change it, then click Add. 

6.   Repeat step 5 for each LUN that you want to map to the partition.

Controller firmware 05.xx.xx.xx:   Complete the following steps to map LUNs to a 

new partition: 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, right-click the host on which you want to map LUNs, and select Define 

Storage Partitioning. The Define Storage Partitioning window opens. 

2.   In the Define Storage Partitioning window, select Host, then click Next. 

3.   Select the logical drive by name, on the right side of the window. 

4.   Accept the default LUN ID, or change it, then click Add. 

5.   Repeat step 4 for each LUN that you want to map to the partition.

Adding LUNs to an existing partition 

When adding LUNs to an existing partition, complete the following steps to map the 

new LUNs to the partition. 
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Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition. 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Additional Mappings. The Define Additional Mapping 

window opens. 

3.   In the Define Additional Mapping window, select the following options, and then 

click Add: 

v   Host group or host 

v   Logical unit number (LUN)(0-255) 

v   Logical drive

Repeat these steps for each LUN that you want to add to the partition. 

Creating direct-attached and SAN-attached configurations 

DS4000 Storage Manager supports IBM DS4000 Storage Subsystems in 

direct-attached HP-UX configurations or in a SAN environment through switches in 

HP-UX configurations. 

Creating a direct-attached configuration 

To create a direct-attached configuration, you must ensure that: 

v   One or two HP-UX servers can be connected to DS4000 storage subsystems. 

v   Two server DS4400 or DS4500 configurations require four host-side minihubs, 

each with exactly one fibre channel connection from each HBA to a minihub.

Note:  DS4100, DS4200, DS4300, DS4700, and DS4800 storage subsystems do 

not have minihubs. 

v   There are two or four HBAs (HP A6795A or HP A5158A) per DS4000 storage 

subsystem. Each pair must be configured to one DS4000 partition. 

v   No external hubs are being used.

Complete the following steps to set up a direct-attached configuration: 

1.   Connect the HBAs to each controller or minihub port of the DS4000 storage 

subsystem. 

2.   Configure and verify the configuration.

Creating a SAN-attached configuration 

To create a SAN-attached configuration, you must ensure that: 

v   Multiple fibre channel HBAs within the same server must not be able to discover 

the same DS4000 controller port. 

v   The IBM Fibre Channel HBAs are isolated from each other if they are connected 

to the same switch that is connected to the same DS4000 controller port. 

v   Each fibre channel HBA and controller port must be in its own fabric zone, if they 

are connecting through a single fibre channel switch, such as a 2109-F16. 

Multiple DS4000 devices can be configured to the same set of fibre channel 

HBAs through a fibre channel switch.

Complete the following steps to set up a SAN-attached configuration: 
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Note:  For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245. 

1.   Connect the HBAs to the switch or switches. 

2.   Connect the DS4000 storage subsystems to the switch or switches. 

3.   Set the required zones on the fibre channel switch or switches, if applicable. 

4.   Configure and verify the configuration.

Enabling multipath I/O with PV-links 

If the HP-UX system is attached with two host bus adapters to the DS4000 storage 

subsystem, you can establish redundant access to storage by using physical 

volume links (PV-links), a feature of the HP-UX operating system. PV-links achieve 

access redundancy by using devices with both primary and secondary paths to the 

same device. 

Important: 

v   There are two methods for establishing redundant access to storage using 

PV-links: 

–   If you have DS4000 controller firmware version 06.1.xx.xx or 05.xx.xx.xx 

installed, use method 1. 

–   If you have DS4000 controller firmware version 04.xx.xx.xx installed, use 

method 2.

v   For both methods, you must have SMutil installed on the host.

Using PV-links:  Method 1 

If you have DS4000 controller firmware version 06.1.xx.xx or higher, or 05.xx.xx.xx 

installed, use the following procedure to enable multipath I/O by using PV-links: 

1.   Run the hot_add command from HP-UX at the shell prompt. This command 

updates any new devices that are created or added. A dump is generated. 

When the hot_add command runs, each new logical drive that is created in the 

Subsystem Management window represents a disk device to the operating 

system. 

 #hot_add 

  

2.   Run the SMdevices command. The system provides a dump similar to the 

example in Figure 20 on page 101. Notice that every logical drive and logical 

drive access unit has been assigned a logical unit number (LUN). Each logical 

drive has two paths. Each DS4000 controller has one logical drive access. For 

example, a subsystem that contains two DS4000 controllers has two logical 

drive accesses. 

 #SMdevices 
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Note:  If you do not see the logical drives and logical drive accesses after 

running the hot_add and SMdevices commands, restart the HP-UX host 

by running the reboot command. 

 #reboot 

  

3.   Determine the preferred and alternate path for each logical drive by examining 

the output from the SMdevices command, as shown in the example in 

Figure 20. Notice that each device is listed twice; one instance is the preferred 

path and one instance is the alternate path. 

Preferred path 

In the sample output that is shown in Figure 20, the preferred path is 

/dev/rdsk/c166t0d0: 

 /dev/rdsk/c166t0d0 [Storage Subsystem DS4000, Logical Drive 

Accounting, LUN 0, Logical Drive WWN <600a0b80000f56d00000001e3eaead2b>, 

Preferred Path (Controller-B):   In Use] 

  

Alternate path 

In the sample output that is shown in Figure 20, the alternate path is 

/dev/rdsk/c172t0d0: 

 /dev/rdsk/c166t0d0 [Storage Subsystem DS4000, Logical Drive Accounting, LUN 0, 

Logical Drive WWN <600a0b80000f56d00000001e3eaead2b>, 

Preferred Path (Controller-B): In Use] 

/dev/rdsk/c166t0d1 [Storage Subsystem DS4000, Logical Drive HR, LUN 1, 

Logical Drive WWN <600a0b80000f5d6c000000273eaeae30>, 

Alternate Path (Controller-B): Not In Use] 

/dev/rdsk/c166t0d2 [Storage Subsystem DS4000, Logical Drive Finance, 

LUN 2, Logical Drive WWN <600a0b80000f5d6c000000253eaeadf8>, 

Alternate Path (Controller-B): Not In Use] 

/dev/rdsk/c166t0d3 [Storage Subsystem DS4000, Logical Drive Purchasing, 

LUN 3, Logical Drive WWN <600a0b80000f5d6c000000243eaeadbe>, 

Alternate Path (Controller-B): Not In Use] 

/dev/rdsk/c166t0d4 [Storage Subsystem DS4000, Logical Drive Development, 

LUN 4, Logical Drive WWN <600a0b80000f56d00000001d3eaeacef>, 

Preferred Path (Controller-B): In Use] 

/dev/rdsk/c166t3d7 [Storage Subsystem DS4000, Logical Drive Access, LUN 31, 

Logical Drive WWN <600a0b80000f56d00000001b00000000>] 

  

/dev/rdsk/c172t0d0 [Storage Subsystem DS4000, Logical Drive Accounting, LUN 0, 

Logical Drive WWN <600a0b80000f56d00000001e3eaead2b>, 

Alternate Path (Controller-A): Not In Use] 

/dev/rdsk/c172t0d1 [Storage Subsystem DS4000, logical Drive HR, LUN 1, 

Logical Drive WWN <600a0b80000f5d6c000000273eaeae30>, 

Preferred Path (Controller-A): In Use] 

/dev/rdsk/c172t0d2 [Storage Subsystem DS4000, Logical Drive Finance, LUN 2, 

Logical Drive WWN <600a0b80000f5d6c000000253eaeadf8>, 

Preferred Path (Controller-A): In Use] 

/dev/rdsk/c172t0d3 [Storage Subsystem DS4000, Logical Drive Purchasing, LUN 3, 

Logical Drive WWN <600a0b80000f5d6c000000243eaeadbe>, 

Preferred Path (Controller-A): In Use] 

/dev/rdsk/c172t0d4 [Storage Subsystem DS4000, Logical Drive Development, LUN 4, 

Logical Drive WWN <600a0b80000f56d00000001d3eaeacef>, 

Alternate Path (Controller-A): Not In Use] 

/dev/rdsk/c172t3d7 [Storage Subsystem DS4000, Logical Drive Access, LUN 31, 

Logical Drive WWN <600a0b80000f5d6c0000002200000000>] 

  

Figure 20. Sample SMdevices command output (method 1)
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/dev/rdsk/c172t0d0 [Storage Subsystem DS4000, Logical Drive 

Accounting, LUN 0, Logical Drive WWN <600a0b80000f56d00000001e3eaead2b>, 

Alternate Path (Controller-A):   NotIn Use] 

  

Using PV-links:  Method 2 

If you have DS4000 controller firmware version 4.xx.xx.xx installed, use the 

following procedures to enable multipath I/O by using PV-links: 

v   Determine the preferred and alternate paths 

v   Create the logical drives and logical drive groups

Determining preferred and alternate paths 

Complete the following steps to determine the preferred and alternate paths. 

1.   Run the hot_add command from HP-UX at the shell prompt. This command 

updates any new devices that are created or added. A dump is generated. 

When the hot_add command runs, each new logical drive that is created in the 

Subsystem Management window represents a disk device to the operating 

system. 

 #hot_add 

  

2.   Run the SMdevices command. The system provides a dump similar to the 

example in Figure 21. Notice that every logical drive and logical drive access 

unit has been assigned a logical unit number (LUN). Each logical drive has two 

paths. Each DS4000 controller has one logical drive access. For example, a 

subsystem that contains two DS4000 controllers has two logical drive accesses. 

 #SMdevices 

  

 

 /dev/rdsk/c166t0d0 [Storage Subsystem DS4000, Logical Drive Accounting, LUN 0, 

 Logical Drive WWN <600a0b80000f56d00000001e3eaead2b>] 

/dev/rdsk/c166t0d1 [Storage Subsystem DS4000, Logical Drive HR, LUN 1, 

Logical Drive WWN <600a0b80000f5d6c000000273eaeae30>] 

/dev/rdsk/c166t0d2 [Storage Subsystem DS4000, Logical Drive Finance, LUN 2, 

Logical Drive WWN <600a0b80000f5d6c000000253eaeadf8>] 

/dev/rdsk/c166t0d3 [Storage Subsystem DS4000, Logical Drive Purchasing, LUN 3, 

Logical Drive WWN <600a0b80000f5d6c000000243eaeadbe>] 

/dev/rdsk/c166t0d4 [Storage Subsystem DS4000, Logical Drive Development, LUN 4, 

Logical Drive WWN <600a0b80000f56d00000001d3eaeacef>] 

/dev/rdsk/c166t3d7 [Storage Subsystem DS4000, Logical Drive Access, LUN 31, 

Logical Drive WWN <600a0b80000f56d00000001b00000000>] 

  

/dev/rdsk/c172t0d0 [Storage Subsystem DS4000, Logical Drive Accounting, LUN 0, 

Logical Drive WWN <600a0b80000f56d00000001e3eaead2b>] 

/dev/rdsk/c172t0d1 [Storage Subsystem DS4000, logical Drive HR, LUN 1, 

Logical Drive WWN <600a0b80000f5d6c000000273eaeae30>] 

/dev/rdsk/c172t0d2 [Storage Subsystem DS4000, Logical Drive Finance, LUN 2, 

Logical Drive WWN <600a0b80000f5d6c000000253eaeadf8>] 

/dev/rdsk/c172t0d3 [Storage Subsystem DS4000, Logical Drive Purchasing, LUN 3, 

Logical Drive WWN <600a0b80000f5d6c000000243eaeadbe>] 

/dev/rdsk/c172t0d4 [Storage Subsystem DS4000, Logical Drive Development, LUN 4, 

Logical Drive WWN <600a0b80000f56d00000001d3eaeacef>] 

/dev/rdsk/c172t3d7 [Storage Subsystem DS4000, Logical Drive Access, LUN 31, 

Logical Drive WWN <600a0b80000f5d6c0000002200000000>] 

  

Figure 21. Sample SMdevices command output (method 2)
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Note:  If you do not see the logical drives and logical drive accesses after 

running the hot_add and SMdevices commands, restart the HP-UX host 

by running the reboot command. 

 #reboot 

  

3.   Determine the preferred and alternate path for each logical drive by examining 

the output from the SMdevices command, as shown in the example in 

Figure 21 on page 102. 

Notice that each device is listed twice; one instance is the preferred path and 

one instance is the alternate path. Also, notice that each device has a worldwide 

name (WWN). Part of the WWN of each logical drive is unique for each 

controller in the DS4000 storage subsystem. If you examine the WWNs for the 

logical drive access in Figure 21 on page 102, you notice that they differ in only 

five digits, f56d0 and f5d6c. 

The devices in Figure 21 on page 102 are viewed through the controllers c166 

and c172. To determine the preferred path of a specific logical drive seen by the 

operating system perform the following steps: 

a.   Find the WWN for each logical drive access. In this case, Logical Drive 

Access 1 is associated with c166 and has the WWN of f56d0. 

 /dev/rdsk/c166t3d7 [Storage Subsystem DS4000, Logical Drive Access, LUN 31, 

Logical Drive WWN <600a0b80000f56d00000001b00000000>] 

  

Logical Drive Access 2 is associated with c172 and has the WWN of f5d6c: 

 /dev/rdsk/c172t3d7 [Storage Subsystem DS4000, Logical Drive Access, LUN 31, 

Logical Drive WWN <600a0b80000f5d6c0000002200000000>] 

  

b.   Identify the preferred device path name for the attached storage device by 

matching the logical drive WWN to a logical drive access WWN. In this 

case, the WWN for LUN 0 is associated with controller c166 and c172. 

Therefore, the preferred path for LUN 0 is /dev/rdsk/c166t0d0, which is 

controller c166: 

 /dev/rdsk/c166t0d0 [Storage Subsystem DS4000, Logical Drive 

Accounting, LUN 0, Logical Drive g<600a0b80000f56d00000001e3eaead2b>] 

  

The alternate path is /dev/rdsk/c172t0d0, which is controller c172: 

 /dev/rdsk/c172t0d0 [Storage Subsystem DS4000, Logical Drive 

Accounting, LUN 0, Logical Drive WWN <600a0b80000f56d00000001e3eaead2b>] 

  

c.   To keep a record for future reference, enter this path information for LUN 0 

into a matrix (similar to the one in Table 15). 

 Table 15. Sample record of logical drive preferred and alternate paths 

LUN  Logical drive name Preferred path Alternate path 

0 Accounting /dev/rdsk/c166t0d0 /dev/rdsk/c172t0d0 

1 HR /dev/rdsk/c172t0d1 /dev/rdsk/c166t0d1 

2 Finance dev/rdsk/c172t0d2 /dev/rdsk/c166t0d2 

3 Purchasing /dev/rdsk/c172t0d3 /dev/rdsk/c166t0d3 

4 Development /dev/rdsk/c166t0d4 /dev/rdsk/c172t0d4
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d.   Repeat step 3a on page 103 through step 3c on page 103 for each logical 

drive that is seen by the operating system. 

Continue to the next procedure. 

Creating volumes and volume groups 

After you have determined the preferred and alternate paths, and have recorded 

them in a matrix for future reference, perform the following steps to create volumes 

and volume groups. 

Important:  Do not use SAM for DS4000 storage configuration. If you do, you might 

get unexpected results.

Note:  The steps in this procedure refer to LUN 0 in Table 15 on page 103. 

1.   Create a physical volume and define the primary paths for the attached storage 

devices. The primary path will be the preferred path. Type the following 

command at the shell prompt: 

 #pvcreate /dev/rdsk/c166t0d0 

  

The system confirms the creation of the new physical volume. 

2.   Create volume groups.

Note:  For more information on how to create volume groups, refer to HP-UX 

documentation or to man pages. 

a.   Make a directory for volume group by typing the following commands. This 

directory must reside in the /dev directory. 

 #cd /dev 

#mkdir /vg1 

  

b.   Create the group special file in the /dev directory for the volume group by 

typing the following command: 

 #mknod /dev/vg1/group c 64 0x010000 

  

c.   Create a volume group and define physical volume names (primary link) for 

the attached storage device by typing the following command: 

 #vgcreate /dev/vg1/ /dev/dsk/c166t0d0 

  

d.   Define the secondary path name (alternate path) for the attached-storage 

device by typing the following command: 

 #vgextend vg1 /dev/dsk/c172t0d0 

  

Note:  You can also use the vgextend command to add additional storage 

devices to an existing volume group. Add the primary path first, then 

add the alternate path, as shown in the following example: 

1)   Add the primary path for LUN1. 

 #vgextend vg1 /dev/dsk/c172t0d1 
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2)   Add the secondary path for LUN1. 

 #vgextend vg1 /dev/dsk/c166t0d1 

  

3.   Create logical volumes. For more information, refer to HP-UX documentation. 

4.   Create file systems for the logical volumes. 

5.   Repeat step 1 on page 104 through step 4 to create additional volume groups. 

For more information, refer to HP-UX documentation. 

6.   Verify the primary (preferred) and secondary (alternate) paths for each device 

by typing the following command: 

 #vgdisplay -v vgname 

  

where vgname is the volume group name.

Redistributing logical drives in case of failure 

Auto Volume Transfer (AVT) is enabled, by default, on HP-UX hosts. If a failure 

occurs that initiates a controller failover, AVT redirects I/O to the available controller. 

AVT does not require manual redistribution. 

Important: If a failure occurs in a heterogeneous host environment, the HP-UX host 

with AVT enabled will automatically redistribute its LUNs when the path becomes 

available. However, you will need to manually redistribute logical drives on any host 

that does not have AVT enabled. Failure to do so will leave the subsystem in a 

Needs Attention state, because hosts that do not support AVT or have AVT disabled 

will not automatically redirect I/O to the preferred controller. In this case, Storage 

Manager Recovery Guru will indicate which host platform is associated with the 

LUN that is in a failover state. 
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Chapter  4.  Installing  and  configuring  storage  management  

software  on  Solaris  host  systems  

This chapter provides the following information for Solaris operating systems: 

v   “Installing DS4000 Storage Manager” on page 108 

v   “Configuring storage subsystems” on page 115 

v   “Creating storage partitions” on page 119 

v   “Creating direct-attached and SAN-attached configurations” on page 123 

v   “Configuring the host bus adapter cards” on page 123 

v   “Installing a failover driver on Solaris” on page 134 

v   “Verifying external storage” on page 148 

v   “Redistributing logical drives in case of failure” on page 149

Solaris system requirements 

This section lists the minimum hardware and software requirements for a Solaris 

host in a DS4000 storage subsystem that is managed by DS4000 Storage Manager 

10.10. 

Hardware requirements 

The Solaris system must be a SPARC S20 processor with: 

v   1 GB system memory 

v   CD-ROM drive 

v   Mouse or similar pointing device 

v   Ethernet network interface card 

v   2 GB available on /opt and root (or root-equivalent) privileges for installing RDAC

Software requirements 

Use the following software: 

Operating system 

Ensure that the Solaris host is running one of the following operating 

systems with the appropriate patches: 

Solaris 8 

Maintenance update 7, including the latest patch 

Solaris 9 

Maintenance update 4, including the latest patch 

Solaris 10 

Including the latest patch

Notes:  

1.   See your Solaris operating system documentation or contact your operating 

system supplier to ensure that you have the correct patches. In addition, review 

the device driver readme files for other Solaris patches that you might need. 

2.   Updated DS4000 Storage Manager readme files contain important configuration 

information that supersedes this document. To access the most recent DS4000 

Storage Manager readme file for Solaris, see “Finding the Storage Manager 

readme files online” on page 24. 

3.   Solaris 10 does not support the RDAC failover driver or JNI host bus adapters.
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Installing DS4000 Storage Manager 

The DS4000 Storage Manager software includes the following software packages: 

SMruntime (required) 

SMruntime is a Java compiler for the DS4000 Storage Manager software 

packages. SMruntime must be installed before the other packages are 

installed. 

SMesm (required with SMclient) 

SMesm is the mechanism for delivering ESM firmware, which contains a 

defined set of ESM firmware files that are used by the auto-sync 

mechanism. 

SMclient (optional) 

SMclient is Storage Manager’s graphical user interface (GUI), which you 

use to manage your storage subsystems. If you are not using your Solaris 

host as a storage management station (for example, if you are using a 

Windows management station with SMclient installed), then you do not 

need to install SMclient on your Solaris host. 

SMagent (optional) 

SMagent contains host-agent software, which you can use to manage your 

subsystems if you are using an in-band management configuration 

(managing the storage subsystems through the fibre channel I/O path to the 

host). If you are using an out-of-band management configuration, you do 

not need to install SMagent. 

SMutil (required) 

SMutil is a utility that you can use to register and map new logical drives to 

the operating system. SMutil is required on Solaris host systems.

You can install all of the DS4000 Storage Manager software packages automatically 

by using the Storage Manager installation wizard, or you can install each package 

manually. This section contains the following procedures: 

v   “Installing Storage Manager using the installation wizard” 

v   “Installing Storage Manager packages manually” on page 109 (original method)

Installing Storage Manager using the installation wizard 

The DS4000 Storage Manager installation wizard can install all of the Storage 

Manager software packages automatically. If you prefer, you can install just the 

following required packages onto your Solaris host: 

v   SMruntime 

v   SMutil

To choose the packages that you want to install, select Custom Installation during 

the installation procedure, as described in “Steps for installing Storage Manager 

using the installation wizard” on page 109. 

Installation wizard requirements 

To use the installation wizard, you must meet the following requirements: 

v   You are installing DS4000 Storage Manager 10.10. 

v   Your Solaris host has a graphics adapter card installed.

If you are installing Storage Manager 10.10 on Solaris, and your system does not 

meet the requirements for using the wizard, does not have a graphics card 

installed, or if for any reason you do not want to use the wizard to install the 
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software, you can perform the installation without a GUI by typing the sh 

<installer-package-name.bin> -i console command in the command line 

interface. You can also skip this section and install the stand-alone host software 

packages using the procedures described in “Installing Storage Manager packages 

manually.” All the packages are included with the installation CD. 

Note:  Do not install the software packages in the same server by using both the 

installation wizard and the manual installation method. 

Steps for installing Storage Manager using the installation wizard 

Complete the following steps to install the DS4000 Storage Manager software using 

the installation wizard. Adjust the steps as necessary for your specific installation. 

1.   Download the following file from the DS4000 Storage Manager CD, or from the 

DS4000 support Web site, to a directory on your system: 

SMIA-SOL-10.10.xx.xx.bin 

2.   Open the file on your system. The Storage Manager Installation wizard’s 

Introduction window opens. 

3.   Follow the instructions in each window of the wizard. When you select the 

installation type, you can choose one of the following options: 

v   Typical (Full) Installation—Installs all Storage Manager software packages 

v   Management Station—Installs SMruntime and SMclient 

v   Host—Installs SMruntime, SMagent and SMutil 

v   Custom—Allows you to select which packages you want to install

Important:  If you plan to use VERITAS DMP or Solaris MPxIO as a failover 

driver instead of RDAC, you must select Custom Installation as 

the installation type. Then, when you select the components you 

want to install, make sure that RDAC is not selected. This is a 

requirement for Solaris 10, which does not support RDAC. 

4.   Restart the system.

Result: The DS4000 Storage Manager software is installed on your system. 

Installing Storage Manager packages manually 

If you are installing Storage Manager 10.10, use the following procedures in the 

order listed to install the DS4000 Storage Manager software on a Solaris storage 

management station. 

1.   “Installing the client software” on page 110 

2.   “Installing the host software” on page 113

Note:  If you are installing Storage Manager 9.12 or higher, do not install the 

software manually. Instead, use the installation procedure that is described in 

“Installing Storage Manager using the installation wizard” on page 108. 

Prerequisites 

Before installing the client software, ensure that the following conditions are met: 

v   This is the SUN SPARCstation workstation that you have identified as the 

storage management station. 

v   This machine is running Solaris 8, 9, or 10, and meets the minimum hardware 

and software requirements described in “Solaris system requirements” on page 

107. 

v   Neither DS4000 SMruntime software nor DS4000 SMclient software is installed 

on the host, and you are ready to install them on this machine. 
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v   The DS4000 Storage Manager installation files are available in a directory on the 

system.

Installing the client software 

For the specific installation order, see Table 3 on page 5. 

Note:  The SMclient is dependent on SMruntime, which is a Java compiler for the 

SMclient. SMruntime must be installed first.

Steps for installing SMruntime software (required):   Modify these commands as 

needed for your installation. No restart is required during the client installation 

process. 

Before you begin: Visit the Web site that is listed in “Finding the Storage Manager 

readme files online” on page 24 to ensure you have the most recent version of the 

software. 

1.   Insert the Solaris installation CD in the CD-ROM drive. 

2.   Start the installation process by typing the following command: 

 pkgadd -d path/filename.pkg 

  

where path/filename is the directory path and name of the package that you 

want to install. Information about packages that can be installed in the specified 

directory is displayed on the command line. The following is an example of what 

you might see displayed. 

 The following packages are available: 

1 SMruntime 

IBM DS4000 Storage Manager 10 Runtime (sparc) 

version number Select package(s) you wish  to process (or ’all’ 

to process all Packages).  (default:all)   [?,??,q]: 

  

3.   Press Enter to select the default (all). The installation process begins. The 

following prompt is displayed: 

 This package contains scripts which will be executed with super-user 

Permission during the process of installing this package. 

Do you want to continue with the installation of <SMruntime> 

[y, n, ?] 

  

4.   Type y and press Enter. The installation process continues. When the 

SMruntime software has been successfully installed, the following message is 

displayed: 

 Installation of <SMruntime> was successful. 

  

5.   Type the following command to verify that the installation is successful: 

 # pkginfo -l SMruntime 

  

The installation is successful if the following message displays: 

 INSTDATE: date/time 

STATUS: completely installed 

  

where date/time is today’s installation date and time.

Steps for installing SMesm software (required if installing SMclient):   If you 

are using your Solaris host as a storage management station, then you must install 
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SMesm on the host. If you are using a different computer as your storage 

management station, install SMesm on that computer. 

Modify these commands as needed for your installation. No restart is required 

during the esm installation process. 

1.   Insert the Solaris installation CD in the CD-ROM drive. 

2.   Start the installation process by typing the following command: 

 # pkgadd -d path/filename.pkg 

  

where path/filename is the directory path and name of the package that you 

want to install. 

Information about packages that can be installed in the specified directory is 

displayed on the command line. The following is an example of what you might 

see displayed. 

 The following packages are available: 

  

1 SMesm                   IBM DS4000 Storage Manager 10 Esm 

                              (sparc) version number 

  

Select package(s) you wish to process (or ’all’ to process all 

packages). (default:all)  [?,??,q]: 

  

3.   Press Enter to select the default (all). 

The installation process begins. The following prompt is displayed: 

 This package contains scripts which will be executed with super-user 

permission during the process of installing this package. 

  

Do you want to continue with the installation of <SMesm> 

  

[y, n, ?] 

  

4.   Type y and press Enter. 

The installation process continues. When the SMesm software has been 

successfully installed, the following message is displayed: 

 Installation of <SMesm> was successful. 

  

5.   Type the following command to verify that the installation is successful: 

 # pkginfo -l SMesm 

  

The installation is successful if the following message displays: 

 INSTDATE: date/time 

STATUS: completely installed 

  

where date/time is today’s installation date and time. 

Result: The esm software installation on this Solaris storage management station is 

complete. Remove the installation CD from the CD-ROM drive. 

Note:  To ensure redundancy in a cluster environment, you must install the esm 

software on at least one additional storage management station or cluster 

server. To install the esm software on additional storage management 
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stations, repeat the installation procedure. Use the corresponding installation 

profile for each storage management station as a guide. 

To find out which cluster services are currently supported with DS4000 on 

Solaris operating systems, see the latest DS4000 interoperability matrix at 

the following Web page: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Steps for installing SMclient software (optional):   If you are using your Solaris 

host as a storage management station, then you must install SMclient on the host. 

If you are using a different computer as your storage management station, install 

SMclient on that computer. 

Modify these commands as needed for your installation. No restart is required 

during the client installation process. 

1.   Insert the Solaris installation CD in the CD-ROM drive. 

2.   Start the installation process by typing the following command: 

 # pkgadd -d path/filename.pkg 

  

where path/filename is the directory path and name of the package that you 

want to install. 

Information about packages that can be installed in the specified directory is 

displayed on the command line. The following is an example of what you might 

see displayed. 

 The following packages are available: 

  

1 SMclient                   IBM DS4000 Storage Manager 10 Client 

                              (sparc) version number 

  

Select package(s) you wish to process (or ’all’ to process all 

packages). (default:all)  [?,??,q]: 

  

3.   Press Enter to select the default (all). 

The installation process begins. The following prompt is displayed: 

 This package contains scripts which will be executed with super-user 

permission during the process of installing this package. 

  

Do you want to continue with the installation of <SMclient> 

  

[y, n, ?] 

  

4.   Type y and press Enter. 

The installation process continues. When the SMclient software has been 

successfully installed, the following message is displayed: 

 Installation of <SMclient> was successful. 

  

5.   Type the following command to verify that the installation is successful: 

 # pkginfo -l SMclient 

  

The installation is successful if the following message displays: 
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INSTDATE: date/time 

STATUS: completely installed 

  

where date/time is today’s installation date and time. 

Result: The client software installation on this Solaris storage management station 

is complete. Remove the installation CD from the CD-ROM drive. 

Note:  To ensure redundancy in a cluster environment, you must install the client 

software on at least one additional storage management station or cluster 

server. To install the client software on additional storage management 

stations, repeat the installation procedure. Use the corresponding installation 

profile for each storage management station as a guide. 

To find out which cluster services are currently supported with DS4000 on 

Solaris operating systems, see the latest DS4000 interoperability matrix at 

the following Web page: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Installing the host software 

If you are installing the optional SMagent, install the host software in the following 

order. If you are not installing SMagent, then SMutil is the only DS4000 Storage 

Manager host software that you need to install. 

v   DS4000 SMagent software (optional—for in-band management only) 

v   DS4000 SMutil software (required)

Prerequisites:   Before installing the host software, ensure that the following 

conditions are met: 

v   This is the Sun SPARCstation workstation that you have identified as the storage 

management station. 

v   This machine is running Solaris 8, 9 or 10, and meets the minimum hardware 

and software requirements described in Appendix B, “JNI and QLogic host bus 

adapter settings,” on page 223. 

v   The SMagent and SMutil software packages are not installed, and you are ready 

to install them on this machine. 

v   RDAC or DMP is not installed.

Note:  SMagent is not supported with DS4000 controller firmware version 

05.42.xx.xx.

Steps for installing SMagent software (optional):   SMagent is required for 

in-band management only. It is not required for out-of-band management. 

Complete the following steps to install SMagent: 

1.   Type the following command to start installing the SMagent package: 

 pkgadd -d path/filename.pkg 

  

where path/filename is the directory path and name of the package that you 

want to install. 

The installation process begins. 

Information about packages that can be installed in the specified directory is 

displayed on the command line. The following is an example of what you might 

see displayed. 
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The following packages are available: 

  

1 SMagent                     IBM DS4000 Storage Manager 10 Agent 

                              (sparc) version number 

  

Select package(s) you wish to process (or ’all’ to process all 

packages). (default:all)  [?,??,q]: 

  

2.   Press Enter to select the default (all). 

The installation process begins. The following prompt is displayed: 

 This package contains scripts which will be executed with super-user 

Permission during the process of installing this package. 

Do you want to continue with the installation of <SMagent> 

[y n, ?] 

  

3.   Type y and press Enter. 

The installation process continues. When the SMagent software has been 

successfully installed, the following message is displayed: 

 Installation of <SMagent> was successful. 

  

4.   Type the following command to verify that the installation is successful: 

 # pkginfo -l SMagent 

  

The installation is successful if the following message displays: 

 INSTDATE: date/time 

STATUS: completely installed 

  

where date/time is today’s installation date and time. 

5.   Remove the installation CD from the CD-ROM drive.

Steps for installing SMutil software (required):   Complete the following steps to 

install SMutil: 

1.    Type the following command to start installing the SMutil package: 

 pkgadd -d path/filename.pkg 

  

where path/filename is the directory path and name of the package that you 

want to install. 

The installation process begins. 

When the SMutil has been successfully installed, the following message is 

displayed: 

 Installation of <SMutil> was successful. 

  

2.   Type the following command to verify that the installation is successful: 

 # pkginfo -l SMutil 

  

The installation is successful if the following message displays: 

 INSTDATE: date/time 

STATUS: completely installed 

  

where date/time is today’s installation date and time.

 

114 DS4000 Storage Manager Version 10 Installation and Support Guide for AIX, HP-UX, Solaris, and Linux on POWER



Result: You have finished installing the host software on this Solaris host. 

Configuring storage subsystems 

To configure DS4000 Storage Manager for a Solaris system, complete the following 

procedures in the order that they are described in this section: 

v   Add storage subsystems to DS4000 SMclient 

v   Update NVSRAM and DS4000 firmware (if necessary)

Before you begin: Read the following information: 

v   All DS4000 storage subsystems have an access logical drive set to LUN 31.

Note:   Do not delete the access LUN or the access logical drive. 

v   If you have purchased a Storage Partitioning premium feature, ensure that the 

feature is enabled. See “Enabling premium features” on page 18 for more 

information. 

v   Versions of controller firmware and NVSRAM that are provided with this product 

might be later releases than those described in this document. To ensure that 

you have the latest versions of the firmware and the NVSRAM, read the Storage 

Manager readme file for Solaris that is provided with the product. See “Finding 

the Storage Manager readme files online” on page 24.

Note:  If you do not have the latest versions of controller firmware and NVSRAM, 

download them and complete the procedure described in “Upgrading 

controller firmware and NVSRAM.” If the version numbers are current, you 

can skip that procedure.

Adding storage subsystems to SMclient 

Complete the following steps to specify the IP addresses of the controllers: 

1.   In the Enterprise Management window, click Edit → Add Storage Subsystem. 

2.   In the Add Storage Subsystem window, type the IP addresses of each controller 

in the storage subsystem, and click Add. The name of the storage subsystem 

displays in the Enterprise Management window.

Important:  Failure to add both controllers results in a partially-managed 

system.

Upgrading controller firmware and NVSRAM 

The procedures in this section describe how to download and install DS4000 

controller firmware and NVSRAM.

Note:  If you are upgrading a DS4800, DS4700, or a DS4200 storage subsystem to 

controller firmware version 07.10.xx.xx, see Appendix D, “Using the IBM 

System Storage DS4000 Controller Firmware Upgrade Tool,” on page 235. 

Overview 

Read the information in the following sections before you begin the download 

procedures: 

v   “Using concurrent download” on page 116 

v   “Using traditional or staged download” on page 116
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Using concurrent download:   Depending on your system’s current firmware 

version, you might be able to use concurrent download. Concurrent download is a 

method of downloading firmware to the controllers that does not require you to stop 

I/O to the controllers during the process.

Note:  Some controller firmware versions might not support concurrent download. 

See the latest Storage Manager readme file for Solaris to find out which 

firmware versions support concurrent download. 

Using traditional or staged download:   There are two methods for downloading 

the firmware to the controllers: 

v   “Traditional download” 

v   “Staged download”

Traditional download:   The traditional download process takes significantly longer 

and must be done in one phase, rather than in two phases as with the staged 

controller firmware download. Therefore the preferred method of controller firmware 

download is the staged controller firmware download. 

Staged download:   With staged firmware download, the download process occurs 

in two distinct phases: firmware transfer and firmware activation. You can perform 

the time-consuming task of loading the firmware online so that it is functionally 

transparent to the application. You can then defer the activation of the loaded 

firmware to a convenient time. 

Some reasons for activating firmware files at a later time include the following: 

v   Time of day—Activating can take a long time, so you might want to wait until I/O 

loads are lighter because the controllers will go offline briefly to activate the new 

firmware. 

v   Type of package—You might want to test the new firmware package on one 

storage subsystem before activating it on other storage subsystems. 

v   Multiple controllers—You can download controller firmware from the storage 

management software to all storage subsystem controllers for later activation.

Notes:  

1.   You cannot use staged download to upgrade DS4000 controller firmware 

version 05.xx.xx.xx to version 6.2x.xx.xx or version 06.xx to version 07.10. You 

can only use staged download if the DS4000 controller firmware version is 

already 6.1x.xx.xx, and you are downloading another version of 6.1x.xx.xx 

firmware or higher. 

2.   Staged controller firmware download is not supported on DS4400 storage 

subsystems. 

Important: Do not perform other storage management tasks, such as creating or 

deleting logical drives, reconstructing arrays, and so on, while downloading the 

DS4000 storage subsystem controller firmware. It is recommended that you close 

all storage management sessions (except for the session that you use to upgrade 

the firmware) to the DS4000 storage subsystem that you plan to update. Also, the 

subsystem must be in Optimal state prior to loading firmware or NVSRAM. 

Preparing for firmware or NVSRAM download 

To prepare for download, review and complete all of the steps in this section before 

you start the download procedures. 
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Check current versions of controller firmware and NVSRAM:   Versions of 

controller firmware and NVSRAM that are provided with this product might be later 

releases than those described in this document. 

To check the controller firmware and NVSRAM versions that are currently installed 

on your system, complete the following steps: 

1.   In the Subsystem Management window, click Storage Subsystem → View 

Profile. The Storage Subsystem Profile window displays. 

2.   In the Storage Subsystem Profile window, click the Controllers tab to view the 

current versions of controller firmware and NVSRAM. 

3.   Click Close to close the Storage Subsystem Profile window. 

4.   To find whether the versions of controller firmware and NVSRAM that are 

currently on your storage subsystem are the latest versions, read the Storage 

Manager readme file for Solaris. See “Finding the Storage Manager readme 

files online” on page 24. 

5.   If you find that you do not have the latest versions of the firmware and 

NVSRAM, download the correct versions from this Web site to a directory on 

your system, then follow the preparation and upgrade procedures that are 

described in this section.

Save the storage subsystem configuration:   Saving the storage subsystem 

configuration to a script file is necessary in order to restore the configuration in the 

event of a catastrophic failure. 

Attention:  Do not use this option if the storage subsystem is undergoing an 

operation that changes any configuration settings. (If any logical drive 

listed in the Logical View of the Subsystem Management window has a 

clock icon, then a configuration change is occurring, and you must wait 

to save the configuration.) 

You can also save the storage subsystem profile, by selecting Storage 

Subsystem → View Profile in the Subsystem Management window, and 

clicking Save As. Then, in the Save Profile window, select the sections 

of the profile that you want to save, specify a name and location for the 

text file, and click Save. 

Save the storage subsystem configuration by completing the following steps: 

1.   In the Subsystem Management window, click Storage Subsystem → 

Configuration → Save. The Save Configuration window displays. 

2.   In the Save Configuration window, select the elements of the configuration that 

you want to save, and click Yes. A save dialog displays. 

3.   In the save dialog, specify a name for the script file and select its location.

Notes:  

a.   The .cfg extension is used by default for the script file if you do not specify a 

file extension. 

b.   Do not store your DS4000 Storage Subsystem configuration script file in the 

same location as the logical drives that are defined on your DS4000 Storage 

Subsystem. If you do, and the logical drives fail during the subsequent 

migration, you will lose data.

4.   Click Save. The Configuration Saved window displays. 

5.   Review the information in the Configuration Saved window, then click OK to 

return to the Subsystem Management window.
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Determine whether you need to stop I/O:   You can use concurrent download 

only if you are upgrading from one version of controller firmware to a later release 

of the same version. 

Example:  For example, if you are upgrading from 06.10.xx.xx to 6.12.xx.xx, you 

can use concurrent download. However, if you are upgrading from 

05.xx.xx.xx to 06.1x.xx.xx, you cannot use concurrent download. 

In addition, before you upgrade controller firmware, ensure that concurrent 

download is supported with your system’s current firmware versions, using the 

information that is listed in Table 16.

Notes:  

1.   Some controller firmware versions might not support concurrent download. See 

the latest Storage Manager readme file for Solaris to find out which firmware 

versions support concurrent download. 

2.   Single-controller (SCU) storage subsystem models do not support concurrent 

download.

 Table 16. Firmware versions that support concurrent download (Solaris) 

DS4000 storage subsystem: Controller firmware version: 

DS4100 06.10.xx.xx, 06.12.xx.xx 

DS4200 06.16.88.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4300 base and Turbo 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4400 06.10.xx.xx. 06.12.xx.xx 

DS4500 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4700 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4800 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

All other DS4000 storage subsystems 05.30.xx.xx, 06.10.xx.xx, 06.12.xx.xx
  

Steps for upgrading the controller firmware 

Complete the following steps to install a new firmware version on the controllers: 

 1.   Download the correct version of the firmware from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 117. 

Place the file in a designated directory on the host system. 

 2.   Check your system’s current firmware versions to determine whether you need 

to stop I/O before upgrading the controller firmware, using the information that 

is listed in Table 16 and in the latest Storage Manager readme file for Solaris. 

Attention: If you do not have the latest firmware levels for concurrent 

download, you must stop I/O to the controllers before you upgrade the 

controller firmware. 

 3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

 4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller Firmware. The Download Firmware window displays. 

 5.   Click Browse to select the firmware file that you previously downloaded to a 

directory on the host. 

 6.   If you want to perform a staged firmware download, select the check box next 

to ″Transfer files but don’t activate them (activate later).″ If you want to perform 

a traditional firmware download, do not select the check box, and the firmware 

will load immediately. 
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7.   Click OK. The Confirm Download window displays. 

 8.   Click Yes to start the download. 

 9.   Verify that the firmware was successfully installed. 

10.   After you verify that the firmware was successfully installed, then you can 

restart I/O to the subsystem.

Steps for upgrading the NVSRAM 

Complete the following steps to install a new version of NVSRAM on the controllers. 

NVSRAM will be activated immediately. 

1.   Download the correct NVSRAM version from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 117. 

Place the file in a designated directory on the host system. 

2.   Stop I/O. 

3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller NVSRAM. The Download NVSRAM window displays. 

5.   Click Browse to select the NVSRAM file that you previously downloaded to a 

directory on the host. 

6.   Click OK. The Confirm Download window displays. 

7.   Click Yes to start the download. 

8.   Verify that the NVSRAM was successfully installed. 

9.   Start I/O.

Creating storage partitions 

To create storage partitions, you must complete the following procedures in this 

section: 

v   “Steps for defining a Solaris host group” on page 120 

v   “Steps for defining the host and host port” on page 120 

v   “Mapping LUNs to a storage partition” on page 121

Storage partitioning overview 

When you begin to create your storage partitions using the procedures in this 

section, be aware of the following information: 

v   If your subsystem is running controller firmware 06.1x.xx.xx or higher, the 

Storage Manager task assistant provides a Storage Partitioning wizard that you 

can use to define your host and host ports, and map LUNs to the storage 

partitions. If your subsystem is running controller firmware 05.xx.xx.xx, you 

cannot use the wizard. Both types of procedures are documented in this section. 

v   The procedures in this section assume that you have already created a physical 

connection between the host and the storage subsystem controllers, and that you 

have also connected and zoned the SAN switch (if any). If you have not 

completed these connections, please note that Storage Manager will not be able 

to list the WWPNs of the HBAs during these procedures. In this case you will 

need to type the WWPNs into the appropriate fields during the steps for defining 

a host and host ports. 

v   Create the Solaris host group at the storage subsystem level. Do not create host 

groups at the default group level. 

Exceptions: If you are running a DS4300 configuration without partitioning 

enabled, you can use the default host group.
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Steps for defining a Solaris host group 

A host group is an entity in the Storage Partitioning topology that defines a logical 

collection of host computers that require shared access to one or more logical 

drives. You can grant individual hosts in a defined host group access to storage 

partitions, independently of the host group. 

Complete the following steps to define a host group: 

1.   Click the Mappings View tab on the Subsystem Management window. 

2.   In the Topology section of the Mappings window, highlight the name of the 

storage subsystem, and click Mappings → Define → Host Group.

Note:  Make sure that the storage subsystem is highlighted in the left panel of 

the Subsystem Management window. Do not highlight Undefined 

Mappings. 

3.   Type the name of the new host group (for example, Solaris). Click Add, and 

then click Close.

Steps for defining the host and host port 

Complete the steps that are appropriate for your storage subsystem controller 

firmware type. 

v   “Controller firmware 06.12.xx.xx or higher” 

v   “Controller firmware 05.xx.xx.xx” on page 121

Controller firmware 06.12.xx.xx or higher 

If your subsystem has controller firmware 06.12.xx.xx or higher installed, complete 

the following steps to define the host and host ports by using the Define a host 

and host ports wizard: 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, right-click the new host group and select Define Host. The 

Introduction (Define Host) window opens. 

2.   Click Next. The Specify Host Name/HBA Attribute (Define Host) window 

opens. 

3.   Type the host name in the Specify Host Name/HBA Attribute (Define Host) 

window. In the left panel, select the correct WWPN of the HBA host port. Click 

Add.

Note:  If you there is not yet a physical connection between the host and the 

DS4000 controllers, as described in the “Storage partitioning overview” 

on page 119, the WWPNs will not display. In this case, you must type the 

correct WWPN into the field. 

4.   You must now provide an alias name for the host port. Click Edit, then type an 

alias name (for example, Port1). 

5.   On configurations with two or more HBAs, repeat step 3 and step 4 for each 

host port that you need to define, then proceed to step 6. 

6.   Click Next. The Specify Host Type window opens. 

7.   Select the correct host type, Solaris or Solaris with DMP, from the drop down 

menu and click Next. The Review window opens.

Note:  Failure to change the host type from the default will cause undesired 

results. If you are using RDAC or MPxIO as your failover driver, select 

the Solaris host type. If you are using DMP, select Solaris with DMP.
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8.   Review the information for accuracy, and make any necessary changes. Then 

click Next.

Recommendation:  Record the name of each host port along with the WWPN 

of its corresponding HBA, and save the information to a file 

for future reference. 

9.   After Storage Manager finishes defining the host and host ports, a dialog 

window opens. If you need to define another host, select Define another host. 

To finish, click Exit. The wizard closes.

Controller firmware 05.xx.xx.xx 

If your subsystem has controller firmware 05.xx.xx.xx installed, complete the 

following steps to define a host and host ports.

Note:  IBM recommends upgrading your controllers to the latest controller firmware 

that is available for your storage subsystem. 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, highlight the new host group and click Mappings → Define → Host. 

2.   Define the new host. Type the name of the Solaris host to which the storage 

subsystem is attached. 

a.   Click Add, and then click Close. 

b.   Highlight the host that you just added, then right-click and select Define 

Host Port. 

c.   Type or select the desired host port for the first HBA, and then change the 

host type to Solaris or Solaris with DMP. Click Add.

Note:  Failure to change the host type from the default will cause undesired 

results. If you are using RDAC or MPxIO as your failover driver, 

select the Solaris host type. If you are using DMP, select Solaris 

with DMP. 

d.   If you are configuring additional HBAs to this partition, choose the host port 

for the next HBA and click Add, and then click Close.

Recommendation:  Before closing the window, record the name of each 

host port along with the WWPN of its corresponding 

HBA, and save the information to a file for future 

reference.

Mapping LUNs to a storage partition 

This section contains the following procedures: 

v   “Mapping LUNs to a new partition” 

v   “Adding LUNs to an existing partition” on page 122

Mapping LUNs to a new partition 

When mapping LUNs for the first time to a newly-created partition, complete the 

procedure in this section that is appropriate to your storage subsystem controller 

firmware type. 

v   “Controller firmware 06.12.xx.xx” on page 122 

v   “Controller firmware 05.xx.xx.xx” on page 122

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition. 
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Controller firmware 06.12.xx.xx:   When mapping LUNs for the first time to a 

newly-created partition, complete the following steps to map LUNs to the partition. 

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition.

Important::  If your subsystem is running controller firmware 06.12.xx.xx or higher, 

you can use the Storage Partitioning wizard feature of the Storage 

Manager task assistant, instead of this procedure, to map LUNs to a 

new storage partition. 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Storage Partitioning. The Define Storage Partitioning 

window opens. 

3.   In the Define Storage Partitioning window, select Host, then click Next. 

4.   Select the logical drive by name, on the right side of the window. 

5.   Accept the default LUN ID, or change it, then click Add. 

6.   Repeat step 5 for each LUN that you want to map to the partition.

Controller firmware 05.xx.xx.xx:   Complete the following steps to map LUNs to a 

new partition: 

1.   In the Topology section of the Mappings view of the Subsystem Management 

window, right-click the host on which you want to map LUNs, and select Define 

Storage Partitioning. The Define Storage Partitioning window opens. 

2.   In the Define Storage Partitioning window, select Host, then click Next. 

3.   Select the logical drive by name, on the right side of the window. 

4.   Accept the default LUN ID, or change it, then click Add. 

5.   Repeat step 4 for each LUN that you want to map to the partition.

Adding LUNs to an existing partition 

When adding LUNs to an existing partition, complete the following steps to map the 

new LUNs to the partition. 

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition. 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Additional Mappings. The Define Additional Mapping 

window opens. 

3.   In the Define Additional Mapping window, select the following options, and then 

click Add: 

v   Host group or host 

v   Logical unit number (LUN)(0-255) 

v   Logical drive

Repeat these steps for each LUN that you want to add to the partition. 
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Creating direct-attached and SAN-attached configurations 

DS4000 Storage Manager supports IBM DS4000 Storage Subsystems in 

direct-attached Solaris configurations or in a SAN environment through switches in 

Solaris configurations. 

Creating a direct-attached configuration 

In a direct-attached configuration, one or two Solaris servers can be connected to 

DS4000 storage subsystems. 

Requirements: 

v   Two-server DS4400 or DS4500 configurations require four host-side minihubs, 

each with exactly one fibre channel connection from each HBA to a minihub.

Note:  DS4100, DS4200, DS4300, DS4700, and DS4800 storage subsystems do 

not have minihubs. 

v   No external hubs can be used.

Complete the following steps to set up a direct-attached configuration: 

1.   Connect the HBAs to each controller or minihub port of the DS4000 storage 

subsystem. 

2.   Configure and verify the configuration.

Creating a SAN-attached configuration 

Use the following procedure to create a SAN-attached configuration. 

Requirements: 

v   Multiple HBAs within the same server must be isolated from each other if they 

are connected to the same switch that is connected to the same DS4000 

controller port. 

v   Each HBA and controller port must be in its own fabric zone, if they are 

connecting through a single switch, such as a 2109-F16. 

See the documentation provided by the switch manufacturer for more information 

about zoning. Multiple DS4000 devices can be configured to the same set of 

HBAs through a fibre channel switch.

Complete the following steps to set up a SAN-attached configuration: 

1.   Connect the HBAs to the switch or switches. 

2.   Connect the DS4000 storage subsystems to the switch or switches. 

3.   Set the required zones on the fibre channel switch or switches, if applicable. 

4.   Configure and verify the configuration.

Note:  For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245. 

Configuring the host bus adapter cards 

Before you can install the failover driver, you must install the HBA driver package 

and modify the configuration file settings using the following procedures. 

v   JNI 

–   “Installing the JNI adapter driver package” on page 124 
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–   “Modifying the HBA settings and binding the HBAs” on page 125 

(SAN-attached only) 

Note:  JNI host bus adapters are supported only on Solaris 8 and 9. They are 

not supported on Solaris 10. 

v   QLogic 

–   “Installing the QLogic adapter driver package” on page 132 

–   “Modifying the QLogic HBA settings” on page 134

v    Emulex 

–   “Changing the Emulex configuration files” on page 132

Note:  Find the latest information about operating system and HBA support, 

clustering support, storage area network (SAN) fabric support, and DS4000 

Storage Manager feature support: 

http://www-1.ibm.com/servers/storage/support/fastt/index.html 

Installing the JNI adapter driver package 

The procedures for installing the JNI adapter driver package and modifying the JNI 

HBA settings both refer to Table 17. 

 Table 17. JNI  model numbers and configuration files 

JNI  HBA  model numbers Configuration files 

FC64-1063-N /kernel/drv/fcaw.conf 

FCI-1063-N /kernel/drv/fca-pci.conf 

FCE2-1063, FCE2-1063, FCE-6410, 

FCE2-6412 

/kernel/drv/jnic.conf 

FCE-1473, FCE2-1473, FCE-6412 (2 GB), 

FCE-6460 

/kernel/drv/jnic146x.conf

  

Before you begin: 

1.   Ensure that the JNI HBAs have been installed and attached directly to the 

controllers or to a SAN fabric switch. 

2.   If attached to SAN fabric switch, ensure that the zones for the DS4000 storage 

subsystem have been created and enabled. 

Notes:  

a.   All fabric switches must be zoned in such a way that a single HBA can 

access only one controller per storage array. 

b.   For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245. 

c.   JNI host bus adapters are supported only on Solaris 8 and 9. They are not 

supported on Solaris 10.

3.   In the Storage Manager readme file for Solaris, identify the correct driver 

packages for the installed HBAs. (See “Finding the Storage Manager readme 

files online” on page 24.)

Complete the following steps to install the JNI adapter driver package: 

1.   Download the most current HBA driver package, as listed in the Storage 

Manager readme file for Solaris, from the following Web site: 

http://www.amcc.com/drivers/notice.html 
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2.   Run the following command to install the JNI adapter driver package: 

 # pkgadd -d adapter_driver_package 

  

where adapter_driver_package is the name of the adapter driver package that 

you want to install, as in the following example: 

 # pkgadd -d JNIC146x.pkg 

  

3.   Run the following command to verify that the JNI adapter drive package is 

installed: 

 # pkginfo adapter_driver_package 

  

where adapter_driver_package is the name of the adapter driver package that 

you installed, as in the following example: 

 # pkginfo -l JNIC146x.pkg 

  

4.   Type the following command to reboot the Solaris host: 

 # shutdown  -g0  -y  -i6 

  

Modifying the HBA settings and binding the HBAs 

The loop settings in the JNI configuration file are set by default to private loop for 

direct-attach configurations. For a SAN-attached configuration that uses a fabric 

switch, modify the loop settings to bind the HBAs to the DS4000 storage controller 

before you install the failover driver on the host. 

This section contains the following procedures: 

v   “Modifying the JNI HBA settings for McData, Cisco, CNT, and IBM SAN 1 GB 

switches” 

v   “Modifying the JNI HBA settings for a IBM SAN 2 GB switch” on page 128

Attention: If you have a direct-attached configuration, skip this section and proceed 

to “Installing the RDAC failover driver” on page 142 or “Installing the DMP failover 

driver” on page 144. You do not need to modify JNI HBA settings if you have a 

direct-attached configuration. 

Modifying the JNI HBA settings for McData, Cisco, CNT, and IBM 

SAN 1 GB switches 

Before you begin: Table 17 on page 124 lists the configuration file for each JNI 

adapter driver package. Also, some of the steps in these procedures refer to 

Appendix G, “DS4000 Diagnostic Data Capture (DDC),” on page 247. 

Complete the following procedures to modify the JNI HBA settings. 

Modifying the loop settings:  

1.   Run the following commands. 

 # cd /kernel/drv 

# vi JNI_configuration_file 

  

where JNI_configuration_file is the JNI configuration file whose HBA settings 

you want to modify, as in the following example: 
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# cd /kernel/drv 

# vi jnic146x.conf 

  

2.   In the vi Editor, uncomment and modify the loop attributes using the information 

that is listed in Appendix G, “DS4000 Diagnostic Data Capture (DDC),” on page 

247. 

3.   Run the following command to save changes made to the JNI configuration file. 

 # :wq 

  

4.   Run the following command to reboot the Solaris host. 

 # shutdown  -g0  -y  -i6 

  

Gathering the binding information:  

1.   After the host reboots, run the following commands to gather binding information 

in the messages log. 

 # cd /var/adm 

# more messages 

  

The messages log displays, as in the following example: 

 Jul 18 14:33:50 sunburn jnic146x: [ID 550325 kern.notice] jnic146x0: 

Hba: JNI,FCR     Model: FCX2-6562 

Jul 18 14:33:50 sunburn jnic146x: [ID 277434 kern.notice] jnic146x0: 

FCode: Version 3.8.9 [BAFA] 

Jul 18 14:33:50 sunburn jnic146x: [ID 188160 kern.notice] jnic146x0: 

IRQ: 1  Channel: 1 

Jul 18 14:33:50 sunburn jnic146x: [ID 428106 kern.notice] jnic146x0: 

SubVend: 1242  Sub: 6562  Rev: b100  Vend: 124 2  Dev: 1560 

Jul 18 14:33:50 sunburn jnic146x: [ID 904290 kern.notice] jnic146x0: 

WWNN: 1000000173008A2E  WWPN: 2000000173008A2E 

Jul 18 14:33:51 sunburn jnic146x: [ID 695386 kern.notice] jnic146x0: 

Auto-negotiating link speed 

Jul 18 14:33:51 sunburn jnic146x: [ID 873028 kern.notice] jnic146x0: 

Configured as Private Loop port 

Jul 18 14:33:52 sunburn jnic146x: [ID 245684 kern.notice] jnic146x0: 

JNIC v5.2.3 (03042900) 

  

Jul 18 14:33:50 sunburn jnic146x: [ID 550325 kern.notice] jnic146x1: 

Hba: JNI,FCR     Model: FCX2-6562 

Jul 18 14:33:50 sunburn jnic146x: [ID 277434 kern.notice] jnic146x1: 

FCode: Version 3.8.9 [BAFA] 

Jul 18 14:33:50 sunburn jnic146x: [ID 188160 kern.notice] jnic146x1: 

IRQ: 1  Channel: 1 

Jul 18 14:33:50 sunburn jnic146x: [ID 428106 kern.notice] jnic146x1: 

SubVend: 1242  Sub: 6562  Rev: b100  Vend: 124 2  Dev: 1560 

Jul 18 14:33:50 sunburn jnic146x: [ID 904290 kern.notice] jnic146x1: 

WWNN: 1000000173009A2E  WWPN: 2000000173009A2E 

Jul 18 14:33:51 sunburn jnic146x: [ID 695386 kern.notice] jnic146x1: 

Auto-negotiating link speed 

Jul 18 14:33:51 sunburn jnic146x: [ID 873028 kern.notice] jnic146x1: 

Configured as Private Loop port 

Jul 18 14:33:52 sunburn jnic146x: [ID 245684 kern.notice] jnic146x1: 

JNIC v5.2.3 (03042900) 

  

2.   Search the messages log for the most recent HBA information. You can do this 

with a backwards search for the installed HBAs. 
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# /SunOS 

  

3.   Record the following information about the installed HBAs: 

v   The JNI driver instances 

v   The WWPNs

For example, for the output listed above, you would record the following 

information: 

 JNI  driver instance WWPN  

jnic146x0 2000000173008A2E 

jnic146x1 2000000173009A2E
  

After you finish gathering the binding information, continue to the next procedure, 

“Binding the HBAs to storage controllers.” 

Binding the HBAs to storage controllers:   The examples in this procedure 

assume that you are binding two JNIC FCE-6460 HBAs to the DS4000 controllers. 

Adjust the steps for your specific configuration. 

1.    Run the following commands to open the JNI configuration file. 

 # cd /kernel/drv 

# vi JNI_configuration_file 

  

where JNI_configuration_file is the name of the JNI configuration file of the HBA 

that you want to modify. 

For example, the following commands open the jnic146x.conf file. 

 # cd /kernel/drv 

# vi jnic146x.conf 

  

2.   In the file, search for a section called Configuration parameters for target to 

FC device mappings, as shown in the following example: 
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############################################################################### 

# 

# Configuration parameters for target to FC device mapping: 

# 

#    targetX_hba, 

#    targetX_lunY_hba, 

#    targetX_wwnn, 

#    targetX_wwpn, 

#    targetX_port, 

# 

# Type: string 

# Default: 

# 

# Example usage: Replace the ’x’ characters with actual WWNN, WWPN, or port ID. 

# 

# target0_hba      = "jnic146x0"; 

# target0_lun0_hba = "jnic146x0"; 

# target0_wwnn     = "xxxxxxxxxxxxxxxx"; 

# target0_wwpn     = "xxxxxxxxxxxxxxxx"; 

# target0_port     = "xxxxxx"; 

# jnic146x0-target0_lun0_hba="jnic146x0"; 

# jnic146x0-target0_wwnn="xxxxxxxxxxxxxxxx"; 

  

  

  

# Example usage: Replace the ’x’ characters with actual WWNN, WWPN, or port ID. 

# 

# target0_hba      = "jnic146x0"; 

# target0_lun0_hba = "jnic146x0"; 

# target0_wwnn     = "xxxxxxxxxxxxxxxx"; 

# target0_wwpn     = "xxxxxxxxxxxxxxxx"; 

# target0_port     = "xxxxxx"; 

# jnic146x0-target0_lun0_hba="jnic146x0"; 

# jnic146x0-target0_wwnn="xxxxxxxxxxxxxxxx"; 

  

3.   Using the information that you recorded in the previous procedure, “Gathering 

the binding information” on page 126, add the following parameters to the file 

for each HBA: 

v   Targetx_hba = JNI driver instance 

v   Targetx_wwpn = Controller WWPN

For example: 

 Target0_hba = jnic146x0 

Target0_wwpn = 2000000173008A2E 

  

Target1_hba = jnic146x1 

Target1_wwpn = 2000000173009A2E 

  

4.   Run the following command to save the changes to the JNI configuration file. 

 # :wq 

  

5.   Run the following command to reboot the Solaris host. 

 # shutdown  -g0  -y  -i6 

  

Modifying the JNI HBA settings for a IBM SAN 2 GB switch 

If you are using a IBM SAN 2 GB switch, you need to force the HBA (FCC-6460, 

FCE-1473, or FCE2-1473 operating in 2 GB mode) to be a public loop device. 
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If you are using any other switch, see “Modifying the JNI HBA settings for McData, 

Cisco, CNT, and IBM SAN 1 GB switches” on page 125 for the correct modification 

procedures. 

Complete the following procedures to modify the JNI HBA settings. 

Gathering the binding information:  

1.   Open the /var/adm/messages file by typing the following command: 

 # more /var/adm/messages 

  

2.   Perform a backwards search of the /var/adm/messages file by typing the 

following command: 

 # /SunOS 

  

3.   Look for the HBAs in the /var/adm/messages file. For example, you might see 

the following information in the /var/adm/messages file: 

 May  6 10:02:11 solar unix: jnic146x0: Port 011000 

(WWN 200200a0b80f478e:200300a0b80f478f) online. 

May  6 10:02:11 solar unix: jnic146x3: Port 610300 

(WWN 200200a0b80f478e:200200a0b80f478f) online. 

  

4.   Record the following information about the installed HBAs: 

v   The JNI driver instances 

v   The WWPNs

For example, for the output listed above, you would record the following 

information: 

 JNI  driver instance WWPN  

jnic146x0 200300a0ba0f478F 

jnic146x3 200200a0ba0f478F
  

5.   Record the WWPN for each FCE-6460-N adapter that is installed on the host. In 

this example, the WWPN is 200300a0ba0f478F for an adapter on target 0, and 

would be 200200a0ba0f478F for an adapter on target 3: 

Attention: In the messages file, notice that each adapter has a network port 

and a port. Do not use the WWPN for the network port; only use the WWPN for 

the port.

Opening the JNI configuration file:   The examples in this procedure assume that 

you are binding two JNIC FCE-6460 HBAs to the controllers. 

Before you begin: See Appendix G, “DS4000 Diagnostic Data Capture (DDC),” on 

page 247 and modify settings accordingly. 

1.   Type the following command: 

 vi /kernel/drv/jnic146x.conf 

  

2.   In the file, look for the section titled Parameters: FcLoopEnabled and 

FcFabricEnabled. Highlight and copy the following text: 

 

  -jnic 146x0-FcLoopEnabled=1; 

  -jnic 146x0-FcFabricEnabled=0; 
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3.   Paste the copy immediately following the text that you copied in step 2 on page 

129, as shown in the following example: 

 -jnic 146x0-FcLoopEnabled=1; 

-jnic 146x0-FcFabricEnabled=0; 

-jnic 146x0-FcLoopEnabled=1; 

-jnic 146x0-FcFabricEnabled=0; 

  

4.   Change the target values according to the information that you gathered from 

the /var/adm/messages file. In this example, one controller is on target 0 and 

the other controller is on target 3: 

 -jnic 146x0-FcLoopEnabled=1; 

-jnic 146x0-FcFabricEnabled=0; 

-jnic 146x3-FcLoopEnabled=1; 

-jnic 146x3-FcFabricEnabled=0; 

  

5.   Set the FcLoopEnabled and FcFabricEnabled attributes, as shown in the 

following example, in which both controllers are attached to a 2 GB switch: 

 -jnic 146x0-FcLoopEnabled=1; 

-jnic 146x0-FcFabricEnabled=1; 

-jnic 146x3-FcLoopEnabled=1; 

-jnic 146x3-FcFabricEnabled=1; 

  

Note:  IBM SAN 2 GB switches (public): 

v   FcLoopEnable=1 

v   FcFabricEnable=1

Binding the HBAs to the storage controllers:   Complete the following steps to 

set and change the target variables to the specified values: 

1.   In the jnic146x.conf file, search for a section called Configuration parameters 

for target to FC device mappings, as shown in the following example: 
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############################################################################### 

# 

# Configuration parameters for target to FC device mapping: 

# 

#    targetX_hba, 

#    targetX_lunY_hba, 

#    targetX_wwnn, 

#    targetX_wwpn, 

#    targetX_port, 

# 

# Type: string 

# Default: 

# 

# Example usage: Replace the ’x’ characters with actual WWNN, WWPN, or port ID. 

# 

# target0_hba      = "jnic146x0"; 

# target0_lun0_hba = "jnic146x0"; 

# target0_wwnn     = "xxxxxxxxxxxxxxxx"; 

# target0_wwpn     = "xxxxxxxxxxxxxxxx"; 

# target0_port     = "xxxxxx"; 

# jnic146x0-target0_lun0_hba="jnic146x0"; 

# jnic146x0-target0_wwnn="xxxxxxxxxxxxxxxx"; 

  

  

  

# Example usage: Replace the ’x’ characters with actual WWNN, WWPN, or port ID. 

# 

# target0_hba      = "jnic146x0"; 

# target0_lun0_hba = "jnic146x0"; 

# target0_wwnn     = "xxxxxxxxxxxxxxxx"; 

# target0_wwpn     = "xxxxxxxxxxxxxxxx"; 

# target0_port     = "xxxxxx"; 

# jnic146x0-target0_lun0_hba="jnic146x0"; 

# jnic146x0-target0_wwnn="xxxxxxxxxxxxxxxx"; 

  

2.   Using the information that you recorded in the previous procedure, “Gathering 

the binding information” on page 129, add the following parameters to the file 

for each HBA: 

v   Targetx_hba = JNI driver instance 

v   Targetx_wwpn = Controller WWPN

For example: 

 Target0_hba = jnic146x0 

Target0_wwpn = 200300a0ba0f478F 

  

Target1_hba = jnic146x3 

Target1_wwpn = 200200a0ba0f478F 

  

3.   Type the following command to save the changes to the JNI configuration file: 

 # :wq 

  

4.   Type the following command to reboot and configure the Solaris host: 

 # shutdown  -g0  -y  -i6 

  

When you are finished, install the failover driver on the host. See “Installing the 

RDAC failover driver” on page 142 or “Installing the DMP failover driver” on page 

144 for more information. 
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Changing the Emulex configuration files 

For more detailed information about using Emulex HBAs, see the DS4000 Storage 

Manager readme file for Solaris. For steps for finding the readme file on the Web, 

see “Finding the Storage Manager readme files online” on page 24. 

Also, you can find the latest information about operating system and HBA support, 

clustering support, storage area network (SAN) fabric support, and DS4000 Storage 

Manager feature support: 

http://www-1.ibm.com/servers/storage/support/fastt/index.html 

Before you begin: 

v   Ensure that the Emulex HBAs have been installed, and are attached either 

directly to the controllers or to the SAN fabric switch. 

v   If the HBAs are attached to a SAN fabric switch, ensure that the zones for the 

DS4000 storage subsystem are created and enabled. 

Notes:  

1.   All fabric switches must be zoned in such a way that a single HBA can 

access only one controller per storage array. 

2.   For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245.

Ensure that the following /kernel/drv/lpfc.conf file parameters are set to the 

correct values: 

 Table 18. /kernel/drv/lpfc.conf settings for using Emulex HBAs 

/kernel/drv/lpfc.conf parameter Value 

No-device-delay 0 

Network-on 0 

Linkdown-tmo 60 

Nodev-tmo 60
  

Installing the QLogic adapter driver package 

This section describes how to install the QLogic adapter driver package. 

Before you begin: 

v   Ensure that the QLogic HBAs have been installed, and are attached either 

directly to the controllers or to the SAN fabric switch. 

v   If the HBAs are attached to a SAN fabric switch, ensure that the zones for the 

DS4000 storage subsystem are created and enabled. 

Notes:  

1.   All fabric switches must be zoned in such a way that a single HBA can 

access only one controller per storage array. 

2.   For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245.

Complete the following steps to install the QLogic adapter driver package. 

1.   Download the most current adapter driver package from the following Web site 

to a local directory on the host: 
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www.QLogic.com 

2.   Un-compress the QLogic adapter driver package, by typing the following 

command: 

 # uncompress qlogic_adapter_driver. 

  

where qlogic_adapter_driver is the name of the compressed adapter driver (for 

example, qla2300_pkg_v408.Z). 

3.   Install the QLogic adapter driver package, by typing the following command: 

 # pkgadd -d adapter_driver_pkg 

  

where adapter_driver_pkg is the name of the package that you want to install 

(for example, qla2300_pkg_408). A package installation menu displays. 

4.   From the package installation menu, select package 3: 

 3. QLA2300-3 QLogic QLA23000 driver 

             (Sparc) Solaris 8-9, Rev=4.08 

  

Note:  You do not need to install any of the QLSDMLIB packages that display in 

the package installation menu. 

5.   Follow the instructions in the package installation utility to install the QLogic 

adapter driver package. 

Note:  When the following screen displays, press Enter to install the driver 

object in the default directory (/kernel/drv): 

 Where do you want the driver object installed? 

[default = /kernel/drv] 

  

6.   Verify that the QLogic adapter package is installed, by typing the following 

command: 

 # pkginfo -l pkg_version 

  

where pkg_version is the name of the adapter driver package that you installed 

(for example, QLA2300–3). 

7.   The following screen displays. Type y, then press Enter. 

 Do you want to continue with the installation of the pkg_version? 

[y, n, ?] 

  

where pkg_version is the name of the adapter driver package that you installed 

(for example, QLA2300–3). 

8.   Reboot the Solaris host, by typing the following command: 

 # shutdown  -g0  -y  -i6 

  

When you are done, go to the next procedure, “Verifying the HBA installation.” 

Verifying the HBA installation 

Complete the following steps to verify that the HBAs are installed: 

1.   Type the following command: 

 # view /var/adm/messages 
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A list of administrative messages displays. 

2.   Scroll down the list until you see the HBAs listed. 

3.   Record the WWPN and the HBA number for each of the two HBA cards. 

When you are done, go to the next procedure, “Modifying the QLogic HBA settings.” 

Modifying the QLogic HBA settings 

Complete the following steps to modify the QLogic HBA settings: 

1.   Open the QLogic configuration file, by typing the following commands: 

 # cd /kernel/drv 

# vi QLogic_conf_file.conf 

  

where QLogic_conf_file.conf is the name of the QLogic configuration file (for 

example, qla2300.conf). 

2.   In the vi Editor, uncomment and modify the loop attributes on each of the two 

QLogic HBA cards, using the information that is listed in Appendix G, “DS4000 

Diagnostic Data Capture (DDC),” on page 247. 

3.   Save the changes to the QLogic configuration file, by typing the following 

command: 

 # :wq 

  

4.   Reboot the Solaris host, by typing the following command: 

 # shutdown  -g0  -y  -i6 

  

When you are finished, install the failover driver, as described in the next section. 

Installing a failover driver on Solaris 

A failover driver monitors I/O paths. If a component failure occurs in one of the fibre 

channel paths, the failover driver reroutes all I/O to another path. 

Solaris host systems require one of the following failover drivers: 

v   Solaris Multiplexed I/O (MPxIO) 

v   RDAC 

v   VERITAS VolumeManager with Dynamic Multipathing (DMP)

Notes:  

1.   RDAC is not supported on Solaris 10. You must use either Solaris MPxIO or the 

VERITAS DMP failover driver. 

2.   With Solaris 10, MPxIO capability is built in. If you want to use MPxIO with 

previous versions of Solaris, you must install SUN StorEdge SAN Foundation 

Suite.

This section includes the following procedures: 

v   “Enabling the MPxIO failover driver” on page 135 

v   “Installing the RDAC failover driver” on page 142 

v   “Installing the DMP failover driver” on page 144
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Enabling the MPxIO failover driver 

Multiplexed I/O (MPxIO) is a Sun Solaris multipath driver architecture. This failover 

driver enables storage arrays to be accessed through multiple host controller 

interfaces from a single instance of the storage array. MPxIO helps protect against 

storage subsystem outages because of controller failures. If one controller fails, 

MPxIO automatically switches to an alternate controller. 

MPxIO is fully integrated within the Solaris 10 operating system. For Solaris 8 and 9 

operating systems, MPxIO is available as part of the Sun StorEdge SAN 

Foundation Suite (version 4.4.11 or later), and must be installed separately. 

For the latest supported version of Sun StorEdge SAN Foundation Suite, the latest 

Solaris kernel patches, and the most recent updates to information about using 

MPxIO, check the DS4000 Storage Manager readme file for Solaris. (See “Readme 

files and concepts” on page 1 for steps for finding the readme file on the Web.) 

This section contains the following topics: 

v   “Device name change considerations for MPxIO” 

v   “Acquiring the latest MPxIO driver version” 

v   “Steps for enabling the MPxIO failover driver” on page 136 

v   “Disabling the MPxIO multipath driver” on page 142

Note:  For more information, please refer to the following Sun documents, which 

you can find at the Sun Web site: 

http://docs.sun.com 

v   Sun StorEdge SAN Foundation Software Installation Guide 

v   Sun StorEdge SAN Foundation Software Configuration Guide 

v   Sun Solaris Fibre Channel and Storage Multipathing Administration Guide 

Device name change considerations for MPxIO 

In the /dev and /devices trees, devices are named differently from their original 

names when MPxIO is enabled. For example: 

Device name with MPxIO disabled 

/dev/dsk/c1t1d0s0 

MPxIO-enabled device name 

/dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2 

Therefore, you must configure applications that directly consume device to use the 

new names whenever the MPxIO configuration is enabled or disabled. 

In addition, the /etc/vfstab file and the dump configuration also contain references 

to device names. When you use the stmsboot command to enable or disable 

MPxIO, as described in the next sections, /etc/vfstab and the dump configuration 

are automatically updated with the new device names. 

Acquiring the latest MPxIO driver version 

The method of acquiring MPxIO depends upon which version of Solaris you have 

installed, as described in the following list: 

Solaris 10 

MPxIO is fully-integrated within the Solaris 10 operating system, and does 
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not need to be installed separately. MPxIO with Solaris 10 is updated using 

regular Solaris 10 patches, which are available at the following Sun 

Technical Support Web site: 

 http://sunsolve.sun.com

Note:  It is recommended that you install the regular kernel jumbo patch, 

because there are dependencies between the various patches that 

make up the driver stack.

Solaris 8 and 9 

Because MPxIO is not included with Solaris 8 and 9, you must download 

the required SAN suite (Sun StorEdge SAN Foundation Suite) from the Sun 

Technical Support Web site: 

 http://sunsolve.sun.com 

On this page, click SAN 4.4 release Software/Firmware Upgrades & 

Documentation. 

Note: Install the software using the provided install_it.ksh script.

Steps for enabling the MPxIO failover driver 

This section describes how to enable MPxIO by using the stmsboot command. In 

addition to enabling MPxIO, this command also updates the device names in the 

/etc/vfstab file and the dump configuration files during the next reboot. 

Note:  In Solaris 10, the stmsboot command is used to enable or disable MPxIO 

on all devices. 

Before you begin:  

1.   Install the Solaris operating system, and the latest patches. 

2.   Ensure that the Solaris host type was selected when the host was defined. See 

“Steps for defining the host and host port” on page 120 for more information.

Steps for enabling MPxIO on Solaris 8 and 9:  

1.   Install the latest version of Sun StorEdge SAN Foundation Suite and required 

patches, using the Sun StorEdge install_it script. For more information, see 

the Sun StorEdge SAN Foundation Suite x.xx Installation Guide (where x.xx is 

the version of StorEdge software). 

2.   Edit the /kernel/drv/scsi_vhci.conf configuration file to ensure that the 

VID/PID is not specified in this file. Also, ensure that the following entries exist 

in the file: 

mpxio-disable=”no”; 

load-balance=”none”; 

auto-failback=”enable”; 

Exception: In a cluster environment where logical drives (LUNs) are shared 

between multiple Sun servers, you might need to set the auto-failback 

parameter to disable to prevent the following phenomenon, which can occur 

when one of the servers has a failed path to one of the shared LUNs: 

If a host in a cluster server configuration loses a physical path to a DS4000 

storage subsystem controller, LUNs that are mapped to the cluster group can 

periodically failover and then failback between cluster nodes until the failed path 

is restored. This behavior is the result of the automatic logical drive failback 

feature of the multipath driver. The cluster node with a failed path to a DS4000 

controller issues a failover command for all LUNs that were mapped to the 

cluster group to the controller that it can access. After a programmed interval, 

the nodes that did not have a failed path will issue a failback command for the 
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LUNs because they can access the LUNs on both controllers, resulting in the 

cluster node with the failed path not being able to access certain LUNs. This 

cluster node will then issue a failover command for all LUNs, repeating the LUN 

failover-failback cycle. 

Note: See the latest DS4000 interoperability matrix at the following Web page 

for supported cluster services: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

3.   If you made any changes to the /kernel/drv/scsi_vhci.conf file in the 

previous step, save the file and reboot the server using the following command: 

 # shutdown  –g0  –y  –i6 

  

4.   If needed, update the fibre channel HBA firmware. 

5.   Create the DS4000 logical drives and map them to the fibre channel HBA ports 

in the Sun servers.

Steps for enabling MPxIO on Solaris 10:   Before you begin: Keep in mind the 

following considerations for stmsboot -e [enable] -d [disable] and -u [update]: 

v   When you run the stmsboot command, it is recommended that you accept the 

default to Reboot the system now. 

v   The stmsboot command saves copies of the original /kernel/drv/fp.conf and 

/etc/vfstab files before modifying them, so you can use the saved files to 

recover from any unexpected problems. 

v   Ensure that the eeprom boot device is set to boot from the current boot device.

Complete the following steps to enable MPxIO on all fibre channel devices: 

1.   Run the stmsboot -e command, and select the default [y] to reboot the 

system: 

 # stmsboot -e 

  

WARNING: This operation will require a reboot. 

Do you want to continue ? [y/n] (default: y) y 

The changes will come into effect after rebooting the system. 

Reboot the system now ? [y/n] (default: y) y 

  

Note:  During the reboot, /etc/vfstab and the dump configuration are updated 

to reflect the device name changes. 

2.   After the reboot, configure your applications to use new device names, as 

explained in “Device name change considerations for MPxIO” on page 135. 

3.   If necessary, edit the /kernel/drv/fp.conf configuration file to verify that the 

following parameter is set as follows: 

mpxio-disable=”no”; 

Edit the /kernel/drv/scsi_vhci.conf configuration file to verify that the 

following parameters are set as follows: 

load-balance=”none”; 

auto-failback=”enable”; 

4.   If you made any changes to configuration files in the previous step, save the 

file, and reboot the server using the following command: 

 # shutdown  -g0  -y  -i6 
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5.   If needed, update the fibre channel HBA firmware. 

6.   Create the DS4000 logical drives and map them to the fibre channel HBA ports 

in the Sun servers.

Verifying devices and configuring failover/failback path for the 

mapped LUNs 

1.   Verify devices using the cfgadm –al command to display about the host ports 

and their attached devices: 

 # cfgadm -al 

Ap_Id                          Type         Receptacle   Occupant     Condition 

PCI0                           vgs8514/hp   connected    configured   ok 

PCI1                           unknown      empty        unconfigured unknown 

PCI2                           unknown      empty        unconfigured unknown 

PCI3                           mult/hp      connected    configured   ok 

PCI4                           unknown      empty        unconfigured unknown 

PCI5                           unknown      empty        unconfigured unknown 

PCI6                           unknown      empty        unconfigured unknown 

PCI7                           mult/hp      connected    configured   ok 

PCI8                           mult/hp      connected    configured   ok 

c0                             scsi-bus     connected    configured   unknown 

c0::dsk/c0t6d0                 CD-ROM       connected    configured   unknown 

c1                             fc-private   connected    configured   unknown 

c1::500000e0106fca91           disk         connected    configured   unknown 

c1::500000e0106fcde1           disk         connected    configured   unknown 

c1::500000e0106fcf31           disk         connected    configured   unknown 

c1::500000e0106fd061           disk         connected    configured   unknown 

c1::500000e0106fd7b1           disk         connected    configured   unknown 

c1::500000e0106fdaa1           disk         connected    configured   unknown 

c1::50800200001d9841           ESI          connected    configured   unknown 

c2                             fc-fabric    connected    configured   unknown 

c2::201400a0b811804a           disk         connected    configured   unusable 

c2::201400a0b8118098           disk         connected    configured   unusable 

c2::201700a0b8111580           disk         connected    configured   unusable 

c3                             fc-fabric    connected    configured   unknown 

c3::201500a0b8118098           disk         connected    configured   unusable 

c3::201600a0b8111580           disk         connected    configured   unusable 

c3::202500a0b811804a           disk         connected    configured   unusable 

c4                             fc-fabric    connected    configured   unknown 

c4::200400a0b80f1285           disk         connected    configured   unknown 

c4::200400a0b8127a26           disk         connected    configured   unusable 

c5                             fc-fabric    connected    configured   unknown 

c5::200400a0b82643f5           disk         connected    unconfigured unknown 

c5::200500a0b80f1285           disk         connected    configured   unknown 

c5::200500a0b8127a26           disk         connected    configured   unusable 

c5::200c00a0b812dc5a           disk         connected    configured   unknown 

usb0/1                         usb-kbd      connected    configured   ok 

usb0/2                         usb-mouse    connected    configured   ok 

usb0/3                         unknown      empty        unconfigured ok 

usb0/4                         unknown      empty        unconfigured ok 

# 

  

2.   You can also display information about the attachment points on a system. In 

the following example, c0 represents a fabric-connected host port, and c1 

represents a private, loop-connected host port. (Use the cfgadm command to 

manage the device configuration on fabric-connected host ports.) 

By default, the device configuration on private, loop-connected host ports is 

managed by Solaris host.

Note:  The cfgadm -1 command displays information about fibre channel host 

ports. Also use the cfgadm -al command to display information about 

fibre channel devices. The lines that include a port World Wide Name 
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(WWN) in the Ap_Id field associated with c0 represent a fabric device. 

Use the cfgadm configure and cfgadm unconfigure commands to 

manage those devices and make them available to Solaris hosts.

 # cfgadm -l 

Ap_Id           Type         Receptacle   Occupant     Condition 

c0              fc-fabric    connected    unconfigured unknown 

c1              fc-private   connected    configured   unknown 

  

3.   Configure the device using the following command: 

 cfgadm –c configure Ap-Id 

  

The Ap_ID argument specifies the attachment point ID of the configured fibre 

channel devices. This ID can be the controller number and WWN of a device 

(for example, c3::50020f230000591d). 

See the output example in step 1. Also, see the cfgadm man page for an 

explanation of attachment points.

Note:  An Ap_Id with type fc-private cannot be unconfigured. Only type 

fc-fabric can be configured and unconfigured.
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4.   Use the luxadm probe command to list all mapped LUNs: 

 # luxadm probe 

luxadm probe 

No Network Array enclosures found in /dev/es 

  

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006ADE452CBC62d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006ADF452CBC6Ed0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE0452CBC7Ad0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE1452CBC88d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE2452CBC94d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE3452CBCA0d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE4452CBCACd0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE5452CBCB8d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE6452CBCC4d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE7452CBCD2d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE8452CBCDEd0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AE9452CBCEAd0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AEA452CBCF8d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AEB452CBD04d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AEC452CBD10d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006AED452CBD1Ed0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006B2A452CC65Cd0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006B2B452CC666d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006B2C452CC670d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006B2D452CC67Ad0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

        Logical Path:/dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c0t600A0B800011121800006B32452CC6ACd0s2 

  Node WWN:200400a0b8111218  Device Type:Disk device 

    Logical Path:/dev/rdsk/c8t201400A0B8111218d7s2 

  

5.   You can then use the luxadm display logical path command to list more details 

on each mapped LUN, including the number of paths to each LUN. The 

following example uses a logical path from the previous example: 
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# luxadm display /dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2 

DEVICE PROPERTIES for disk: /dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2 

  Vendor:               IBM 

  Product ID:           1742-900 

  Revision:               0914 

  Serial Num:           1T51207691 

  Unformatted capacity: 1024.000 MBytes 

  Write Cache:          Enabled 

  Read Cache:           Enabled 

    Minimum prefetch:   0x0 

    Maximum prefetch:   0x0 

  Device Type:          Disk device 

  Path(s): 

  

  /dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2 

  /devices/scsi_vhci/ssd@g600a0b800011121800006b31452cc6a0:c,raw 

   Controller           /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0,1/fp@0,0 

    Device Address              201400a0b8111218,1e 

    Host controller port WWN    210100e08ba0fca0 

    Class                       secondary 

    State                       STANDBY 

   Controller           /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0,1/fp@0,0 

    Device Address              201500a0b8111218,1e 

    Host controller port WWN    210100e08ba0fca0 

    Class                       primary 

    State                       ONLINE 

   Controller           /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0/fp@0,0 

    Device Address              201400a0b8111218,1e 

    Host controller port WWN    210000e08b80fca0 

    Class                       secondary 

    State                       STANDBY 

   Controller           /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0/fp@0,0 

    Device Address              201500a0b8111218,1e 

    Host controller port WWN    210000e08b80fca0 

    Class                       primary 

    State                       ONLINE 

# 

  

Unconfiguring a failover/failback path 

Before you unconfigure a fabric device, stop all activity to the device and unmount 

any file systems on the fabric device. (See your Solaris administration 

documentation for unmounting procedures.) 

To unconfigure a failover/failback path, complete the following steps: 

1.   Run the cfgadm -al command to display information about the host ports and 

their attached devices. 

2.   Unconfigure the LUN by running the following command: 

 cfgadm –c unconfigure Ap-Id 

  

Where Ap_Id is the LUN that you want to unconfigure. 

3.   Run the cfgadm -al command again, to verify that the LUN is now 

unconfigured. 

4.   If necessary, define the file structure using the newfs command. Add entries to 

the /etc/vfstab file. 

5.   Reboot the server using the following command: 

 # shutdown -g0 -y -i6 
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Disabling the MPxIO multipath driver 

For Solaris 10, unconfigure all devices using the cfgadm –c unconfigure AP-id 

Ap-id command. Then, run the stmsboot –d command, and accept the default to 

Reboot the system now. 

For Solaris 8 and 9, unconfigure all devices using the cfgadm –c unconfigure 

AP-id Ap-id command, and edit the /kernel/drv/scsi_vhci.conf configuration file 

to set the value of the mpxio-disable parameter to yes. Then, reboot the system. 

To learn how to revert the patches or the StorEdge software, please see the Sun 

StorEdge SAN Foundation Installation Software Guide at 

http://docs.sun.com. 

Installing the RDAC failover driver 

This section describes how to install RDAC on a Solaris host. 

Before you begin::  

1.   Because you cannot run both RDAC and MPxIO, make sure that MPxIO is 

disabled. Check the configuration files (/kernel/drv/scsi_vhci.conf and/or 

/kernel/drv/fp.conf) and make sure that the value of the mpxio-disable 

parameter to set to Yes. 

2.   You must install an HBA driver package before you install RDAC. If you have a 

SAN-attached configuration, you must also modify the HBA's configuration file 

before you install RDAC. If you fail to follow the procedures in this order, 

problems can occur. 

For information about how to install the HBA driver packages and modify the 

settings, see “Configuring the host bus adapter cards” on page 123. 

Notes:  

1.   RDAC is only supported on Solaris 8 and 9. (RDAC is not supported on Solaris 

10.) 

2.   Modifying failover settings in the HBA's configuration file after installing RDAC 

requires the removal of the RDAC from the host.

Steps for installing the RDAC failover driver 

Important: In some configurations, a patch is required for RDAC to function 

properly. Before you begin the RDAC installation, check the DS4000 Storage 

Manager readme file for Solaris to find out whether the patch is required for your 

specific configuration. In addition, you can find the latest RDAC versions and other 

important information in the readme file. (For steps for finding the readme file on the 

Web, see “Finding the Storage Manager readme files online” on page 24.) 

Complete the following steps to install RDAC: 

1.   Insert the Solaris installation CD in the CD-ROM drive.

Note:  In this procedure, the installation CD is mounted at /cdrom/SM91. Modify 

these commands as needed for your installation. 

2.   Type the following command to start installing the RDAC package: 

 # pkgadd -d path/filename.pkg 

  

where path/filename is the directory path and name of the package that you 

want to install. 
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The installation process begins. 

Information about packages that can be installed in the specified directory is 

displayed on the command line, as in the following example: 

 The following packages are available: 

  

1 RDAC                        Redundant Disk Array Controller 

                              (sparc) version number 

  

Select package(s) you wish to process (or ’all’ to process all 

packages). (default:all)  [?,??,q]: 

  

3.   Type the value of the package you are installing and press Enter. 

The installation process begins. 

4.   The software automatically checks for package conflicts. If any conflicts are 

detected, a message is displayed indicating that some files are already installed 

and are in use by another package. 

The following prompt is displayed: 

 Do you want to install these conflicting files [y, n, ?] 

  

Type y and press Enter. 

5.   The following prompt is displayed: 

 This package contains scripts which will be executed with super-user 

permission during the process of installing this package. 

  

Do you want to continue with the installation of <RDAC> 

  

[y, n, ?] 

  

Type y and press Enter. 

The installation process continues. 

6.   When the RDAC package has been successfully installed, the following 

message is displayed: 

 Installation of <RDAC> was successful. 

  

Ensure that the variables in the configuration files for the JNI adapter cards 

have been set to the correct values. For information about these configuration 

files and their variables, see “Modifying the HBA settings and binding the HBAs” 

on page 125. 

7.   Reboot the Solaris host by typing the following command: 

 # shutdown  -g0  -y  -i6 

  

Attention: Any modifications to the persistent bindings in the jnic146x.conf 

configuration file requires the removal of RDAC. After the RDAC is removed you 

can modify the persistent bindings in the jnic146x.conf file, and then reinstall 

RDAC. 

Complete the following steps to modify the sd.conf or jnic146x.conf files: 

1.    Remove RDAC by typing the following command: 

 # pkgrm RDAC_driver_pkg_name 
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where RDAC_driver_pkg_name is the name of the RDAC driver package that 

you want to remove. 

2.   Verify RDAC drive package removal by typing the following command: 

 # pkginfo RDAC_driver_pkg_name 

  

where RDAC_driver_pkg_name is the name of the RDAC driver package that 

you removed. 

3.   Reboot the Solaris host by typing the following command: 

 # shutdown  -g0  -y  -i6 

  

4.   Modify persistent bindings in the sd.conf or edit the sd.conf file by typing the 

following command: 

 # vi /kernel/drv/jnic146x.conf or sd.conf 

  

When you have finished making changes, run the following command to save 

the changes: 

 # :wq 

  

5.   Install the RDAC driver package by typing the following command: 

 # pkgadd -d RDAC_driver_pkg_name 

  

where RDAC_driver_pkg_name is the name of the RDAC driver package that 

you want to install. 

6.   Verify package installation by typing the following command: 

 # pkginfo RDAC_driver_pkg_name 

  

where RDAC_driver_pkg_name is the name of the RDAC driver package that 

you installed. 

7.   Reboot the Solaris host by typing the following command: 

 # shutdown  -g0  -y  -i6 

  

Note:  You must reboot the host after modifying the jnic146x.conf file, because the 

jnic146x.conf driver is only read during the boot process. Failure to reboot 

the host might result in some devices being inaccessible. 

Installing the DMP failover driver 

This section describes how to install VERITAS Dynamic Multipathing (DMP), which 

is a failover driver for Solaris hosts. While RDAC allows you to have only 32 LUNs, 

DMP allows you to have up to 256 LUNs. 

Important This section refers to the following Web site for some installation 

procedures: 

www.veritas.com 

System requirements 

Ensure that your system meets the following requirements for installing DMP: 

v   Solaris operating system 

 

144 DS4000 Storage Manager Version 10 Installation and Support Guide for AIX, HP-UX, Solaris, and Linux on POWER

http://www.veritas.com


v   VERITAS VolumeManager 4.0, 4.1 

v   SMibmasl.pkg (enables Solaris to recognize the DS4000 machine type)

DMP installation overview 

Ensure that your system meets the following prerequisites for installing DMP: 

v   The HBAs are installed on the Solaris host. 

v   The parameter settings in the HBA configuration file (for example, jnic146x.conf) 

are modified. 

v   In a SAN environment, bindings are configured. 

v   The zones are created and enabled for the Solaris partition. 

v   Storage is mapped to the Solaris partition.

Note:  For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245. 

Perform the following procedures, in the order listed, to complete the DMP 

installation: 

1.   “Preparing for VERITAS DMP installation” 

2.   “Installing VERITAS VolumeManager packages for DMP” on page 147 

3.   “Installing the SMibmasl software package” on page 147 

4.   “Configuring VERITAS VolumeManager” on page 147 

5.   “Starting the VERITAS Enterprise Administrator” on page 147

Preparing for VERITAS DMP installation 

Complete the following steps to prepare the host for installing VERITAS DMP: 

 1.   Choose the Solaris host on which you want to install DMP. 

 2.   Manually define the targets and LUNs in the /kernel/drv/sd.conf file, by 

completing the following steps. 

By default, the /kernel/drv/sd.conf file defines targets 0, 1, 2, and 3. LUN0 

also is defined for targets 0, 1, 2, and 3. 

Notes: 

v   Each target represents a controller to a subsystem, and each LUN 

represents a logical drive. 

v   If you are adding additional target or LUN definitions to the 

/kernel/drv/sd.conf file for an existing DMP configuration, be sure to 

reboot the Solaris host.

a.   Open the /kernel/drv/sd.conf file with the vi Editor, by typing the 

following command: 

 # vi /kernel/drv/sd.conf 

  

The file looks similar to the following example: 
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# 

# Copyright (c) 1992, Sun Microsystems, Inc. 

# 

# ident "@(#)sd.conf 1.9  98/01/11 SMI" 

  

name="sd" class="scsi" class_prop="atapi" 

target=0 lun=0; 

  

name="sd" class="scsi" class_prop="atapi" 

target=1 lun=0; 

  

name="sd" class="scsi" class_prop="atapi" 

target=2 lun=0; 

  

name="sd" class="scsi" class_prop="atapi" 

target=3 lun=0; 

  

b.   Add additional target and LUN definitions, using the vi Editor. In the 

following example, it is assumed that the Solaris host is attached to one 

DS4000 subsystem with three LUNs mapped to the DS4000 storage 

partition. In addition, the access LUN must be mapped to the partition. 

 # 

# Copyright (c) 1992, Sun Microsystems, Inc. 

# 

# ident "@(#)sd.conf 1.9  98/01/11 SMI" 

  

name="sd" class="scsi" class_prop="atapi" 

target=0 lun=0; 

  

name="sd" class="scsi" class_prop="atapi" 

target=1 lun=0; 

  

name="sd" class="scsi" class_prop="atapi" 

target=2 lun=0; 

  

name="sd" class="scsi" class_prop="atapi" 

target=3 lun=0; 

  

name="sd" class="scsi" target=0 lun=1; 

name="sd" class="scsi" target=0 lun=2; 

name="sd" class="scsi" target=0 lun=3; 

name="sd" class="scsi" target=0 lun=31; 

name="sd" class="scsi" target=1 lun=1; 

name="sd" class="scsi" target=1 lun=2; 

name="sd" class="scsi" target=1 lun=3; 

name="sd" class="scsi" target=1 lun=31; 

  

c.   Save the new entries in the /kernel/drv/sd.conf file, by typing the 

following command: 

 # :wq 

  

 3.   Verify that RDAC is not installed on the host, by typing the following command: 

 # pkginfo -l RDAC 

  

 4.   If RDAC is installed, remove it by typing the following command: 

 # pkgrm RDAC 
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5.   Verify that a host partition has been created. If not, create one by following the 

procedure that is described in “Creating storage partitions” on page 119. 

Attention: Set the host port type to Solaris with DMP. Failure to do so results 

in an inability to map for more than the RDAC limit of 32 LUNs and causes 

other undesired results. 

 6.   Ensure that all of the paths are optimal and are in a preferred path state from 

the SMclient. 

 7.   Reboot the host and ensure that the devices show up by typing the following 

command: 

 # SMdevices 

  

 8.   Verify that you have a 1 GB logical drive available for the rootdg. 

 9.   Label the logical drive that you are using for the rootdg, by typing the following 

command: 

 # format 

  

10.   Reboot the Solaris host, by typing the following command: 

 # shutdown  -g0  -y  -i6 

  

Installing VERITAS VolumeManager packages for DMP 

Before you begin to install VERITAS VolumeManager packages for DMP, ensure 

that you have the VERITAS VolumeManager license key and any other VERITAS 

licenses that you want to install available during the installation process. This 

document does not describe how to install the VERITAS product. 

For VERITAS VolumeManager installation procedures, see the VERITAS product 

documentation for Solaris at the following Web site: 

www.veritas.com 

Installing the SMibmasl software package 

Complete the following steps to install the SMibmasl software package: 

1.   Install the SMibmasl package, by typing the following command: 

Tip: You can select either the default (all), or select option 1. 

 # pkgadd -d SMibmasl_pkg 

  

2.   Reboot the Solaris host, by typing the following command: 

 # shutdown  -g0  -y  -i6 

  

Configuring VERITAS VolumeManager 

This document does not describe how to configure the VERITAS product. For 

VERITAS VolumeManager configuration procedures, see the VERITAS product 

documentation for Solaris at the following Web site: 

www.veritas.com 

Starting the VERITAS Enterprise Administrator 

After you have installed the VERITAS packages, and configured the rootdg, you 

must stop and restart the VERITAS Enterprise Administrator (VEA). 
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Tip: VEA starts automatically after a reboot. 

For these procedures, see the VERITAS product documentation for Solaris at the 

following Web site: 

www.veritas.com 

In addition, see the VERITAS documentation for information about how to complete 

the following tasks: 

v   Start VERITAS 

v   Set up disk groups 

v   Create volumes 

v   Create file systems 

v   Mount file systems

Verifying external storage 

After you install the failover driver, complete the following steps to verify that the 

host recognizes the external storage. 

Before you begin: SMutil must be installed on the host to enable the SMdevices 

and hot_add commands, which you use in the following procedure. For information 

about how to install SMutil, see “Steps for installing SMutil software (required)” on 

page 114. 

Restriction: Do not delete the access LUN or the access logical drive. RDAC uses 

the access LUN for communication between controllers and DS4000 Storage 

Manager. Therefore, a storage subsystem with two controllers would require two 

access LUNs. The access LUN is typically assigned the LUN number 31, by 

default. 

1.   Run the following command to verify that the host recognizes the external 

DS4000 storage: 

 # /opt/IBM_FAStT/util/SMdevices 

  

You must see two access LUNs, and all the configured storage (logical drives). 

If any of these are missing, run the following command: 

 # /etc/raid/bin/hot_add 

  

2.   Run the following command to verify that SMutil and the host both recognize all 

the configured storage: 

 # format 

  

You must see two access LUNs, and all configured storage (logical drives). If 

you still do not see all the storage, check the following: 

v   Recheck the zones. 

v   Ensure that the zones have been enabled. 

v   Recheck the targets and WWPNs. 

v   Check to see if the DS4000 Controllers and expansion drawers are powered 

on. 

v   Check to see if the switch or switches are powered on. 

v   Check fibre channel cables.
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Redistributing logical drives in case of failure 

If you select Solaris as the host type when you define the host and host port, Auto 

Volume Transfer (AVT) is disabled on Solaris hosts. In this case, if a failure occurs 

that initiates a controller failover, you must manually redistribute logical drives to 

their preferred paths. 

Complete the following steps to manually redistribute logical drives to their preferred 

paths: 

1.   Repair or replace any faulty components. For more information, see the 

Installation, User’s and Maintenance Guide for the appropriate DS4000 storage 

subsystem. 

2.   Using the Subsystem Management window, redistribute logical drives to their 

preferred paths by clicking Advanced → Recovery → Redistribute Logical 

Drives.

See “Steps for defining the host and host port” on page 120 for more information 

about setting host types. 
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Chapter  5.  Installing  and  configuring  storage  management  

software  on  POWER-based  Linux  host  systems  

You can use DS4000 Storage Manager 10.10 with the following Linux distributions 

for POWER-based host operating systems: 

v   SUSE Enterprise Linux Server 9 (SLES 9) 

v   SUSE Enterprise Linux Server 10 (SLES 10) 

v   Red Hat Enterprise Linux 4 

v   Red Hat Enterprise Linux 5 (SMclient only)

Note:  Before you begin any of the tasks in this chapter, see “Host operating 

system requirements” for the system requirements that are listed for your 

Linux distribution. For host I/O attachment to Red Hat Enterprise Linux 5 

(storage management only), contact IBM. 

This chapter contains the following topics: 

v   “Before Storage Manager installation: Configuring the host” on page 156 

v   “Storage Manager installation and configuration” on page 162 

v   “After Storage Manager installation: Completing the host configuration” on page 

175 

v   “Performing common maintenance tasks” on page 181 

v   “Remotely installing Linux (SAN boot)” on page 191

For additional Linux on POWER/Series p support, see the following Web sites: 

Linux on POWER resource center 

www.ibm.com/servers/enable/linux/power/ 

Linux on Series p support 

www.ibm.com/servers/eserver/pseries/linux/

Host operating system requirements 

This section lists the requirements and restrictions for POWER-based Linux host 

operating systems: 

v   “SUSE Enterprise Linux Server system requirements” 

v   “Red Hat Enterprise Linux 4 (RHEL 4) system requirements” on page 153

SUSE Enterprise Linux Server system requirements 

This section lists the minimum hardware and software requirements for a 

POWER-based host running SLES 9 or SLES 10 attached to a DS4200 Express, 

DS4300 Turbo, DS4400, DS4500, DS4700, or DS4800 storage subsystem that is 

managed by DS4000 Storage Manager. 

Important:  See the Storage Manager readme file for Linux on POWER for 

information about UTM LUN limitations. For steps that will help you find 

the readme files on the Web, see “Finding the Storage Manager 

readme files online” on page 24. 

Host hardware requirements 

At a minimum, the following hardware is required: 
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v   Host: IBM Eserver Series p or POWER server with 64-bit PowerPC® 

architecture™ 

v   Management station for DS4000 Storage Manager 

You can use the SLES host as the management station for DS4000 Storage 

Manager. 

v   For AIX, HP-UX, Solaris, or RHEL management stations, see the minimum 

requirements listed in the appropriate chapters in this document.

Software requirements 

Check the Storage Manager readme file for Linux on POWER for the latest 

supported versions of each item listed in this section.

Note:  See“Finding the Storage Manager readme files online” on page 24 for steps 

that will help you find the readme files on the Web. 

SUSE Linux Enterprise Server 10 

v   Version: SLES 10.1 

v   Kernel: 2.6.16.46-0.12-ppc64

QLogic driver 

Version: 8.01.07-k3 

Emulex driver 

Version: 8.1.10.9 

SUSE Linux Enterprise Server 9 

v   Version: SP3 

v   Kernel: 2.6.5-7.xx-pseries64

Emulex driver 

Version: 8.0.16.27 

Emulex Application Kit 

Version: elxlinuxapps-3.0a14-8.0.16.27-1-1 

QLogic drivers 

v   QLogic device driver version: 8.01.06 

v   QLogic device driver (for BladeCenter® only), version: 8.01.06 or 

later

IBM Storage Manager RDAC MPP driver 

v   rdac-LINUX-09.02.B5.yy-source.tar.gz for SLES 9 and RHEL 4 

v   rdac-LINUX-09.02.C5.xx-source.tar.gz for SLES 10.1

IBM Storage Manager software packages  

SMIA-LINUXPPC-10.10.A5.xx.bin 

 The following individual software packages are included in the SMIA 

package. You can install them with the SMIA package, or they can be 

installed individually: 

v   SMruntime-LINUX-10.10.A5.01.ppc64.rpm 

v   SMclient-LINUX-10.10.G5.00-1.noarch.rpm 

v   SMutil-LINUX-10.00.A5.xx-1.ppc64.rpm 

v   SMagent-LINUX-10.00.A5.xx-1.ppc64.rpm 

v   SMesm-LINUX-10.10.G5.xx-1.noarch.rpm
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Red Hat Enterprise Linux 4 (RHEL 4) system requirements 

This section lists the minimum hardware and software requirements for a 

POWER-based host running RHEL 4 on a DS4300 Turbo, DS4400, DS4500, 

DS4700 or DS4800 storage subsystem that is managed by DS4000 Storage 

Manager. 

Host hardware requirements 

The following hardware is required at minimum: 

Host: IBM Eserver Series p or POWER server with 64-bit PowerPC architecture. 

Software requirements 

Check the Storage Manager readme file for Linux on POWER for the latest 

supported versions of each item listed in this section.

Note:  See “Finding the Storage Manager readme files online” on page 24 for steps 

that will help you find the readme files on the Web. 

Red Hat Enterprise Linux 

v   Version 4.5 

v   Kernel 2.6.9-55.EL

Emulex HBA driver and application kit 

v   Emulex driver: 8.0.16.27 or later 

v   Emulex Application Kit: elxlinuxapps-3.0a14-8.0.16.27-1-1

QLogic device driver (for BladeCenter only) 

Version 8.01.06 or later 

IBM Storage Manager RDAC MPP driver  

rdac-LINUX-09.01.B5.xx-source.tar.gz 

IBM Storage Manager software packages  

SMIA-LINUXPPC-10.10.A5.xx.bin 

 The following individual software packages are included in the SMIA 

package. You can install them with the SMIA package, or separately: 

v   SMruntime-LINUX-10.10.A5.01.ppc64.rpm 

v   SMclient-LINUX-10.10.G5.00-1.noarch.rpm 

v   SMutil-LINUX-10.00.A5.xx-1.ppc64.rpm 

v   SMagent-LINUX-10.00.A5.xx-1.ppc64.rpm 

v   SMesm-LINUX-10.10.G5.xx-1.noarch.rpm

Note:  Updated readme files contain important configuration information that 

supersede this document. To access the most recent DS4000 Storage 

Manager readme file for Linux on POWER, see “Finding the Storage 

Manager readme files online” on page 24. 

Linux host restrictions 

Before you begin working with DS4000 Storage Manager, read the following list of 

restrictions. These restrictions apply to both SLES and RHEL operating systems, 

except as otherwise noted.

Important:  See the Storage Manager readme file for Linux on POWER for 

up-to-date restrictions and limitations on supported configurations. For 

 

Chapter 5. Installing and configuring storage management software on POWER-based Linux host systems 153



steps for finding the readme files on the Web, see “Finding the Storage 

Manager readme files online” on page 24.

SAN and connectivity restrictions 

v   Dual-path configurations are supported only with the IBM RDAC failover 

driver. 

v   Linux on POWER-based hosts can support the following number of host 

bus adapters (HBAs): 

–   Single-path: Single-path configurations can support up to two HBAs 

per controller. You can configure one HBA to each miniHUB on the 

DS4000 controller. Each HBA-to-controller relationship must reside in 

a separate zone and a separate partition. 

–   Dual-path (RDAC): Dual-path configurations can support two HBAs 

per partition, and one partition per host, per DS4000 storage 

subsystem.

v   Direct-attached single-path configurations are restricted to single-initiator 

configurations only. You can only make one connection to each minihub 

on a DS4000 storage subsystem.

Note:  DS4100, DS4200 Express, DS4300 Turbo, DS4700, and DS4800 

storage subsystems do not have minihubs. 

v   Single-switch configurations are allowed, but each HBA and DS4000 

controller combination must be in a separate SAN zone. 

v   Other storage devices, such as tape devices or other disk storage, must 

be connected through separate HBAs and SAN zones. 

v   Clustering is not currently supported.

Note:  For more information about zoning and enabling zones, see 

Appendix F, “Connecting HBAs in a FC switch environment,” on page 

245.

Linux RDAC restrictions (AVT/ADT) 

v   This Linux RDAC release does not support auto-volume 

transfer/auto-disk transfer (AVT/ADT) mode. AVT/ADT is automatically 

enabled in the Linux storage partitioning host type. Use the Linux host 

type for Linux partitions, and run the AVT disable script to disable 

AVT/ADT.

Partitioning restrictions 

v   Dual-path configurations are supported only with the IBM RDAC failover 

driver. 

v   The maximum number of partitions per POWER-based Linux host, per 

DS4000 storage subsystem, is as follows: 

–   Without RDAC: Four partitions 

–   With RDAC: One partition

v    Map the host type as follows: 

–   Without RDAC: All logical drives in single-path configurations must 

be mapped as host type Linux (AVT is enabled in this host type). 

–   With RDAC: All logical drives in dual-path configurations must be 

mapped as host type Linux with AVT disabled, using the AVT disable 

script.
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Important:  See the Storage Manager readme file for Linux on POWER 

for up-to-date information about using AVT/ADT. To find the 

readme files on the Web, see “Finding the Storage Manager 

readme files online” on page 24. 

v   On each partition, you must map a LUN 0. 

v   On each controller, you must configure at least one partition with an LUN 

between 0 and 31 that is not a UTM or access logical drive.

Direct-attached and SAN-attached configurations 

POWER-based Linux hosts support DS4000 storage subsystems in direct-attached 

and SAN-attached configurations. 

Creating a direct-attached configuration 

The following types of direct-attached configurations are supported: 

v   One to four POWER-based Linux host servers, in single-path configurations, can 

be connected to each DS4000 storage subsystem. 

v   One or two POWER-based Linux servers, in dual-path RDAC configurations, can 

be connected to each DS4000 storage subsystem. Each server must have 

exactly one HBA connected to each controller port. 

v   Single and dual HBA configurations are supported.

Note:  Two-server, dual-path DS4400 or DS4500 configurations require four 

host-side minihubs, each with exactly one fibre channel connection from 

each HBA to a minihub. 

Complete the following steps to set up a direct-attached configuration: 

1.   Ensure that no external hubs are being used. 

2.   Connect the HBAs to each controller or minihub port of the DS4000 storage 

subsystem. 

3.   Configure and verify the configuration.

Creating a SAN-attached configuration 

Before you begin: To create a SAN-attached configuration, you must ensure that: 

v   Multiple fibre channel HBAs within the same server must not be able to discover 

the same DS4000 controller port. 

v   The IBM Fibre Channel HBAs in a host system must be isolated from each other 

if they are connected to the same switch that is connected to the same DS4000 

controller port. 

v   An RDAC configuration requires two HBAs or two ports on a single HBA per host 

system, each port must be in a separate fabric, or zone, that is connected to one 

of the two controllers. 

v   Each fibre channel HBA on each host, and controller port on each DS4000 

subsystem, must be in its own fabric zone, if they are connecting through a 

single fibre channel switch. 

Note:  Single HBA configurations are allowed. If you have a single HBA in a 

SAN-attached configuration, the controller must be fibre channel 

connected to the HBA through a switch.

 Attention:  Having a single HBA configuration can lead to loss of access data in 

the event of a path failure.
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Complete the following steps to set up a SAN-attached configuration: 

1.   Connect the HBAs to the switch or switches. 

2.   Connect the DS4000 storage subsystems to the switch or switches. 

3.   Set the required zones on the fibre channel switch or switches, if applicable. 

4.   Configure, then verify the configuration by logging into the switch to view the 

system.

Important:  See the Storage Manager readme file for Linux on POWER for 

up-to-date information about supported configurations. For steps for 

finding the readme files on the Web, see “Finding the Storage Manager 

readme files online” on page 24.

Note:  For more information about zoning and enabling zones, see Appendix F, 

“Connecting HBAs in a FC switch environment,” on page 245. 

Before Storage Manager installation: Configuring the host 

Before you install the Storage Manager software, complete the procedures that are 

described in this section to configure your Linux host for the DS4000 storage 

subsystem. 

Best practice:  When you boot the host in preparation for installation of the Storage 

Manager software packages, IBM recommends that you ensure that 

DS4000 devices are not yet attached to the host system. Attaching 

DS4000 devices before you configure the host increases system 

boot time, and can complicate the installation process. Attach the 

DS4000 devices after you complete the steps in this section, and 

before you install the Storage Manager software. 

Configuring the SLES host 

After you install SLES on your host, and before you begin to install the Storage 

Manager software and configure your subsystems, complete the steps in this 

section, as needed.

Note:  The correct HBA driver is not always included in the Linux kernel. You may 

need to download the correct version of the HBA and application packages. 

Downloading the Series p HBA driver utility packages 

The type of HBA driver that you need depends on your configuration: 

v   For a BladeCenter configuration: Complete the steps described in 

“Downloading the QLogic HBA driver (for BladeCenter servers only)” on page 

158. 

v   For all other SLES configurations: Complete the steps described in the next 

section, “Downloading the Emulex driver/utility packages.”

Downloading the Emulex driver/utility packages:   Check the DS4000 Storage 

Manager readme file for Linux on POWER for the latest supported versions of the 

following packages. For steps for finding the readme files on the Web, see “Finding 

the Storage Manager readme files online” on page 24. 

Application package 

Monitors HBAs and facilitates downloading of HBA firmware 

Driver package 

Compiles changes in the configuration file (/etc/lpfc.conf) 
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Release notes 

Instructions for upgrading the device driver

Then, download the packages from the Emulex Web site, if needed:http://
www.emulex.com/ibm/support/index.jsp 

Note:  You can use the lputil utility to check current HBA firmware levels or to 

download firmware.

Installing the lpfc driver:   If you want to install the lpfc driver, complete the following 

steps to install it now. 

1.   Create a directory for the lpfc driver package. 

2.   Download the appropriate driver package to the directory that you just created. 

3.   Uncompress the file by typing the following command: 

 # tar -zxvf package_name.tgz 

  

4.   The following is the recommended procedure to update physical HBA driver. 

a.   Get the latest HBA drivers supported by MPP. 

b.   Install the drivers, using the package installation instructions. 

c.   After the driver is installed, change back to the initial Linux RDAC installation 

directory, and reinstall the RDAC driver using the following commands: 

 # make clean 

# make uninstall 

# make 

# make install 

  

5.   Reboot the server.

Installing the optional lpfc application kit:   If you want to install the optional lpfc 

application kit, complete the following steps to install it now. 

1.   Create a directory for the lpfcdfc driver package. 

2.   Download the appropriate driver package to the directory that you just created. 

3.   Uncompress the file by typing the following command: 

 # tar -zxvf package_name.tgz 

  

4.   In the directory, find the readme.txt file, and follow the instructions for installing 

the driver package.

Note:  If the RDAC driver is already installed, you will need to unload the 

mppVhba and mppUpper modules before proceeding with the upgrade. 

See the readme file in the appropriate linuxrdac directory for more 

information. For example, 

 rmmod mppVhba 

rmmod lpfcdfc 

# or lpfcdfc then lpfc if the HBA 

# application package is installed 

rmmod mppUpper 

  

5.   After the driver is installed, change back to the initial Linux RDAC installation 

directory and reinstall the RDAC driver using the following commands: 
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# make clean 

# make uninstall 

# make 

# make install 

  

6.   Reboot the server.

Downloading the QLogic HBA driver (for BladeCenter servers only):   Complete 

the following steps to install the HBA driver for BladeCenter servers, if necessary.

Note:  In most cases, the driver is included in the Linux distribution. 

1.   Check the DS4000 Storage Manager readme file for Linux on POWER for the 

latest supported version of the following package. (For steps for finding the 

readme files on the Web, see “Finding the Storage Manager readme files 

online” on page 24.)

qla2xxx-v8.01.xx-dist.tgz 

2.   Direct your Internet browser to the following IBM Web page: 

www.ibm.com/servers/storage/support/disk/ 

a.   From the ″Support for disk systems″ page, click on the link for your specific 

storage device. 

b.   On the next page, select the Download tab. 

c.   Under ″Fixes and drivers,″ click on ″Storage Manager, firmware, HBA and 

tools (including readmes).″ 

d.   Select the HBA tab. 

e.   Locate the driver for your specific HBA, and click on the link under the 

column entitled, Current version and readmes.

3.   Download the driver into a directory on your system. 

4.   Uncompress the file. 

5.   The uncompressed QLogic files include a readme. Follow the installation 

procedures in the readme file to install the HBA driver and utilities.

Note:  If the RDAC driver is already installed, you will need to unload the 

mppVhba and mppUpper modules before proceeding with the upgrade. 

See the readme file in the appropriate linuxrdac directory for more 

information. For example, 

 rmmod mppVhba 

rmmod qla2300 

# then 

qla2xxx 

rmmod mppUpper 

  

6.   After the driver is installed, change back to the initial Linux RDAC installation 

directory and reinstall the RDAC driver using the following commands: 

 # make clean 

# make uninstall 

# make 

# make install 

  

7.   Reboot the server.
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Modifying the configuration file 

Add the following options to the appropriate configuration file, if they are not already 

there.

Note:  Later versions of the RDAC driver automatically add the required or 

preferred configuration options to the initrd on installation. These options, 

and any still listed in the modprobe configuration file, will be configured on 

reboot, with preference given to the options in the modprobe configuration 

file, if there are duplicate option values listed. For example, the RDAC 

recommended value for the lpfc_nodev_tmo is 60 seconds; if the modprobe 

configuration file has the lpfc_nodev_tmo=60 option value listed, and 

mppUpdate or the RDAC driver is installed after the setting is entered into 

the modprobe configuration file, then on a system reboot, the 

lpfc_nodev_tmo value will be 60 seconds.

 options lpfc lpfc_nodev_tmo=60 lpfc_lun_queue_depth=xx  

  

Explanation of new lines: 

v   lpfc_lun_queue_depth=xx Setting the queue_depth attribute to the appropriate 

value is important for system performance. If you have a large DS4000 

configuration with many logical drives and hosts attached, use this setting for 

high performance. See “Viewing or changing queue depth” on page 184 to learn 

how and when to adjust the queue depth for your system. 

v   lpfc lpfc_nodev_tmo=60 The setting must be 60 for proper error handling on 

RDAC configurations only. Do not use this setting for single-path configurations. 

See the Emulex readme file for information about preferred settings for 

non-RDAC configurations.

QLogic HBA driver options (for BladeCenter servers only) 

 options qla2xxx ql2xfailover=0 ql2xmaxqdepth=xx 

  

v   ql2xfailover=0 This setting ensures that the QLogic failover driver is not 

installed. The IBM RDAC driver is incompatible with any other failover driver. 

QLogic drivers included with the Linux distribution may not include this option. 

Refer to the driver documentation to determine that this option is supported. 

v   ql2xmaxqdepth=8 Setting the queue_depth attribute to the appropriate value is 

important for system performance. If you have a large DS4000 configuration with 

many logical drives and hosts attached, use this setting for high performance.

Warning: If the HBA options are not manually added to the modprobe configuration 

file, and the HBA modules are manually unloaded, then (rmmod/modprobe/insmod 

commands used) the appropriate options will not be configured unless they are 

stated on the modprobe command line. For example, the QLogic HBA driver needs 

to be upgraded and the ql2xfailover=0 option is not in the /etc/modprobe.conf file. 

To upgrade the driver, the mppVhba and mppUpper modules are unloaded via 

rmmod. The new driver is installed and then all of the modules are reloaded using 

the modprobe command. The QLogic driver that is actually loaded is the failover 

driver, which is not supported with RDAC. 

Recording the HBA worldwide port names 

During the installation process, you need to know the HBA worldwide port names. 

Complete the following steps to view and record the HBA WWPNs: 

1.   Type the following command to view the HBAs: 

 # ls /proc/scsi/lpfc 
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Result: A list displays that contains assigned numbers for all of the HBAs 

discovered on the system. 

2.   In the list, identify the host number of the HBA that is connected to the DS4000, 

and go to that directory by typing the following command: 

 # cd /sys/class/scsi_host/host# 

  

where # is the assigned HBA number that you found in step 1 on page 159. 

3.   Type the following command to view the WWPN of the HBA, and connected 

DS4000 controllers: 

 # cat port_name 

  

where port_name is the assigned HBA number. 

Note that the port_name value is equivalent to the WWPN.

Note:  For additional methods of getting the WWPN information for an HBA, refer to 

vendor-specific documentation for your Linux distribution. 

Recording the WWPNs for Blades only:   Complete the following steps to view 

and record the Qlogic WWPNs: 

1.   Type the following command: 

 # ls /proc/scsi/qla2* 

  

Result: A list displays that contains assigned numbers for each HBA discovered 

on the system. 

2.   For each HBA, type the following command: 

 # cat /proc/scsi/qla2300/x 

  

where x is the assigned HBA number that you found in the previous step. 

Result: You see the following display: 

 scsi-qla#-adapter-port-xxxxxxxxxxxxxx 

  

The adapter port value, xxxxxxxxxxxxxx, is the WWPN.

Configuring the RHEL 4 host 

After you install RHEL 4 on your host, and before you begin to install the Storage 

Manager software and configure your subsystems, complete the steps in this 

section. 

Downloading the RHEL 4 Series p HBA driver utility packages 

The type of HBA driver that you need depends on your configuration: 

v   For a BladeCenter configuration: Complete the steps described in 

“Downloading the QLogic HBA driver (for BladeCenter servers only)” on page 

161. 

v   For all other RHEL 4 configurations: Complete the steps described in the next 

section, “Downloading the Emulex HBA driver utility packages.”

Downloading the Emulex HBA driver utility packages:   Download the following 

packages from the Emulex Web site: 

http://www.emulex.com/ibm/support/index.jsp 
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Utility package Compressed package filenames 

Emulex device driver See the DS4000 Storage Manager readme file for Linux on 

POWER for the latest supported versions. For steps for finding 

the readme files on the Web, see “Finding the Storage Manager 

readme files online” on page 24. 

Emulex Application Kit  

Note: You need the lputil utility, which is included in the Emulex Application Kit, to check 

current HBA firmware levels or to download firmware.
  

Installing the lpfc application kit on the RHEL 4 host:   Complete the following steps 

to install lpfc application kit: 

1.   Create a directory for the lpfc application kit. 

2.   Download the application kit package file to the directory you just created. 

3.   Uncompress the file by typing the following command: 

 # tar -zxvf package_name.tgz 

  

4.   In the directory, find the readme.txt file, and follow the instructions for installing 

the application kit.

Downloading the QLogic HBA driver (for BladeCenter servers only):   Complete 

the following steps to install the HBA driver for BladeCenter servers: 

1.   Check the DS4000 Storage Manager readme file for Linux on POWER for the 

latest supported version of the following package. (For steps for finding the 

readme files on the Web, see “Finding the Storage Manager readme files 

online” on page 24.)

qla2xxx-v8.01.xx-dist.tgz 

2.   Direct your Internet browser to the following IBM Web page: 

www.ibm.com/servers/storage/support/disk/ 

a.   From the ″Support for disk systems″ page, click on the link for your specific 

storage device. 

b.   On the next page, select the Download tab. 

c.   Under ″Fixes and drivers,″ click on ″Storage Manager, firmware, HBA and 

tools (including readmes).″ 

d.   Select the HBA tab. 

e.   Locate the driver for your specific HBA, and click on the link under the 

column entitled, Current version and readmes.

3.   Download the driver into a directory on your system. 

4.   Uncompress the file. 

5.   The uncompressed QLogic files include a readme. Follow the installation 

procedures in the readme file to install the HBA driver and utilities.

Modifying the configuration file 

Add the following lines to the configuration file, if they are not already there. 

 options lpfc lpfc_nodev_tmo=60 lpfc_lun_queue_depth=xx  

  

Note:  Later versions of the lpfc and RDAC drivers automatically add the required 

or preferred configuration options on installation.
Explanation of new lines: 
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v   lpfc_lun_queue_depth=xx—Setting the queue_depth attribute to the appropriate 

value is important for system performance. If you have a large DS4000 

configuration with many logical drives and hosts attached, use this setting for 

high performance. See “Viewing or changing queue depth” on page 184 to learn 

how and when to adjust the queue depth for your system. 

v   lpfc lpfc_nodev_tmo=60—The setting must be set to 60 for proper error handling 

on RDAC configurations only. Do not use this setting for single-path 

configurations. See the Emulex readme file for information about preferred 

settings for non-RDAC configurations.

Recording the HBA worldwide port names 

During the installation process, you need to know the HBA worldwide port names. 

Complete the following steps to view and record the HBA WWPNs: 

1.   Type the following command to view a the HBAs: 

 # ls /proc/scsi/lpfc 

  

Result: A list displays that contains assigned numbers for all of the HBAs 

discovered on the system. 

2.   In the list, identify the host number of the HBA that is connected to the DS4000, 

and go to that directory by typing the following command: 

 # cd /sys/class/scsi_host/host# 

  

where # is the assigned HBA number that you found in step 1. 

3.   Type the following command to view the WWPN of the HBA, and connected 

DS4000 controllers: 

 cat port_name 

  

where port_name is the assigned HBA number. 

Note that the port_name value is equivalent to the WWPN.

Recording the WWPNs for JS20 Blades only:   Complete the following steps to 

view and record the Qlogic WWPNs: 

1.   Type the following command: 

 # ls /proc/scsi/qla2* 

  

Result: A list displays that contains assigned numbers for each HBA discovered 

on the system. 

2.   For each HBA, type the following command: 

 # cat /proc/scsi/qla2300/x 

  

where x is the assigned HBA number that you found in the previous step. 

Result: You see the following display: 

 scsi-qla#-adapter-port-xxxxxxxxxxxxxx 

  

The adapter port value, xxxxxxxxxxxxxx, is the WWPN.

Storage Manager installation and configuration 

After you complete the host configuration procedures that are described in “Before 

Storage Manager installation: Configuring the host” on page 156, you can install 

and configure Storage Manager following the steps in this section.
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Note:  Before you begin the Storage Manager installation, ensure that the DS4000 

devices are attached to the host. 

With Storage Manager 10.10, the Storage Manager client software and utilities are 

available for POWER-based SLES 9, SLES 10, and RHEL 4 hosts.

Note:  RHEL 5 is supported only for SMclient. 

v   For host I/O attachment to Red Hat Enterprise Linux 5 (storage management 

only), contact IBM. 

v   For information about installing DS4000 Storage Manager on an AIX, Solaris, or 

HP-UX management station, see the appropriate installation chapter in this 

document: 

–   Chapter 4, “Installing and configuring storage management software on 

Solaris host systems,” on page 107 

–   Chapter 5, “Installing and configuring storage management software on 

POWER-based Linux host systems,” on page 151 

–   Chapter 6, “Completing the software configuration,” on page 197

v    For information about installing DS4000 Storage Manager on a Windows or i386 

processor-based Linux management station, see IBM System Storage DS4000 

Storage Manager Installation and Host Support Guide for Intel-based Operating 

System Environments. 

v   For information about installing DS4000 Storage Manager on a POWER-based 

RHEL 4 management station, see the appropriate sections in this chapter.

Requirements 

v   DS4000 Storage Manager 10.10 

v   Graphics adapter card or a remote graphical console program (such as VNC or 

Exceed) 

v   Graphical Interface X Configuration (such as XFree86) installed and configured 

on the host 

v   The DS4000 storage subsystem must be attached to the host

Opening a remote Xwindows or VNC connection 

The Storage Manager SMIA package must be installed in a graphics environment, 

as indicated in the listed requirements. If the local console does not have a 

graphics card, you can install the package remotely through VNC or Xwindows 

connections, as follows: 

Xwindows connection 

 Complete the following steps to open a remote Xwindow connection: 

1.   Ensure that an Xwindows program is installed and running on your 

server. 

2.   Open a remote Xwindow from your PC using Exceed by typing the 

following command line in the Exceed Client Startup window with 

appropriate other selections: 

 

 xterm -display PC-IP-ADDR:0 -T remote-IPADDR 

-r -ls +sb -sl 2000 -n remote-IPADDR -geom 80x24+0+0 

  

VNC connection 

 Complete the following steps to open a VNC connection: 
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1.   Open the VNC Web browser by typing the following commands: 

 # cd /root 

# vncserver 

  

2.   When you are asked for a password, type a new password and write it 

down. A message displays a session number, as in the following 

example: 

 hostIP:1 

  

where 1 is the session number. 

3.   Open a local browser window and enter <host IP:580 session number>, 

as shown in the following example: 

 http://192.168.1.1:5809 

  

where the host IP is 192.168.1.1, and the session number is 1.

Installing DS4000 Storage Manager and utilities 

Use the procedures in this section to install DS4000 Storage Manager on your 

SLES 9, SLES 10, or RHEL 4 host. 

You can install all of the DS4000 Storage Manager software packages automatically 

by using the Storage Manager installation wizard, or you can install each package 

manually. This section contains the following procedures. 

v   “Installing Storage Manager using the installation wizard” 

v   “Installing Storage Manager packages manually” on page 165 (original method)

Prerequisites 

If you are installing SMclient on the host, ensure that the following conditions are 

met. 

v   The host on which you are installing SMclient meets the minimum hardware and 

software requirements described in “Host hardware requirements” on page 153. 

v   The Graphical Interface X Configuration is installed and configured. If this was 

not completed at Linux installation, configure it now using one of the following 

tools: 

SLES 9 Use xfree86. 

SLES 10 Use sax2. 

RHEL 4 and 5 Use redhat-config-xfree86.

v    The DS4000 Storage Manager files have been downloaded to a directory on the 

host.

Note:  If you do not have the files, you can find them at the following Web site: 

www-1.ibm.com/servers/storage/support/disk/ Click the link for your 

storage subsystem. When the storage subsystem page opens, click the 

Download tab, and follow the links to the Storage Manager files.

Installing Storage Manager using the installation wizard 

The DS4000 Storage Manager installation wizard is a Java-based interactive 

method of choosing which packages to automatically install on your host system. 

The installation wizard installs the following software packages on the host: 
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v   SMruntime 

v   SMesm 

v   SMclient 

v   SMagent 

v   SMutil

If you are installing Storage Manager 10.10 on Linux on POWER, and your system 

does not meet the requirements for using the wizard, does not have a graphics card 

installed, or if for any reason you do not want to use the wizard to install the 

software, you can perform the installation without a GUI by typing the sh 

<installer-package-name.bin> -i console command in the command line 

interface. You can also skip this section and install the stand-alone host software 

packages using the procedures described in “Installing Storage Manager packages 

manually.” All the packages are included with the installation CD. 

Steps for installing DS4000 Storage Manager software using the installation 

wizard:   Complete the following steps to install the DS4000 Storage Manager 

software using the installation wizard. Adjust the steps as necessary for your 

specific installation. 

1.   Download the Storage Manager SMIA package file from the DS4000 Storage 

Manager CD, or from the DS4000 support Web site, to a directory on your 

system. 

2.   Open the file on your system by typing the following command: 

 # sh SMIA-LINUXPPC-09.xx.A5.xx.bin 

  

The Storage Manager Installation Wizard’s Introduction window opens. 

3.   Follow the instructions in each window of the wizard. When you select the 

installation type, you can choose one of the following options: 

v   Typical (Full) Installation—Installs all Storage Manager software packages 

v   Management Station—Installs SMruntime and SMclient 

v   Host—Installs SMruntime, SMagent and SMutil 

v   Custom—Allows you to select which packages you want to install

Result: The DS4000 Storage Manager software is installed on your system. 

Installing Storage Manager packages manually 

Use the following procedures, in the order listed, to install the DS4000 Storage 

Manager software on a POWER-based Linux storage management station. 

Install the Storage Manager software in the following order. 

1.   “Steps for installing SMruntime software” 

2.   “Steps for installing SMclient software” on page 166 

3.   “Steps for installing SMutil” on page 167 

4.   “Steps for installing SMagent (optional)” on page 167

Note:  SMclient is dependent on SMruntime, which is a Java compiler for SMclient 

and must be installed first.

Steps for installing SMruntime software:   Modify the following commands as 

needed for your installation. No restart is required during the installation process. 
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1.   Install SMruntime by typing the following command: 

 # rpm -ihv SMruntime-LINUX-10.xx.A5.xx-1.ppc64.rpm 

  

2.   Verify that the installation was successful by typing the following command: 

 

 # rpm -qa | grep SMruntime 

  

Steps for installing SMesm software (required if installing SMclient):   Modify 

the following commands as needed for your installation. No restart is required 

during the client installation process. 

1.   Install SMesm by typing the following command: 

 # rpm -ihv SMesm-LINUX-10.xx.G5.xx-1.noarch.rpm 

  

2.   Verify that the installation was successful by typing the following command: 

 # rpm -qa |grep SMesm 

  

Result: The verification process shows the package name and version. 

After completing the installation of the esm software, you can launch the SMesm on 

the host by typing the following command: 

 # /opt/IBM_DS4000/SMesm 

  

Result: The Storage Manager Enterprise Management window opens.

Note:  If the Enterprise Management window does not open, verify that the Storage 

Manager software packages listed in the installation procedures completed 

their installation without error, and that the X Graphical Interface is 

configured and running on the server. 

(The SMesm is a Java-based program that must run in a graphical interface 

or remote graphical window. See “Opening a remote Xwindows or VNC 

connection” on page 163.) 

If the verification process returns an error, contact your support 

representative. 

Steps for installing SMclient software:   Modify the following commands as 

needed for your installation. No restart is required during the client installation 

process. 

1.   Install SMclient by typing the following command: 

 # rpm -ihv SMclient-LINUX-10.xx.G5.xx-1.noarch.rpm 

  

2.   Verify that the installation was successful by typing the following command: 

 # rpm -qa |grep SMclient 

  

Result: The verification process shows the package name and version. 

After completing the installation of the client software, you can launch the SMclient 

on the host by typing the following command: 
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# /opt/IBM_DS4000/SMclient 

  

Result: The Storage Manager Enterprise Management window opens.

Note:  If the Enterprise Management window does not open, verify that the Storage 

Manager software packages listed in the installation procedures completed 

their installation without error, and that the X Graphical Interface is 

configured and running on the server. 

(The SMclient is a Java-based program that must run in a graphical interface 

or remote graphical window. See “Opening a remote Xwindows or VNC 

connection” on page 163.) 

If the verification process returns an error, contact your support 

representative. 

Steps for installing SMutil:   Modify the commands as needed for your installation. 

No restart is required during the installation process. 

1.   Install SMutil by typing the following command: 

 # rpm -ihv SMutil-LINUX-10.xx.A5.xx-1.ppc64.rpm 

  

2.   Verify that the installation was successful by typing the following command: 

 # rpm -qa |grep SMutil 

  

Result: The verification process shows the package name and version.

Steps for installing SMagent (optional):   SMagent is required for in-band 

management only. It is not required for out-of-band management. 

Note:  SMagent is not supported with DS4000 controller firmware version 

05.42.xx.xx. 

Modify the commands as needed for your installation. No restart is required during 

the installation process. 

1.   Install SMagent by typing the following command: 

 # rpm -ihv SMagent-LINUX-10.xx.A5.xx-1.ppc64.rpm 

  

2.   Verify that the installation was successful by typing the following command: 

 # rpm -qa |grep SMagent 

  

Result: The verification process shows the package name and version.

Note:   If no UTM LUNs are assigned on the DS4000, SMagent stops with a 

warning message that there are no UTM LUNs available. This is normal. 

After a UTM LUN is assigned, start the SMagent program by typing SMagent 

start.

Starting or stopping SMagent software:   Use the following command to manually 

start SMagent: 

 # SMagent start 
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Use the following command to manually stop SMagent: 

 # SMagent stop 

  

Configuring storage subsystems using DS4000 Storage Manager 

If you have purchased a Storage Partitioning premium feature, ensure that the 

premium feature is enabled. For more information, see “Enabling premium features” 

on page 18. 

Note:  Before you configure storage subsystems, be sure to read the following 

sections in the Introduction chapter: 

v   “Storage subsystem management methods” on page 8 

v   “Setting up IP addresses for DS4000 storage controllers” on page 13

This section contains the following topics: 

v   “Adding storage subsystems to SMclient” 

v   “Storage Partitioning: Defining a host group” on page 172

Adding storage subsystems to SMclient 

After the disk subsystem is configured on the network, perform the following steps 

to add storage subsystems to DS4000 SMclient.

Notes:  

1.   If the Enterprise Management window does not open, verify that the Storage 

Manager software packages listed in the installation procedures completed their 

installation without error, and that the X Graphical Interface is configured and 

running on the server. 

(The SMclient is a Java-based program that must run in a graphical interface or 

remote graphical window. See “Opening a remote Xwindows or VNC 

connection” on page 163.) 

If the verification process returns an error, contact your support representative. 

2.   Storage Manager client software version 10.10 is supported on SLES 9, SLES 

10, RHEL 4, and for the SMclient only, RHEL 5.

1.   Start SMclient on the management station by typing the following command: 

 # /opt/IBM_DS4000/SMclient 

  

The Enterprise Management window opens. 

2.   Complete the following steps to add the storage subsystems to the SMclient: 

a.   In the Enterprise Management window, click Edit → Add Storage 

Subsystem. 

b.   In the Add Storage Subsystem window, type the IP addresses of each 

controller in the storage subsystem, and click Add. The name of the storage 

subsystem displays in the Enterprise Management window.

Note:  Failure to add both controllers results in a partially-managed system.

3.   Double-click the name of the storage subsystem to open its Subsystem 

Management window.

Upgrading controller firmware and NVSRAM 

The procedures in this section describe how to download and install DS4000 

controller firmware and NVSRAM.
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Note:  If you are upgrading a DS4800, DS4700, or a DS4200 storage subsystem to 

controller firmware version 07.10.xx.xx, see Appendix D, “Using the IBM 

System Storage DS4000 Controller Firmware Upgrade Tool,” on page 235. 

After upgrading to controller firmware version 07.10.xx.xx, use the SMclient 

for maintenance releases and future code levels. 

Overview:   Read the information in the following sections before you begin the 

download procedures: 

v   “Using concurrent download” 

v   “Upgrading controller firmware and NVSRAM” on page 168 

v   “Using traditional or staged download”

Using concurrent download:   Depending on your system’s current firmware version, 

you might be able to use concurrent download. Concurrent download is a method of 

downloading firmware to the controllers that does not require you to stop I/O to the 

controllers during the process.

Note:  Concurrent download is not supported with controller firmware version 

06.14.xx.xx and might not be supported on other versions. Check the 

Storage Manager readme file for Linux on POWER to find out which 

firmware versions currently support concurrent download. 

Using traditional or staged download:   There are two methods for downloading the 

firmware to the controllers: 

v   Traditional download 

v   Staged download

Traditional download 

The traditional download process takes significantly longer and must be 

done in one phase, rather than in two phases as with the staged controller 

firmware download. Therefore the preferred method of controller firmware 

download is the staged controller firmware download. 

Staged download 

 With staged firmware download, the download process occurs in two 

distinct phases: firmware transfer and firmware activation. You can perform 

the time-consuming task of loading the firmware online so that it is 

functionally transparent to the application. You can then defer the activation 

of the loaded firmware to a convenient time. 

Some reasons for activating firmware files at a later time include the 

following: 

v   Time of day—Activating can take a long time, so you might want to wait 

until I/O loads are lighter because the controllers will go offline briefly to 

activate the new firmware. 

v   Type of package—You might want to test the new firmware package on 

one storage subsystem before activating it on other storage subsystems. 

v   Multiple controllers—You can download controller firmware from the 

storage management software to all storage subsystem controllers for 

later activation.

Notes:  

1.   You cannot use staged download to upgrade DS4000 controller 

firmware version 05.xx.xx.xx to 06.xx.xx.xx or 6.xx.xx.xx to 07.10.xx.xx. 

You can only use staged download if the DS4000 controller firmware 
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version is already 06.xx.xx.xx or higher, and you are downloading 

another version of 06.xx.xx.xx firmware or higher. 

2.   Staged controller firmware download is not supported on DS4400 

storage subsystems. 

Important: Do not perform other storage management tasks, such as 

creating or deleting logical drives, reconstructing arrays, and so on, while 

downloading the DS4000 storage subsystem controller firmware. It is 

recommended that you close all storage management sessions (except for 

the session that you use to upgrade the firmware) to the DS4000 storage 

subsystem that you plan to update.

Preparing for firmware or NVSRAM download:   To prepare for download, review 

and complete all of the steps in this section before you start the download 

procedures. 

Check current versions of controller firmware and NVSRAM:   Versions of controller 

firmware and NVSRAM that are provided with this product might be later releases 

than those described in this document. 

To check the controller firmware and NVSRAM versions that are currently installed 

on your system, complete the following steps: 

1.   In the Subsystem Management window, click Storage Subsystem → View 

Profile. The Storage Subsystem Profile window displays. 

2.   In the Storage Subsystem Profile window, click the Controllers tab to view the 

current versions of controller firmware and NVSRAM. 

3.   Click Close to close the Storage Subsystem Profile window. 

4.   To find whether the versions of controller firmware and NVSRAM that are 

currently on your storage subsystem are the latest versions, check the Storage 

Manager readme file for Linux on POWER online. (See “Finding the Storage 

Manager readme files online” on page 24 for details.) 

5.   If you find that you do not have the latest versions of the firmware and 

NVSRAM, download the correct versions from this Web site to a directory on 

your system, then follow the preparation and upgrade procedures that are 

described in this section.

Save the storage subsystem configuration:   Saving the storage subsystem 

configuration to a script file is necessary in order to restore the configuration in the 

event of a catastrophic failure. 

Attention:  Do not use this option if the storage subsystem is undergoing an 

operation that changes any configuration settings. (If any logical drive 

listed in the Logical View of the Subsystem Management window has a 

clock icon, then a configuration change is occurring, and you must wait 

to save the configuration.) 

You can also save the storage subsystem profile by selecting Storage 

Subsystem → View Profile in the Subsystem Management window, and 

clicking Save As. Then, in the Save Profile window, select the sections 

of the profile that you want to save, specify a name and location for the 

text file, and click Save. 

Save the storage subsystem configuration by completing the following steps: 
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1.   In the Subsystem Management window, click Storage Subsystem → 

Configuration → Save. The Save Configuration window displays. 

2.   In the Save Configuration window, select the elements of the configuration that 

you want to save, and click Yes. A save dialog displays. 

3.   In the save dialog, specify a name for the script file and select its location.

Notes:  

v   The .cfg extension is used by default for the script file if you do not 

specify a file extension. 

v   Do not store your DS4000 Storage Subsystem configuration script file 

in the same location as the logical drives that are defined on your 

DS4000 Storage Subsystem. If you do, and the logical drives fail 

during the subsequent migration, you will lose data.

4.   Click Save. The Configuration Saved window displays. 

5.   Review the information in the Configuration Saved window, then click OK to 

return to the Subsystem Management window.

Determine whether you can use concurrent download:   You can use concurrent 

download only if you are upgrading from one version of controller firmware to a later 

release of the same version. For example, if you are upgrading from 06.10.xx.xx to 

06.12.xx.xx, you can use concurrent download. However, if you are upgrading from 

05.xx.xx.xx to 06.1x.xx.xx, you cannot use concurrent download, and you need to 

stop I/O before upgrading controller firmware.

Notes:  

1.   Concurrent download is not supported with controller firmware version 

06.14.xx.xx.and might not be supported with other firmware versions. See the 

latest Storage Manager readme file for Linux on POWER to find out which 

firmware versions currently support concurrent download. 

2.   You can only use concurrent download if an RDAC driver is installed on the 

host. 

3.   Single-controller (SCU) storage subsystem models do not support concurrent 

download.

 Table 19. Firmware versions that support concurrent download (Linux on POWER) 

DS4000 storage subsystem: Controller firmware version: 

DS4100 06.10.xx.xx, 06.12.xx.xx 

DS4200 06.16.88.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4300 base and Turbo 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4400 06.10.xx.xx. 06.12.xx.xx 

DS4500 06.10.xx.xx, 06.12.xx.xx, 06.19.xx.xx, 06.60.xx.xx 

DS4700 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

DS4800 06.16.xx.xx, 06.23.xx.xx, 06.60.xx.xx, 07.10.xx.xx 

All other DS4000 storage subsystems 05.30.xx.xx, 06.10.xx.xx, 06.12.xx.xx
  

Steps for upgrading the controller firmware:   Complete the following steps to 

install a new firmware version on the controllers: 

1.   Download the correct version of the firmware from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 170. 

Place the file in a designated directory on the host system. 
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2.   Check your system’s current firmware versions to determine whether you need 

to stop I/O, using the information that is listed in “Using concurrent download” 

on page 169 and in the latest Storage Manager readme file for Linux on 

POWER. In addition, verify that an RDAC driver is installed on the host. 

Attention: If you do not have the correct firmware versions for concurrent 

download, or if an RDAC driver is not installed, you must stop I/O to the 

controllers before you upgrade the firmware. 

3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller Firmware. The Download Firmware window displays. 

5.   Click Browse to select the firmware file that you previously downloaded to a 

directory on the host. 

6.   If you want to perform a staged firmware download, select the check box next to 

″Transfer files but don’t activate them (activate later).″ If you want to perform a 

traditional firmware download, do not select the check box, and the firmware will 

load immediately. 

7.   Click Transfer. The Confirm Download window displays. 

8.   Click Yes to start the download. 

9.   Verify that the firmware was successfully installed.

Steps for upgrading the NVSRAM:   Complete the following steps to install a new 

version of NVSRAM on the controllers. NVSRAM will be activated immediately. 

1.   Download the correct NVSRAM version from the Web site that is listed in 

“Check current versions of controller firmware and NVSRAM” on page 170. 

Place the file in a designated directory on the host system. 

2.   Stop I/O. 

3.   Ensure that the array is in an Optimal state. If it is not, resolve the issue before 

continuing to the next step. 

4.   In the Subsystem Management window, click Advanced → Maintenance → 

Download → Controller NVSRAM. The Download NVSRAM window displays. 

5.   Click Browse to select the NVSRAM file that you previously downloaded to a 

directory on the host. 

6.   Click Transfer. The Confirm Download window displays. 

7.   Click Yes to start the download. 

8.   Verify that the NVSRAM was successfully installed. If using Linux host profile, 

run the AVT disable script, again, to disable AVT. 

9.   Start I/O.

Storage Partitioning: Defining a host group 

A host group is an entity in the Storage Partitioning topology that defines a logical 

collection of host computers that require shared access to one or more logical 

drives. You can grant individual hosts in a defined host group access to storage 

partitions, independently of the host group. You can make logical drive-to-LUN 

mappings to the host group or to an individual host in a host group. 

If you have purchased a Storage Partitioning premium feature, ensure that the 

premium feature is enabled. 

Steps for defining a host group, host, and host ports:   Complete the following 

steps to define a host group. 
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Before you begin: Note the following information. 

v    If your subsystem is running controller firmware 06.1x.xx.xx or higher, after you 

define your host group you can use the Storage Partitioning wizard feature of the 

Storage Manager task assistant to define hosts, host ports, and storage 

partitions. 

v   Create the host group at the storage subsystem level. Do not create host groups 

at the default group level. 

Exception: If you are running a DS4000 configuration without partitioning 

enabled, you can use the default host group. 

v    If using Linux host profile, run the AVT disable script, again, to disable AVT.

Important::  See the Storage Manager readme file for Linux on POWER for 

up-to-date information about using AVT/ADT. For steps to find the 

readme files on the Web, see “Finding the Storage Manager readme 

files online” on page 24.

 1.   Click the Mappings View tab on the Subsystem Management window. 

 2.   In the Topology section of the Mappings window, highlight the name of the 

storage subsystem, and click Mappings → Define → Host Group.

Note:  Make sure that the storage subsystem is highlighted in the left panel of 

the Subsystem Management window. Do not highlight Undefined 

Mappings. 

 3.   Type the name of the new host group (for example, RHEL 4). Click Add, and 

then click Close. 

 4.   Highlight the new host group and click Mappings → Define → Host. 

 5.   Type the name of the host to which the storage subsystem is attached (for 

example, redhatserver). Click Add, and then click Close. 

 6.   Highlight the host that you just added, then right-click and select Define Host 

Port. 

 7.   Select the first HBA’s host port identifier (for example, 

10:00:00:00:c9:24:0c:3f.). If you do not see the identifier that you are looking 

for, see the “Important” note at the end of this procedure. 

 8.   Change the host type, as follows, according to your configuration: 

v   Single-path: Select Linux. 

v   Dual-path (RDAC): Dual-path (RDAC): select Linux host profile and run the 

AVT disable script to disable AVT.

Important::  See the Storage Manager readme file for Linux on POWER for 

up-to-date information about using AVT/ADT. For steps for finding 

the readme files on the Web, see “Finding the Storage Manager 

readme files online” on page 24.
Click Add.

Important::  Failure to change the host type from the default might cause 

undesired results. 

 9.   If you are configuring an additional HBA to this partition, choose the host port 

for the next HBA and click Add, and then click Close.

Note:  You must configure two HBAs per partition if you are using RDAC.
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Recommendation::  Before closing the window, record the name of each host 

port along with the WWPN of its corresponding HBA, and 

save the information to a file for future reference. 

10.   Verify that the WWPN matches the Host Port Identifier number assigned to the 

host port in the host partition table of the DS4000 SMclient. 

11.   Repeat this procedure to verify the second host port, if configuring for RDAC.

Important::  The host port identifier is the worldwide port name (WWPN) of the host 

bus adapter. If you do not see the one you want in the host port 

identifier drop down menu, check the following: 

Fibre channel cable 

You might not be using the correct cable. Verify that you are 

using the correct fibre channel cable, and that it is connected 

properly. 

Switch zoning 

If you are connected to a switch, ensure that it is zoned 

correctly. 

Note:  For more information about zoning and enabling zones, 

see Appendix F, “Connecting HBAs in a FC switch 

environment,” on page 245.

lpfc module 

You might not have initialized the lpfc module (verify with the 

lsmod command). Load the appropriate module by typing 

modprobe lpfc or modprobe lpfcdfc for the subsystem that 

does not display in the menu.

Mapping LUNs to a storage partition 

This section contains the following procedures: 

v   “Mapping LUNs to a new partition” 

v   “Adding LUNs to an existing partition” on page 175

Important:  

1.    It is recommended that you always map the LUNs using consecutive numbers, 

starting with LUN 0. For example, map LUNs to numbers 0; 1; 2; 3; 4; 5; and so 

on, without skipping any numbers. (For RHEL 4 hosts, this is required.) 

2.   It is recommended that you do not map at the host group level. If you do, every 

attached host can see all the LUNs. 

3.   On each partition, you must map a LUN 0. (It is recommended that LUN 0 is not 

a UTM LUN.) 

4.   You must map at least one non-UTM LUN on each partition.

Mapping LUNs to a new partition:   When mapping LUNs for the first time to a 

newly-created partition, complete the following steps to map LUNs to the partition. 

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition.

Important::  If your subsystem is running controller firmware 06.1x.xx.xx or higher, 

you can use the Storage Partitioning wizard feature of the Storage 

Manager task assistant, instead of this procedure, to map LUNs to a 

new storage partition.
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1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Storage Partitioning. The Define Storage Partitioning 

window opens. 

3.   In the Define Storage Partitioning window, select Host, then click Next. 

4.   Select the logical drive by name, on the right side of the window. 

5.   Accept the default LUN ID, or change it, then click Add. 

6.   Repeat step 5 for each LUN that you want to map to the partition.

Adding LUNs to an existing partition:   When adding LUNs to an existing 

partition, complete the following steps to map the new LUNs to the partition. 

Before you begin: Read “DS4000 Storage Manager performance planning” on 

page 14 for information about planning the number of LUNs to map to each 

partition. 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Additional Mappings. The Define Additional Mapping 

window opens. 

3.   In the Define Additional Mapping window, select the following options, and then 

click Add: 

v   Host group or host 

v   Logical unit number (LUN)(0-255) 

v   Logical drive

Repeat these steps for each LUN that you want to add to the partition. 

Failover drivers 

A Linux on POWER host system requires either the RHEL or the SLES Redundant 

Disk Array Controller (RDAC) failover driver for fibre channel path redundancy. 

The failover driver monitors I/O paths. If a component failure occurs in one of the 

fibre channel paths, the failover driver reroutes all I/O to another path. 

After Storage Manager installation: Completing the host configuration 

After you install the Storage Manager software, complete the host configuration 

procedures that are described in this section. 

Installing the RDAC Multipath driver 

This section describes how to install the RDAC driver for a dual-path 

POWER-based Linux configuration. 

Important::  Before you install RDAC, make sure that the partitions and LUNs are 

configured and assigned and that the correct HBA driver is installed. 

Complete the following steps to install RDAC: 

1.   Download the RDAC driver package from the IBM DS4000 support Web site. 

RDAC package for SLES 9, SLES 10, and RHEL 4: 

rdac_LINUX_09.01.B5.xx_source_tar_gz
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2.   Create a directory on the host and download the RDAC driver package to that 

directory. 

3.   Uncompress the file by typing the following command: 

 # tar -zxvf rdac-LINUX-package_version-source.tar.gz 

  

where package_version is the SLES 9, SLES 10, or RHEL 4 package version 

number that is specified in step 1 on page 175. 

Result: A directory called linuxrdac-version# (SLES 9, SLES 10, and RHEL 4) 

or linuxrdac (RHEL 4) is created. 

4.   Open the Readme.txt that is included in the linuxrdac-version# directory. 

5.   In the Readme.txt, find the instructions for building and installing the driver and 

complete the steps, which include rebooting the server.

Note:  Make sure you reboot the server before you proceed to step 6. 

6.   Type the following command to list the installed modules: 

 # lsmod 

  

7.   Verify that module entries are included in the lsmod list, as follows: 

Module entries for SLES 9, SLES 10, and RHEL 4: 

v   mppVhba 

v   mppUpper 

v   lpfc (or qla2xxx for BladeCenter configurations) 

v   lpfcdfc (if ioctl module is installed)

Note:  If you do not see the mpp_Vhba module, the likely cause is that the 

server was rebooted before the LUNs were assigned, so the mpp_Vhba 

module was not installed. If this is the case, assign the LUNs now, reboot 

the server, and then repeat step 7. 

8.   Type the following command to verify the driver version: 

 # mppUtil -V 

  

Result: The Linux multipath driver version displays. 

9.   Type the following command to verify that devices are configured with the 

RDAC driver 

 # ls -1R /proc/mpp 

  

Result: An output similar to the following example displays: 

 

176 DS4000 Storage Manager Version 10 Installation and Support Guide for AIX, HP-UX, Solaris, and Linux on POWER



# ls -1R /proc/mpp 

/proc/mpp: 

total 0 

dr-xr-xr-x    4 root     root            0 Oct 24 02:56 DS4100-sys1 

crwxrwxrwx    1 root     root     254,   0 Oct 24 02:56 mppVBusNode 

  

/proc/mpp/ DS4100-sys1: 

total 0 

dr-xr-xr-x    3 root     root            0 Oct 24 02:56 controllerA 

dr-xr-xr-x    3 root     root            0 Oct 24 02:56 controllerB 

-rw-r--r--    1 root     root            0 Oct 24 02:56 virtualLun0 

-rw-r--r--    1 root     root            0 Oct 24 02:56 virtualLun1 

-rw-r--r--    1 root     root            0 Oct 24 02:56 virtualLun2 

-rw-r--r--    1 root     root            0 Oct 24 02:56 virtualLun3 

-rw-r--r--    1 root     root            0 Oct 24 02:56 virtualLun4 

-rw-r--r--    1 root     root            0 Oct 24 02:56 virtualLun5 

  

/proc/mpp/ DS4100-sys1/controllerA: 

total 0 

dr-xr-xr-x    2 root     root            0 Oct 24 02:56 lpfc_h6c0t2 

  

/proc/mpp/ DS4100-sys1/controllerA/lpfc_h6c0t2: 

total 0 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN0 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN1 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN2 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN3 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN4 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN5 

  

/proc/mpp/ DS4100-sys1/controllerB: 

total 0 

dr-xr-xr-x    2 root     root            0 Oct 24 02:56 lpfc_h5c0t0 

  

/proc/mpp/ DS4100-sys1/controllerB/lpfc_h5c0t0: 

total 0 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN0 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN1 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN2 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN3 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN4 

-rw-r--r--    1 root     root            0 Oct 24 02:56 LUN5 

  

Note:  After you install the RDAC driver, the following commands and man pages 

are available: 

v   mppUtil 

v   mppBusRescan 

v   mppUpdate 

v   RDAC

Performing initial device identification 

The initial device identification procedures in this section apply to all distributions: 

SLES 9, SLES 10, and RHEL 4. Exceptions are noted. 

Complete the steps in this section, in the order they are listed: 

1.   “Probing the scsi bus” on page 178 

2.   “Associating each HBA WWPN with its assigned host port” on page 178 

3.   “Viewing the LUNs” on page 179 
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4.   “Associating the system LUN devices with DS4000 LUNs” on page 180

Probing the scsi bus 

Probe the scsi bus by completing one of the following procedures, according to 

whether RDAC is installed on your system. 

v   With RDAC installed: 

Type the following command: 

 # mppBusRescan 

  

v   Without RDAC installed: 

You need to remove modules and reload them. Type the following commands to 

remove the modules: 

 # rmmod hba_device_driver 

  

Type the following commands to reload the modules: 

 # modprobe hba_device_driver 

  

Associating each HBA WWPN with its assigned host port 

Associate each HBA WWPN with its assigned host port by completing the following 

steps: 

1.   Type the following commands: 

 #cd /sys/class/fc_host/host# 

  

#ls 

  

A list of HBAs is displayed, as shown in the following example: 

 . .. 10 11 7 8 9 

  

2.   For each HBA in the directory, type the following command: 

 #cat cat port_name 

#cat node_name 

  

where hba# is an HBA in the directory. The HBA’s properties display, as shown 

in the following example: 

 hostname:/ # cat /proc/scsi/lpfc/10 

Emulex LightPulse FC SCSI 2.10h 

HBA: Emulex LightPulse LP9802 (2 Gigabit) on PCI bus 01 device 08 irq 179 

SerialNum: 1E402065E2 

Firmware Version: 1.90 (H2D1.90X2) 

Hdw: 2003806d 

VendorId: 0xf98010df 

Portname: 10:00:00:00:c9:3b:5c:7b   Nodename: 20:00:00:00:c9:3b:5c:7b 

  

Link Up - Ready: 

   PortID 0x1 

   Private Loop 

   Current speed 2G 

  

lpfc0t00 DID 0000dc WWPN 20:35:00:a0:b8:11:15:a6 WWNN 20:04:00:a0:b8:11:15:a6 
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Note:  This display is representative of Linux 2.4 kernels. For 2.6 kernels, you 

see only the recognized target WWPNs, as shown in the following 

example: 

 lpfc0t00 DID 0000dc WWPN 20:35:00:a0:b8:11:15:a6 WWNN 20:04:00:a0:b8:11:15:a6 

  

3.   Check the output to verify connectivity with the storage controllers. The output in 

this example shows that one DS4000, with WWPN DID 0000dc WWPN 

20:35:00:a0:b8:11:15:a6, is attached to the HBA.

Viewing the LUNs 

View the LUNs by typing the following command: 

 # cat/proc/scsi/scsi 

  

The LUN properties display, as shown in the following example: 

 Host: scsi10 Channel: 00 Id: 00 Lun: 00 

  Vendor: IBM      Model: 1815      FAStT  Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

Host: scsi10 Channel: 00 Id: 00 Lun: 01 

  Vendor: IBM      Model: 1815      FAStT  Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

Host: scsi10 Channel: 00 Id: 00 Lun: 02 

  Vendor: IBM      Model: 1815      FAStT  Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

..... 

Host: scsi12 Channel: 00 Id: 00 Lun: 00 

  Vendor: IBM      Model: 1815      FAStT  Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

Host: scsi12 Channel: 00 Id: 00 Lun: 01 

  Vendor: IBM      Model: 1815      FAStT  Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

Host: scsi12 Channel: 00 Id: 00 Lun: 02 

  Vendor: IBM      Model: 1815      FAStT  Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

.... 

Host: scsi13 Channel: 00 Id: 00 Lun: 00 

  Vendor: IBM      Model: VirtualDisk      Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

Host: scsi13 Channel: 00 Id: 00 Lun: 01 

  Vendor: IBM      Model: VirtualDisk      Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

Host: scsi13 Channel: 00 Id: 00 Lun: 02 

  Vendor: IBM      Model: VirtualDisk      Rev: 0914 

  Type:   Direct-Access                    ANSI SCSI revision: 03 

  

The example shows three LUNs, which are assigned to a partition with two HBAs 

for dual-path, with RDAC installed.

Notes:  

1.   Each LUN is displayed on both of its configured paths. The active, assigned 

HBAs are numbers 10 and 12. 

2.   The VirtualDisk is RDAC’s logical disk. There is one VirtualDisk for each LUN, 

regardless of number of paths available. 

3.   If RDAC is installed but you do not see any VirtualDisks in the output, the most 

likely cause is that the mpp_Vhba module did not get installed. (This happens if 

the RDAC driver was installed before any LUNs were configured.) Use the 
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lsmod command to verify whether the mpp_Vhba module is installed. If it is 

missing from the list of modules, make sure that the LUNs are configured, then 

reboot the host.

SLES 9 and SLES 10: On SLES operating systems only, you can use the lsscsi 

command to view LUNs, instead of cat/proc/scsi/scsi. The advantage of using 

lsscsi is that the output is easier to read, as follows: 

 # lsscsi 

[10:0:0:0]   disk    IBM      1815      FAStT  0914  - 

[10:0:0:1]   disk    IBM      1815      FAStT  0914  - 

[10:0:0:2]   disk    IBM      1815      FAStT  0914  - 

... 

[12:0:0:0]   disk    IBM      1815      FAStT  0914  - 

[12:0:0:1]   disk    IBM      1815      FAStT  0914  - 

[12:0:0:2]   disk    IBM      1815      FAStT  0914  - 

... 

[13:0:0:0]   disk    IBM      VirtualDisk      0914  /dev/sdb 

[13:0:0:1]   disk    IBM      VirtualDisk      0914  /dev/sdc 

[13:0:0:2]   disk    IBM      VirtualDisk      0914  /dev/sdd 

  

The fourth column shows the DS4000 model type and the sixth column shows the 

Linux assigned device number. In this example, only the Virtual RDAC devices are 

assigned a system device name. If RDAC is not installed, however, system device 

names display for all of the devices listed in the output. 

Associating the system LUN devices with DS4000 LUNs 

Type the following command: 

 # SMdevices 

  

The device properties display, as shown in the following example: 

 IBM TotalStorage DS4000/FAStT Storage Manager Devices, Version 09.14.A5.00 

Built Mon Mar 28 20:52:15 CST 2005 

(C) Copyright International Business Machines Corporation, 2003-2005 Licensed Ma 

terial - Program Property of IBM.  All rights reserved. 

  

  /dev/sdb (/dev/sg5) [Storage Subsystem subsystem_name, Logical Drive Raid-1-2C, 

LUN 0, Logical Drive ID <600a0b800011162000000f61423cc8ae>, Preferred Path (Contro 

ller-A): In Use] 

  /dev/sdc (/dev/sg6) [Storage Subsystem subsystem_name, Logical Drive Raid-1-3C, 

LUN 1, Logical Drive ID <600a0b80001115ae00000828423cc8db>, Preferred Path (Contro 

ller-B): In Use] 

  /dev/sdd (/dev/sg7) [Storage Subsystem subsystem_name, Logical Drive Raid-1-4C, 

LUN 2, Logical Drive ID <600a0b800011162000000f67423cc8f6>, Preferred Path (Contro 

ller-A): In Use] 

  

  

The example shows the assigned system device numbers that are associated with 

the DS4000 storage subsystem name, and storage assigned LUN ID, as they are 

displayed on the DS4000 storage unit. 

SLES 9, SLES 10, and RHEL 4: On SLES and RHEL 4 operating systems only, 

you can use the following steps instead of using SMdevices:

Note:  You might want to do this if you do not have SMutil installed. 
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Type the following command from the linuxrdac directory: 

 # lsvdev 

  

The following is an example of the lsvdev output: 

 [root@ibm-sys linuxrdac-09.01.B5.34]# ./lsvdev 

Array Name Lun sd device 

DS4500-test-sys 0 -> /dev/sdd 

DS4500-test-sys 1 -> /dev/sde 

DS4500-test-sys 2 -> /dev/sdf 

DS4500-test-sys 3 -> /dev/sdg 

DS4500-test-sys 4 -> /dev/sdh 

DS4500-test-sys 5 -> /dev/sdi 

DS4500-test-sys 6 -> /dev/sdj 

DS4500-test-sys 7 -> /dev/sdk 

DS4500-test-sys 8 -> /dev/sdl 

DS4300-test-sys 0 -> /dev/sdad 

DS4300-test-sys 1 -> /dev/sdae 

DS4300-test-sys 2 -> /dev/sdaf 

DS4300-test-sys 3 -> /dev/sdag 

DS4300-test-sys 4 -> /dev/sdah 

DS4300-test-sys 5 -> /dev/sdai 

DS4300-test-sys 6 -> /dev/sdaj
  

Performing common maintenance tasks 

This section describes some common system administration tasks. The procedures 

in this section apply to all three distributions: SLES 9, SLES 10, and RHEL 4. 

Exceptions are noted. 

v   “Checking LUN size” 

v   “Using dynamic capacity expansion and dynamic volume expansion” on page 

182 

v   “Using the SMdevices utility to find information about LUNs” on page 183 

v   “Viewing or changing queue depth” on page 184 

v   “Replacing IBM host bus adapters on a system” on page 186

Checking LUN size 

This procedure is for SLES 9, SLES 10, and RHEL 4 only. Do not use this 

procedure with RHEL 3, which is no longer supported. 

Complete the following steps to check the size of a LUN: 
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1.   Type the following commands: 

 #cd /sys/block/sdXX 

# cat size 

  

where XX is the device name. Result: A number displays, as in the following 

example: 

 8388608 

  

2.   Multiply this number by 512 (bytes) to calculate the size of the LUN, as shown 

in the following example: 

8388608 * 512 = 4294967296 (~ 4GB) 

Result: The result of the calculation is the size of the LUN. In the example, the 

LUN size is approximately 4 GB.

Using dynamic capacity expansion and dynamic volume expansion 

Dynamic volume expansion (DVE) increases the size of a logical drive. In order to 

perform a DVE, there must be free capacity available on the array. If there is not, 

you can first perform a dynamic capacity expansion (DCE) to increases the array’s 

capacity by adding drives. 

Performing a dynamic capacity expansion operation 

Before you begin:  You can find more information about this procedure in the 

Storage Manager online help. 

Complete the following steps to increase the capacity on the array by performing a 

DCE: 

1.   In the Logical/Physical view of the Subsystem Management window, right-click 

on an array and select Add Free Capacity (Drives). 

2.   In the Add Free Capacity (Drives) window, select one or two available drives 

and click Add. 

After you have ensured that there is sufficient free capacity within the array, you can 

perform a DVE operation, as described in the next topic. 

Performing a dynamic volume expansion operation 

Before you begin:  Ensure that there is available free capacity within the array. You 

can check free capacity availability using DS4000 Storage 

Manager, in the Logical/Physical view of the Subsystem 

Management window. If there is not enough free capacity, and 

extra drives are available, you can add one or more to the 

array by performing a dynamic capacity expansion (DCE) 

operation before you perform the DVE operation. 

You can find more information about this procedure in the 

Storage Manager online help. 

Restrictions:  

1.   You cannot resize the logical drive while the logical drive group is activated in 

classic or enhanced concurrent mode. 

2.   You cannot resize the root logical drive group. 

3.   Dynamic Volume Expansion is not supported on 2.4 kernels.
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Complete the following steps to increase the size of a logical drive by performing a 

DVE: 

1.   Stop I/O to the logical drive whose size you want to increase. 

2.   Unmount the logical drive, if it is mounted. 

3.   From the Logical/Physical window of the Subsystem Management window, 

right-click the logical drive and select Increase Capacity. The Increase Logical 

Drive Capacity—Additional Instructions window opens. 

4.   Read the additional instructions and click OK. The Increase Logical Drive 

Capacity window opens. 

5.   Type the amount that you want to increase the logical drive, and click OK. 

You see a clock icon on every logical drive within the array. You must wait for 

the process to complete before you can begin any host intervention. 

Tip:  If the storage subsystem is busy, the process might take several hours to 

complete. 

6.   On the host, rescan the logical drive by typing the following commands: 

 # cd /sys/block/sdXX/device 

# echo 1 > rescan 

  

where XX is the device name. 

7.   Check the size of the logical drive using the steps that are described in 

“Checking LUN size” on page 181. 

8.   Remount the logical drive.

Using the SMdevices utility to find information about LUNs 

SMutil features an excellent utility, SMdevices, which you can use to map the 

host-assigned device name for each LUN back to its corresponding DS4000 

storage subsystem device. 

In the SMdevices output, you can view the following DS4000 storage subsystem 

information, as it is shown on SMclient. 

Note:  The examples in the list refer to the sample SMdevices output. 

v   Host assigned name (/dev/sdh) 

v   DS4000 storage subsystem name (DS4500_Storage_Server-A) 

v   Logical drive name Raid-5-0A 

v   LUN ID (LUN 4) 

v   Preferred controller owner, and whether that controller is currently controlling the 

logical drive

The following example shows a sample SMdevices output for the subsystem 

DS4500_Storage_Server-A: 
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# SMdevices 

IBM FAStT Storage Manager Devices, Version 09.12.A5.00 

Built Fri Jan 14 16:42:15 CST 2005 

(C) Copyright International Business Machines Corporation, 

2004 Licensed Material - Program Property of IBM.  All rights reserved. 

  

  /dev/sdh (/dev/sg10) [Storage Subsystem DS4500_Storage_Server-A, 

Logical Drive Raid-5-0A, LUN 4, Logical Drive ID 

<600a0b80000f0fc300000044412e2dbf>, Preferred Path (Controller-A): In Use] 

  /dev/sdd (/dev/sg6) [Storage Subsystem DS4500_Storage_Server-A, 

Logical Drive Raid-5-1A, LUN 0, Logical Drive ID 

<600a0b80000f13ec00000016412e2e86>, Preferred Path (Controller-B): In Use] 

  /dev/sde (/dev/sg7) [Storage Subsystem DS4500_Storage_Server-A, 

Logical Drive Raid-0-0A, LUN 1, Logical Drive ID 

<600a0b80000f0fc30000003c412e2d59>, Preferred Path (Controller-A): In Use] 

  /dev/sdf (/dev/sg8) [Storage Subsystem DS4500_Storage_Server-A, 

Logical Drive Raid-1-0A, LUN 2, Logical Drive ID 

<600a0b80000f0fc30000003e412e2d79>, Preferred Path (Controller-A): In Use] 

  /dev/sdg (/dev/sg9) [Storage Subsystem DS4500_Storage_Server-A, 

Logical Drive Raid-3-0A, LUN 3, Logical Drive ID 

<600a0b80000f13ec00000012412e2e4c>, Preferred Path (Controller-A): In Use] 

  

Viewing  or changing queue depth 

Setting the queue_depth attribute to the appropriate value is important for system 

performance. If you have a large DS4000 configuration with many logical drives and 

hosts attached, use this setting for high performance. 

This section provides methods for calculating your system’s maximum queue depth, 

which you can use as a guideline to help you determine the best queue depth 

setting for your configuration.

Note:  Changing queue depths for firmware version 07.10.xx.xx is not required. The 

default queue depths for the HBAs are allowed without restriction. 

Calculating maximum queue depth 

The formula for calculating the maximum queue depth for your system depends on 

which firmware version is installed on the controller. Use one of the following 

formulas to calculate the maximum queue depth for your system. 

Important::  

1.   The maximum queue depth might not be an optimal setting in all cases. Use the 

maximum queue depth as a guideline, and adjust the setting as necessary for 

your specific configuration. 

2.   In systems with one or more SATA devices attached, you might need to set the 

queue depth attribute to a lower value than the maximum queue depth.

Formula for controller firmware version 07.10.xx.xx 

 On DS4000 storage systems that are running DS4000 controller firmware 

version 07.10.xx.xx, use the following formula to determine the maximum 

queue depth: 

For DS4800: 4096 / (number-of-hosts * LUNs-per-host) 

For example, a system with four hosts, each with 32 LUNs, would have a 

maximum queue depth of 32: 

4096 / ( 4 * 32 ) = 32 

For DS4700/DS4200: 2048 / (number-of-hosts * LUNs-per-host) 
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For example, a system with four hosts, each with 32 LUNs, would have a 

maximum queue depth of 16: 

2048 / ( 4 * 32 ) = 16 

Formula for controller firmware versions 06.xx.xx.xx or 05.4x.xx.xx 

 On DS4000 storage systems that are running DS4000 controller firmware 

versions 05.4x.xx.xx, 06.xx.xx.xx, or later, use the following formula to 

determine the maximum queue depth: 

2048 / (number-of-hosts * LUNs-per-host) 

For example, a system with four hosts, each with 32 LUNs, would have a 

maximum queue depth of 16: 

2048 / ( 4 * 32 ) = 16 

Formula for controller firmware version 05.30.xx.xx 

 On DS4000 storage systems that are running DS4000 controller firmware 

version 05.30.xx.xx or earlier, use the following formula to determine the 

maximum queue depth: 

512 / (number-of-hosts * LUNs-per-host ) 

For example, a system with four hosts, each with 32 LUNs, would have a 

maximum queue depth of 4: 

512 / ( 4 * 32 ) = 4

Viewing the current queue depth 

To see the queue depth of each LUN, type the following command: 

 # cat /proc/scsi/sg/{device_hdr,devices} 

  

Note:  If RDAC is installed, the queue depth number that is displayed in the output 

is not the same as the host setting for queue depth, because the RDAC 

driver takes two queues for each LUN. For example, in the following sample 

output, the queue depth of LUNs mapped to host 11 is set to 10; because 

RDAC is installed, the output shows a queue depth of 8.

 #cat /proc/scsi/sg/device_hdr devices 

host    chan    id      lun     type    opens   qdepth  busy    online 

0         0       1       0       5        0        2       0       1 

0         0       8       0       0        3        8       0       1 

11        0       4       0       0        0        8       0       1 

11        0       4       1       0        0        8       0       1 

11        0       4       2       0        0        8       0       1 

11        0       4       3       0        0        8       0       1 

11        0       4       4       0        0        8       0       1 

  

Changing the queue depth 

Complete the following steps to change the queue depth: 

1.   Using the vi editor, open one of the following configuration files for editing, 

according to your operating system: 

v   SLES 9 and SLES 10: /etc/modprobe.conf.local 

v   RHEL 4: /etc/modprobe.conf

2.   Add one of the following options parameters to the configuration file, according 

to your type of HBA: 
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v   Emulex HBA: lpfc_lun_queue_depth=xx 

v   JS20 BladeCenter HBA: ql2xmaxqdepth=xx

where xx is the new queue depth value. 

3.   Set the new queue depth value, as follows: 

v   With RDAC installed: Type the mppUpdate command, then reboot the 

server. 

v   Without RDAC installed: Uninstall the appropriate HBA driver, then reload it.

Example:  To change the queue depth value to 10 on an RHEL 4 system with an 

Emulex HBA and a JS20 BladeCenter HBA, you would type the following 

commands: 

 # vi /etc/modprobe.conf 

options lpfc lpfc_lun_queue_depth=10 

options qla2xxx ql2xmaxqdepth=10 

  

Replacing IBM host bus adapters on a system 

This section provides requirements and procedures for replacing IBM host bus 

adapters in Series p servers on your SLES 9 SP3 or RHEL 4 host system using 

PCI Hotplug tools.

Important::  This procedure is specific for SLES 9 and RHEL 4 host operating 

systems only. Do not use this procedure with any other operating 

system. 

Requirements 

Operating system: 

See one of the following sections for operating system requirements: 

v   “SUSE Enterprise Linux Server system requirements” on page 151 

v   “Red Hat Enterprise Linux 4 (RHEL 4) system requirements” on page 

153

PCI Hotplug tools: 

 Ensure that the following tools are installed in the /usr/sbin directory: 

v    lsslot 

v    drslot_chrp_pci

If these tools are not installed, complete the following steps to install them: 

1.   Ensure that rdist-6.1.5-792.1 and compat-2004.7.1-1.2 are installed 

from the SLES 9 media. 

2.   Download the PCI Hotplug Tools rpm files from the following Web site: 

https://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/suselinux/
hmcmanaged/sles10.html 

3.    On the Web page, select SLES 9 Tools. Download and install the 

following rpm files: 

v   librtas-1.3.1-0.ppc64.rpm 

v   rpa-pci-hotplug-1.0-29.ppc64.rpm

4.    Type the following command to install each rpm file: 

 # rpm -Uvh <filename>.rpm 

  

where <filename> is the name of the rpm file.
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Host bus adapters: 

The following host bus adapters are supported with this procedure: 

v   FC 6228 

v   FC 6239 

v   FC 5716 

v   FC 5758 

v   FC 5759

Note:  See the Storage Manager readme file for Linux on POWER for 

information about additional supported HBAs.

PCI  core: 

The PCI core must be loaded on the system. Type the following command 

to verify: 

 # ls -l /sys/bus/pci/slots 

  

If the PCI core is loaded, the output will look similar to the following: 

 elm17c224:/usr/sbin # ls -l /sys/bus/pci/slots 

total 0 

drwxr-xr-x  8 root root 0 Sep  6 04:29 . 

drwxr-xr-x  5 root root 0 Sep  6 04:29 .. 

drwxr-xr-x  2 root root 0 Sep  6 04:29 0000:00:02.0 

drwxr-xr-x  2 root root 0 Sep  6 04:29 0000:00:02.4 

drwxr-xr-x  2 root root 0 Sep  6 04:29 0000:00:02.6 

drwxr-xr-x  2 root root 0 Sep  6 04:29 0001:00:02.0 

drwxr-xr-x  2 root root 0 Sep  6 04:29 0001:00:02.6 

drwxr-xr-x  2 root root 0 Sep  6 04:29 control 

  

If the /sys/bus/pci/slots directory does not exist, then the PCI core is not 

loaded. 

rpaphp driver: 

The rpaphp driver must be loaded on the system. Type the following 

command to verify: 

 ls -l /sys/bus/pci/slots/* 

  

If the rpaphp driver is loaded, the output will look similar to the following: 

 elm17c224:/usr/sbin # ls -l /sys/bus/pci/slots/* 

/sys/bus/pci/slots/0000:00:02.0: 

total 0 

drwxr-xr-x  2 root root    0 Sep  6 04:29 . 

drwxr-xr-x  8 root root    0 Sep  6 04:29 .. 

-r--r--r--  1 root root 4096 Sep  6 04:29 adapter 

-rw-r--r--  1 root root 4096 Sep  6 04:29 attention 

-r--r--r--  1 root root 4096 Sep  6 04:29 max_bus_speed 

-r--r--r--  1 root root 4096 Sep  6 04:29 phy_location 

-rw-r--r--  1 root root 4096 Sep  6 04:29 power 

  

Listing information about the I/O slots 

Before you replace an HBA using PCI Hotplug, you can use the lsslot tool to list 

information about the I/O slots. This section describes how to use lsslot, and 

provides examples. 

Syntax for the lsslot command:   Use the lsslot tool as follows: 

v   Syntax: lsslot [ -c slot | -c pci [ -a | -o]] [ -s drc-name ] [ -F delimiter ] 
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v   Options: 

No options Displays all DR slots 

-c slot Displays all DR slots 

-c pci Displays all PCI Hotplug slots 

-c pci -a Displays all available (empty) PCI Hotplug slots 

-c pci -o Displays all occupied PCI Hotplug slots 

-F Uses delimiter to delimit columns

Listing PCI Hotplug slots using the lsslot command:   This section shows the 

command lines you can use to list PCI Hotplug slots.

Note:  In the Device(s) columns of the command-line outputs, the PCI devices in 

the slots are listed as follows: xxxx:yy:zz.t. (For example: 0001:58:01.1) 

List all PCI Hotplug slots:   Type the following command to list all PCI Hotplug slots: 

 # lsslot -c pci -a 

  

The resulting output looks similar to the following: 

 

 # Slot                   Description                         Device(s) 

 U7879.001.DQD014E-P1-C1  PCI-X capable, 64 bit, 133MHz slot  Empty 

 U7879.001.DQD014E-P1-C2  PCI-X capable, 64 bit, 133MHz slot  0002:58:01.0 

 U7879.001.DQD014E-P1-C3  PCI-X capable, 64 bit, 133MHz slot  0001:40:01.0 

 U7879.001.DQD014E-P1-C4  PCI-X capable, 64 bit, 133MHz slot  Empty 

 U7879.001.DQD014E-P1-C5  PCI-X capable, 64 bit, 133MHz slot  Empty 

 U7879.001.DQD014E-P1-C6  PCI-X capable, 64 bit, 133MHz slot  0001:58:01.0 

 0001:58:01.1 

  

List all empty PCI Hotplug slots:   Type the following command to list all empty PCI 

Hotplug slots: 

 # lsslot -c pci -a 

  

The resulting output looks similar to the following: 

 

 # Slot                   Description                         Device(s) 

 U7879.001.DQD014E-P1-C1  PCI-X capable, 64 bit, 133MHz slot  Empty 

 U7879.001.DQD014E-P1-C4  PCI-X capable, 64 bit, 133MHz slot  Empty 

 U7879.001.DQD014E-P1-C5  PCI-X capable, 64 bit, 133MHz slot  Empty 

  

List all occupied PCI Hotplug slots:   Type the following command to list all occupied 

PCI Hotplug slots: 

 # lsslot -c pci -o 

  

The resulting output looks similar to the following: 

 

 # Slot                   Description                         Device(s) 

 U7879.001.DQD014E-P1-C2  PCI-X capable, 64 bit, 133MHz slot  0002:58:01.0 

 U7879.001.DQD014E-P1-C3  PCI-X capable, 64 bit, 133MHz slot  0001:40:01.0 

 U7879.001.DQD014E-P1-C6  PCI-X capable, 64 bit, 133MHz slot  0001:58:01.0 

 0001:58:01.1 
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Show detailed information about a particular device:   Select a device number from 

the output of # lsslot -c pci -o, as seen in the previous output example, and 

type the following command to show detailed information about that particular 

device: 

 # lspci | grep xxxx:yy:zz.t 

  

where xxxx:yy:zz.t is the number of the PCI Hotplug device. The resulting output 

looks similar to the following: 

 0001:40:01.0 Ethernet controller: Intel Corp. 82545EM Gigabit 

Ethernet Controller (Copper) (rev 01) 

  

Replacing a PCI Hotplug HBA 

Syntax for the drslot_chrp_pci command:   Use the drslot_chrp_pci tool as 

follows: 

v   Syntax: drslot_chrp_pci -c slot {-r | -a | -R | -i } -s slot-name 

v   Options: 

-r Remove 

-a Add 

-R Replace 

-i Identify

Replacing an HBA:   Complete the following procedures to replace a PCI Hotplug 

HBA by using the drslot_chrp_pci command.

Note:  In these procedures, the variable slot-name refers to the slot that contains 

the HBA that you are replacing.

Attention:  Before you remove the HBA, you will need to remove the fibre channel 

cable that is attached to the HBA. The fibre channel cable must remain 

unattached for at least five minutes to ensure that all I/O activity is 

transferred to the alternate path. Failure to remove the fibre channel 

cable can lead to undesirable results. 

1. Identify the PCI Hotplug slot:   Type the following command to identify the PCI 

Hotplug slot: 

 # drslot_chrp_pci -i -s  slot-name 

  

where slot-name is the name of the slot for the HBA you are replacing. (Example: 

U7879.001.DQD014E-P1-C3) 

The light at slot slot-name begins flashing, and this message displays: 

 The visual indicator for the specified 

PCI slot has been set to the identify 

state. Press Enter to continue or 

enter x to exit. 
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2. Hot unplug the HBA from the slot:   Complete the following steps to hot unplug 

(remove) the HBA: 

1.   Remove the fibre channel cable that is connected to this HBA, and wait for 

failover to complete. 

2.   After failover is complete, type the following command: 

 # drslot_chrp_pci -r -s   slot-name 

  

This message displays: 

 The visual indicator for the specified 

PCI slot has been set to the identify 

state. Press Enter to continue or 

enter x to exit. 

  

3.   Press Enter. This message displays: 

 The visual indicator for the specified 

PCI slot has been set to the action state. 

Remove the PCI card from the identified slot 

and press Enter to continue. 

  

4.   Press Enter. 

5.   Physically remove the HBA from the slot. 

6.   Type the following command to verify that the slot is empty: 

 # lsslot -c pci -s    slot-name 

  

If the slot is empty, the resulting output looks similar to the following: 

 # Slot                   Description                         Device(s) 

U7879.001.DQD014E-P1-C3  PCI-X capable, 64 bit, 133MHz slot  Empty 

  

3. Hot plug the HBA into the slot:   Complete the following steps to hot plug the 

HBA into the slot. 

1.   Type the following command: 

 # drslot_chrp_pci -a -s      slot-name 

  

This message displays: 

 The visual indicator for the specified 

PCI slot has been set to the identify 

state. Press Enter to continue or 

enter x to exit. 
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2.   Press Enter. This message displays: 

 The visual indicator for the specified 

PCI slot has been set to the action state. 

Insert the PCI card into the identified slot, 

  

connect any devices to be configured 

and press Enter to continue. Enter x to exit. 

  

3.   Insert the new HBA into the slot. 

4.   Type the following command to verify that the slot is no longer empty: 

 # lsslot -c pci -s     slot-name 

  

If the slot is not empty, the resulting output looks similar to the following: 

 # Slot                   Description                         Device(s) 

U7879.001.DQD014E-P1-C3  PCI-X capable, 64 bit, 133MHz slot  0001:40:01.0 

  

Reassigning the WWPN on the DS4000 storage subsystem 

After you replace the HBA, you must reassign its new WWPN on the DS4000 

storage subsystem. Complete the following steps: 

1.   If RDAC is installed, type the following command to recognize the new HBA: 

 # mppBusRescan 

  

2.   Start Storage Manager. 

3.   In the Mappings View of the Storage Manager Subsystem Management window, 

select the HBA Host Port that was previously assigned to the HBA that you 

replaced. 

4.   Right-click the HBA Host Port, then select Replace.... A new Storage Manager 

window opens. 

5.   In the new window, select the new host WWPN from the pull-down menu, or 

type the WWPN in the New Identifier field. 

6.   Click OK to close the window. 

7.   Type mppBusRescan again. Verify that the newly-replaced HBA recognizes the 

LUNs by checking the lsscsi output.

Remotely installing Linux (SAN boot) 

This section describes how to remotely install (SAN boot) a SLES or RHEL Linux 

operating system onto a Series p host server that is connected by fibre channel to a 

DS4000 storage subsystem. 

Software requirements 

See the following sections for operating system requirements: 

v   “SUSE Enterprise Linux Server system requirements” on page 151 

v   “Red Hat Enterprise Linux 4 (RHEL 4) system requirements” on page 153
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Hardware requirements 

The following hardware is required: 

v   IBM Eserver Series p server(s) 

v   Supported IBM Series p host bus adapters (HBAs) 

v   DS4000 storage subsystem

Assumptions 

This procedure assumes the following: 

v   No installation is present. 

v   After the installation is complete, the boot and swap devices will run on a 

DS4000 storage subsystem.

Preparing for the SAN boot procedure 

Complete the following steps before you begin the installation: 

1.   Be familiar with the following topics: 

v   How to connect to and operate an IBM Series p server 

v   How to create LUNs on the DS4000 storage subsystem 

v   How to set up a SAN network or direct-attached SAN storage devices, so 

that the configured server can access the DS4000 LUNs 

v   How the Linux kernel boot process functions, and what processes and 

procedures are used to boot a Linux distribution for a local storage device

2.   Ensure that you have a copy of your RHEL 4, SLES 9, or SLES 10 operating 

system installation file available, either on CD or on an accessible network. 

3.   Verify that the BOOT BIOS is enabled on the HBA devices that are configured 

for the server. (The BOOT BIOS setting enables discovery and use of SAN disk 

devices during the installation process.) 

4.   It is required to remove all but one path to the primary controller for the LUN 

that will be used for installation. This can be done by pulling a fibre channel 

cable or by disabling or blocking a fibre channel switch port. 

5.   Ensure that the size of the boot device that you plan to use is at least 20 GB. 

(This is the minimum size for installing all packages from the installation media 

to the boot devices.) 

In addition, ensure that the size of the swap device is equivalent to or larger 

than the size of the server’s physical memory.

Notes:  

a.   Disks that are used during the installation process must have their preferred 

paths set to the DS4000 controller that is attached to the active fibre 

channel path in the system (and not to the one that you deconfigured in step 

4). 

b.   For simplicity, the procedure described in this document assumes that the 

boot, root, and swap devices are all located on the same device. However, 

this is not a requirement for the installation.

Steps for performing the SAN boot procedure 

The installation media (source for installation) that is used in the following steps is 

an NFS-exported set of CDs. However, you can use any of the following installation 

sources: 

v   CD 

v   NFS 
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v   HTTP 

v   FTP 

v   Other source

Important:  

1.   The initial release of SLES 9 does not adequately support the SAN boot 

process. When you initially boot the system, boot from one of the currently 

available service packs before installing the SLES 9 base code. 

2.   Not all of the details about installation and partitioning are documented in this 

procedure. To determine which packages are needed for the type of system you 

are installing, you must refer to your system’s installation procedures.

Note:   

Complete the following steps. 

1.   From the System Management Services menu (SMS), select your installation 

source, and boot from the media. (See your server’s installation manual for 

further instructions.) 

2.   Verify that the HBA module is loaded. (For RHEL, the module is lpfc; for SLES, 

the module is lpfcdd.) 

3.   Verify that the SAN devices you are using for the installation have been 

detected successfully.

Note:  If the SAN devices are already configured for multiple path access, Linux 

discovers the same physical device multiple times—once for each logical 

path to the device. 

4.   Note which SAN device will be used for the installation (for example, /dev/sdh.) 

Also, note which HBA device is used to discover the SAN device. (You will need 

this information later in the procedure.) 

5.   For RHEL: Select the installation options that are appropriate for your 

configuration. For partitioning options, select Autopartition then select the drive 

you are using as the installation target. Then, continue to the steps listed in 

“Completing the RHEL procedure” on page 194. 

For SLES: Select the installation options that are appropriate for your 

configuration until the Installation Settings dialog displays. Then complete the 

following steps: 

a.   In the Installation Settings dialog, select Change. 

b.   In the next dialog that displays, select Partitioning.

Note:  For SLES, partitioning is necessary to ensure that the device that you 

noted in step 4 is used as the root/boot installation target. 

c.   In the Custom Partitioning dialog, select the device, then select Custom 

partitioning for experts. 

d.   Ensure that there is a PReP boot partition on the root/boot device, and that 

it is the first partition. 

e.   Continue to partition devices as required to complete this configuration. 

f.   Finish the installation. 

Note:  When attempting to create the yaboot boot loader, an error occurs 

that states that the ’fcp’ device type is unknown. Click OK, and then 

select No when asked to retry.
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g.   Open the SMS menu to reboot from the installation source media. (If you 

are booting from a CD, continue to a point where you can abort the 

installation and return to the command-line menu. If you are booting from 

the network, the command-line menu is already present.) 

h.   Select the option to boot from an installed system, select the root device 

that you just installed, and continue. 

i.   When the YaST installation wizard displays, use the wizard to finish the 

installation. 

j.   Continue to “Completing the SLES procedure.”

Completing the SLES procedure 

After you finish the previous steps, you must complete the following steps to finish 

the SAN boot procedure for the SLES system: 

1.   Use YaST to upgrade the installed system to the latest SLES 9 service pack. 

(As of this writing, the latest service pack is SP 3. SLES 10 service packs have 

not been released yet.) 

2.   Run the cat /etc/yaboot.conf command, and verify that the data in this file 

looks correct for the boot and root partitions. 

3.   Run the yaboot command. This permits the installation of the yaboot loader to 

the PReP boot partition of the drive (resolving the installation error that occurred 

in the previous steps). 

4.   Reboot again and open the SMS menu. This time, the boot device that you set 

up in the previous steps is ready to be used. Select the option to boot from a 

hard drive/SAN, and select the HBA that is associated with the SAN disk device 

on which the installation was completed. 

5.   The installation boot device should now be listed in the ″bootable″ devices that 

are discovered on the selected HBA. Select the appropriate device, and boot. 

6.   Set the installed boot device as the default boot device for the system. 

Note:  This step is not required. However, it is recommended to enable 

unattended reboots after this procedure is complete.

If all of the preceding steps were completed accurately, the SLES system is now 

booted in single-path mode from the SAN. Complete the following steps to verify 

the installation: 

1.   Use the df command to check the mounted devices and verify that the root is 

mounted in the appropriate location. 

2.   Use the swapon -s command to verify that the swap device is correctly 

mounted. 

3.   Verify that the other configured partitions are also correctly mounted. 

This completes the single-path SAN boot procedure for SLES systems. 

Note:  With dual-path systems, you can now reconfigure the second fibre channel 

connection that you deconfigured in step 4 of “Preparing for the SAN boot 

procedure” on page 192, and proceed to “Installing the RDAC Multipath 

driver” on page 175. 

Completing the RHEL procedure 

After you finish the previous steps, you must complete the following steps to finish 

the SAN boot procedure for the RHEL 4 system: 
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1.   Reboot again and open the SMS menu. This time, the boot device that you set 

up in the previous steps is ready to be used. Select the option to boot from a 

hard drive/SAN, and select the HBA that is associated with the SAN disk device 

on which the installation was completed. 

2.   The installation boot device should now be listed in the “bootable” devices that 

are discovered on the selected HBA. Select the appropriate device, and boot. 

3.   Set the installed boot device as the default boot device for the system. 

Note:  This step is not required. However, it is recommended to enable 

unattended reboots after this procedure is complete.

If all of the preceding steps were completed accurately, the RHEL system is now 

booted in single-path mode from the SAN. Complete the following steps to verify 

the installation: 

1.   Check the mounted devices, and verify that the root is mounted in the 

appropriate location. 

2.   Verify that the swap device and other configured partitions are correctly 

mounted. 

This completes the single-path SAN boot procedure for RHEL systems. 

Note:  With dual-path systems, you can now reconfigure the second fibre channel 

connection that you deconfigured in step 4 of “Preparing for the SAN boot 

procedure” on page 192, and proceed to “Installing the RDAC Multipath 

driver” on page 175.
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Chapter  6.  Completing  the  software  configuration  

After you finish installing DS4000 Storage Manager, you must complete your 

configuration. This chapter describes how to complete the DS4000 Storage 

Manager configuration by performing the following tasks: 

v   “Configuring storage subsystems” on page 201 

v   “Configuring alert notifications” on page 205 

v   “Renaming storage subsystems” on page 206 

v   “Creating a storage subsystem profile” on page 206 

v   “Performing other storage subsystem management tasks” on page 207

If your subsystem is running at controller firmware version 6.1x.xx.xx or later, you 

can use the Storage Manager Task Assistant to complete many of the procedures 

described in this section. See “Using the Task Assistant” for more information. 

 Attention:  For cluster configurations, complete all applicable configuration 

procedures for each storage subsystem before installing the storage management 

software on a second host or cluster server. 

Overview of heterogeneous host configurations 

The heterogeneous hosts feature enables hosts that are running different operating 

systems to access a single storage subsystem. DS4000 Storage Manager 9.1x or 

higher supports up to 64 storage partitions, which enables a multiple host-type 

subsystem to share storage capacity, consolidate storage, and reduce storage 

management costs. 

Host computers can run on completely different operating systems (for example, 

AIX and Solaris) or variants of the same operating system (for example, Solaris 

running in a cluster environment). When you define a host type in the Define New 

Host Port window, the heterogeneous hosts feature enables the controllers in the 

storage subsystem to tailor their behavior (such as LUN reporting and error 

conditions) to the needs of the operating system or variant of the host that is 

sending the information. 

Important: When you define host types in a heterogeneous environment, you must 

set each host type to its appropriate operating system so that the firmware on each 

controller can respond correctly for the appropriate operating system. 

Before you begin setting up the configuration for you heterogeneous host, see the 

IBM DS4000 Storage Manager Concepts Guide. 

Using the Task  Assistant 

The Task Assistant provides a convenient, central location from which you can 

choose to perform the most common tasks in the Enterprise Management window 

and in the Subsystem Management window. 

If your subsystem is running at controller firmware version 6.1x.xx.xx or later, you 

can use the Storage Manager Task Assistant to complete many of the procedures 

described in this section. 
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In the Enterprise Management window, the Task Assistant provides shortcuts to 

these tasks: 

v   Adding storage subsystems 

v   Naming or renaming storage subsystems 

v   Setting up alert destinations 

v   Managing storage subsystems

In the Subsystem Management window, the Task Assistant provides shortcuts to 

these tasks: 

v   Configuring storage subsystems 

v   Saving configurations 

v   Defining hosts 

v   Creating a new storage partition 

v   Mapping additional logical drives

If there is a problem with the storage subsystem, a shortcut to the Recovery Guru 

appears, where you can learn more about the problem and find solutions to correct 

the problem. 

To open the Task Assistant, choose View → Task Assistant from either the 

Enterprise Management window or the Subsystem Management window, or click 

the Task Assistant button in the toolbar:
  

 

The Task Assistant window opens. See Figure 22 on page 199 for the Enterprise 

Management window Task Assistant or Figure 23 on page 200 for the Subsystem 

Management window Task Assistant. 
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Figure 22. The task assistant in the Enterprise Management window
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Note:  The Task Assistant is automatically invoked every time you open the 

Subsystem Management window unless you check the Don’t show the task 

assistant at startup again check box at the bottom of the window.
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Figure 23. The task assistant in the Subsystem Management window
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Configuring storage subsystems 

Use the following procedures to start the DS4000 SMclient from either the storage 

management station or from a host that is acting as a storage management station 

(a host with the client software installed). Use the SMclient to discover and 

configure each attached storage subsystem. 

Performing an initial automatic discovery of storage subsystems 

Complete the following steps to begin an initial automatic discovery of all the 

attached hosts and storage subsystems: 

1.   If you are running the DS4000 SMclient from AIX, first change to the /SMclient 

directory and then type SMclient. (For more information about initial automatic 

discovery on AIX systems, see “Identifying devices on AIX hosts” on page 47.) If 

you are running the client software from Solaris 8 or 9, type SMclient. 

2.   Click Yes to begin the initial automatic discovery.

Note:  It can take up to one minute for the Enterprise Management window to 

refresh after an initial automatic discovery. If you need to stop the 

automatic discovery operation for any reason, close the Enterprise 

Management window. 

When the initial automatic discovery is finished, all attached hosts and attached 

storage subsystems are displayed in the Subsystem Management window, as 

shown in Figure 24.
 

SJ001148

  

Figure 24. Subsystem Management window
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3.   Ensure that all of the attached hosts and storage subsystems are displayed as 

expected. If they are not, complete the following steps: 

a.   Check the hardware and connections for possible problems (see the 

hardware documentation for specific procedures). 

b.   See the Enterprise Management window help topic on discovering storage 

subsystems and take the appropriate action that is indicated. 

c.   Ensure that the storage subsystem is on the local subnetwork. If it is not, 

click Edit → Add Storage Subsystem to add it. See the Enterprise 

Management window help topic on adding devices.

Note:  Failure to add both controllers results in a partially-managed 

subsystem. 

d.   If a storage subsystem is duplicated in the device tree after an automatic 

discovery, remove the duplicate storage subsystem icon from the device tree 

by clicking Edit → Remove... in the Enterprise Management window. Click 

Yes when the dialog window appears.

4.   Ensure that the status of each storage subsystem is Optimal: 

v   If any device shows a status of Unresponsive, remove the device from the 

management domain, and then add it again. See the Enterprise Management 

window help topic on removing and adding devices. 

v   If the device still shows an unresponsive status, contact your IBM 

technical-support representative.

5.   Go to “Configuring alert notifications” on page 205.

Creating arrays and logical drives 

Important: You should create a storage subsystem profile and save it in a safe 

place whenever you modify the arrays and logical drives in your storage subsystem. 

This saved profile contains detailed controller information, including logical and 

physical disk configuration information that can help you recover the configuration in 

the event of a catastrophic failure. Do not save the profile in the logical drives for 

which you create this configuration information backup. 

To create a storage subsystem profile, select Storage Subsystem → View Profile 

in the Storage Subsystem Management window and click the Save As button when 

the Storage Subsystem Profile window opens. In addition, using firmware version 

07.10.xx.xx, you can also select Advanced → Troubleshooting → Collect All 

Support Data as shown in Figure 25 on page 203 to collect all the various types of 

inventory, status, diagnostic and performance data from this storage subsystem and 

save them to a single compressed file.
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An array is a set of fibre channel or SATA hard drives that are logically grouped 

together to form a Redundant Array of Independent Disks (RAID). 

A logical drive is a logical structure, which is the basic structure that you create to 

store data on the storage subsystem. The operating system recognizes a logical 

drive as a single drive. Choose a RAID level to meet application needs for data 

availability and maximize fibre channel I/O performance. 

Maximum number of drives:  

1.   For firmware level 06.xx.xx.xx, the maximum number of drives supported in an 

array is 30, regardless of the hard drive capacity. Each array can be divided into 

from 1 to 256 logical drives. 

2.   For firmware levels 05.4x.xx.xx and later, the maximum number of drives 

supported in an array is 30, regardless of the hard drive capacity. Each array 

can be divided into from 1 to 256 logical drives. 

3.   For firmware levels 05.3x.xx.xx and lower, the maximum number of hard drives 

supported for each array is 30 if the hard drive capacities are 73.4GB or less 

and 14 if the hard drive capacities are 146GB.

Note:  For cluster configurations, if you add or delete logical drives, you must make 

them known to both nodes A and B. 

Creating an array 

In the DS4000 Storage Manager Subsystem Management window, perform the 

following steps to create an array from unconfigured capacity nodes. 
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Figure 25. Collect All Support Data window
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1.   Use either of the following two methods to create a new array: 

v   Select Total Unconfigured Capacity node, and click Array → Create, or; 

v   Select and right-click Total Unconfigured Capacity node, and click Create 

Array.

The Introduction (Create Array) window opens. 

2.   Click Next to continue. 

3.   The Array Name & Drive Selection (Create Array) window opens. 

v   Array name—Enter a name for the new array. This name can be a maximum 

of 30 characters. 

v   Drive selection choices—Select one of the two options. 

–   Automatic (Recommended)—Choose from a list of automatically 

generated drive and capacity options. (This option is preselected by 

default.) 

–   Manual (Advanced)—Choose specific drives to obtain capacity for the new 

array.

v   Click Next to continue.

4.   The RAID Level and Capacity (Create Array) window opens. Specify the RAID 

level (redundancy protection). 

5.   Select the number of drives (overall capacity) for the new array. 

6.   Click Finish. 

7.   The Array Created window opens. If, at this point, you want continue the 

process to create a logical drive, click Yes; if you want to wait to create a logical 

drive at another time, click No.

Creating a logical drive 

In the DS4000 Storage Manager Subsystem Management window, perform the 

following steps to create a logical drive. 

 1.   In the Logical/Physical View tab of the Introduction (Create Logical Drive) 

window, you will see how much Free Capacity is available for all existing 

arrays. Select the Free Capacity of an array for which you want to create a 

new logical drive; then, right-click and select Create Logical Drive. 

 2.   Click Next. 

 3.   In the Specify Capacity/Name (Create Logical Drive) window, specify the 

following parameters for the logical drive you are creating. 

New logical drive capacity 

The capacity can either be the entire unconfigured capacity in an array 

or a portion of the array's capacity. 

Units Choose GB, MB, or TB, depending upon the capacity available. 

Name Choose a name that is unique in the storage subsystem, up to a 

maximum of 30 characters.

 4.   Under Advanced logical drive parameters, select from one of the options. 

v   Use recommended settings 

v   Customize settings (I/O characteristics and controller ownership) 

You can create the logical drive using the DS4000 storage subsystem 

recommended settings, or you can customize your I/O characteristics, 

controller ownership, and logical-drive-to-LUN mapping settings. To use the 

recommended (default) settings, select Use recommended settings, and click 
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Next, then proceed to step 6. If you want to customize your settings, select 

Customize settings, and click Next, then proceed to step 5. 

 5.   In the Advanced logical drive parameters window, specify the appropriate I/O 

characteristics (characteristics type, segment size, and cache read-ahead 

multiplier). 

The I/O characteristics settings can be set automatically or they can be 

manually specified, based on one of the following logical drive usages—file 

system, database, or multimedia. Click Next. The Specify Logical Drive-to-LUN 

Mapping (Create Logical Drive) window opens. 

 6.   In the Specify Logical Drive-to-LUN Mapping (Create Logical Drive) window, 

specify the logical drive-to-LUN mapping. 

The logical drive-to-LUN mapping preference can be one of the following two 

settings: 

Default mapping 

The Automatic setting specifies that a LUN is automatically assigned to 

the logical drive using the next available LUN within the default host 

group. This setting grants logical drive access to host groups or host 

computers that have no specific logical drive-to-LUN mappings (those 

that were designated by the default host group node in the Topology 

view). If the Storage Partition feature is not enabled, you must specify 

the Automatic setting. In addition, you can also change the host type to 

match the host operating system. 

Map later using the Mappings View 

This setting specifies that you are not going to assign a LUN to the 

logical drive during creation. This setting enables you to define a 

specific logical drive-to-LUN mapping and create storage partitions 

using the Mappings Defined option. When you enable storage 

partitioning, specify this setting.

 7.   Click Finish to create the logical drive. The Creation Successful (Create 

Logical Drive) window opens and states that the logical drive was successfully 

created. 

 8.   In the Creation Successful (Create Logical Drive) window, click Yes and 

proceed to step 9, if you want to create another logical drive; otherwise, click 

No. When the Completed (Create Logical Drive) window opens, click OK, and 

and continue with step 10. 

 9.   In the Allocate Capacity (Create Logical Drive) window, choose to create the 

new logical drive from free capacity on the same array, free capacity on a 

different array, or from unconfigured capacity (create a new array). Then 

continue with step 1 on page 204. 

10.   The Completed (Create Logical Drive) window opens. Click OK. 

11.   Register the logical drive with the operating system. 

After you create logical drives with automatic logical drive-to-LUN mappings, 

follow the appropriate instructions in the Installation and Support Guide for your 

operating system to allow it to discover the new logical drive.

Configuring alert notifications 

After you have added devices to the management domain, you should set up alert 

notification options to report critical events on the storage subsystems. The 

following alert notification options are available: 
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v   Alert notifications are sent to a designated network management station (NMS) 

using simple network management protocol (SNMP) traps. 

v   Alert notifications are sent to a designated e-mail address. See the Enterprise 

Management window help for specific procedures. To send e-mail to IBM, contact 

your customer service representative. 

v   Alert notifications are sent to a designated alphanumeric pager when third-party 

software is used to convert e-mail messages. See the Enterprise Management 

window help for specific procedures. 

For more information about notification options, see the IBM DS4000 Storage 

Manager Concepts Guide. 

Complete the following steps to set up alert notifications using SNMP traps. You 

need to set up the designated management station only once. 

1.   Ensure that the installation CD is inserted in the CD-ROM drive on your 

designated NMS. 

2.   From the installation CD, copy the SM9.MIB file from the SM9mib directory to 

the NMS. 

3.   Follow the steps required by your NMS to compile the MIB. For details, contact 

your network administrator or see the documentation for the storage 

management product you are using.

Renaming storage subsystems 

When you start the storage management software for the first time, the storage 

subsystems are unnamed. In the Subsystem Management window, click Storage 

Subsystem → Rename. Rename each storage subsystem from <unnamed> to a 

name that is appropriate for your network. 

Creating a storage subsystem profile 

Create a storage subsystem profile and save it in a safe place whenever you 

modify the arrays and logical drives in your storage subsystem. This profile contains 

detailed controller information, including logical and physical disk configuration 

information. In the event of a catastrophic failure, you can use the storage 

subsystem profile to help recover the configuration. 

Complete the following steps to create a storage subsystem profile: 

1.   In the Storage Subsystem Management window, click Storage Subsystem → 

View Profile. The Storage Subsystem Profile window opens. 

2.   Click Save As. 

3.   Type a file name for the storage subsystem profile and save it to a directory.

If you have a storage subsystem with firmware 04.01.xx.xx or earlier, you must also 

perform a controller state capture in addition to saving the storage subsystem 

profile. To use the Capture State Information feature, upgrade your controller to the 

latest firmware available for your storage subsystem. 

Complete the following steps to create a storage subsystem profile by using the 

Capture State Information feature. 

1.   Click Advanced → Troubleshooting → Capture State Information. The State 

Capture window opens. 

2.   Click Browse to specify the file name for the state capture information. 
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3.   Click Start to start the capture process. 

4.   Click Cancel to close the State Capture window when the capture is complete.

Performing other storage subsystem management tasks 

You can also perform other storage subsystem management tasks at this time. To 

perform the following tasks and other storage subsystem management tasks, see 

the appropriate topics in the Subsystem Management window online help: 

v   Locate a storage subsystem 

v   View a storage subsystem profile 

v   Configure a storage subsystem password 

v   Create and manage arrays and array groups 

v   Use the performance monitor 

v   Create storage partitions (if Storage Partitioning is enabled on your system) 

v   Download drive firmware

If you are installing the storage management software in a cluster environment, 

repeat all applicable client software installation procedures for a second storage 

management station and for all applicable host software on a second host. See the 

following sections for installation instructions: 

v   Chapter 4, “Installing and configuring storage management software on Solaris 

host systems,” on page 107 

v   Chapter 5, “Installing and configuring storage management software on 

POWER-based Linux host systems,” on page 151 

v   Chapter 6, “Completing the software configuration,” on page 197
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Chapter  7.  Using  DS4000  Storage  Manager  with  

high-availability  cluster  services  

The high-availability clustering services provided by DS4000 Storage Manager allow 

application services to continue when a hardware or software failure occurs. This 

system protects you from software failures as well as from the failure of a CPU, 

disk, or LAN component. If a component fails, its redundant partner component 

takes over cluster services and coordinates the transfer between components. 

General information 

This document does not describe how to install or configure cluster services. Refer 

to documentation that is provided with your cluster service products for this 

information. 

 

 

Important: 

The information in this document might not include up-to-date cluster software 

version levels. 

For the latest requirements and user information about using DS4000 Storage 

Manager with cluster services, see the readme file that is located in the 

DS4000 Installation CD for your host operating system, or check the most 

recent readme files online. 

See “Readme files and concepts” on page 1 for instructions on finding the 

readme files online. 

You can also find more information on the DS4000 Interoperability matrix, 

which is maintained at the following Web site: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Using cluster services on HP-UX systems 

The information in this document might not show up-to-date cluster software version 

levels. Check the Storage Manager readme file for HP-UX for up-to-date information 

about clustering requirements. See “Readme files and concepts” on page 1 for 

instructions on finding the readme file online. 

You can also refer to the DS4000 Interoperability Matrix at the following Web site: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

You can choose among many configurations when you set up clustering on an 

HP-UX system. A minimum configuration consists of two servers that are configured 

with both a primary and two standby LANs to establish a heartbeat LAN. 

Provide fibre channel connections to the storage subsystem through two switches 

that provide the necessary redundant data path for the hosts. Ensure that each 

server has two HP Tachyon host bus adapters. 

For more information, see Appendix E, “Limitations,” on page 241. 
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Using cluster services on Solaris systems 

The following sections contain general hardware requirements and additional 

information about the cluster services. 

 

 

Important: 

The information in this document might not show up-to-date cluster software 

version levels. Check the Storage Manager readme file for Solaris for 

up-to-date information about clustering requirements, including the latest 

supported versions of VERITAS Cluster Server. See “Readme files and 

concepts” on page 1 for instructions on finding the readme file online. 

You can also refer to the DS4000 Interoperability Matrix at the following Web 

site: 

www.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

General hardware requirements 

Each Solaris system in the cluster requires the following hardware: 

v   At least three Ethernet ports: 

–   Two for the private network connections 

–   At least one for the public network connection

v    Two fibre channel host bus adapters for connection to the storage subsystem 

v   A SCSI connection for operating system disks 

v   Each VERITAS Cluster Server system requires at least 128 MB of RAM and 35 

MB of free disk space

System dependencies 

This section provides information about VERITAS VolumeManager, RDAC IDs, and 

single points of failure. 

VERITAS VolumeManager and Data Multipathing 

If you are using RDAC as your failover driver, and you are using the VERITAS 

VolumeManager, you must disable Data Multipathing (DMP). Complete one of the 

following procedures, according to your version of VERITAS VolumeManager. 

Note:  If you are using the VERITAS Cluster Server, you must change the stack 

size parameters. Open the /etc/system file in the Vi text editor and make the 

following changes: 

v   Change the default value for set lwp_default_stksize to 0x8000 

v   Change the default value for set rcpcmod:svc_default_stksize to 0x8000

VERITAS VolumeManager 3.1 or earlier:   For VERITAS VolumeManager 3.1 or 

earlier, you must disable DMP for all devices. 

Complete the following steps: 

1.   Open the /etc/system file in the vi Editor by typing the following command: 

 # vi /etc/system 

  

2.   Comment out the forceload: drv/vxdmp line. 
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3.   Save and close the /etc/system file.

RDAC IDs 

Add up to eight additional IDs to the /etc/symsm/rmparams file. Complete the 

following steps to add them: 

1.   Open the /etc/symsm/rmparams file in the vi Editor by typing the following 

command: 

 # vi /etc/symsm/rmparams 

  

2.   Modify the Rdac_HotAddIDs line as follows: 

 Rdac_HotAddIDs:0:1:2:3:4:5:6:7:8 

  

3.   Save and close the /etc/symsm/rmparams file.

Single points of failure 

When setting up cluster services, it is important to eliminate single points of failure 

because a single point of failure makes a cluster only as strong as its weakest 

component. Set up the storage subsystem for shared storage; for example, all the 

nodes in the cluster must recognize the same storage and the host types must be 

set correctly. 

Using cluster services on AIX systems 

The following sections contain general hardware requirements and additional 

information about the cluster services. 

 

 

Important: 

The information in this document might not show up-to-date cluster software 

version levels. Check the Storage Manager readme file for AIX for up-to-date 

information about clustering requirements. See “Readme files and concepts” 

on page 1 for instructions on finding the readme file online. 

You can also refer to the following Web sites for the most current information 

about AIX and clustering: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

http://publib.boulder.ibm.com/infocenter/clresctr/index.jsp 

General hardware requirements 

For hardware, software, firmware and RDAC requirements, see Appendix C, 

“Downloading ESM firmware and drive firmware,” on page 229. 

High Availability Cluster Multi-Processing 

This section contains general requirements and usage notes for High Availability 

Cluster Multi-Processing (HACMP) support with DS4000 Storage Manager. 

Software requirements 

For the latest supported HACMP versions, see the DS4000 Interoperability Matrix at 

the following Web site: 
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Configuration limitations 

The following limitations apply to HACMP configurations: 

v   HACMP C-SPOC cannot be used to add a DS4000 disk to AIX using the Add a 

Disk to the Cluster facility. 

v   HACMP C-SPOC does not support enhanced concurrent mode volume groups. 

v   Single-HBA configurations are allowed, but each single-HBA configuration 

requires that both controllers in the DS4000 be connected to a switch, within the 

same SAN zone as the HBA. 

Attention::  Although single-HBA configurations are supported, they are not 

recommended for HACMP environments because they introduce a 

single point-of-failure in the storage I/O path. 

v    Switched fabric connections between the host nodes and the DS4000 storage 

subsystem are recommended. However, direct attachment from the host nodes to 

the DS4000 storage subsystem in an HACMP environment is supported, only if 

all the following restrictions and limitations are met: 

–   Only dual-controller DS4000 storage subsystem versions are supported for 

direct attachment in a high-availability (HA) configuration. 

–   The AIX operating system must be version 05.2 or later. 

–   The HACMP clustering software must be version 05.1 or later. 

–   All host nodes that are directly attached to the DS4000 storage subsystem 

must be part of the same HACMP cluster. 

–   All logical drives (LUNs) that are surfaced by the DS4000 storage subsystem 

are part of one or more enhanced concurrent-mode volume groups. 

–   The volume group varyon is in the active state only on the host node that 

owns the HACMP non-concurrent resource group (which contains the 

enhanced concurrent-mode volume group or groups). For all other host nodes 

in the HACMP cluster, the enhanced concurrent-mode volume group varyon 

is in the passive state. 

–   Direct operations on the logical drives in the enhanced concurrent-mode 

volume groups cannot be performed, from any host nodes in the HACMP 

cluster, if the operations bypass the Logical VolumeManager (LVM) layer of 

the AIX operating system. For example, you cannot use a DD command while 

logged in as the root user. 

–   Each host node in the HACMP cluster must have two fibre channel 

connections to the DS4000 storage subsystem. One direct fibre channel 

connection must be to controller A in the DS4000 storage subsystem, and the 

other direct fibre channel connection must be to controller B in the DS4000 

storage system. 

–   You can directly attach a maximum of two host nodes in an HACMP cluster to 

a dual-controller version of a DS4100 or DS4300 storage subsystem. 

–   You can directly attach a maximum of two host nodes in an HACMP cluster to 

a DS4000 storage subsystem. Each host node must have two direct fibre 

channel connections to the storage subsystem. 

Note:  In a DS4400 or DS4500 storage subsystem, the two direct fibre 

channel connections from each host node must to independent 

miniHUBs. Therefore, this configuration requires that four host 

miniHUBs (feature code 3507) be installed in the DS4400 or DS4500 

storage subsystem—two host miniHUBs for each host node in the 

HACMP cluster.
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Other HACMP usage notes 

The following notations are specific to HACMP environments: 

v   HACMP clusters can support from two to 32 servers on each DS4000 partition. If 

you run this kind of environment, be sure to read and understand the AIX device 

drivers queue depth settings that are described in Chapter 4, “Installing and 

configuring storage management software on Solaris host systems,” on page 

107. 

v   You can attach non-clustered AIX hosts to a DS4000 that is running DS4000 

Storage Manager and is attached to an HACMP cluster. However, you must 

configure the non-clustered AIX hosts on separate host partitions on the DS4000.

Parallel System Support Programs and General Parallel File System 

This section contains general requirements and usage notes for Parallel System 

Support Programs (PSSP) and General Parallel File System™ (GPFS™) support with 

DS4000 Storage Manager. 

Software requirements 

For the latest supported PSSP and GPFS versions, see the DS4000 Interoperability 

Matrix at the following Web site: 

www.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Configuration limitations 

The following limitations apply to PSSP and GPFS configurations: 

v   Direct connection is not allowed between the host node and a DS4000 storage 

subsystem. Only switched fabric connection is allowed. 

v   RVSD clusters can support up to two IBM Virtual Shared Disk and RVSD servers 

for each DS4000 partition. 

v   Single node quorum is not supported in a dual-node GPFS cluster with DS4000 

disks in the configuration. 

v   Heterogeneous configurations are not supported.

Other PSSP and GPFS usage notes 

In GPFS file systems, the following DS4000 cache settings are supported: 

v   Read cache enabled or disabled 

v   Write cache enabled or disabled 

v   Cache mirroring enabled or disabled (depending upon the write cache mirroring 

setting)

The performance benefits of read or write caching depends on the application. 

GPFS, PSSP,  and HACMP cluster configuration diagrams 

The diagrams in this section show both the preferred and failover paths from an 

HBA pair to a given volume or set of volumes. 

A preferred path to a volume is determined when the volume is created and 

distributed across a DS4000 controller. The controller to which it is assigned 

determines which path is preferred or active for I/O transfer. Volumes can, and in 

most cases should, be assigned to both controllers, balancing the I/O load across 

HBAs and DS4000 controllers. 
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Figure 26 shows a cluster configuration that contains a single DS4000 storage 

subsystem, with one to four partitions.
 

Figure 27 on page 215 shows a cluster configuration that contains three DS4000 

storage subsystems, with one partition on each storage subsystem.
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Figure 26. Cluster configuration with single DS4000 storage subsystem—one to four partitions
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Figure 28 on page 216 shows a cluster configuration that contains four DS4000 

storage subsystems, with one partition on each storage subsystem.
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Figure 27. Cluster configuration with three DS4000 storage subsystems—one partition per DS4000
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Figure 29 on page 217 shows a cluster configuration that contains two DS4000 

storage subsystems, with two partitions on each storage subsystem.
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Figure 28. Cluster configuration with four DS4000 storage subsystems—one partition per DS4000
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Figure 30 on page 218 shows an HACMP/GPFS cluster configuration that contains 

a single DS4000 storage subsystem, with one partition.
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Figure 29. RVSD cluster configuration with two  DS4000 storage subsystems—two partitions per DS4000
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Figure 31 on page 219 shows an HACMP/GPFS cluster configuration that contains 

two DS4000 storage subsystems, with two partitions on each storage subsystem.
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Figure 30. HACMP/GPFS cluster configuration with one DS4000 storage subsystem—one partition
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Appendix  A.  MC/Service  Guard  configuration  details  

Note:  The Hewlett-Packard publication Managing MC/ServiceGuard suggests using 

vgimport -m -s with LVM commands during the configuration distribution 

process. It is important to consider, however, that the vgimport command 

does not preserve the primary and alternate paths of the imported volume 

groups. 

When vgimport reconstructs the newly imported volume groups, entries are made 

in the /etc/lvmtab file. In this process of reconstruction, the system reorders disks in 

the file. The revised order of LUNs on the list causes LUNs to remain on 

non-preferred paths after failover. You might expect this condition to occur during 

distribution of the volume groups using the following LVM command: 

 vgimport -s -m /tmp/vg_group_name.map /dev/vg_group_name 

  

where vg_group_name is the name of the volume group that is being distributed. 

This precaution applies only when you use the -s option to import devices or disks 

with redundant paths. The condition occurs because the -s option causes a search 

on the system for each disk when used with vgimport. 

When the new list is prepared, the links that were previously designated as primary 

and alternate might not remain as they had been configured on node A. 

Complete the following steps to correct the paths that were changed in this way 

when using vgimport -m -s with LVM commands. 

Note:  The following instructions are for a two-node cluster. You can easily expand 

or adapt these instructions to accommodate a cluster which has more than 

two nodes. 

1.   Identify and note the primary and alternate paths for each device by typing the 

following command: 

 # SMdevices 

  

2.   Compare the primary and alternate paths for each device on node A to Node B 

by using the vgdisplay -v command. As previously noted, an expected behavior 

of the vgimport -m -s command is that the primary and alternate paths change 

during export. 

On node A: 

 #vgdisplay -v volume_group_name 

  

where vg_group_name is the name of the volume group whose paths you want 

to display. 

On node B: 

 #vgdisplay -v volume_group_name 

  

where vg_group_name is the name of the volume group whose paths you want 

to display. 

3.   If the original primary path of a disk becomes an alternate path after the newly 

imported volume group entry is created in /etc/lvmtab, the order can be easily 

reverted by using vgreduce to remove the wrong primary path and then using 
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vgextend to add the path back again: 

 #vgreduce 

vg1 /dev/dsk/device_name#vgextend 

vg1 /dev/dsk/device_name 
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Appendix  B.  JNI  and  QLogic  host  bus  adapter  settings  

The following tables detail settings for the various host bus adapter (HBA) cards for 

Sun Solaris. 

Note:  JNI host bus adapters are supported only on Solaris 8 and 9. They are not 

supported on Solaris 10. 

JNI HBA card settings 

The JNI cards are not plug-and-play with autoconfiguration. Instead, you might need 

to change the settings or bindings. 

Configuration settings for FCE-1473/FCE-6460/FCX2-6562/FCC2-6562  

These JNI HBAs (FCE-1473, FCE-6460, FCX2-6562, and FCC2-6562) are 

supported with all currently-supported levels of DS4000 controller firmware. 

Important: For all settings that are listed in Table 20, you must uncomment the line. 

This is true for both default settings and for settings that you must change. 

For more information about setting the attributes for JNI HBAs, see “Modifying the 

HBA settings and binding the HBAs” on page 125. 

 Table 20. Configuration settings for FCE-1473/FCE-6460/FCX2-6562/FCC2-6562 

Original value New  value 

FcLoopEnabled = 1 FcLoopEnabled = 0 (for non-loop; auto-topology) 

FcLoopEnabled = 1 (for loop) 

Note: See “Modifying the JNI HBA settings for a IBM SAN 2 

GB switch” on page 128 for more information about setting 

these parameters. 

FcFabricEnabled = 0 FcFabricEnabled = 0 (for non-fabric; auto-topology) 

FcFabricEnabled = 1 (for fabric) 

Note: See “Modifying the JNI HBA settings for a IBM SAN 2 

GB switch” on page 128 for more information about setting 

these parameters. 

FcEngHeartbeatInterval = 5 Same as original value (in seconds). 

FcLinkUpRecoveryTime = 

1000 

Same as original value (in milliseconds). 

BusRetryDelay = 5000 Same as original value (in milliseconds). 

TargetOfflineEnable = 1 TargetOfflineEnable = 0 (Disable) 

TargetOfflineEnable = 1 (Enable) 

FailoverDelay = 30; FailoverDelay = 60 (in seconds) 

FailoverDelayFcTape = 300 Same as original value (seconds). 

TimeoutResetEnable = 0 Same as original value. 

QfullRetryCount = 5 Same as original value 

QfullRetryDelay = 5000 Same as original value (in milliseconds). 

LunRecoveryInterval = 50 Same as original value (in milliseconds). 

FcLinkSpeed = 3 Same as original value. (This value [auto-negotiate] is the 

recommended setting.) 

JNICreationDelay = 1 JNICreationDelay = 10 (in seconds) 
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Table 20. Configuration settings for FCE-1473/FCE-6460/FCX2-6562/FCC2-6562 (continued) 

Original value New value 

FlogiRetryCount = 3 Same as original value. 

FcFlogiTimeout = 10 Same as original value (in seconds). 

PlogiRetryCount = 3 Same as original value. 

PlogiControlSeconds = 30 Same as original value (in seconds). 

LunDiscoveryMethod = 1 Same as original value (LUN reporting). 

CmdTaskAttr = 0 CmdTaskAttr = 0 (Simple Queue) 

CmdTaskAttr = 1 (Untagged) 

automap = 0 automap = 1 (Enable) 

FclpEnable = 1 FclpEnable = 0 (Disable) 

OverrunFailoverCount = 0 Same as original value. 

PlogiRetryTime = 50 Same as original value. 

SwitchGidPtSyncEnable = 0 Same as original value. 

target_throttle = 256 Same as original value. 

lun_throttle = 64 Same as original value. 

Add these settings. (See 

“Modifying the HBA settings 

and binding the HBAs” on 

page 125 for procedures.) 

target0_hba = “jnic146x0”; 

target0_wwpn = “<controller wwpn>” 

target1_hba = “jnic146x1”; 

target1_wwpn = “<controller wwpn>”
  

Note:  You might need to run the /etc/raid/bin/genjniconf reconfigure script from the 

Solaris shell.

 # /etc/raid/bin/genjniconf 

  

Configuration settings for FCE-1063/FCE2-1063/FCE-6410/FCE2-6410  

These JNI HBAs (FCE-1063, FCE2-1063, FCE-6410, and FCE2-6410) are 

supported with all currently-supported levels of DS4000 controller firmware. 

Important: For all settings that are listed in Table 21, you must uncomment the line. 

This is true for both default settings and for settings that you must change. 

For more information about setting the attributes for JNI HBAs, see “Modifying the 

HBA settings and binding the HBAs” on page 125. 

 Table 21. Configuration settings for FCE-1063/FCE2-1063/FCE-6410/FCE2-6410 

Original value New value 

FcLoopEnabled = 1 FcLoopEnabled = 0 (for non-Loop) 

FcLoopEnabled = 1 (for Loop) 

Note: See “Modifying the JNI HBA settings for a IBM SAN 2 

GB switch” on page 128 for more information about setting 

these parameters. 

FcFabricEnabled = 0 FcFabricEnabled = 0 (for non-fabric) 

FcFabricEnabled = 1 (for fabric) 

Note: See “Modifying the JNI HBA settings for a IBM SAN 2 

GB switch” on page 128 for more information about setting 

these parameters. 
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Table 21. Configuration settings for FCE-1063/FCE2-1063/FCE-6410/FCE2-6410 (continued) 

Original value New  value 

FcPortCfgEnable = 1 FcPortCfgEnable = 0 (port reconfiguration not required) 

FcPortCfgEnable = 1 (port reconfiguration required) 

FcEngHeartbeatInterval = 5 Same as original value (in seconds). 

FcLrrTimeout = 100 Same as original value (in milliseconds). 

FcLinkUpRecoverTime = 

1000 

Same as original value (in milliseconds). 

BusyRetryDelay = 5000 Same as original value (in milliseconds). 

FailoverDelay = 30; FailoverDelay = 60; 

TimeoutResetEnable = 0 Same as original value. 

QfullRetryCount = 5 Same as original value. 

QfullRetryDelay = 5000 Same as original value (in milliseconds). 

loRecoveryDelay = 50 Same as original value (in milliseconds). 

JniCreationDelay = 5; JniCreationDelay = 10; 

FlogiRetryCount = 3 Same as original value. 

PlogiRetryCount = 5 Same as original value. 

FcEmIdEndTcbTimeCount = 

1533 

Same as original value. 

target_throttle = 256 Same as original value. (Default throttle for all targets.) 

lun_throttle = 64 Same as original value. (Default throttle for all LUNs.) 

automap = 0 automap = 0 (persistence binding) 

automap = 1 (automapping) 

Add these settings. (See 

“Modifying the HBA settings 

and binding the HBAs” on 

page 125 for procedures.) 

target0_hba = “jnic146x0”; 

target0_wwpn = “controller wwpn” 

target1_hba = “jnic146x1”; 

target1_wwpn = “controller wwpn”
  

v   You might need to run the /etc/raid/bin/genjniconf reconfigure script from the 

Solaris shell. 

 # /etc/raid/bin/genjniconf 

  

v   Set portEnabled = 1; only when you see JNI cards entering non-participating 

mode in the /var/adm/messages file. Under that condition: 

1.   Set FcPortCfgEnabled = 1; 

2.   Restart the host. 

3.   Set FcPortCfgEnabled = 0; 

4.   Restart the host again. 

When you have done so, check /var/adm/messages to be sure that it sets the 

JNI cards to Fabric or Loop mode.

Configuration settings for FCI-1063 

This JNI HBA (FCI-1063) is supported only in configurations with DS4000 controller 

firmware versions 05.4x.xx.xx, or earlier. 
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Important: For all settings that are listed in Table 22, you must uncomment the line. 

This is true for both default settings and for settings that you must change. 

For more information about setting the attributes for JNI HBAs, see “Modifying the 

HBA settings and binding the HBAs” on page 125. 

 Table 22. Configuration settings for FCI-1063 

Original value New  value 

scsi_initiator_id = 0x7d Same as original value. 

fca_nport = 0; fca_nport = 1 (for the fabric) / fca_nport = 0 (for the 

loop) 

public_loop = 0 Same as original value. 

target_controllers = 126 Same as original value. 

ip_disable = 1; Same as original value. 

ip_compliant = 0 Same as original value. 

qfull_retry_interval = 0 Same as original value. 

qfull_retry_interval = 1000 Same as original value (in milliseconds) 

failover = 30; failover = 60 (in seconds) 

failover_extension = 0 Same as original value. 

recovery_attempts - 5 Same as original value. 

class2_enable = 0 Same as original value. 

fca_heartbeat = 0 Same as original value. 

reset_glm = 0 Same as original value. 

timeout_reset_enable = 0 Same as original value. 

busy_retry_delay= 100; Same as original value. (in milliseconds) 

link_recovery_delay = 1000; Same as original value. (in milliseconds) 

scsi_probe_delay = 500; scsi_probe_delay = 5000 (in milliseconds; 10 

milliseconds resolution) 

def_hba_binding = “fca-pci*”; def_hba_binding = “nonjni”; (for binding) 

def_hba_binding = “fcaw”; (for non-binding) 

def_wwnn_binding = “$xxxxxx” def_wwnn_binding = “xxxxxx” 

def_wwpn_binding = “$xxxxxx” Same as the original entry. 

fca_verbose = 1 Same as the original entry. 

Will be added by reconfigure script name=“fca-pci” parent=“physical path” 

unit-address=“#” 

Will be added by reconfigure script target0_hba=“fca-pci0” target0_wwpn=“controller 

wwpn”; 

Will be added by reconfigure script name=“fca-pci” parent=“physical 

path”unit-address=“#” 

Will be added by reconfigure script target0_hba=“fca-pci1” target0_wwpn= “controller 

wwpn”;
  

Note:  You might need to run the /etc/raid/bin/genjniconf reconfigure script from the 

Solaris shell. 

 # /etc/raid/bin/genjniconf 
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Configuration settings for FC64-1063 

This JNI HBA (FC64-1063) is supported only in configurations with DS4000 

controller firmware versions 05.4x.xx.xx, or earlier. 

Important: For all settings that are listed in Table 23, you must uncomment the line. 

This is true for both default settings and for settings that you must change. 

For more information about setting the attributes for JNI HBAs, see “Modifying the 

HBA settings and binding the HBAs” on page 125. 

 Table 23. Configuration settings for FC64-1063 

Original value New  value 

fca_nport = 0; fca_nport =1; 

ip_disable = 0; ip_disable=1; 

failover = 0; failover =30; 

busy_retry_delay = 5000; busy_retry_delay = 5000; 

link_recovery_delay = 1000; link_recovery_delay = 1000; 

scsi_probe_delay = 5000; scsi_probe_delay = 5000; 

def_hba_binding = “fcaw*”; Direct attached configurations: 

def_hba_binding = “fcaw*”; 

  

SAN-attached configurations: 

def_hba_binding = “nonJNI”; 

def_wwnn_binding = “$xxxxxx” def_wwnn_bindindef_hba_ binding = “nonjni”; g = “xxxxxx” 

def_wwnn_binding = “$xxxxxx” Same as the original entry. 

Will be added by reconfigure 

script 

name=“fcaw” parent=“<physical path>”unit-address=“<#>” 

Will be added by reconfigure 

script 

target0_hba=“fcaw0” target0_wwpn=“<controller wwpn>”; 

Will be added by reconfigure 

script 

name=“fcaw” parent=“<physical path>”unit-address=“<#>” 

Will be added by reconfigure 

script 

target0_hba=“fcaw0” target0_wwpn= “<controller wwpn>”;

  

Note:  You might need to run the /etc/raid/bin/genscsiconf reconfigure script from 

the shell prompt. 

 # /etc/raid/bin/genscsiconf 
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QLogic HBA card settings 

The QLogic cards are not plug-and-play with autoconfiguration. Instead, you need 

to change the settings or bindings, as described in Table 24. 

Note:  In Table 24, the HBA is identified as hba0. However, you need to modify the 

settings on both QLogic HBA cards: hba0 and hba1. 

When you modify the settings on hba1 use the same values that are listed in 

the table, but change all instances of hba0 to hba1, as shown in the 

following example: 

 HBA  card Original value New  value 

hba0 hba0-execution-throttle=16; hba0-execution-throttle=255; 

hba1 hba1-execution-throttle=16; hba1-execution-throttle=255;
  

In the vi Editor, uncomment and modify the loop attributes of each QLogic HBA 

card, using the values described in Table 24. 

For more information about setting the attributes for QLogic HBAs, see “Modifying 

the QLogic HBA settings” on page 134. 

 Table 24. Configuration settings for QL2342 

Original value New  value Comments 

max-frame-length=2048; max-frame-length=2048 Use the default. 

execution-throttle=16; execution-throttle=255; Change. 

login-retry-count=8; login-retry-count=30; Change. 

enable-adapter-hard-loop-ID=0; enable-adapter-hard-loop-
ID=1; 

Change. 

adapter-hard-loop-ID=0; adapter-hard-loop-ID=0; Needs to be a 

unique number. 

enable-LIP-reset=0; enable-LIP-reset=0; Use the default. 

hba0-enable-LIP-full-login=1; hba0-enable-LIP-full-login=1; Use the default. 

enable-target-reset=0; enable-target-reset=0; Use the default. 

reset-delay=5 reset-delay=8 Change. 

port-down-retry-count=8; port-down-retry-count=70; Change. 

maximum-luns-per-target=8; maximum-luns-per-target=0; Change. 

connection-options=2; connection-options=2; Use the default. 

fc-tape=1; fc-tape=0; Change. 

loop-reset-delay = 5; loop-reset-delay = 8; Change. 

> gbyte-addressing = disabled; > gbyte-addressing = 

enabled; 

Change. 

link-down-timeout = 30; link-down-timeout = 60; Change.
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Appendix  C.  Downloading  ESM  firmware  and  drive  firmware  

The information in this appendix describes how to download current ESM firmware 

to a DS4000 EXP storage expansion enclosure and current drive firmware to a 

DS4000 storage subsystem, using the following procedures: 

v   “Verifying and downloading ESM firmware” 

v   “Downloading drive firmware” on page 232

Verifying and downloading ESM firmware 

This section describes how to verify current ESM firmware levels and how to 

download ESM firmware to an DS4000 EXP storage expansion enclosure, using the 

following procedures: 

v   “Verifying current ESM firmware version” 

v   “Downloading ESM firmware” on page 230 

v   “Automatic ESM firmware synchronization” on page 232

Important:  If you are using DS4000 controller firmware version 05.41.xx.xx or 

05.42.xx.xx with the EXP100, the EXP100 ESM firmware must be at 

version 955x or higher. However, you cannot upgrade the EXP100 

firmware from 953x to 955x. 

Before proceeding, see the IBM TotalStorage DS4000 EXP100 Storage 

Expansion Enclosure Installation and User’s Guide or see the readme 

for controller firmware version 05.42.xx.xx at the following Web site: 

www-1.ibm.com/servers/storage/support/disk/ 

Click the link for DS4100 (FAStT100). When the page opens, click the 

Download tab, then follow the links to the readmes. 

Verifying current ESM firmware version 

Choose one of the following methods to determine the storage expansion 

enclosure’s ESM firmware version, using DS4000 Storage Manager. 

v   Method One: 

1.   In the Subsystem Management window, click Storage Subsystem → View 

Profile. The Storage Subsystem Profile window opens. 

2.   Select the Enclosures tab and scroll through the Profile For Storage 

Subsystem panel to locate the ESM card firmware version information. 

Tip: The Profile for Storage Subsystem panel contains all the profile information 

for the entire subsystem. Therefore, it might be necessary to scroll through a 

large amount of information to locate the ESM firmware version information. 

v   Method Two: 

1.   In the Physical View panel of the Subsystem Management window, click 

Advanced → Maintenance → Download → ESM firmware. The Download 

Environmental (ESM) Card Firmware window opens. 

2.   In the Download Environmental (ESM) Card Firmware window, locate the 

firmware version of each ESM in the drive enclosure. 

Tip: Each enclosure has two ESM cards: A and B.
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Downloading ESM firmware 

To find the latest versions of ESM firmware files that you need to download, see the 

most recent DS4000 readme file, which is located at the following Web site: 

www-1.ibm.com/servers/storage/support/disk/ 

Click the link for your storage subsystem. When the page opens, click the 

Download tab, then follow the links to the readmes. 

Complete the following procedures to download ESM firmware: 

v   “Preparing for the download” 

v   “Downloading the ESM firmware” on page 231

Preparing for the download 

To prepare for the download, review and complete all of the steps in this section 

before you start the download procedures that are listed in “Downloading the ESM 

firmware” on page 231. 

Before you begin: Ensure that you have the latest version of the DS4000 Storage 

Manager installed on your DS4000 management station. You can download the 

latest version from the following IBM DS4000 support Web site: 

www-1.ibm.com/servers/storage/support/disk/ 

Complete the following steps to prepare your system for the firmware download: 

1. Backup your logical drives. 

Complete a full backup of all logical drives that are defined in the DS4000 

storage subsystem. 

2. Save the storage subsystem profile. 

 Saving a profile is necessary in order to restore a storage subsystem 

configuration in the event of a catastrophic failure. Save your storage 

subsystem profile by completing the following steps: 

1.   In the Subsystem Management Menu, select Storage Subsystem → 

View → Profile. The Storage Subsystem Profile window opens. 

2.   In the Storage Subsystem Profile window, click Save As. The Save 

Profile window opens. 

3.   In the Save Profile window, select or enter the file directory and file 

name. Click Save to save the profile. The Save Profile window closes. 

Attention: Do not store DS4000 Storage Subsystem profiles in the 

same location as the logical drives that are defined on your DS4000 

Storage Subsystem. If you do, and the logical drives fail during the 

subsequent migration, you will lose data. 

4.   Click Close to close the Storage Subsystem Profile window.

3.  Verify current EXP ESM status. 

In the DS4000 Storage Manager Subsystem Management window, verify 

that all ESMs in the configuration that you are upgrading are in the Optimal 

state, and there are not any lost drive-path redundancy errors. Correct any 

problems using the suggested instructions in the DS4000 Storage Manager 

Recovery Guru window. 
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To verify, either click the Recovery Guru icon in the Subsystem 

Management window, or click the Enclosure Status icon in each enclosure 

with the red X mark overlay, as displayed in the Physical View. 

5. Determine whether you need to stop I/O. 

 Downloading firmware without stopping I/O is referred to as concurrent 

download. Concurrent ESM firmware download is supported with the 

following conditions: 

v   You can only use concurrent ESM firmware download with fibre channel 

storage expansion enclosures. With SATA storage expansion enclosures, 

you must stop I/O before downloading ESM firmware. 

v   You must download the ESM firmware to one storage expansion 

enclosure at a time. If you want to download ESM firmware to multiple 

storage expansion enclosures at the same time, you must stop I/O 

before downloading. 

v   Ensure that concurrent ESM download is supported with the new ESM 

firmware package by checking its readme file before you download the 

package. If concurrent download is not supported with the new firmware, 

you must stop I/O before downloading the firmware.

When you are done, continue to “Downloading the ESM firmware.” 

Downloading the ESM firmware 

Before you begin: To find the latest versions of ESM firmware files that you need 

to download, see the most recent DS4000 readme file, which is located at the 

following Web site: 

www-1.ibm.com/servers/storage/support/disk/ 

Click the link for your storage subsystem. When the page opens, click the 

Download tab, then follow the links to the readmes. 

Complete the following steps to download the ESM firmware to the DS4000 EXP 

storage expansion enclosure: 

1.   In the Subsystem Management window, select Advanced → Maintenance → 

Download → ESM firmware. The Download Environmental (ESM) Card 

Firmware window opens. 

2.   In the Download Environmental (ESM) Card Firmware window, select the 

storage expansion enclosure to be updated with new firmware, and then click 

Browse to open the Select Environmental (ESM) Card Firmware File window.

Attention:  You can download the ESM firmware to several storage expansion 

enclosures at the same time by selecting more than one storage 

expansion enclosure – however, you must stop all I/O before 

performing the download. If you do not want to stop I/O, then 

download the ESM firmware to each storage expansion enclosure, 

one at a time. Detailed information about download times can be 

found in the readme for your host OS. See “Readme files and 

concepts” on page 1. 

3.   In the Select Environmental (ESM) Card Firmware File window, select the 

directory that contains the ESM firmware file, then select the name of the ESM 

firmware file. Click OK to close the window and continue. 
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Note:  You might need to select All Files (*.*) in the “Files of type” pull-down 

menu to display the correct file name for selection. If you do, then a 

warning window opens. Click OK when the warning window opens. 

4.   In the Download Environmental (ESM) Card Firmware window, click Start. 

When the Confirm Download window opens, type yes and click OK. The ESM 

firmware download begins. During the download, the status field of the 

Download Environmental (ESM) Card Firmware window displays the progress of 

each enclosure.

When the status field of each enclosure displays a status of Complete, the ESM 

firmware download is complete. 

Automatic ESM firmware synchronization 

When you install a new ESM into an existing storage expansion enclosure in a 

DS4000 storage subsystem that supports automatic ESM firmware synchronization, 

the firmware in the new ESM is automatically synchronized with the firmware in the 

existing ESM. This resolves any ESM firmware mismatch conditions automatically. 

To enable automatic ESM firmware synchronization, ensure that your system meets 

the following requirements: 

v   The Storage Manager Event Monitor must be installed and running 

v   The DS4000 storage subsystem must be defined in the Enterprise Management 

window of the Storage Manager client (SMclient)

Note:  Storage Manager 10.10 currently supports automatic ESM firmware 

synchronization with EXP810 storage expansion enclosures only. Contact 

IBM for information about support for other types of storage expansion 

enclosures in the future. To correct ESM firmware mismatch conditions in 

storage expansion enclosures without automatic ESM firmware 

synchronization support, you must download the correct ESM firmware file 

by using the ESM firmware download menu function in the SMclient 

Subsystem Management window. 

Downloading drive firmware 

This section provides instructions for downloading DS4000 drive firmware. See the 

online help for additional information. 

Important: 

1.   IBM supports firmware download with I/O, sometimes referred to as ″concurrent 

firmware download.″ This feature is not supported for drive firmware. 

2.   Before starting the drive firmware download process: 

v   Stop all I/O activity before downloading drive firmware to a DS4000 Storage 

Subsystem. 

v   Unmount the file systems on all logical drives accessing the drives that you 

select for firmware upgrade. 

v   Complete a full backup of all data residing on the drives that you select for 

firmware upgrade.

Downloading drive firmware with Storage Manager version 9.1x and 

higher 

To download drive firmware for using DS4000 Storage Manager version, perform 

the following steps: 
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1.   From the Enterprise Management window, select a storage subsystem. 

 2.   On the Enterprise Management window’s menu bar, click Tools → Manage 

Storage Subsystem Device. The Subsystem Management window opens. 

 3.   On the Subsystem Management window’s menu bar, click Advanced → 

Maintenance → Download → Drive Firmware/Mode pages .... The Download 

Drive Firmware wizard window opens to the Introduction page. Read the 

instructions displayed and click Next.

Note:  Storage Manager version 9.1x and higher offers you the option to 

download and update up to four different firmware file types 

simultaneously. Previous Storage Manager versions did not offer this 

capability. 

 4.   Click Browse to locate the subsystem directory that contains the firmware that 

you plan to download. 

 5.   Select the firmware file that you plan to download and click OK. The file 

appears listed in the ″Selected Packages″ window pane. 

 6.   Select the firmware file for any additional drive types that you intend to 

download and click OK. Additional files appear listed in the ″Selected 

Packages″ window pane. A maximum total of four drive types is possible. 

 7.   Click Browse to repeat step 6 until you have selected each firmware file that 

you plan to download. 

 8.   When you have finished specifying the firmware packages for download, select 

Next. 

 9.   The Select Drive window opens, containing two tabs, a Compatible Drives tab 

and an Incompatible Drives tab. The Compatible Drives tab contains a list 

of the drives compatible to the firmware package types that you selected. From 

that list, select the drives to which you plan to download the drive firmware that 

you selected in steps 6 and 7. 

Note:  The firmware that you propose to download should be listed on the 

Compatible Drives tab. If your particular drives’ product ID matches 

the firmware type, however, and it is not listed as compatible on the tab, 

contact your IBM technical support representative for additional 

instructions. 

10.   Select the Compatible Drives tab. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

individually, or press and hold the Shift key while using your mouse to select 

multiple drives listed in series. The compatible firmware that you selected in 

steps 5 and 6 will download to the drives that you select. 

11.   Click Finish to initiate download of the drive firmware to each compatible drive 

that you selected in step 9. 

12.   The Download Drive Firmware warning opens and prompts: ″Do you want to 

continue?″ Type yes and click OK to start the drive firmware download. 

13.   The Download Progress window opens. Do not intervene until the download 

process completes. 

14.   Every drive scheduled for firmware download will be designated as in 

progress until successful or failed.

Note:  Complete the following two steps if you receive a failure. 

a.   Click the Save as button to save the error log. 

b.   On the Subsystem Management window menu bar, click Advanced 

→ Trouble Shooting → Open Event Log and complete the following 
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tasks necessary to save the storage subsystem event log before 

contacting your IBM Service Representative and proceeding to step 

15. 

1)   Click the Select all button. 

2)   Click Save the Storage Subsystem Event Log.

When the Close button appears active, the drive firmware download process is 

complete. 

15.   Click Close to exit the Download Progress window. 

16.   Use either of the following procedures to determine or verify what level of drive 

firmware resides on a particular drive: 

v   Right-click that drive in the Logical/Physical View in the Subsystem 

Management window and click Properties. The associated drive firmware 

version will be listed in the drive properties table. 

v   Click Storage Subsystem → View Profile in the Logical/Physical View of 

the Subsystem Management window.

Downloading drive firmware with Storage Manager version 8.x 

To download drive firmware for using DS4000 Storage Manager version 8.x, 

perform the following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   Click Tools → Manage Device. The Subsystem Management window opens. 

 3.   Click Advanced → Download → Drive Firmware. The Download Drive 

Firmware window opens. It presents a list of all installed drives. 

 4.   From the list of all installed drives, select the drive to which you plan to 

download drive firmware. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

singly, or press and hold the Shift key while selecting multiple drives in series 

by using your mouse pointer. 

 5.   Click Browse to identify the directory that contains the drive firmware that you 

intend to download. 

 6.   Select the file containing the drive firmware that you intend to download. 

 7.   Select Start. The Confirm Download window appears. 

 8.   Type yes when the Confirm Download window prompts: Are you sure you 

want to continue? 

 9.   The download begins and the Status window indicates progress. Do not 

intervene until the download process completes. 

10.   When the Cancel button appears active, the download process is complete. 

Press Cancel to close the Status window. 

11.   To determine or verify the level of drive firmware residing on a particular drive, 

click View → Subsystem Profile in the Logical/Physical View of the Subsystem 

Management window.
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Appendix  D.  Using  the  IBM  System  Storage  DS4000  Controller  

Firmware  Upgrade  Tool  

IBM System Storage DS4000 Controller Firmware Upgrade Tool  

overview 

 

Caution: 

Before using the IBM System Storage DS4000 Controller Firmware Upgrade 

Tool to migrate to version 07.10, it is extremely important that all data for 

DS4800, DS4700, and DS4200s be completely backed up and that existing 

system configurations be saved. Once the tool has completed an upgrade, 

controllers cannot be returned to previous firmware version levels. The 

Controller Firmware Upgrade Tool is to be used only when migrating DS4800, 

DS4700, and DS4200 controllers from version 06.xx to version 07.10. This tool 

is not intended to replace, nor should be used to perform, standard upgrades 

for controller, ESM, or drive firmware. (To perform a standard controller, ESM, 

or drive firmware upgrade, please see Appendix C, “Downloading ESM 

firmware and drive firmware,” on page 229. 

 You must perform the upgrade offline. You should perform the overall installation of 

Storage Manager into an existing host environment online. For most failover drivers 

to take effect, you must reboot the host. 

You must make sure that all devices have an Optimal status before you download 

firmware. You must also check the current firmware level. 

Attention:  Potential loss of data access—Make sure the firmware you download 

is compatible with the Storage Manager software that is installed on 

your storage system. If non-compatible firmware is downloaded, you 

might lose access to the drives in the storage system, so upgrade 

Storage Manager first. 

Do not make changes to your configuration or remove drives or 

enclosures during the upgrade process. 

For information about the current firmware versions, see “Readme files 

and concepts” on page 1 to find out how to access the most recent 

Storage Manager readme files on the Web. 

Checking the device health conditions 

Perform the following steps to determine the health condition of your device. 

1.   From the Array Management Window in Storage Manager, right-click the 

storage system. The Storage Manager software establishes communication with 

each managed device and determines the current device status. 

There are six possible status conditions: 

v    Optimal—Every component in the managed device is in the desired working 

condition. 

v    Needs Attention—A problem exists with the managed device that requires 

intervention to correct it. 
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v    Fixing—A Needs Attention condition has been corrected, and the managed 

device is currently changing to an Optimal status. 

v    Unresponsive—The storage management station cannot communicate with 

the device, or one controller or both controllers in the storage system. 

v    Contacting Device—The management software is establishing contact with 

the device. 

v    Needs Upgrade—The storage system is running a level of firmware that is 

no longer supported by the storage management software.

2.   If the status is a Needs Attention status, write down the condition. Contact an 

IBM Technical Support representative for fault resolution.

Note:  The Recovery Guru in the Storage Manager software also provides a 

detailed explanation of, and recovery procedures for, the conditions.

Installing the upgrade tool 

To install the upgrade tool, complete the following steps. 

1.   Open the SMFWUpgInstaller-xxxx-10.10.A5.xx.bin installation file, according to 

your operating system procedures. The IBM System Storage DS4000 Controller 

Firmware Upgrade Tool installation window appears. 

2.   Click Next. 

3.   Accept the license agreement, and click Next. 

4.   Select the folder in which you want to install the tool, and click Next. 

5.   Click Install. 

6.   Click Done.

Adding a storage subsystem 

To add a storage subsystem using the upgrade tool, perform the following steps. 

1.   Click Add. The Select Addition Method window appears. 

2.   Select either Automatic or Manual.
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3.   Click OK to begin adding storage subsystems. 

4.   To see any issues with the storage system you added that might impede 

upgrading the firmware, click View Log.

Downloading the firmware 

To download the firmware, perform the following steps. 

1.   You need to first select the storage subsystem you want to activate to enable 

the download button, then Click Download Firmware. The Download Firmware 

window appears.
 

ds4k_swut_initial

  

Figure 32. Selection Addition Method window
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2.   Select the controller firmware file that you want to download. Click Browse to 

choose the file from a directory on your computer or on your network. 

3.   Select the NVSRAM file you want to download. Click Browse to choose the file 

from a directory on your computer or on your network. 

ds4k_swut_download

  

Figure 33. Download Firmware window
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4.   Click OK. The firmware starts to download. A status bar appears in the 

Controller Firmware Upgrade window.
 

The firmware begins the activation process, and the status bar in the IBM System 

Storage DS4000 Controller Firmware Upgrade Tool window appears.
 

ds4k_swut_progress

  

Figure 34. Download progress window
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Viewing  the IBM System Storage DS4000 Controller Firmware Upgrade 

Tool  log file 

If you encounter any problems updating your firmware, perform the following steps 

to view the log file. 

1.   Click View Log. The View Log window appears. This log documents any issues 

with the storage system that might prevent you from updating the firmware. 

2.   If any issues are documented in the log, correct those issues before you try to 

download the firmware.

ds4k_swut_activate

  

Figure 35. Firmware activating window
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Appendix  E.  Limitations  

This sections in this appendix contain descriptions of potential problems and ways 

to work around them. 

AIX 

The following information might apply to your storage subsystem. 

1.   Storage Manager prompts you for a password if all hard disk drives are 

removed from the storage subsystem. After removing all drives from a storage 

subsystem (or not powering on drives and only the controller), the IBM DS4000 

Storage Manager software will prompt you for a password when trying to start 

the software or trying to perform protected operations. Any password entered 

will fail. 

Password information is stored on a reserved area of each hard disk drive on 

the storage subsystem. Each drive stores a mirrored copy of the password data. 

When there are no drives in the storage subsystem, the storage management 

software does not find the password data when you attempt password protected 

operations. Add one drive to the storage subsystem and retry the operation. 

2.   Auto LUN/Array Transfer is not supported. If a controller fails over arrays to the 

alternate controller and the failed controller is replaced and brought back online, 

the arrays do not automatically transfer to the preferred controller. This must be 

done manually by redistributing arrays. 

3.   If the controller in the IBM DS4000 Storage Server with firmware 05.4x.xx.xx is 

connected to a SAN with more than 256 host connections per controller port, 

that can log into the controllers, one must either use the switch zoning function 

or rearrange the SAN connections so that only the maximum number of host 

connections can be seen and log into the controller. 

4.   Dynamically changing the cache read ahead multiplier setting via the storage 

manager client may result in an error message indicating the operation has 

failed. Despite the error message, the request to change the cache read ahead 

multiplier will remain queued to the controllers and will eventually complete 

when I/O activity to the storage subsystem has subsided. In order to avoid the 

error message and any delays in the cache read ahead multiplier value 

changing, it is recommended to change the cache read ahead multiplier when 

the subsystem is in a quiesced state.

HP-UX 

The following information might apply to your storage subsystem. 

1.    If you are upgrading controller firmware in IBM FAStT500 storage controller 

with 512MB Cache, you will have to stop I/O and reboot both controllers before 

upgrading firmware followed by NVSRAM. You can reboot the controllers either 

by power cycling the storage subsystem or by pressing the Reset button on 

both controllers. The Reset button is located on the right of the indicator lights in 

the opening on the front of each controller unit. 

To determine Storage Controller cache level, perform the following: 

a.   On a storage management station start the client software and select a 

storage subsystem. 

b.   Select Tools → Manage Device to open the Subsystem Management 

Window 
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c.   Highlight the Storage Subsystem that you are upgrading and then select 

Storage Subsystem → Profile. It may take a little time for it to create the 

Storage Subsystem profile. 

d.   Under the Controllers heading is an entry that displays information similar to 

the following example: 

Cache/processor size (MB):  256/32  

If this setting is listed as 512/32 you will need to arrange to perform this 

upgrade procedure at a time that you can stop I/O to the Storage 

Subsystem in order to ensure a successful firmware download and 

installation.

2.   Storage Manager prompts you for a password if all hard disk drives are 

removed from the storage subsystem. After removing all drives from a storage 

subsystem (or not powering on drives and only the controller), the IBM DS4000 

Storage Manager software will prompt you for a password when trying to start 

the software or trying to perform protected operations. Any password entered 

will fail. 

Password information is stored on a reserved area of each hard disk drive on 

the storage subsystem. Each drive stores a mirrored copy of the password data. 

When there are no drives in the storage subsystem, the storage management 

software does not find the password data when you attempt password protected 

operations. Add one drive to the storage subsystem and retry the operation. 

Since the RAID controller unit should not be powered on until the expansion 

units are attached and powered on, this should be done by powering off the 

RAID controller unit, properly attaching all expansion units (with drives installed), 

to the RAID controller unit and powering them on, and then powering the RAID 

controller unit back on. At this point the storage subsystems can be 

rediscovered and managed using the IBM DS4000 Storage Manager 8.3x 

software. 

3.   Display issues when using 256 color settings. A brownish hash pattern is 

displayed on the windows and in online help when running in 256 color mode. 

Run the Storage Manager 8 application in a higher display mode. 

4.   If you get "Error 21—The Operation cannot complete because a ... is in 

progress" error when you issue a Subsystem Management command from the 

IBM DS4000 Storage Manager Client, the command may be cached. If the 

command is cached, the IBM DS4000 Storage Manager Client will run the 

command as soon as the controller resources are available. Wait for at least ten 

minutes and check to see whether the command has been run. If not, reattempt 

the command. 

5.   The IBM FAStT500, DS4400 or DS4500 Storage Server hardware and software 

is designed to have redundant paths from the host system to ensure the 

availability of storage. However, it is possible to connect a single host adapter 

from the host system to one of the controller minihubs and then connect this 

minihub to the minihub of the other controller. 

This configuration will create a FC-AL loop between the host adapter and the 

two IBM FAStT500, DS4400 or DS4500 Storage Server controllers and no 

redundant path to the host system. When you connect the two minihubs 

together, always connect the IN port of one minihub to the OUT port of the other 

minihub or vice versa. Do not connect the IN port of one to the IN port of the 

other minihub or the OUT port of one minihub to the OUT port of the other 

minihub. 

 

242 DS4000 Storage Manager Version 10 Installation and Support Guide for AIX, HP-UX, Solaris, and Linux on POWER



6.   DS4000 now supports 127 LUNs on HP-UX. However, the number of actual 

LUNs might vary from HP-UX host to host. The number of LUNs supported 

varies depending on the number of processors and memory. 

7.   Dynamically changing the cache read ahead multiplier setting via the storage 

manager client may result in an error message indicating the operation has 

failed. Despite the error message, the request to change the cache read ahead 

multiplier will remain queued to the controllers and will eventually complete 

when I/O activity to the storage subsystem has subsided. In order to avoid the 

error message and any delays in the cache read ahead multiplier value 

changing, it is recommended that you change the cache read ahead multiplier 

when the subsystem is in a quiesced state.

Solaris 

1.   Upgrading FAStT500 with 512MB Cache. If you are upgrading controller 

firmware in IBM FAStT500 storage controller (MT 3552), you will have to stop 

I/O and reboot both controllers before upgrading NVSRAM followed by 

Firmware. You can reboot the controller by either power cycle the storage 

subsystem or by pressing the Reset button on both controllers. The Reset 

button is located on the right of the indicator lights in the opening on the front of 

each controller unit. 

To determine Storage Controller cache level, perform the following: 

a.   On a storage management station start the client software and select a 

storage subsystem. 

b.   Select Tools → Manage Device to open the Subsystem Management 

Window 

c.   Highlight the Storage Subsystem that you are upgrading and then select 

Storage Subsystem → Profile. It may take a little time for it to create the 

Storage Subsystem profile. 

d.   Under the Controllers heading is an entry that displays information similar to 

the following example: 

Cache/processor size (MB):  256/32  

If this setting is listed as 512/32 you will need to arrange to perform this 

upgrade procedure at a time that you can stop I/O to the Storage 

Subsystem in order to ensure a successful firmware download and 

installation.

2.   Storage Manager prompts you for a password if all hard disk drives are 

removed from the storage subsystem. After removing all drives from a storage 

subsystem (or not powering on drives and only the controller), the IBM DS4000 

Storage Manager software will prompt you for a password when trying to start 

the software or trying to perform protected operations. Any password entered 

will fail. 

Password information is stored on a reserved area of each hard disk drive on 

the storage subsystem. Each drive stores a mirrored copy of the password data. 

When there are no drives in the storage subsystem, the storage management 

software does not find the password data when you attempt password protected 

operations. Add one drive to the storage subsystem and retry the operation. 

Since the RAID controller unit should not be powered on until the expansion 

units are attached and powered on, this should be done by powering off the 

RAID controller unit, properly attaching all expansion units (with drives installed), 

to the RAID controller unit and powering them on, and then powering the RAID 
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controller unit back on. At this point the storage subsystems can be 

rediscovered and managed using the IBM DS4000 Storage Manager 8.3x 

software. 

3.   Auto LUN/Array Transfer is not supported. If a controller fails over arrays to the 

alternate controller and the failed controller is replaced and brought back online, 

the arrays do not automatically transfer to the preferred controller. This must be 

done manually by redistributing arrays. 

4.   Display issues when using 256 color settings. A brownish hash pattern is 

displayed on the windows and in online help when running in 256 color mode. 

Run the Storage Manager 8 application in a higher display mode. 

5.   If you get "Error 21—The Operation cannot complete because a ... is in 

progress" error when you issue a Subsystem Management command from the 

IBM DS4000 Storage Manager Client, the command may be cached. If the 

command is cached, the IBM DS4000 Storage Manager Client will run the 

command as soon as the controller resources are available. Wait for at least ten 

minutes and check to see whether the command has been run. If not, reattempt 

the command. 

6.   The IBM FAStT500, DS4400 or DS4500 Storage Server hardware and software 

is designed to have redundant paths from the host system to ensure the 

availability of storage. However, it is possible to connect a single host adapter 

from the host system to one of the controller minihubs and then connect this 

minihub to the minihub of the other controller. 

This configuration will create a FC-AL loop between the host adapter and the 

two IBM FAStT500, DS4400 or DS4500 Storage Server controllers and no 

redundant path to the host system. When you connect the two minihubs 

together, always connect the IN port of one minihub to the OUT port of the other 

minihub or vice versa. Do not connect the IN port of one to the IN port of the 

other minihub or the OUT port of one minihub to the OUT port of the other 

minihub.
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Appendix  F.  Connecting  HBAs  in  a FC  switch  environment  

When connecting fibre channel host bus adapters in host servers to DS4000 

Storage Server host ports in a fibre channel switch environment, IBM recommends 

that you establish one-to-one zones between the HBA and DS4000 host ports. 

For instructions on how to set up a zone inside a fibre channel switch, see your 

fibre channel switch’s installation and user’s guide. 

Note:  You can find links to switch documentation at the following Web site:

www.ibm.com/servers/storage/support/san/index.html 

Figure 36 illustrates a sample configuration consisting of two host servers, each 

with two fibre channel host bus adapters, each of which are connected to a DS4000 

Storage Server host port through a fibre channel switch. 
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Figure 36. Fibre channel fabric switch environment connecting host servers to a DS4000 

Storage Server
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Legend: 

 Controller Zone Port Connection to 

and from 

Description 

A 1 �7�
�3� 

HA1
CA2 

This will zone the fibre channel HBA port 

HA1 in host server A to port 2 of the 

DS4000 Storage Server controller A. 

2 �1�
�3� 

HB1
CA2 

This will zone the fibre channel HBA port 

HB1 in host server B to port 2 of the 

DS4000 Storage Server controller A. 

B 3 �6�
�4� 

HA2
CB2 

This will zone the fibre channel HBA port 

HA2 in host server A to port 2 of the 

DS4000 Storage Server controller B. 

4 �0�
�4� 

HB2
CB2 

This will zone the fibre channel HBA port 

HB2 in host server B to port 2 of the 

DS4000 Storage Server controller B.
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Appendix  G.  DS4000  Diagnostic  Data  Capture  (DDC)  

DDC information 

Under rare circumstances an internal controller error can force a routine to perform 

a function referred to as a DDC or Diagnostic Data Capture. When this has 

occurred, if you open the Enterprise Management window you will notice a red stop 

sign next to the name of the storage that has the error (is in a non-optimal state). 

Click on that storage to bring up the Subsystem Management window. You can then 

click on the Recovery Guru which will show what the issue is, or you can check in 

the MEL (DS4000 Storage Manager Major Events Log), where a critical event will 

be posted. See “DDC MEL events” on page 249. 

DDC function implementation 

In order to assist IBM support in collecting data for troubleshooting certain unusual 

events in controller firmware, the Diagnostic Data Capture (DDC) function was 

implemented in the latest controller firmware version of the following DS4000 

storage subsystem controller firmware versions: 

v   07.10.xx.xx 

v   06.23.xx.xx or greater 

v   06.19.xx.xx 

v   06.16.xx.xx 

v   06.15.24.xx or higher 

v   06.12.27.xx or higher

Note:  This function is not implemented with controller firmware code versions that 

are less then 06.12.27.xx level. 

How Diagnostic Data Capture works 

When the DDC function is implemented, the DS4000 storage subsystem status will 

change from Optimal to Needs Attention due to DDC. This will occur whenever the 

controllers in the DS4000 subsystem detect unusual events like Master abort (due 

to a bad address accessed by the fibre channel chip resulting in a PCI bus error), 

when the controller is not able to process host I/O requests for an extended period 

of time (several minutes), when there is destination device number registry 

corruption, an EDC error is returned by the disk drives, a Quiescence failure for the 

Logical Drive owned by the alternate controller. or corruption in records related to 

Storage Partition Management. Once the Needs Attention due to DDC flag is set, it 

will be persistent across the power-cycle and controller reboot, provided the 

controller cache batteries are sufficiently charged. In addition, data reflecting the 

state of the subsystem controllers at the moment in time that the unusual event 

occurred will be collected and saved until it is retrieved by the user. To clear the 

Needs Attention due to DDC flag and to retrieve the saved diagnostic data, see 

“Recovery steps” on page 248. 

Because the current DDC function implementation will hold the DDC data for only 

one unusual event at a time until the DDC data is saved, the SMcli commands must 

be performed as soon as possible whenever the Needs Attention due to DDC error 

occurs. This is so the controllers can be ready for capturing data for any other 

unusual events. Until the diagnostic data is saved and the Needs Attention due to 

DDC flag is cleared, any occurrences of other unusual events will not trigger the 

controller to capture diagnostic data for those events. An unusual event is 

considered a candidate for a DDC trigger if a previous DDC trigger is at least 48 
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hours old or the user has successfully retrieved the previous DDC information. In 

addition, DDC information is only available in the case of a controller that is online. 

A controller that is in service or lock down mode will not trigger a DDC event. After 

collecting the DDC data, contact IBM support to report the problem and to enlist 

assistance in troubleshooting the condition that triggered the event. 

Recovery steps 

Follow steps 1–6 to complete the DDC recovery process. 

1.   Open either the Script Editor from the Enterprise Management Window (EMW), 

or the Command Line Interface (CLI).

Note:  Refer to the EMW online help for more information on the syntax of 

these commands. 

2.    

 Table 25. Recovery Step 2 

If... Then... 

You want to save the diagnostic data Go to Step 3. 

You do NOT want to save the diagnostic 

data 

Go to Step 5.

  

3.   Execute the following SMcli command: 

save storageSubsystem diagnosticData file="filename "; 

Where filename is the location and name of the file that will be saved. The file 

will be formatted as a .zip file.

Note:  Currently, the esm parameter of the command syntax is not supported. 

4.    

 Table 26. Recovery Step 4 

If... Then... 

No error was returned Go to Step 6. 

An error was returned If... Then... 

The error message indicates 

that there was a problem 

saving the data 

Wait 2 minutes and then 

restart Step 3. 

The error message indicates 

that there was a problem 

resetting the data 

Wait 2 minutes and then go 

to Step 5.

  

5.   Execute the following SMcli command: 

reset storageSubsystem diagnosticData; 

 Table 27. Recovery Step 5 

If... Then... 

No error was returned Go to step 6. 

An error was returned Wait 2 minutes and then execute the 

command again. The controllers may need 

additional time to update status. Note that 

you may also get an error if the diagnostic 

data status has already been reset. 

Go to step 6.
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6.   Select Recheck to rerun the Recovery Guru. The failure should no longer 

appear in the Summary area.

After this process has been successfully completed, the DDC message will 

automatically be removed, and a recheck of the Recovery Guru will show no entries 

for DDC capture. If for some reason the data has not been removed, the Recovery 

Guru gives an example of how to clear the DDC information without saving the 

data. Follow the above procedure using the following command in the script editor: 

reset storageSubsystem diagnosticData; 

DDC MEL events 

When the Diagnostic Data Capture action is triggered by an unusual event, one or 

more of the following events will be posted in the storage subsystems event logs, 

depending on the user actions. 

1.   Event number: 0x6900. 

Description: Diagnostic Data is available. 

Priority: Critical. 

This is logged when an unusual controller event triggers the DDC function to 

store Diagnostic Data. 

2.   Event number: 0x6901. 

Description: Diagnostic Data retrieval operation started. 

Priority: Informational. 

This is logged when the user runs the SMcli command to retrieve and save the 

Diagnostic Data, as described in step 3 of the “Recovery steps” on page 248. 

3.   Event number: 0x6902. 

Description: Diagnostic Data retrieval operation completed. 

Priority: Informational. 

This is logged when the Diagnostic Data retrieval and save completes. 

4.   Event number: 0x6903. 

Description: Diagnostic Data Needs Attention status/flag cleared. 

Priority: Informational. 

This is logged when the user resets the Needs Attention flag due to DDC, using 

the SMcli command or Diagnostic Data retrieval and save completes 

successfully when initiated by the user executing the save storageSubsystem 

diagnosticData SMcli command.
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Appendix  H.  Accessibility  

This section provides information about alternate keyboard navigation, which is a 

DS4000 Storage Manager accessibility feature. Accessibility features help a user 

who has a physical disability, such as restricted mobility or limited vision, to use 

software products successfully. 

By using the alternate keyboard operations that are described in this section, you 

can use keys or key combinations to perform Storage Manager tasks and initiate 

many menu actions that can also be done with a mouse. 

Note: In addition to the keyboard operations that are described in this section, the 

DS4000 Storage Manager version 9.14 - 10.10 (and later) software installation 

packages for Windows include a screen reader software interface. 

To enable the screen reader, select Custom Installation when using the installation 

wizard to install Storage Manager 9.14 - 10.10 (or later) on a Windows 

host/management station. Then, in the Select Product Features window, select Java 

Access Bridge in addition to the other required host software components. 

Table 28 defines the keyboard operations that enable you to navigate, select, or 

activate user interface components. The following terms are used in the table: 

v   Navigate means to move the input focus from one user interface component to 

another. 

v   Select means to choose one or more components, typically for a subsequent 

action. 

v   Activate means to carry out the action of a particular component.

Note:  In general, navigation between components requires the following keys: 

v   Tab - Moves keyboard focus to the next component or to the first member 

of the next group of components 

v   Shift-Tab - Moves keyboard focus to the previous component or to the 

first component in the previous group of components 

v   Arrow keys - Move keyboard focus within the individual components of a 

group of components

 Table 28. DS4000 Storage Manager alternate keyboard operations 

Short cut Action 

F1 Open the Help. 

F10 Move keyboard focus to main menu bar and post first 

menu; use the arrow keys to navigate through the 

available options. 

Alt+F4 Close the management window. 

Alt+F6 Move keyboard focus between dialogs (non-modal) and 

between management windows. 
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Table 28. DS4000 Storage Manager alternate keyboard operations (continued) 

Short cut Action 

Alt+ underlined letter Access menu items, buttons, and other interface 

components by using the keys associated with the 

underlined letters. 

For the menu options, select the Alt + underlined letter 

combination to access a main menu, and then select the 

underlined letter to access the individual menu item. 

For other interface components, use the Alt + underlined 

letter combination. 

Ctrl+F1 Display or conceal a tool tip when keyboard focus is on 

the toolbar. 

Spacebar Select an item or activate a hyperlink. 

Ctrl+Spacebar 

(Contiguous/Non-contiguous) 

AMW Logical/Physical View 

Select multiple drives in the Physical View. 

To select multiple drives, select one drive by pressing 

Spacebar, and then press Tab to switch focus to the next 

drive you want to select; press Ctrl+Spacebar to select 

the drive. 

If you press Spacebar alone when multiple drives are 

selected then all selections are removed. 

Use the Ctrl+Spacebar combination to deselect a drive 

when multiple drives are selected. 

This behavior is the same for contiguous and 

non-contiguous selection of drives. 

End, Page Down Move keyboard focus to the last item in the list. 

Esc Close the current dialog (does not require keyboard 

focus). 

Home, Page Up Move keyboard focus to the first item in the list. 

Shift+Tab Move keyboard focus through components in the reverse 

direction. 

Ctrl+Tab Move keyboard focus from a table to the next user 

interface component. 

Tab Navigate keyboard focus between components or select 

a hyperlink. 

Down arrow Move keyboard focus down one item in the list. 

Left arrow Move keyboard focus to the left. 

Right arrow Move keyboard focus to the right. 

Up arrow Move keyboard focus up one item in the list.
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Appendix  I. Additional  DS4000  documentation  

The following tables present an overview of the IBM System Storage DS4000 

Storage Manager, Storage Subsystem, and Storage Expansion Enclosure product 

libraries, as well as other related documents. Each table lists documents that are 

included in the libraries and what common tasks they address. 

You can access the documents listed in these tables at both of the following Web 

sites: 

www.ibm.com/servers/storage/support/disk/ 

www.ibm.com/shop/publications/order/ 

DS4000 Storage Manager Version 10 library 

Table 29 associates each document in the DS4000 Version 10 Storage Manager 

library with its related common user tasks.

 Table 29. DS4000 Storage Manager Version 10 titles by user tasks 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM System 

Storage DS4000 

Storage Manager 

Installation and Host 

Support Guide for 

Windows 

2000/Server 

2003/2008, 

NetWare, VMWare 

ESX Server, and 

Linux 

U U U 

IBM System 

Storage DS4000 

Storage Manager 

Installation and Host 

Support Guide for 

AIX, UNIX, Solaris, 

and Linux on 

POWER  

U U U 

IBM System 

Storage DS4000 

Storage Manager 

Copy Services 

User’s Guide 

U U U U 

IBM System 

Storage DS4000 

Storage Manager 

Concepts Guide 

U U U U U U 
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Table 29. DS4000 Storage Manager Version 10 titles by user tasks (continued) 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM  System 

Storage DS4000 

Fibre Channel and 

Serial ATA Intermix 

Premium Feature 

Installation 

Overview 

U U U U 

  

DS4800 Storage Subsystem library 

Table 30 associates each document in the DS4800 Storage Subsystem library with 

its related common user tasks.

 Table 30. DS4800 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4800 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4800 

U U U 

IBM TotalStorage 

DS4800 Controller 

Cache Upgrade Kit 

Instructions 

U U U  
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DS4700 Storage Subsystem library 

Table 31 associates each document in the DS4700 Storage Subsystem library with 

its related common user tasks.

 Table 31. DS4700 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4700 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4700 and 

DS4200, Sections 2, 

3, and 4 also for 

installing the 

EXP810 and 

EXP420 

U U U  
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DS4500 Storage Subsystem library 

Table 32 associates each document in the DS4500 (previously FAStT900) Storage 

Subsystem library with its related common user tasks.

 Table 32. DS4500 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4500 Storage 

Subsystem 

Installation, User's, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4500 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4500 Rack 

Mounting 

Instructions 

U U  
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DS4400 Storage Subsystem library 

Table 33 associates each document in the DS4400 (previously FAStT700) Storage 

Subsystem library with its related common user tasks. 

 Table 33. DS4400 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server User’s Guide 

U U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server Installation 

and Support Guide 

U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Cabling 

Instructions 

U U  
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DS4300 Storage Subsystem library 

Table 34 associates each document in the DS4300 (previously FAStT600) Storage 

Subsystem library with its related common user tasks.

 Table 34. DS4300 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4300 Storage 

Subsystem 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4300 Rack 

Mounting 

Instructions 

U U 

IBM TotalStorage 

DS4300 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4300 SCU  Base 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 SCU  Turbo 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 Turbo 

Models 6LU/6LX 

Upgrade Kit 

U U  
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DS4200 Express Storage Subsystem library 

Table 35 associates each document in the DS4200 Express Storage Subsystem 

library with its related common user tasks.

 Table 35. DS4200 Express Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4200 Express 

Storage Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4700 and 

DS4200, Sections 2, 

3, and 4 also for 

installing the 

EXP810 and 

EXP420 

U U U  
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DS4100 Storage Subsystem library 

Table 36 associates each document in the DS4100 (previously FAStT100) Storage 

Subsystem library with its related common user tasks.

 Table 36. DS4100 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4100 Storage 

Server Installation, 

User’s and 

Maintenance Guide 

U U U U U 

IBM TotalStorage 

DS4100 Storage 

Server Cabling 

Guide 

U  
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DS4000 Storage Expansion Enclosure documents 

Table 37 associates each of the following documents with its related common user 

tasks. 

 Table 37. DS4000 Storage Expansion Enclosure document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4000 EXP810 

Storage Expansion 

Enclosure 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4700 and 

DS4200, Sections 2, 

3, and 4 also for 

installing the 

EXP810 and 

EXP420 

U U U 

IBM TotalStorage 

DS4000 EXP700 

and EXP710 

Storage Expansion 

Enclosures 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM DS4000 

EXP500 Installation 

and User’s Guide 

U U U U U 

IBM System Storage 

DS4000 EXP420 

Storage Expansion 

Enclosure 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4000 Hard Drive 

and Storage 

Expansion 

Enclosures 

Installation and 

Migration Guide 

U U  
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Other DS4000 and DS4000-related documents 

Table 38 associates each of the following documents with its related common user 

tasks. 

 Table 38. DS4000 and DS4000–related document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM Safety 

Information 

U 

IBM TotalStorage 

DS4000 Hardware 

Maintenance Manual 

¹ 

U 

IBM System Storage 

DS4000 Problem 

Determination Guide 

U 

IBM Fibre Channel 

Planning and 

Integration: User’s 

Guide and Service 

Information 

U U U U 

IBM TotalStorage 

DS4000 FC2-133 

Host Bus Adapter 

Installation and 

User’s Guide 

U U 

IBM TotalStorage 

DS4000 FC2-133 

Dual Port Host Bus 

Adapter Installation 

and User’s Guide 

U U 

IBM Netfinity Fibre 

Channel Cabling 

Instructions 

U 

IBM Fibre Channel 

SAN  Configuration 

Setup Guide 

U U U U 

Notes:  

1.   The IBM TotalStorage DS4000 Hardware Maintenance Manual does not contain maintenance information for the 

IBM System Storage DS4100, DS4200, DS4300, DS4500, DS4700, or DS4800 storage subsystems. You can find 

maintenance information for these products in the IBM System Storage DSx000 Storage Subsystem Installation, 

User's, and Maintenance Guide for the particular subsystem.
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Notices  

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be 

used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not grant you any 

license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

 For license inquiries regarding double-byte (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other 

country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATIONS ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR 

A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply to 

you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publications. IBM may make improvements or 

changes (or both) in the product(s) or program(s) (or both), described in this 

publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those 

Web sites. The materials at those Web sites are not part of the materials for this 

IBM product and use of those Web sites is at your own risk. 

Information concerning non-IBM products was obtained from the suppliers of those 

products, their published announcements or other publicly available sources. IBM 

has not tested those products and cannot confirm the accuracy of performance, 
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compatibility or any other claims related to non-IBM products. Questions on the 

capabilities of non-IBM products should be addressed to the suppliers of those 

products. 

IBM may use or distribute any of the information you supply in any way it believes 

appropriate without incurring any obligation to you. 

Some software may differ from its retail version (if available), and may not include 

user manuals or all program functionality. 

Trademarks 

The following terms are trademarks of International Business Machines Corporation 

in the United States, other countries, or both:

IBM 

AIX 

Eserver 

FlashCopy 

Netfinity 

POWER 

Series p 

RS/6000 

TotalStorage 

Microsoft Windows and Windows NT® are registered trademarks of Microsoft 

Corporation in the United States, other countries, or both. 

Java and all Java-based trademarks and logos are trademarks or registered 

trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 

Linux is a registered trademark of Linus Torvalds in the United States, other 

countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other 

countries. 

Other company, product, or service names may be trademarks or service marks of 

others. 
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Glossary  

This glossary provides definitions for the 

terminology and abbreviations used in IBM 

System Storage DS4000 publications. 

If you do not find the term you are looking for, see 

the IBM Glossary of Computing Terms located at 

the following Web site: 

www.ibm.com/ibm/terminology 

This glossary also includes terms and definitions 

from: 

v   Information Technology Vocabulary by 

Subcommittee 1, Joint Technical Committee 1, 

of the International Organization for 

Standardization and the International 

Electrotechnical Commission (ISO/IEC 

JTC1/SC1). Definitions are identified by the 

symbol (I) after the definition; definitions taken 

from draft international standards, committee 

drafts, and working papers by ISO/IEC 

JTC1/SC1 are identified by the symbol (T) after 

the definition, indicating that final agreement 

has not yet been reached among the 

participating National Bodies of SC1. 

v   IBM Glossary of Computing Terms. New York: 

McGraw-Hill, 1994.

The following cross-reference conventions are 

used in this glossary: 

See Refers you to (a) a term that is the 

expanded form of an abbreviation or 

acronym, or (b) a synonym or more 

preferred term. 

See also 

Refers you to a related term.

Abstract Windowing Toolkit (AWT).  A Java graphical 

user interface (GUI). 

accelerated graphics port (AGP).  A bus specification 

that gives low-cost 3D graphics cards faster access to 

main memory on personal computers than the usual 

peripheral component interconnect (PCI) bus. AGP 

reduces the overall cost of creating high-end graphics 

subsystems by using existing system memory. 

access volume.  A special logical drive that allows the 

host-agent to communicate with the controllers in the 

storage subsystem. 

adapter.  A printed circuit assembly that transmits user 

data input/output (I/O) between the internal bus of the 

host system and the external fibre-channel (FC) link and 

vice versa. Also called an I/O adapter, host adapter, or 

FC adapter. 

advanced technology (AT®) bus architecture.  A bus 

standard for IBM compatibles. It extends the XT™ bus 

architecture to 16 bits and also allows for bus 

mastering, although only the first 16 MB of main 

memory are available for direct access. 

agent.  A server program that receives virtual 

connections from the network manager (the client 

program) in a Simple Network Management 

Protocol-Transmission Control Protocol/Internet Protocol 

(SNMP-TCP/IP) network-managing environment. 

AGP.   See accelerated graphics port. 

AL_PA.   See arbitrated loop physical address. 

arbitrated loop.  One of three existing fibre-channel 

topologies, in which 2 - 126 ports are interconnected 

serially in a single loop circuit. Access to the Fibre 

Channel Arbitrated Loop (FC-AL) is controlled by an 

arbitration scheme. The FC-AL topology supports all 

classes of service and guarantees in-order delivery of 

FC frames when the originator and responder are on 

the same FC-AL. The default topology for the disk array 

is arbitrated loop. An arbitrated loop is sometimes 

referred to as a Stealth Mode. 

arbitrated loop physical address (AL_PA).  An 8-bit 

value that is used to uniquely identify an individual port 

within a loop. A loop can have one or more AL_PAs. 

array.  A collection of fibre-channel or SATA hard drives 

that are logically grouped together. All the drives in the 

array are assigned the same RAID level. An array is 

sometimes referred to as a ″RAID set.″ See also 

redundant array of independent disks (RAID), RAID 

level. 

asynchronous write mode.  In remote mirroring, an 

option that allows the primary controller to return a write 

I/O request completion to the host server before data 

has been successfully written by the secondary 

controller. See also synchronous write mode, remote 

mirroring, Global Copy,Global Mirroring. 

AT.  See advanced technology (AT) bus architecture. 

ATA.  See AT-attached. 

AT-attached.  Peripheral devices that are compatible 

with the original IBM AT computer standard in which 

signals on a 40-pin AT-attached (ATA) ribbon cable 

followed the timings and constraints of the Industry 

Standard Architecture (ISA) system bus on the IBM PC 

AT computer. Equivalent to integrated drive electronics 

(IDE). 
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auto-volume transfer/auto-disk transfer (AVT/ADT).  

A function that provides automatic failover in case of 

controller failure on a storage subsystem. 

AVT/ADT.   See auto-volume transfer/auto-disk transfer. 

AWT.  See Abstract Windowing Toolkit. 

basic input/output system (BIOS).  The personal 

computer code that controls basic hardware operations, 

such as interactions with diskette drives, hard disk 

drives, and the keyboard. 

BIOS.   See basic input/output system. 

BOOTP.   See bootstrap protocol. 

bootstrap protocol (BOOTP).  In Transmission Control 

Protocol/Internet Protocol (TCP/IP) networking, an 

alternative protocol by which a diskless machine can 

obtain its Internet Protocol (IP) address and such 

configuration information as IP addresses of various 

servers from a BOOTP server. 

bridge.  A storage area network (SAN) device that 

provides physical and transport conversion, such as 

fibre channel to small computer system interface (SCSI) 

bridge. 

bridge group.  A bridge and the collection of devices 

connected to it. 

broadcast.  The simultaneous transmission of data to 

more than one destination. 

cathode ray tube (CRT).  A display device in which 

controlled electron beams are used to display 

alphanumeric or graphical data on an 

electroluminescent screen. 

client.  A computer system or process that requests a 

service of another computer system or process that is 

typically referred to as a server. Multiple clients can 

share access to a common server. 

command.  A statement used to initiate an action or 

start a service. A command consists of the command 

name abbreviation, and its parameters and flags if 

applicable. A command can be issued by typing it on a 

command line or selecting it from a menu. 

community string.  The name of a community 

contained in each Simple Network Management 

Protocol (SNMP) message. 

concurrent download.  A method of downloading and 

installing firmware that does not require the user to stop 

I/O to the controllers during the process. 

CRC.   See cyclic redundancy check. 

CRT.  See cathode ray tube. 

CRU.   See customer replaceable unit. 

customer replaceable unit (CRU).  An assembly or 

part that a customer can replace in its entirety when any 

of its components fail. Contrast with field replaceable 

unit (FRU). 

cyclic redundancy check (CRC).   (1) A redundancy 

check in which the check key is generated by a cyclic 

algorithm. (2) An error detection technique performed at 

both the sending and receiving stations. 

dac.  See disk array controller. 

dar.  See disk array router. 

DASD.   See direct access storage device. 

data striping.  See striping. 

default host group.  A logical collection of discovered 

host ports, defined host computers, and defined host 

groups in the storage-partition topology that fulfill the 

following requirements: 

v   Are not involved in specific logical drive-to-LUN 

mappings 

v   Share access to logical drives with default logical 

drive-to-LUN mappings

device type.  Identifier used to place devices in the 

physical map, such as the switch, hub, or storage. 

DHCP.   See Dynamic Host Configuration Protocol. 

direct access storage device (DASD).   A device in 

which access time is effectively independent of the 

location of the data. Information is entered and retrieved 

without reference to previously accessed data. (For 

example, a disk drive is a DASD, in contrast with a tape 

drive, which stores data as a linear sequence.) DASDs 

include both fixed and removable storage devices. 

direct memory access (DMA).   The transfer of data 

between memory and an input/output (I/O) device 

without processor intervention. 

disk array controller (dac).  A disk array controller 

device that represents the two controllers of an array. 

See also disk array router. 

disk array router (dar).  A disk array router that 

represents an entire array, including current and 

deferred paths to all logical unit numbers (LUNs) (hdisks 

on AIX). See also disk array controller. 

DMA.   See direct memory access. 

domain.  The most significant byte in the node port 

(N_port) identifier for the fibre-channel (FC) device. It is 

not used in the fibre channel-small computer system 

interface (FC-SCSI) hardware path ID. It is required to 

be the same for all SCSI targets logically connected to 

an FC adapter. 
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drive channels.  The DS4200, DS4700, and DS4800 

subsystems use dual-port drive channels that, from the 

physical point of view, are connected in the same way 

as two drive loops. However, from the point of view of 

the number of drives and enclosures, they are treated 

as a single drive loop instead of two different drive 

loops. A group of storage expansion enclosures are 

connected to the DS4000 storage subsystems using a 

drive channel from each controller. This pair of drive 

channels is referred to as a redundant drive channel 

pair. 

drive loops.  A drive loop consists of one channel from 

each controller combined to form one pair of redundant 

drive channels or a redundant drive loop. Each drive 

loop is associated with two ports. (There are two drive 

channels and four associated ports per controller.) For 

the DS4800, drive loops are more commonly referred to 

as drive channels. See drive channels. 

DRAM.   See dynamic random access memory. 

Dynamic Host Configuration Protocol (DHCP).  A 

protocol defined by the Internet Engineering Task Force 

that is used for dynamically assigning Internet Protocol 

(IP) addresses to computers in a network. 

dynamic random access memory (DRAM).   A 

storage in which the cells require repetitive application 

of control signals to retain stored data. 

ECC.   See error correction coding. 

EEPROM.   See electrically erasable programmable 

read-only memory. 

EISA.  See Extended Industry Standard Architecture. 

electrically erasable programmable read-only 

memory (EEPROM).  A type of memory chip which can 

retain its contents without consistent electrical power. 

Unlike the PROM which can be programmed only once, 

the EEPROM can be erased electrically. Because it can 

only be reprogrammed a limited number of times before 

it wears out, it is appropriate for storing small amounts 

of data that are changed infrequently. 

electrostatic discharge (ESD).  The flow of current 

that results when objects that have a static charge 

come into close enough proximity to discharge. 

environmental service module (ESM) canister.  A 

component in a storage expansion enclosure that 

monitors the environmental condition of the components 

in that enclosure. Not all storage subsystems have ESM 

canisters. 

E_port.  See expansion port. 

error correction coding (ECC).  A method for 

encoding data so that transmission errors can be 

detected and corrected by examining the data on the 

receiving end. Most ECCs are characterized by the 

maximum number of errors they can detect and correct. 

ESD.  See electrostatic discharge. 

ESM canister.  See environmental service module 

canister. 

automatic ESM firmware synchronization.  When 

you install a new ESM into an existing storage 

expansion enclosure in a DS4000 storage subsystem 

that supports automatic ESM firmware synchronization, 

the firmware in the new ESM is automatically 

synchronized with the firmware in the existing ESM. 

EXP.  See storage expansion enclosure. 

expansion port (E_port).  A port that connects the 

switches for two fabrics. 

Extended Industry Standard Architecture (EISA).  A 

bus standard for IBM compatibles that extends the 

Industry Standard Architecture (ISA) bus architecture to 

32 bits and allows more than one central processing 

unit (CPU) to share the bus. See also Industry Standard 

Architecture. 

fabric.  A fibre channel entity which interconnects and 

facilitates logins of N_ports attached to it. The fabric is 

responsible for routing frames between source and 

destination N_ports using address information in the 

frame header. A fabric can be as simple as a 

point-to-point channel between two N-ports, or as 

complex as a frame-routing switch that provides multiple 

and redundant internal pathways within the fabric 

between F_ports. 

fabric port (F_port).  In a fabric, an access point for 

connecting a user’s N_port. An F_port facilitates N_port 

logins to the fabric from nodes connected to the fabric. 

An F_port is addressable by the N_port connected to it. 

See also fabric. 

FC.  See Fibre Channel. 

FC-AL.  See arbitrated loop. 

feature enable identifier.  A unique identifier for the 

storage subsystem, which is used in the process of 

generating a premium feature key. See also premium 

feature key. 

Fibre Channel (FC).  A set of standards for a serial 

input/output (I/O) bus capable of transferring data 

between two ports at up to 100 Mbps, with standards 

proposals to go to higher speeds. FC supports 

point-to-point, arbitrated loop, and switched topologies. 

Fibre Channel Arbitrated Loop (FC-AL).  See 

arbitrated loop. 

Fibre Channel Protocol (FCP) for small computer 

system interface (SCSI).  A high-level fibre-channel 

mapping layer (FC-4) that uses lower-level fibre-channel 

 

Glossary 267



(FC-PH) services to transmit SCSI commands, data, 

and status information between a SCSI initiator and a 

SCSI target across the FC link by using FC frame and 

sequence formats. 

field replaceable unit (FRU).  An assembly that is 

replaced in its entirety when any one of its components 

fails. In some cases, a field replaceable unit might 

contain other field replaceable units. Contrast with 

customer replaceable unit (CRU). 

FlashCopy.  A premium feature for DS4000 that can 

make an instantaneous copy of the data in a volume. 

F_port.  See fabric port. 

FRU.   See field replaceable unit. 

GBIC.   See gigabit interface converter 

gigabit interface converter (GBIC).   A transceiver that 

performs serial, optical-to-electrical, and 

electrical-to-optical signal conversions for high-speed 

networking. A GBIC can be hot swapped. See also 

small form-factor pluggable. 

Global Copy.  Refers to a remote logical drive mirror 

pair that is set up using asynchronous write mode 

without the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring without 

Consistency Group.″ Global Copy does not ensure that 

write requests to multiple primary logical drives are 

carried out in the same order on the secondary logical 

drives as they are on the primary logical drives. If it is 

critical that writes to the primary logical drives are 

carried out in the same order in the appropriate 

secondary logical drives, Global Mirroring should be 

used instead of Global Copy. See also asynchronous 

write mode, Global Mirroring, remote mirroring, Metro 

Mirroring. 

Global Mirroring.  Refers to a remote logical drive 

mirror pair that is set up using asynchronous write mode 

with the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring with Consistency 

Group.″ Global Mirroring ensures that write requests to 

multiple primary logical drives are carried out in the 

same order on the secondary logical drives as they are 

on the primary logical drives, preventing data on the 

secondary logical drives from becoming inconsistent 

with the data on the primary logical drives. See also 

asynchronous write mode, Global Copy, remote 

mirroring, Metro Mirroring. 

graphical user interface (GUI).  A type of computer 

interface that presents a visual metaphor of a real-world 

scene, often of a desktop, by combining high-resolution 

graphics, pointing devices, menu bars and other menus, 

overlapping windows, icons, and the object-action 

relationship. 

GUI.   See graphical user interface. 

HBA.   See host bus adapter. 

hdisk.  An AIX term representing a logical unit number 

(LUN) on an array. 

heterogeneous host environment.  A host system in 

which multiple host servers, which use different 

operating systems with their own unique disk storage 

subsystem settings, connect to the same DS4000 

storage subsystem at the same time. See also host. 

host.  A system that is directly attached to the storage 

subsystem through a fibre-channel input/output (I/O) 

path. This system is used to serve data (typically in the 

form of files) from the storage subsystem. A system can 

be both a storage management station and a host 

simultaneously. 

host bus adapter (HBA).   An interface between the 

fibre-channel network and a workstation or server. 

host computer.  See host. 

host group.  An entity in the storage partition topology 

that defines a logical collection of host computers that 

require shared access to one or more logical drives. 

host port.  Ports that physically reside on the host 

adapters and are automatically discovered by the 

DS4000 Storage Manager software. To give a host 

computer access to a partition, its associated host ports 

must be defined. 

hot swap.  To replace a hardware component without 

turning off the system. 

hub.  In a network, a point at which circuits are either 

connected or switched. For example, in a star network, 

the hub is the central node; in a star/ring network, it is 

the location of wiring concentrators. 

IBMSAN  driver.  The device driver that is used in a 

Novell NetWare environment to provide multipath 

input/output (I/O) support to the storage controller. 

IC.   See integrated circuit. 

IDE.  See integrated drive electronics. 

in-band.  Transmission of management protocol over 

the fibre-channel transport. 

Industry Standard Architecture (ISA).  Unofficial 

name for the bus architecture of the IBM PC/XT™ 

personal computer. This bus design included expansion 

slots for plugging in various adapter boards. Early 

versions had an 8-bit data path, later expanded to 16 

bits. The ″Extended Industry Standard Architecture″ 

(EISA) further expanded the data path to 32 bits. See 

also Extended Industry Standard Architecture. 
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initial program load (IPL).  The initialization procedure 

that causes an operating system to commence 

operation. Also referred to as a system restart, system 

startup, and boot. 

integrated circuit (IC).  A microelectronic 

semiconductor device that consists of many 

interconnected transistors and other components. ICs 

are constructed on a small rectangle cut from a silicon 

crystal or other semiconductor material. The small size 

of these circuits allows high speed, low power 

dissipation, and reduced manufacturing cost compared 

with board-level integration. Also known as a chip. 

integrated drive electronics (IDE).  A disk drive 

interface based on the 16-bit IBM personal computer 

Industry Standard Architecture (ISA) in which the 

controller electronics reside on the drive itself, 

eliminating the need for a separate adapter card. Also 

known as an Advanced Technology Attachment 

Interface (ATA). 

Internet Protocol (IP).  A protocol that routes data 

through a network or interconnected networks. IP acts 

as an intermediary between the higher protocol layers 

and the physical network. 

Internet Protocol (IP) address.  The unique 32-bit 

address that specifies the location of each device or 

workstation on the Internet. For example, 9.67.97.103 is 

an IP address. 

interrupt request (IRQ).  A type of input found on 

many processors that causes the processor to suspend 

normal processing temporarily and start running an 

interrupt handler routine. Some processors have several 

interrupt request inputs that allow different priority 

interrupts. 

IP.  See Internet Protocol. 

IPL.  See initial program load. 

IRQ.   See interrupt request. 

ISA.  See Industry Standard Architecture. 

Java Runtime Environment (JRE).  A subset of the 

Java Development Kit (JDK) for end users and 

developers who want to redistribute the Java Runtime 

Environment (JRE). The JRE consists of the Java virtual 

machine, the Java Core Classes, and supporting files. 

JRE.  See Java Runtime Environment. 

label.  A discovered or user entered property value that 

is displayed underneath each device in the Physical and 

Data Path maps. 

LAN.   See local area network. 

LBA.   See logical block address. 

local area network (LAN).  A computer network 

located on a user’s premises within a limited geographic 

area. 

logical block address (LBA).  The address of a logical 

block. Logical block addresses are typically used in 

hosts’ I/O commands. The SCSI disk command 

protocol, for example, uses logical block addresses. 

logical partition (LPAR).  (1) A subset of a single 

system that contains resources (processors, memory, 

and input/output devices). A logical partition operates as 

an independent system. If hardware requirements are 

met, multiple logical partitions can exist within a system. 

(2) A fixed-size portion of a logical volume. A logical 

partition is the same size as the physical partitions in its 

volume group. Unless the logical volume of which it is a 

part is mirrored, each logical partition corresponds to, 

and its contents are stored on, a single physical 

partition. (3) One to three physical partitions (copies). 

The number of logical partitions within a logical volume 

is variable. 

logical unit number (LUN).  An identifier used on a 

small computer system interface (SCSI) bus to 

distinguish among up to eight devices (logical units) with 

the same SCSI ID. 

loop address.  The unique ID of a node in 

fibre-channel loop topology sometimes referred to as a 

loop ID. 

loop group.  A collection of storage area network 

(SAN) devices that are interconnected serially in a 

single loop circuit. 

loop port.  A node port (N_port) or fabric port (F_port) 

that supports arbitrated loop functions associated with 

an arbitrated loop topology. 

LPAR.  See logical partition. 

LUN.  See logical unit number. 

MAC.   See medium access control. 

management information base (MIB).  The 

information that is on an agent. It is an abstraction of 

configuration and status information. 

man  pages.  In UNIX-based operating systems, online 

documentation for operating system commands, 

subroutines, system calls, file formats, special files, 

stand-alone utilities, and miscellaneous facilities. 

Invoked by the man  command. 

MCA.   See micro channel architecture. 

media scan.  A media scan is a background process 

that runs on all logical drives in the storage subsystem 

for which it has been enabled, providing error detection 

on the drive media. The media scan process scans all 
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logical drive data to verify that it can be accessed, and 

optionally scans the logical drive redundancy 

information. 

medium access control (MAC).   In local area 

networks (LANs), the sublayer of the data link control 

layer that supports medium-dependent functions and 

uses the services of the physical layer to provide 

services to the logical link control sublayer. The MAC 

sublayer includes the method of determining when a 

device has access to the transmission medium. 

Metro Mirroring.  This term is used to refer to a 

remote logical drive mirror pair which is set up with 

synchronous write mode. See also remote mirroring, 

Global Mirroring. 

MIB.   See management information base. 

micro channel architecture (MCA).   Hardware that is 

used for PS/2 Model 50 computers and above to 

provide better growth potential and performance 

characteristics when compared with the original 

personal computer design. 

Microsoft Cluster Server (MSCS).  MSCS, a feature 

of Windows NT Server (Enterprise Edition), supports the 

connection of two servers into a cluster for higher 

availability and easier manageability. MSCS can 

automatically detect and recover from server or 

application failures. It can also be used to balance 

server workload and provide for planned maintenance. 

mini hub.  An interface card or port device that 

receives short-wave fiber channel GBICs or SFPs. 

These devices enable redundant fibre channel 

connections from the host computers, either directly or 

through a fibre channel switch or managed hub, over 

optical fiber cables to the DS4000 Storage Server 

controllers. Each DS4000 controller is responsible for 

two mini hubs. Each mini hub has two ports. Four host 

ports (two on each controller) provide a cluster solution 

without use of a switch. Two host-side mini hubs are 

shipped as standard. See also host port, gigabit 

interface converter (GBIC), small form-factor pluggable 

(SFP). 

mirroring.  A fault-tolerance technique in which 

information on a hard disk is duplicated on additional 

hard disks. See also remote mirroring. 

model.  The model identification that is assigned to a 

device by its manufacturer. 

MSCS.   See Microsoft Cluster Server. 

network management station (NMS).  In the Simple 

Network Management Protocol (SNMP), a station that 

runs management application programs that monitor 

and control network elements. 

NMI.   See non-maskable interrupt. 

NMS.  See network management station. 

non-maskable interrupt (NMI).  A hardware interrupt 

that another service request cannot overrule (mask). An 

NMI bypasses and takes priority over interrupt requests 

generated by software, the keyboard, and other such 

devices and is issued to the microprocessor only in 

disastrous circumstances, such as severe memory 

errors or impending power failures. 

node.  A physical device that allows for the 

transmission of data within a network. 

node port (N_port).  A fibre-channel defined hardware 

entity that performs data communications over the 

fibre-channel link. It is identifiable by a unique worldwide 

name. It can act as an originator or a responder. 

nonvolatile storage (NVS).  A storage device whose 

contents are not lost when power is cut off. 

N_port.  See node port. 

NVS.  See nonvolatile storage. 

NVSRAM.   Nonvolatile storage random access 

memory. See nonvolatile storage. 

Object Data Manager (ODM).   An AIX proprietary 

storage mechanism for ASCII stanza files that are 

edited as part of configuring a drive into the kernel. 

ODM.   See Object Data Manager. 

out-of-band.  Transmission of management protocols 

outside of the fibre-channel network, typically over 

Ethernet. 

partitioning.  See storage partition. 

parity check.  (1) A test to determine whether the 

number of ones (or zeros) in an array of binary digits is 

odd or even. (2) A mathematical operation on the 

numerical representation of the information 

communicated between two pieces. For example, if 

parity is odd, any character represented by an even 

number has a bit added to it, making it odd, and an 

information receiver checks that each unit of information 

has an odd value. 

PCI local bus.  See peripheral component interconnect 

local bus. 

PDF.  See portable document format. 

performance events.  Events related to thresholds set 

on storage area network (SAN) performance. 

peripheral component interconnect local bus (PCI  

local bus).  A local bus for PCs, from Intel, that 

provides a high-speed data path between the CPU and 

up to 10 peripherals (video, disk, network, and so on). 

The PCI bus coexists in the PC with the Industry 

Standard Architecture (ISA) or Extended Industry 
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Standard Architecture (EISA) bus. ISA and EISA boards 

plug into an IA or EISA slot, while high-speed PCI 

controllers plug into a PCI slot. See also Industry 

Standard Architecture, Extended Industry Standard 

Architecture. 

polling delay.  The time in seconds between 

successive discovery processes during which discovery 

is inactive. 

port.  A part of the system unit or remote controller to 

which cables for external devices (such as display 

stations, terminals, printers, switches, or external 

storage units) are attached. The port is an access point 

for data entry or exit. A device can contain one or more 

ports. 

portable document format (PDF).  A standard 

specified by Adobe® Systems, Incorporated, for the 

electronic distribution of documents. PDF files are 

compact; can be distributed globally by e-mail, the Web, 

intranets, or CD-ROM; and can be viewed with the 

Acrobat Reader, which is software from Adobe Systems 

that can be downloaded at no cost from the Adobe 

Systems home page. 

premium feature key.  A file that the storage 

subsystem controller uses to enable an authorized 

premium feature. The file contains the feature enable 

identifier of the storage subsystem for which the 

premium feature is authorized, and data about the 

premium feature. See also feature enable identifier. 

private loop.  A freestanding arbitrated loop with no 

fabric attachment. See also arbitrated loop. 

program temporary fix (PTF).  A temporary solution or 

bypass of a problem diagnosed by IBM in a current 

unaltered release of the program. 

PTF.  See program temporary fix. 

RAID.   See redundant array of independent disks 

(RAID). 

RAID  level.  An array’s RAID level is a number that 

refers to the method used to achieve redundancy and 

fault tolerance in the array. See also array, redundant 

array of independent disks (RAID). 

RAID  set.  See array. 

RAM.   See random-access memory. 

random-access memory (RAM).   A temporary storage 

location in which the central processing unit (CPU) 

stores and executes its processes. Contrast with DASD. 

RDAC.   See redundant disk array controller. 

read-only memory (ROM).   Memory in which stored 

data cannot be changed by the user except under 

special conditions. 

recoverable virtual shared disk (RVSD).  A virtual 

shared disk on a server node configured to provide 

continuous access to data and file systems in a cluster. 

redundant array of independent disks (RAID).  A 

collection of disk drives (array) that appears as a single 

volume to the server, which is fault tolerant through an 

assigned method of data striping, mirroring, or parity 

checking. Each array is assigned a RAID level, which is 

a specific number that refers to the method used to 

achieve redundancy and fault tolerance. See also array, 

parity check, mirroring, RAID level, striping. 

redundant disk array controller (RDAC).   (1) In 

hardware, a redundant set of controllers (either 

active/passive or active/active). (2) In software, a layer 

that manages the input/output (I/O) through the active 

controller during normal operation and transparently 

reroutes I/Os to the other controller in the redundant set 

if a controller or I/O path fails. 

remote mirroring.  Online, real-time replication of data 

between storage subsystems that are maintained on 

separate media. The Enhanced Remote Mirror Option is 

a DS4000 premium feature that provides support for 

remote mirroring. See also Global Mirroring, Metro 

Mirroring. 

ROM.   See read-only memory. 

router.  A computer that determines the path of 

network traffic flow. The path selection is made from 

several paths based on information obtained from 

specific protocols, algorithms that attempt to identify the 

shortest or best path, and other criteria such as metrics 

or protocol-specific destination addresses. 

RVSD.  See recoverable virtual shared disk. 

SAI.  See Storage Array Identifier. 

SA Identifier.  See Storage Array Identifier. 

SAN.   See storage area network. 

SATA.  See serial ATA. 

scope.  Defines a group of controllers by their Internet 

Protocol (IP) addresses. A scope must be created and 

defined so that dynamic IP addresses can be assigned 

to controllers on the network. 

SCSI.  See small computer system interface. 

segmented loop port (SL_port).  A port that allows 

division of a fibre-channel private loop into multiple 

segments. Each segment can pass frames around as 

an independent loop and can connect through the fabric 

to other segments of the same loop. 

sense data.  (1) Data sent with a negative response, 

indicating the reason for the response. (2) Data 

describing an I/O error. Sense data is presented to a 

host system in response to a sense request command. 
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serial ATA.  The standard for a high-speed alternative 

to small computer system interface (SCSI) hard drives. 

The SATA-1 standard is equivalent in performance to a 

10 000 RPM SCSI drive. 

serial storage architecture (SSA).  An interface 

specification from IBM in which devices are arranged in 

a ring topology. SSA, which is compatible with small 

computer system interface (SCSI) devices, allows 

full-duplex packet multiplexed serial data transfers at 

rates of 20 Mbps in each direction. 

server.  A functional hardware and software unit that 

delivers shared resources to workstation client units on 

a computer network. 

server/device events.  Events that occur on the server 

or a designated device that meet criteria that the user 

sets. 

SFP.  See small form-factor pluggable. 

Simple Network Management Protocol (SNMP).  In 

the Internet suite of protocols, a network management 

protocol that is used to monitor routers and attached 

networks. SNMP is an application layer protocol. 

Information on devices managed is defined and stored 

in the application’s Management Information Base 

(MIB). 

SL_port.  See segmented loop port. 

SMagent.  The DS4000 Storage Manager optional 

Java-based host-agent software, which can be used on 

Microsoft Windows, Novell NetWare, AIX, HP-UX, 

Solaris, and Linux on POWER host systems to manage 

storage subsystems through the host fibre-channel 

connection. 

SMclient.  The DS4000 Storage Manager client 

software, which is a Java-based graphical user interface 

(GUI) that is used to configure, manage, and 

troubleshoot storage servers and storage expansion 

enclosures in a DS4000 storage subsystem. SMclient 

can be used on a host system or on a storage 

management station. 

SMruntime.  A Java compiler for the SMclient. 

SMutil.  The DS4000 Storage Manager utility software 

that is used on Microsoft Windows, AIX, HP-UX, Solaris, 

and Linux on POWER host systems to register and map 

new logical drives to the operating system. In Microsoft 

Windows, it also contains a utility to flush the cached 

data of the operating system for a particular drive before 

creating a FlashCopy. 

small computer system interface (SCSI).  A standard 

hardware interface that enables a variety of peripheral 

devices to communicate with one another. 

small form-factor pluggable (SFP).  An optical 

transceiver that is used to convert signals between 

optical fiber cables and switches. An SFP is smaller 

than a gigabit interface converter (GBIC). See also 

gigabit interface converter. 

SNMP.  See Simple Network Management Protocol and 

SNMPv1. 

SNMP trap event.  (1) (2) An event notification sent by 

the SNMP agent that identifies conditions, such as 

thresholds, that exceed a predetermined value. See 

also Simple Network Management Protocol. 

SNMPv1.  The original standard for SNMP is now 

referred to as SNMPv1, as opposed to SNMPv2, a 

revision of SNMP. See also Simple Network 

Management Protocol. 

SRAM.   See static random access memory. 

SSA.  See serial storage architecture. 

static random access memory (SRAM).   Random 

access memory based on the logic circuit know as 

flip-flop. It is called static because it retains a value as 

long as power is supplied, unlike dynamic random 

access memory (DRAM), which must be regularly 

refreshed. It is however, still volatile, meaning that it can 

lose its contents when the power is turned off. 

storage area network (SAN).  A dedicated storage 

network tailored to a specific environment, combining 

servers, storage products, networking products, 

software, and services. See also fabric. 

Storage Array Identifier (SAI or SA Identifier).  The 

Storage Array Identifier is the identification value used 

by the DS4000 Storage Manager host software 

(SMClient) to uniquely identify each managed storage 

server. The DS4000 Storage Manager SMClient 

program maintains Storage Array Identifier records of 

previously-discovered storage servers in the host 

resident file, which allows it to retain discovery 

information in a persistent fashion. 

storage expansion enclosure (EXP).  A feature that 

can be connected to a system unit to provide additional 

storage and processing capacity. 

storage management station.  A system that is used 

to manage the storage subsystem. A storage 

management station does not need to be attached to 

the storage subsystem through the fibre-channel 

input/output (I/O) path. 

storage partition.  Storage subsystem logical drives 

that are visible to a host computer or are shared among 

host computers that are part of a host group. 

storage partition topology.  In the DS4000 Storage 

Manager client, the Topology view of the Mappings 

window displays the default host group, the defined host 

group, the host computer, and host-port nodes. The 

host port, host computer, and host group topological 
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elements must be defined to grant access to host 

computers and host groups using logical drive-to-LUN 

mappings. 

striping.  Splitting data to be written into equal blocks 

and writing blocks simultaneously to separate disk 

drives. Striping maximizes performance to the disks. 

Reading the data back is also scheduled in parallel, with 

a block being read concurrently from each disk then 

reassembled at the host. 

subnet.  An interconnected but independent segment 

of a network that is identified by its Internet Protocol (IP) 

address. 

sweep method.  A method of sending Simple Network 

Management Protocol (SNMP) requests for information 

to all the devices on a subnet by sending the request to 

every device in the network. 

switch.  A fibre-channel device that provides full 

bandwidth per port and high-speed routing of data by 

using link-level addressing. 

switch group.  A switch and the collection of devices 

connected to it that are not in other groups. 

switch zoning.  See zoning. 

synchronous write mode.  In remote mirroring, an 

option that requires the primary controller to wait for the 

acknowledgment of a write operation from the 

secondary controller before returning a write I/O request 

completion to the host. See also asynchronous write 

mode, remote mirroring, Metro Mirroring. 

system name.  Device name assigned by the vendor’s 

third-party software. 

TCP.   See Transmission Control Protocol. 

TCP/IP.  See Transmission Control Protocol/Internet 

Protocol. 

terminate and stay resident program (TSR 

program).  A program that installs part of itself as an 

extension of DOS when it is executed. 

topology.  The physical or logical arrangement of 

devices on a network. The three fibre-channel 

topologies are fabric, arbitrated loop, and point-to-point. 

The default topology for the disk array is arbitrated loop. 

TL_port.  See translated loop port. 

transceiver.  A device that is used to transmit and 

receive data. Transceiver is an abbreviation of 

transmitter-receiver. 

translated loop port (TL_port).  A port that connects 

to a private loop and allows connectivity between the 

private loop devices and off loop devices (devices not 

connected to that particular TL_port). 

Transmission Control Protocol (TCP).  A 

communication protocol used in the Internet and in any 

network that follows the Internet Engineering Task Force 

(IETF) standards for internetwork protocol. TCP 

provides a reliable host-to-host protocol between hosts 

in packed-switched communication networks and in 

interconnected systems of such networks. It uses the 

Internet Protocol (IP) as the underlying protocol. 

Transmission Control Protocol/Internet Protocol 

(TCP/IP).  A set of communication protocols that 

provide peer-to-peer connectivity functions for both local 

and wide-area networks. 

trap.  In the Simple Network Management Protocol 

(SNMP), a message sent by a managed node (agent 

function) to a management station to report an 

exception condition. 

trap recipient.  Receiver of a forwarded Simple 

Network Management Protocol (SNMP) trap. 

Specifically, a trap receiver is defined by an Internet 

Protocol (IP) address and port to which traps are sent. 

Presumably, the actual recipient is a software 

application running at the IP address and listening to 

the port. 

TSR program.  See terminate and stay resident 

program. 

uninterruptible power supply.  A source of power 

from a battery that is installed between a computer 

system and its power source. The uninterruptible power 

supply keeps the system running if a commercial power 

failure occurs, until an orderly shutdown of the system 

can be performed. 

user action events.  Actions that the user takes, such 

as changes in the storage area network (SAN), changed 

settings, and so on. 

worldwide port name (WWPN).   A unique identifier for 

a switch on local and global networks. 

worldwide name (WWN).  A globally unique 64-bit 

identifier assigned to each fibre channel port. 

WORM.   See write-once read-many. 

write-once read many (WORM).   Any type of storage 

medium to which data can be written only a single time, 

but can be read from any number of times. After the 

data is recorded, it cannot be altered. 

WWN.   See worldwide name. 

zoning.  (1) In fibre channel environments, the 

grouping of multiple ports to form a virtual, private, 

storage network. Ports that are members of a zone can 

communicate with each other, but are isolated from 

ports in other zones. (2) A function that allows 

segmentation of nodes by address, name, or physical 

port and is provided by fabric switches or hubs.
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